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1 Introduction
Software	applications	for	astronomy	on	the	Macintosh	are	not	nearly	as	abundant	as	applications	on
other	platforms.	Although	there	are	several	planetarium-style	applications	(TheSky,	Starry	Night,	
SkySafari,	etc.)	and	a	few	others	for	telescope	control,	CCD	camera	operation	(iCCD,	CCDSoft,	etc.)	
and	a	few	minor	utilities,	there	are	some	serious	gaps.	One	of	these	is	astronomical	visual	observa-
tion	planning	and	logging.	AstroPlanner	attempts	to	Fill	this	particular	gap.

Although	originally	developed	on	and	for	the	Macintosh,	a	Windows	version	is	available	which	is	
functionally	identical	to	the	Macintosh	version.	The	examples	and	descriptions	in	this	manual	are	il-
lustrated	with	screen	shots	from	the	macOS	version,	but	the	Windows	version	behaves	identically	
(except	where	noted).

1.1 What AstroPlanner does
AstroPlanner	is	a	stand-alone	application	that	allows	the	user	to	plan	and	execute	an	observing	ses-
sion.	The	user	can	enter	objects	to	be	viewed	manually,	import	them	from	text	Files,	look	them	up	in	
several	supplied	catalogues,	or	use	observing	plans	previously	created	by	others.	These	objects	can	
be	both	deep-sky	and	solar	system	objects	(planets,	sun,	moon,	asteroids,	comets,	etc.).

Once	a	list	of	objects	has	been	created,	they	can	be	observed	and	log	entries	recorded	for	each	of	
them.	The	application	will	also	control	a	wide	range	of	computerised	Go	To	telescopes,	in	order	to	
slew	to	selected	objects.	Several	Digital	Setting	Circle	(DSC)	systems	are	also	supported.	Telescope	
control	is	optional,	so	AstroPlanner	can	be	used	to	great	effect	even	if	you	don’t	have	a	computerised
telescope	mount.

The	application	computes	the	visibility	of	the	objects	for	the	current	observing	session,	shows	the	
sky	for	that	time	and	can	show	the	Field-of-view	for	the	current	object	as	if	it	was	being	viewed	
through	a	virtual	eyepiece,	or	the	sensor	of	an	imager.

Additionally,	if	you	have	a	network	connection,	you	can	download	high-resolution	photographs	of	
any	part	of	the	sky	from	the	Digital	Sky	Survey	(DSS	and	SDSS).

1.2 What AstroPlanner doesn’t do
AstroPlanner	is	not	a	full-blown	planetarium	application.	It	will	not	produce	detailed	sky	maps	or	
do	the	kinds	of	things	an	application	such	as	Starry	Night,	Voyager	or	TheSky	will	do.	It	will	also	not	
do	other	specialised	stuff	like	controlling	CCD	cameras	or	autoguiders,	or	astronomical	image	
processing.

It	is	also	not	a	"one	button	does	it	all"	application,	but	rather	an	intricate	set	of	tools	that	gives	you	
full	control	over	your	observation	planning.	It's	not	difFicult	to	learn	to	use	the	application	in	its	ba-
sic	form.	If	you	run	through	the	quick	start	tutorial	(Chapter	5	on	page	16)	you'll	get	a	good	feel	for	
the	basics.	Using	the	application	to	its	full	extent	does	have	a	learning	curve,	but	you	can	assimilate	
new	skills	as	and	when	you	need	them.	

You	don't	need	to	read	this	entire	manual.	We	recommend	you	read	through	the	First	dozen	chap-
ters.	The	rest	is	reference	material	which	you	can	use	when	you	need	to.	If	you	are	already	familiar	
with	previous	versions	of	AstroPlanner,	you	might	not	need	to	crack	the	manual	at	all.

Feel	free	to	experiment!
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2 Installation
This	chapter	runs	through	the	process	of	installing	AstroPlanner	V2	on	your	computer	(whether	you
are	a	First-time	user	or	upgrading	from	an	older	version).

If	you	are	upgrading	from	AstroPlanner	V1.x	you	should	be	aware	that	the	installations	are	indepen-
dent,	so	that	you	can	run	both	V1	and	V2	together	without	them	interfering	with	each	other.

2.1 Hardware and operating system requirements
AstroPlanner	is	a	64-bit	application	(32-bit	also	available	for	Windows).

For	both	platforms	a	screen	with	an	absolute	minimum	size	(width	and	height)	of	1024	x	600	pixels	
is	required.	If	you	are	connecting	to	a	telescope,	you'll	also	need	a	built-in	serial	port,	an	USB-to-Ser-
ial	converter	(the	Keyspan	products	are	recommended),	or	a	SkyFi/StarSeek	WiFi-to-serial	device.

2.1.1 macOS
AstroPlanner	V2	currently	requires	macOS	10.11	or	later	running	on	an	Intel-based	Macintosh.	
You'll	need	at	least	250MB	of	disk	space,	and	for	a	complete	installation	with	all	optional	catalogues,
2GB+	of	disk	space.

2.1.2 Windows
AstroPlanner	V2	requires	Windows	7	SP1	or	later.	You'll	need	at	least	250MB	of	disk	space,	and	for	a
complete	installation	with	all	optional	catalogues,	2GB+	of	disk	space.

2.2 Telescope mount compatibility
AstroPlanner	V2	has	built-in	drivers	for	the	following	computerised	telescopes	and	mounts:

Astro-Physics	GTO Orion	Intelliscope	with	COL

Celestron	NexStar Orion	SynScan	GoTo

Celestron	Ultima	2000 Sky	Engineering	Sky	Commander

GTD	Pulsar	2 Starmaster	Sky	Tracker

iOptron	GOTONOVA	and	V2 StellarCAT	ServoCAT

Meade	LX200	Classic Takahashi	Temma

Meade	LX200	GPS/R/ACF	(Autostar	II) Tasco	Starguide

Meade	MAX	Mount Vixen	SkySensor

Meade	RCX400 Vixen	SkySensor	2000PC

Meade	ETX,	DS,	LX,	LXD,	LS	series	(Autostar) Vixen	Star	Book

Meade	Magellan Wildcard	Innovations	Argo	Navis

These	drivers	are	available	for	both	Mac	and	Windows.

Additionally,	basic	ASCOM	is	supported	for	the	Windows	version,	so	that	if	your	telescope	mount	
isn't	listed	above,	you	can	use	the	ASCOM	driver	of	your	choice	(note	that	only	telescopes	can	be	dri-
ven	via	the	ASCOM	system,	not	focusers,	etc.)
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2.3 Macintosh application installation
2.3.1 On-line
Download	the	application	from	the	download	web	page:

https://www.astroplanner.net/download.html

The	application	is	in	the	form	of	a	disk	image	File	(.dmg	extension).	

Figure	1:	.dmg	File	in	the	Finder

If	your	browser	does	not	mount	and	open	the	disk	image	for	you,	do	so	by	double-clicking	it	in	the	
Finder.

Figure	2:	Disk	image	opened

Drag	the	application	File	to	your	Applications	folder	(or	drag	in	onto	the	Applications	icon	in	the	disk
image	window).	There	is	no	installer	-	just	run	the	AstroPlanner	application.

2.3.2 DVD-ROM or USB Flash Drive
If	you	ordered	the	DVD-ROM	or	USB	Flash	Drive	with	the	application,	then	mount	the	disk	in	your	
computer,	Find	the	AstroPlanner	disk	image	and	proceed	as	for	the	on-line	installation	above.

Note	that	if	your	DVD-ROM	or	USB	Flash	Drive	is	outdated,	you	might	want	to	download	the	applica-
tion	since	it	will	guarantee	the	latest	version.	If	you	don't	have	the	ability	or	desire	to	download	the	
application,	you	can	always	order	the	latest	version	of	the	application	and	catalogues	on	DVD-ROM	
or	USB	Flash	Drive	for	a	modest	fee.

2.3.3 V2.3 and macOS 10.15 Catalina
Due	to	issues	in	the	Final	development	process,	V2.3	is	neither	code-signed	or	notarised.	This	means	
that	macOS	10.15	might	complain	when	you	First	run	the	application.	We	hope	to	resolve	this	issue	
in	V2.3.1.
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2.4 Windows application installation
2.4.1 On-line
Download	the	application	from	the	download	web	page:

http://www.astroplanner.net/download.html

The	application	is	in	the	form	of	an	installer	application	(InstallAstroPlanner.exe).

Figure	3:	Windows	installer	icon

Double-click	the	installer	to	install	the	application	and	supporting	Files	on	your	hard	disk.

Figure	4:	Windows	installer	in	action

2.4.2 DVD-ROM or USB Flash Drive
If	you	ordered	the	DVD-ROM	or	USB	Flash	Drive	with	the	application,	then	mount	the	disk	in	your	
computer.	The	installer	should	run	automatically.	If	not,	Find	the	InstallAstroplanner.exe	on	the	disk	
and	double-click	it.	Proceed	as	for	the	on-line	installation	above.

Note	that	if	your	DVD-ROM	or	USB	Flash	Drive	is	outdated,	you	might	want	to	download	the	applica-
tion	since	it	will	guarantee	the	latest	version.	If	you	don't	have	the	ability	or	desire	to	download	the	
application,	you	can	always	order	the	latest	version	of	the	application	and	catalogues	on	DVD-ROM	
or	USB	Flash	Drive	for	a	modest	fee.

2.4.3 Uninstalling
When	AstroPlanner	is	installed	it	also	includes	information	required	to	uninstall	AstroPlanner	and	
an	Uninstall	application.
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2.5 Installing catalogues
When	you	First	run	AstroPlanner	it	only	installs	a	few	minimal	catalogues	by	default	(Bright	Star,	
Messier,	NGC).	You	will	need	to	install	more	catalogues	to	make	full	use	of	the	application.	You	can	
elect	to	install	these	catalogues	by	downloading	them	from	the	on-line	web	site	or,	if	you	have	a	
DVD-ROM	or	USB	Flash	Drive	containing	catalogues,	by	installing	them	directly	from	there.

If	you	are	running	AstroPlanner	for	the	First	time,	the	Setup	Wizard	will	give	you	the	opportunity	to	
install	catalogues	(see	Section	4.2	on	page	8	for	First	time	users,	or	Section	23.1	on	page	325	for	in-
stalling	catalogues	via	the	Setup	Wizard	at	a	later	date).

Otherwise	you	use	the	Catalogue	Manager	(File	>	Catalogue	Manager...)	to	manage	your	cata-
logues.	This	is	detailed	in	Chapter	23	on	page	325.
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3 Unregistered users
If	you	are	an	unregistered	user	(i.e.	you	haven't	yet	paid	for	a	licence,	or	need	to	pay	for	an	upgrade	
to	the	current	version),	then	you	will	Find	that	some	features	are	limited	or	unavailable	to	you.	While
you	are	welcome	to	continue	using	AstroPlanner	you	will	need	to	register	in	order	to	remove	these	
restrictions	and	limitations.

3.1 Limitations
The	most	obvious	limitation	is	that	each	time	you	run	the	AstroPlanner	application,	you	will	be	
asked	for	your	licence	number.	This	is	irritating,	but	might	help	to	give	you	the	incentive	to	register.

Figure	5:	Unregistered	user	dialog

The	second	major	limitation	is	that	you	are	limited	to	the	three	installed	catalogues	(Bright	Star,	
Messier	and	NGC).	You	cannot	download	or	install	any	other	catalogues.	Note	that	if	you	are	a	regis-
tered	AstroPlanner	V1	user,	but	have	not	paid	the	upgrade	fee	(if	required),	you	are	also	restricted	to
using	these	three	catalogues,	even	if	you	have	others	installed	via	AstroPlanner	V1.

Other	limitations:

• No	external	catalogues	can	be	used	(USNO	A2.0,	USNO	B1.0,	UCAC3,	etc.).

• No	SIMBAD	searches	can	be	performed.

• You	can	download	user-contributed	plans	only	if	they	contain	objects	from	your	installed	cata-
logues	(i.e.	Messier	and	NGC	objects	only)

• You	cannot	upload	user-contributed	plans	or	user-contributed	scripts.

• You	cannot	import	objects	from	Files,	or	by	downloading	them	(e.g.	comets,	minor	planets,	tour	
Files,	etc.)

3.2 How to register
Go	to	the	web	site	in	your	browser:

https://www.astroplanner.net/

Navigate	to	the	Purchase	page	where	you	will	be	able	to	see	what	your	options	are.
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4 First-time users
If	you	have	never	used	AstroPlanner	before,	this	is	what	will	happen	the	First	time	you	run	the	appli-
cation	after	installing	it.

4.1 Licence
You'll	be	asked	to	agree	to	the	(fairly	liberal)	AstroPlanner	application	licence.	If	you	agree,	click	Yes.
If	you	don't,	click	No	and	the	application	immediately	terminates.

Figure	6:	Licence	agreement	dialog

For	your	convenience,	the	text	of	the	agreement	is	given	below:
NOTICE	TO	USER:	THIS	IS	A	CONTRACT.	BY	INDICATING	YOUR	ACCEPTANCE	BELOW,	YOU	ACCEPT	ALL	
THE	TERMS	AND	CONDITIONS	OF	THIS	AGREEMENT.	IF	YOU	DO	NOT	AGREE	WITH	THE	TERMS	AND	
CONDITIONS	OF	THIS	AGREEMENT,	DESTROY	THE	SOFTWARE	AND	ALL	ASSOCIATED	DOCUMENTATION,	
OR	IF	YOU	PAID	FOR	THE	PRODUCT,	RETURN	IT	FOR	A	REFUND.

This	iLanga,	Inc.	("iLanga")	End	User	License	Agreement	(the	"Agreement")	accompanies	software	("Soft-
ware")	and	related	explanatory	written	materials	("Documentation").	The	term	"Software"	shall	also	in-
clude	any	upgrades,	modiFied	versions,	updates,	additions,	and	copies	of	the	Software	licensed	to	you	by	
iLanga.	iLanga	grants	to	you	a	nonexclusive	license	to	use	the	Software	and	Documentation,	provided	that	
you	agree	to	the	following:

USE	OF	THE	SOFTWARE

You	may:

a.	Install	and	use	the	Software	on	a	hard	disk	or	other	storage	device	of	any	number	of	computers	personal-
ly	owned	and	operated	by	you.

b.	Make	backup	copies	of	the	Software.	

c.	Make	and	use	printed	copies	of	any	document	Files.

COPYRIGHT	

The	Software	is	owned	by	iLanga,	and	its	structure,	organization	and	code	are	the	valuable	trade	secrets	of	
iLanga.	The	Software	is	also	protected	by	United	States	Copyright	Law	and	International	Treaty	provisions.	
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You	must	treat	the	Software	just	as	you	would	any	other	copyrighted	material,	such	as	a	book.	You	may	not	
copy	the	Software	or	the	Documentation,	except	as	set	forth	in	the	"Use	of	the	Software"	section.	Any	copies
that	you	are	permitted	to	make	pursuant	to	this	Agreement	must	contain	the	same	copyright	and	other	
proprietary	notices	that	appear	on	or	in	the	Software.	You	agree	not	to	modify,	adapt	or	translate	the	Soft-
ware.	You	also	agree	not	to	reverse	engineer,	decompile,	disassemble	or	otherwise	attempt	to	discover	the	
source	code	of	the	Software.	Except	as	stated	above,	this	Agreement	does	not	grant	you	any	intellectual	
property	rights	in	the	Software.

TRANSFER

You	may	not	rent,	lease,	sublicense	or	lend	the	Software	or	Documentation.	You	may,	however,	transfer	all	
your	rights	to	use	the	Software	to	another	person	or	legal	entity	provided	(1)	that	you	transfer	this	Agree-
ment,	the	Software,	including	all	copies,	updates	and	prior	versions	and	all	copies	of	font	software	convert-
ed	into	other	formats,	and	all	Documentation	to	such	person	or	entity,	(2)	that	you	retain	no	copies,	includ-
ing	copies	stored	on	a	computer,	and	(3)	that	the	receiving	party	accept	the	terms	and	conditions	of	this	
Agreement.

LIMITED	WARRANTY	

iLanga	warrants	to	you	that	the	Software	will	perform	substantially	in	accordance	with	the	Documentation	
for	the	ninety	(90)	day	period	following	your	receipt	of	the	Software.	If	the	Software	does	not	perform	sub-
stantially	in	accordance	with	the	Documentation,	the	entire	and	exclusive	liability	and	remedy	shall	be	lim-
ited	to	either,	at	iLanga	option,	the	replacement	of	the	Software	or	the	refund	of	the	license	fee	(if	any)	you	
paid	for	the	Software.	ILANGA	DOES	NOT	AND	CANNOT	WARRANT	THE	PERFORMANCE	OR	RESULTS	YOU	
MAY	OBTAIN	BY	USING	THE	SOFTWARE	OR	DOCUMENTATION.	THE	FOREGOING	STATES	THE	SOLE	AND	
EXCLUSIVE	REMEDIES	FOR	ILANGA'S	BREACH	OF	WARRANTY.	EXCEPT	FOR	THE	FOREGOING	LIMITED	
WARRANTY,	ILANGA	AND	ITS	SUPPLIERS	MAKE	NO	WARRANTIES,	EXPRESS	OR	IMPLIED,	AS	TO	NONIN-
FRINGEMENT	OF	THIRD	PARTY	RIGHTS,	MERCHANTABILITY,	OR	FITNESS	FOR	ANY	PARTICULAR	PUR-
POSE.	Some	states	or	jurisdictions	do	not	allow	the	exclusion	of	implied	warranties	or	limitations	on	how	
long	an	implied	warranty	may	last,	so	the	above	limitations	might	not	apply	to	you.	To	the	extent	permissi-
ble,	any	implied	warranties	are	limited	to	ninety	(90)	days.	This	warranty	gives	you	speciFic	legal	rights.	
You	may	have	other	rights	which	vary	from	state	to	state	or	jurisdiction	to	jurisdiction.	For	further	warran-
ty	information,	please	contact	iLanga.

LIMITATION	OF	LIABILITY

IN	NO	EVENT	WILL	ILANGA	BE	LIABLE	TO	YOU	FOR	ANY	CONSEQUENTIAL,	INCIDENTAL	OR	SPECIAL	
DAMAGES,	INCLUDING	ANY	LOST	PROFITS	OR	LOST	SAVINGS	OR	DAMAGE	TO	EQUIPMENT,	EVEN	IF	AN	
ILANGA	REPRESENTATIVE	HAS	BEEN	ADVISED	OF	THE	POSSIBILITY	OF	SUCH	DAMAGES,	OR	FOR	ANY	
CLAIM	BY	ANY	THIRD	PARTY.	SOME	STATES	OR	JURISDICTIONS	DO	NOT	ALLOW	THE	EXCLUSION	OR	LIM-
ITATION	OF	INCIDENTAL,	CONSEQUENTIAL	OR	SPECIAL	DAMAGES,	SO	THE	ABOVE	LIMITATIONS	MAY	
NOT	APPLY	TO	YOU.

4.2 Setup Wizard
As	you	are	a	First	time	user,	the	application	needs	you	set	up	or	customise	various	settings	so	that	
you	can	get	going	without	further	issue.	To	do	this	it	presents	a	Setup	Wizard	dialog	to	lead	you	
through	the	setup.	

4.2.1 Licence information
The	First	thing	you'll	need	to	do	is	enter	your	licence	information	in	the	Fields	given	(unless	you	have
not	yet	registered,	in	which	case	leave	the	Fields	blank).

If	you've	misplaced	your	licence	information,	you	can	get	it	sent	to	you	via	e-mail	by	entering	your	e-
mail	address	in	the	Field	on	the	right	and	clicking	the	Retrieve	button.	If	you	have	changed	your	e-
mail	address	since	you	registered,	then	you	will	not	get	a	reply.	Please	contact	support	with	your	
new	e-mail	address,	remembering	to	include	your	name	and	the	old	e-mail	address:

support@astroplanner.net
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Once	you	have	entered	your	licence	info	(or	not),	click	the	Next	button.

Figure	7:	Setup	Wizard	-	licence	information

4.2.2 Observing site data
AstroPlanner	requires	you	to	specify	information	about	your	observing	site	or	sites.	This	informa-
tion	is	used	to	Figure	out	visibility	at	those	sites.	At	least	one	site	must	be	speciFied.	You'll	need	to	
know	the	latitude	and	longitude	where	your	site	is	situated,	and	its	time	zone.	

However,	if	you	live	in	the	USA	or	Canada,	AstroPlanner	includes	a	database	of	place	names	and	
their	geographic	locations.	Note	that	you	don't	have	to	be	particularly	accurate	with	deFining	the	lat-
itude	or	longitude.	Even	if	you're	out	by	a	degree	or	two,	it	won't	make	much	difference.

Enter	the	site	information	in	the	given	Fields.	The	world	map	will	show	where	the	site	is	(in	case	you	
give	E/W	or	N/S	mixed	up),	and	will	tell	you	if	your	GMT	offset	is	acceptable.		Click	the	Add	this	site	
button	to	add	the	site	data	to	the	resources.

Read	the	text	on	the	right	side	of	the	dialog	for	additional	instructions.	

Note	that	you	don't	have	to	enter	all	of	your	possible	observing	sites	at	this	time,	since	you	can	enter
and	edit	them	later.	Just	add	your	main	site.

When	you	have	Finished,	click	the	Next	button	to	continue.
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Figure	8:	Setup	Wizard	-	Observing	Sites

4.2.3 Telescope data
AstroPlanner	also	expects	you	to	enter	information	about	any	telescopes	you	plan	to	use.	The	infor-
mation	is	used	to	construct	charts	showing	the	view	through	such	a	telescope,	and	what	you	are	
likely	to	see.

The	dialog	includes	a	comprehensive	list	of	commercially-available	telescopes.	If	your	telescope	or	
telescopes	are	in	that	list,	select	the	entry	and	click	the	Add	button.

You	can	also	add	the	information	manually,	and	use	the	Add	this	telescope	button	to	add	the	new	
telescope	entry.

Click	the	Next	button	when	you've	Finished.
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Figure	9:	Setup	Wizard	-	Telescopes

4.2.4 Eyepiece data
You	can	also	enter	information	about	any	eyepieces	you	plan	to	use.	The	information	is	used	in	con-
junction	with	the	telescope	information	to	construct	charts	showing	the	view	through	such	a	tele-
scope/eyepiece	combination,	and	what	you	are	likely	to	see.

The	dialog	includes	a	comprehensive	list	of	commercially-available	eyepiece.	If	your	eyepiece	or	eye-
pieces	are	in	that	list,	select	the	entry	and	click	the	Add	button.

You	can	also	add	the	information	manually,	and	use	the	Add	this	eyepiece	button	to	add	the	new	
eyepiece	entry.

Click	the	Next	button	when	you've	Finished.
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Figure	10:	Setup	Wizard	-	Eyepieces

4.2.5 Catalogues
When	you	enter	the	Catalogues	part	of	the	wizard,	you'll	be	asked	if	you	want	to	install	your	cata-
logues	from	an	AstroPlanner	CD/DVD-ROM	or	USB	Flash	Drive,	if	you	have	such	a	thing.	If	you	do,	
make	sure	the	disk	is	inserted	and	ready	to	read.	Then	click	Yes.

If	you'd	rather	access	the	on-line	inventory	and	download	any	catalogues	you	might	need,	click	No.

Figure	11:	Catalogues	from	DVD-ROM	or	USB	Flash	Drive

A	list	of	available	catalogues	is	presented	(on	the	right	side).	Check	the	checkboxes	next	to	the	cata-
logues	you	wish	to	install	(if	you	want	all	of	them,	click	the	Select	All	button).

- 12 -



If	you're	not	sure	which	ones	you	want,	the	application	can	choose	some	suitable	ones	for	you.	In	
this	case,	in	the	User	Survey	section	on	the	left,	check	all	the	checkboxes	next	to	equipment	you	own,
and	the	kind	of	observing	you	plan	to	be	doing.	As	you	select	options,	suggested	catalogues	will	be	
marked	in	green.	You	can	use	this	as	a	guide,	or	just	click	the	Select	All	Suggested	button.

Figure	12:	Setup	Wizard	-	Catalogues

When	you've	Finished,	click	the	Next	button.	You'll	be	warned	about	the	catalogues	you	selected.

Figure	13:	Catalogue	warning

4.2.6 Sample Plan Document
This	page	of	the	wizard	lets	you	create	a	sample	plan	document	if	you	wish.	Type	in	a	suitable	File	
name,	and	select	some	suitable	astronomical	objects	to	populate	it	with.

The	File	will	be	created	on	your	desktop,	and	opened	for	you.

When	you've	Finished,	click	the	Next	button.
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Figure	14:	Setup	Wizard	-	Sample	Plan	Document

4.2.7 Completion
Finally,	the	actions	you	performed	will	be	summarised	on	the	Complete	page.

To	go	ahead	and	create	the	resources,	sample	File,	and/or	install	catalogues,	click	the	Finish	button.	
Otherwise	click	the	Cancel	button	and	all	actions	will	be	cancelled.

Note	that	you	can	call	up	the	Setup	Wizard	at	any	time	via	the	File	>	Setup	Wizard	menu	item.

If	you	click	Finish	and	there	were	catalogues	selected	to	install,	then	the	Catalogue	manager	win-
dow	is	opened,	and	you'll	need	to	click	the	Install	button	to	Finish	off	the	installation.
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Figure	15:	Setup	Wizard	-	Completion
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5 Quick start tutorial
The	aim	of	this	chapter	is	to	lead	you	through	some	typical	tasks	you	would	use	AstroPlanner	for.	By	
the	end	of	this	chapter	you	should	be	familiar	enough	with	the	application	to	use	it	without	assis-
tance,	and	be	ready	to	start	experimenting	and	exploring.	We	suggest	you	follow	along	and	duplicate
what	is	described	here	yourself,	as	it	will	aid	in	your	familiarisation.

It's	assumed	that	you	have	the	application	open,	and	that	you've	completed	the	installation	tasks.

We're	going	to	do	the	following:

• Set	up	an	observing	plan	for	an	article	in	Sky	&	Telescope	magazine,	which	just	happens	to	be	
available	for	download.

• Set	up	another	observing	plan	for	another	Sky	&	Telescope	article	that	is	not	available.

• Use	the	Plan	Creation	Wizard	and	let	AstroPlanner	set	up	a	custom	plan	for	you.

Once	we've	done	that	we'll	pick	one	of	these	plans	and	do	some	observing.

5.1 Creating a new plan
5.1.1 Setting up a plan that someone else has already done for you
For	illustrative	purposes,	let's	say	we	just	read	the	article	on	pages	67	through	70	of	the	September	
2011	issue	of	Sky	&	Telescope	magazine,	entitled	In	Praise	of	the	Great	Dark	North,	by	David	Rodger.	
This	article	talks	about	a	selection	of	interesting	objects	in	the	northern	sky.	We'd	like	to	set	up	an	
observing	plan	to	look	at	these	objects.	Perhaps	we'll	get	lucky	and	someone	has	already	done	the	
work	for	you	and	is	willing	to	share.	Let's	check	the	on-line	user-contributed	plan	depository.

Figure	16:	User-contributed	plans
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Use	File	>	User-Contributed	Plans	>	Download...	(assuming	you	are	currently	connected	to	the	In-
ternet).	The	window	shown	in	Figure	16	appears.	You	can	look	for	the	item	manually	in	the	hierar-
chical	list	(you'll	Find	it	under	By	Category	>	Magazines	>	Sky	and	Telescope	>	Other),	or	even	
quicker	by	typing	Great	Dark	North	into	the	Find	Field	(centre	right)	and	clicking	Find.

Figure	17:	Using	the	Find	feature

Select	the	GreatDarkNorth.txt	entry	by	clicking	the	checkbox	next	to	it	and	then	clicking	the	Down-
load	button.	The	plan	is	downloaded	and	opened.	Close	the	user-contributed	plans	window	and,	if	
you	so	choose,	save	the	GreatDarkNorth	plan	on	your	hard	disk.

Figure	18:	GreatDarkNorth	observing	plan

5.1.2 Setting up a plan manually
The	next	plan	we	are	going	to	set	up	is	for	an	article	in	the	same	issue	of	Sky	&	Telescope	magazine:	
Deep	Sky	Wonders:	The	Berkeley	Clusters	by	Sue	French	(pages	56	to	58,	September	2011	issue).	This
time	we	won't	assume	someone	else	already	uploaded	the	plan	for	our	convenience,	but	we'll	enter	
the	objects	manually.

Note	that	the	Berkeley	Catalogue	is	available	(for	registered	users)	which	makes	this	a	lot	easier.	
However,	for	the	sake	of	this	exercise,	we'll	assume	the	Berkeley	Catalogue	has	not	been	installed.	
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On	page	57,	French	conveniently	gives	us	a	table	containing	details	about	the	objects	she	refers	to	in	
the	article.	Here	is	a	summary:

Object	ID Magnitude Size RA Dec

NGC	6749 12.4 4' 19h	05.3m +01°	54'

NGC	6791 9.5 10' 19h	20.9m +37°	46'

IC	1310 ~10 4' 20h	10.0m +34°	58'

Berk	82 ~9 4' 19h	11.3m +13°	07'

Messier	29 6.6 10' 20h	24.1m +38°	30'

Berk	86 7.9 7' 20h	20.2m +38°	41'

Berk	87 ~7 10' 20h	21.6m +37°	24'

We're	now	going	to	enter	these	objects	manually.

Create	a	new	plan	document	(File	>	New).

Create	a	new	object	by	clicking	the	+	button	at	the	bottom	left	of	the	object	list.	This	reveals	the	New
Object	dialog.	Type	in	the	ID	of	the	First	object,	NGC	6749	(you	can	skip	the	space	if	you	like).	Hit	the	
Return/Enter	key	or	click	the	Best	button.	NGC	6749	is	found	in	the	catalogues	and	added	to	the	
plan.

Figure	19:	New	object	dialog

Repeat	the	above	procedure	for	NGC	6791,	and	IC	13101.	The	next	object	is	Berk	82.	This	object	can	
be	found	in	the	Berkeley	Catalogue,	but	as	mentioned	above,	we'll	assume	it	isn't	installed.	Click	the	
+	button	as	before,	but	this	time	just	click	the	Empty	button.	This	creates	an	empty	entry.	To	edit	
this	entry	you	will	need	to	reveal	the	editing	Fields	by	clicking	on	the	Show	editing	Lields	button	
(the	small	button,	fourth	from	the	left	underneath	the	object	list).

Into	the	ID	Field	type	"Berk	82".	

Into	the	Right	Ascension	Fields	type	"19"	and	"11.3".	

1. Note	that	you'll	need	the	IC	Catalogue	installed.	Unregistered	users	are	out	of	luck,	and	should	proceed	as	for	Berk	82.
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Into	the	Declination	Fields	type	"13"	and	"7".	

Into	the	Magnitude	Field	type	"9".

Into	the	Size	Field	type	"4".

Use	the	popup	to	the	right	of	the	Type	Field	to	choose	"Open"	as	the	object	type.

Figure	20:	Entering	Berk	82	manually

We're	going	to	demonstrate	another	way	to	enter	Messier	29	(M29).	From	the	Show	Catalogue	pop-
up	button	under	the	list	of	objects,	choose	to	show	the	Messier	Catalogue.
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Figure	21:	Selecting	M29	directly	from	the	catalogue

Select	the	entry	for	M29	and	click	the	Add	Selected	button	(or	drag	the	object	from	the	window	onto
the	object	list	in	your	plan).

Add	the	Final	two	objects	(Berk	86	and	Berk	87)	using	one	the	above	techniques.

Save	the	plan	document	to	hard	disk	if	you	wish.

5.1.3 Letting the Plan Creation Wizard create a plan for you
The	Plan	Creation	Wizard	creates	a	custom	observing	plan	just	for	you.

Start	the	wizard	using	the	File	>	Plan	Creation	Wizard...	menu	command.

Figure	22:	Plan	Creation	Wizard	dialog
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Figure	23:	Plan	Creation	Wizard	-	Who

Use	the	Next	button	to	move	through	the	stages	required	to	build	a	plan.	At	any	stage	you	can	also	
use	the	Previous	button	to	go	back	and	change	an	option	if	you	need	to	do	so.

The	second	panel	(Who)	lets	you	specify	the	observer	(so	we	can	take	into	account	such	aspects	as	
age	and	visual	accuity1).	If	you	haven't	created	an	Observer	resource	just	use	the	"Unknown"	
setting2.	

We	also	specify	the	level	of	difFiculty	for	the	objects	in	the	resulting	observing	plan.	You	can	specify	
Five	levels,	from	Easy	(probably	observable	in	poor	skies	with	minimal	equipment	and	experience)	
through	DifOicult	(probably	requiring	a	lot	of	experience	and	large	aperture	telescopes).	

The	third	panel	(Where	and	When)	speciFies	where	you	will	be	observing	from	(your	observing	
site)	and	when	you	plan	to	do	the	observing.	These	settings	are	used	to	determine	what	objects	will	
be	visible	for	you.	It's	not	reasonable	to	choose	objects	that	either	never	rise	above	the	horizon	at	
your	observing	site,	or	objects	that	never	rise	during	the	observing	period,	but	might	be	visible	at	
other	times	of	the	year.

You	select	the	Observing	site	resource2.	You	then	need	to	specify	the	dates/times	you	plan	to	do	your
observing	(make	sure	the	Restrict	to	option	is	set	to	Date/time).	In	our	case,	we	are	doing	our	ob-
serving	at	the	Winter	Star	Party	site	in	Florida,	during	Winter	(go	Figure),	and	we'll	plan	on	doing	
our	observing	between	the	start	of	nautical	twilight	and	2am	(when	we	collapse	into	our	sleeping	
bag).

1. In the current version of AstroPlanner, these aspects are not taken into account, so any observer has the same weight as any
other	observer.

2. If you want to or need to set up such a resource you can skip ahead to Section 5.2 on page 24. However, you will need to cancel
from	this	dialog	First.

- 21 -



Figure	24:	Plan	Creation	Wizard	-	Where	&	When

The	next	panel	(How)	lets	you	choose	what	instruments	(telescopes	or	binoculars)	you	intend	to	be	
using.	Check	the	appropriate	entries2.

Figure	25:	Plan	Creation	Wizard	-	How

The	next	panel	(What)	speciFies	the	kinds	of	objects	you	want	to	observe	and	how	many.	Select	one	
or	more	object	types	by	checking	the	appropriate	checkboxes.	Don't	worry	about	the	list	of	cata-
logues	-	that's	for	more	advanced	and	specialised	work.

Select	the	maximum	number	of	objects	you'd	like	in	the	observing	plan.	In	this	case	we'll	choose	a	
maximum	of	20	(the	actual	number	found	might	be	fewer).
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Figure	26:	Plan	Creation	Wizard	-	What

The	Final	panel	(Complete)	lets	you	select	whether	to	create	a	new,	untitled	plan	document	for	your	
objects,	or	to	add	them	to	a	currently-open	plan	document.	We'll	choose	a	new	document.

Figure	27:	Plan	Creation	Wizard	-	Complete

When	you	click	the	Finish	button	a	new	document	is	created	with	(in	this	case)	20	objects	in	it.	You	
can	save	the	plan	document	with	whatever	name	you	see	Fit	to	give	it.
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Figure	28:	Plan	Creation	Wizard	-	The	resulting	observing	plan

For	more	information	on	the	Plan	Creation	Wizard	see	Section	10.3	on	page	84.

5.2 Setting up resources
When	you	First	used	AstroPlanner	(assuming	you	didn't	upgrade	from	an	earlier	version,	or	cancel	
from	the	Setup	Wizard),	the	Setup	Wizard	asked	you	to	enter	some	basic	information	about	your	ob-
serving	site	or	sites,	telescopes	and	eyepieces.	All	of	these	entities	are	called	"resources"	(see	Sec-
tion	7.5	on	page	40).	You	will	occasionally	need	to	edit	these	resources	in	order	to	add,	modify	or	
delete	them.	We'll	do	this	to	add	a	telescope	with	a	computerised	mount	for	use	later	in	this	chapter	
(don't	worry	if	you	don't	have	an	actual	computerised	mount	-	we'll	fake	it).

To	edit	resources,	use	the	Edit	>	Resources...	menu	command.
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Figure	29:	Resources	database	window

5.2.1 Sites
The	window	contains	several	tabs,	each	one	containing	a	different	type	of	resource.	The	First	tab	
(Sites)	contains	your	observing	sites.	You	should	have	at	least	one	entry	here.	If	not,	click	the	+	but-
ton	under	the	list	on	the	left	to	create	a	new	one.	Make	sure	you	enter	the	latitude,	longitude	and	
Offset	from	GMT	values	correctly	(other	settings	are	less	critical).

5.2.2 Telescopes
Select	the	second	tab	(Telescopes).	For	this	exercise	you	should	have	at	least	one	telescope	deFined.	
You	should	also	set	up	a	telescope	with	a	computerised	mount,	so	that	you	can	experiment	with	con-
trolling	that	telescope	(see	Section	5.4	on	page	32).	Even	if	you	don't	have	such	a	telescope,	Astro-
Planner	includes	a	telescope	emulator	that	lets	you	control	an	internal	software	telescope	that	looks
to	the	application	like	a	real	telescope.

We	are	going	to	create	such	a	"fake"	telescope:

• Click	the	+	button	under	the	list	of	telescopes	to	create	a	new	entry.	Alternatively,	you	can	click	
the	Select	from	List...	button	and	choose	from	a	list	of	commercially-available	telescopes.

• Change	the	Resource	Name	to	"Experimental"	(or	choose	your	own	name).

• Change	the	Computerised	Mount	via	the	popup	menu	to	"AstroPlanner:	Emulated	Go	To".

• Leave	the	other	Fields	as	they	are.
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Figure	30:	Telescope	resources

If	you	have	a	physical	telescope	with	a	supported	computerised	mount	(e.g.	A	Meade	Autostar-	or	
Celestron	NexStar-controlled	telescope),	then	you	can	set	this	up	quite	easily:

• Change	the	Computerised	Mount	via	the	popup	menu	to	the	particular	mount	you	have	(e.g.	
"Meade:	ETX	series").

• Click	the	Edit...	button	to	the	right	of	the	Computerised	Mount	Popup.	This	opens	a	dialog	to	al-
low	you	to	edit	various	settings	of	your	telescope	mount.

• Select	the	Serial	port	that	your	telescope	will	connect	to	(top	left	of	the	edit	dialog).

• If	available	to	you,	also	set	the	Bit	Rate	(top	right	of	the	dialog)	to	match	your	mount's	bit	rate	
setting.	If	this	is	disabled,	it	means	you	have	no	choice,	and	you	can	ignore	it.

• Leave	the	other	settings	as	they	are,	and	click	OK.
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Figure	31:	Editing	the	Computerised	Mount	settings

5.2.3 Eyepieces
Similarly,	select	the	third	tab	(Eyepieces)	and	enter	at	least	one	eyepiece	resource.	Make	sure,	for	
each	eyepiece,	you	enter	the	focal	length	and	the	apparent	Field-of-view	correctly.		Alternatively,	you	
can	click	the	Select	from	List...	button	and	choose	from	a	list	of	commercially-available	eyepieces.

5.3 Visualising objects
We	will	use	the	plan	we	set	up	manually	(see	Section	5.1.2	on	page	17),	but	you	can	use	any	plan	you
like,	as	long	as	it	has	a	few	objects	in	it.	What	we	would	like	to	do	is	answer	the	questions	below	re-
garding	the	actual	object	in	the	night	sky.	This	is	what	observation	planning	is	all	about.

In	the	open	plan	document	set	the	Site	popup	(top	right)	to	your	preferred	observing	site.

5.3.1 Is an object currently visible in the sky?
Right	now	(daytime	or	nighttime),	can	I	see	the	object?1	This	is	easily	seen	by	looking	at	the	Visibili-
ty	(Vis)	column	of	the	object	list.	If	the	Vis	column	entry	for	an	object	is	blank	(or	contains	"Horz"2),	
it	means	that	the	object	is	not	currently	visible	in	the	sky	and	is	either	below	the	horizon	or	is	never	

1. If	it's	daytime,	this	question	is	theoretical,	unless	the	object	is	the	sun	or	moon.

2. Hidden	by	the	site	horizon	(e.g.	a	wall,	trees,	a	house,	etc.)
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visible	at	the	latitude	of	your	site.	If	the	Vis	column	is	"Yes"	then	the	object	is	currently	visible.	In	
Figure	32,	NGC6749	and	Berk	82	are	currently	not	visible,	and	the	others	are	all	visible.

Additionally,	you	can	look	at	the	Rise	Time	(Rise)	and	Set	Time	(Set)	columns	to	see	when	the	ob-
jects	will	be	visible.	If	Rise	is	"Never"	then	the	object	is	never	visible	at	the	latitude	of	your	selected	
observing	site.	If	Rise	is	"Circum"	then	the	object	is	circumpolar	(i.e.	is	always	visible	at	your	ob-
serving	site).

Figure	32:	Visibility	of	objects

5.3.2 Will an object be visible when I view the sky at a particular date/time in
the future?

The	above	visibility	test	is	for	the	current	time.	You	can	also	check	to	see	whether	the	object	is	going	
to	be	visible	at	another	time	(e.g.	next	Saturday	at	10pm).	To	do	this	we	use	the	Fix	Date	feature	of	
AstroPlanner.	This	allows	you	to	freeze	the	Date	and	Time	at	speciFic	values	and	look	at	the	visibility.

The	Fix	Date	feature	looks	different	depending	on	how	wide	your	plan	document	window	is.	If	your	
window	is	fairly	small	(e.g.	you're	using	a	netbook	computer	with	a	small	screen)	then	you	will	see	a
Fix	Date	button	and	a	checkbox	at	the	top	right	of	the	plan	document	window	(next	to	the	Site	pop-
up)	as	shown	in	the	left	part	of	Figure	33.	If	you	click	the	button,	a	Fixed	Date/Time	Floating	window
appears.	You	choose	the	desired	date	and	time	using	the	controls	on	the	window	and	click	the	Apply
button.	The	visibility	settings	will	all	change	to	reFlect	the	new	date/time.	You	can	go	back	to	current
real	time	by	unchecking	the	checkbox	next	to	the	Fix	Date	button.

If	your	window	is	wide	enough,	the	Fix	Date	button	vanishes	and	is	replaced	by	a	Date/Time	panel	
(see	the	right	part	of	Figure	33).	Just	change	the	date	or	time	controls	to	Fix	the	date.	Going	back	to	
real	time	occurs	when	you	uncheck	the	Fix	date	checkbox.

Figure	33:	Fixed	date/time
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5.3.3 Where in the sky is the object?
This	is	where	the	Sky	tab	comes	in.	The	tab	contains	an	all-sky	chart	showing	the	whole	sky	as	it	ap-
pears	at	the	selected	Site	at	the	current	or	selected	date	and	time.	If	you	had	selected	the	object	of	
interest	in	the	object	list	before	switching	to	this	tab,	the	object	will	be	shown	on	the	chart	if	it's	
above	the	horizon	(in	the	Figure	below,	Berk	87	is	selected).

Feel	free	to	twiddle	with	the	various	Display	Options	on	the	right	of	the	chart.	You	can	also	use	the	
slider	under	the	Display	Options	to	see	the	chart	at	other	times	of	the	day/night.

Figure	34:	Sky	tab

5.3.4 What am I going to see through my telescope?
The	next	question	is	Figuring	out	what	you	are	going	to	see	when	you	look	through	your	telescope	
with	a	particular	eyepiece.	This	is	done	by	selecting	the	object	in	question	in	the	object	list	and	
switching	to	the	Field	of	View	tab.

For	our	example	here,	we	will	select	M29	in	the	objects	list	and	then	select	the	Field	of	View	tab.

This	tab	displays	a	chart	that	attempts	to	preview	what	you	will	see	through	a	telescope.	On	the	
right	side	are	various	settings	to	help	you	with	that.	Most	importantly,	at	the	top	are	settings	that	let	
you	select	the	telescope	and	eyepiece	you	are	going	to	use.	

In	our	case	(see	Figure	35),	we	are	going	to	use	a	telescope	called	"Orion	ED	80	APO"	together	with	a
"Panoptic	35mm"	eyepiece.	Once	those	are	selected,	the	application	computes	the	actual	Field	diam-
eter	(in	this	case,	1.19°)	and	draws	a	chart	centred	on	M29	of	that	computed	diameter.	You	will	also	
want	to	see	what	stars	are	going	to	appear	in	the	Field	of	view.	You	do	that	by	selecting	one	(or	
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more)	stellar	catalogues	in	the	list	at	the	bottom	right.	If	a	catalogue's	checkbox	is	checked	then	any	
objects	in	that	catalogue	that	also	appear	in	the	Field	of	view	will	be	charted	(if	they	are	within	the	
Magnitude	Limits	deFined).

Figure	35:	Field	of	View	tab

In	the	Field	of	view	chart,	non-stellar	objects	are	displayed	using	symbols,	which	means	the	Field	of	
view	chart	is	only	a	representation	of	what	you	will	see.

5.3.5 What does the object actually look like?
Figuring	out	what	an	object	actually	looks	like	through	a	telescope	is	not	an	easy	problem	to	solve.	
What	can	be	done	though,	is	to	look	at	a	photographic	image	of	the	object	and	use	that,	understand-
ing	the	fact	that	in	reality	it	will	typically	appear	much	dimmer	when	viewed	visually	through	a	
telescope.

AstroPlanner	includes	the	ability	to	download	and	save	images	of	the	objects	you	want	to	observe.	
These	images	come	from	photographic	sky	surveys	(in	particular	the	Digital	Sky	Survey	(DSS)1	and	
the	Sloan	Digital	Sky	Survey	(SDSS)).	We	will	download	images	for	the	objects	in	our	plan.	Proceed	
as	follows	(noting	that	this	will	require	an	Internet	connection):

• Select	Images	>	Download	Images...	from	the	main	menu.

• In	the	Images	window	(Figure	36)	select	to	download	for	all	the	objects	(7	in	this	case).

1. Also	known	as	POSS	(Palomar	Observatory	Sky	Survey)
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• Select	the	checkbox	to	Select	image	size	from	object,	and	make	the	image	size	200%	of	object	
size.

• Select	the	POSS	1st	Gen	data	source	by	checking	its	checkbox.

• Click	the	Start	Download	button.

Figure	36:	Download	Images

The	download	then	proceeds.	The	Status	tab	shows	the	progress.

Figure	37:	Downloading	in	progress

Once	the	download	has	completed	(or	before	if	you	like),	close	the	download	window	and	go	back	to
the	Objects	tab	of	your	plan	document.	You'll	see	that	the	Images	column	of	the	list	now	has	a	"D"	
badge	in	it.	This	signiFies	that	the	object	has	one	or	more	associated	images.	If	you	select	such	an	ob-
ject	then	the	image	of	that	object	will	appear	on	the	right	of	the	object	list,	as	shown	in	Figure	38.

If	you	then	switch	to	the	Field	of	View	tab,	the	image	will	be	displayed	as	part	of	the	chart,	as	shown
in	Figure	39.
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Figure	38:	Objects	list	with	images

Figure	39:	Image	of	IC1310	in	Field	of	view	chart

5.4 Using a computerised telescope
For	this	demonstration	we	are	going	to	use	our	"Experimental"	telescope	resource	that	we	set	up	to	
use	an	emulated	go	to	mount.	You	can	use	a	real	computerised	mount	if	you	wish,	the	process	is	
identical	(if	somewhat	noisier	in	the	case	of	a	real	mount).

In	the	plan	document	window,	choose	your	telescope	resource	in	the	telescope	panel	at	the	top	left.
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Check	the	Connect	to	telescope	checkbox.	The	application	then	attempts	to	connect	to	the	tele-
scope	mount,	after	which	the	checkbox	caption	changes	to	Connected	to	telescope,	with	the	tele-
scope	Firmware	version	number	if	applicable.

Figure	40:	Telescope	panel	before	and	after	connecting

In	the	case	of	the	emulated	mount,	a	small	Floating	window	appears	showing	the	current	status	of	
the	emulated	telescope.

Figure	41:	Emulated	telescope	Floating	window

At	the	top	of	the	plan	document	window	the	"LED"	displays	will	now	include	the	Telescope	RA,	Dec,	
Altitude	and	Azimuth	(assuming	there's	enough	width	to	display	them).

Now	select	an	object	in	the	object	list.	If	it	is	currently	visible	the	Slew	to	Object	button	next	to	the	
Telescope	popup	will	be	enabled.	Click	the	button	to	slew	the	telescope	to	the	selected	object.

Figure	42:	Telescope	slewing	to	selected	object
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5.5 Making observations and logging them
So	now	we	have	an	idea	on	how	to	construct	an	observing	plan,	how	to	get	a	heads-up	on	what	we're
likely	to	see,	and	how	to	control	our	telescope.	Now	we	can	observe.	This	section	is	a	brief	tutorial	
on	how	to	log	observations.

To	log	an	observation:

• Select	the	object	you	are	observing	in	the	list	in	the	Objects	tab	of	the	plan	document	window.

• Click	the	New	Observation	button	under	the	list1.	The	Observation	Date/Time	dialog	is	opened.

• If	you	are	logging	observations	at	your	telescope,	you	click	the	Now	button,	otherwise	enter	the	
date	and	time	of	the	observation.	The	graphic	at	the	top	shows	the	current	time	of	day/night	and
the	altitude	of	the	object	(red	crosses).	Click	OK.

Figure	43:	Observation	date/time	dialog

• The	observation	is	added	to	list	of	observations	for	this	object.	It's	now	up	to	you	to	Fill	in	the	ap-
plicable	Fields	for	the	observing	session	(this	observation	is	the	First	observation	logged	for	this	
session).	You	should	also	log	a	description	of	what	you	saw.

1. This	is	a	short	cut	for	switching	to	the	Observations	tab	and	clicking	the	+	button	under	the	list	of	observations.
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Figure	44:	Observations	tab	with	a	logged	observation

5.6 Printing reports
AstroPlanner	includes	features	for	printing	observing	forms	(forms	with	blank	spaces	that	you	can	
Fill	in	by	hand),	observing	reports	(a	printed	list	of	observations),	and	Finder	charts	(for	a	particular	
object:	charts	at	various	resolutions	that	help	you	to	Find	the	object	in	the	Field).

We	will	continue	using	the	small	plan	we	devised	earlier.	Note	that	you	can	see	the	printed	output	as
an	on-screen	preview	without	having	to	print	it	out	on	dead	trees.

We'll	look	only	at	printing	observing	forms.	The	other	types	of	printed	reports	are	very	similar.

5.6.1 Observing forms
Here's	how	to	print	observing	forms	for	the	objects	in	your	plan:

• Go	to	the	Objects	tab.

• Use	the	File	>	Print...	menu	command.

• The	Print	Objects	dialog	is	displayed.	Choose	Observing	Forms	from	the	Task	popup.

• Select	the	informational	Fields	you'd	like	printed	out	for	each	object	(under	Object	Fields),	and	
the	Fields	you'd	like	to	print	out	as	a	blank	template	(Session	and	Observation	Fields).

• There	are	a	number	of	Options	you	can	play	with.	For	this	exercise	we	left	the	default	settings,	
but	added	the	Object	images	setting	under	Images	and	Charts.	We	also	selected	the	Sketching	
Templates	option.	See	Figure	45.

• Click	the	Preview...	button.	The	First	time	you	use	this	in	a	run	the	Printer	Setup	dialog	will	be	
displayed	so	that	you	can	specify	paper	size,	portrait	vs.	landscape,	etc.

• The	preview	window	is	then	generated	(Figure	46).	If	you're	happy	with	the	report	format	then	
use	the	Print...	button	to	print	it	out,	otherwise	close	the	preview	window	and	try	again.
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Figure	45:	Print	dialog	for	observing	forms
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Figure	46:	Print	preview	for	observing	forms
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6 How to get help
AstroPlanner	is	a	very	rich	application1	and	it	takes	some	time	and	effort	to	get	it	to	do	your	bidding.
There	are	several	ways	to	get	help.	Remember:	no	question	is	too	dumb.

6.1 User Manual
This	manual	is	the	"deFinitive"	source	of	assistance	for	the	application.	Use	the	PDF	search	features	
to	Find	what	you	want	within	the	manual,	or	just	peruse	the	Table	of	Contents.	If	a	feature	isn't	dis-
cussed	in	this	manual,	it's	a	bug!	(please	contact	the	vendor	-	see	below)

There's	a	troubleshooting	chapter	in	this	manual	if	you	are	having	problems	that	you	think	are	ab-
normal	(e.g.	the	application	is	crashing,	won't	connect	to	your	telescope,	etc.).

6.2 User group
There's	a	Yahoo	group	dedicated	to	AstroPlanner:

http://tech.groups.yahoo.com/group/astroplanner/

There	are	a	lot	of	friendly	people	there,	including	the	author	of	the	application,	who	are	ready	to	an-
swer	your	questions.	There's	also	an	archive	of	posts,	and	searching	it	might	throw	light	on	your	
issue.

6.3 Vendor
Feel	free	to	send	your	questions,	requests,	etc.	to	technical	support:

support@astroplanner.net

Although	we	need	sleep	too,	we'll	get	back	to	you	as	soon	as	we	can.

6.4 FAQ
There's	a	FAQ	(Frequently	Asked	Questions)	page	at:

http://www.astroplanner.net/faq.html

This	will	be	updated	as	questions	come	in	that	are	considered	of	interest	to	more	than	just	the	asker
of	the	question.

6.5 Blog
Although	it	can't	really	be	classiFied	as	a	"help	resource",	there's	a	blog	written	by	the	AstroPlanner	
author	that	might	occasionally	offer	some	insight	into	the	devious	mind	behind	the	product:

http://blog.astroplanner.net/

1. Some	might	use	the	phrases	"overly-complex",	"feature-laden",	or	"learning-curve	challenged".

- 38 -



7 Anatomy of AstroPlanner
In	order	to	understand	how	AstroPlanner	goes	about	its	functions,	you	need	to	understand	a	little	
about	the	entities	that	make	up	its	“anatomy”.	AstroPlanner	manipulates	these	entities	in	order	to	
plan	and	log	observations,	etc.

7.1 Plans
The	fundamental	entity	that	you	will	work	with	in	AstroPlanner	is	the	Plan.	This	is	a	list	of	astro-
nomical	objects	that	are	to	be	observed	(or	have	already	been	observed).	Each	plan	is	stored	in	a	
separate	Plan	document	on	disk.	For	example,	you	might	have	a	plan	containing	the	Messier	objects,	
or	a	plan	containing	interesting	galaxies	in	Andromeda.	

These	plans	will	contain	anything	from	a	single	object	to	several	hundred	objects.	In	fact	there	is	no	
limit	to	the	number	of	objects	you	can	have	in	a	plan,	although	once	you	get	to	a	few	thousand,	the	
application	might	become	sluggish.

You	can	open	several	plan	documents	at	a	time.	Each	plan	lives	in	its	own	window,	which	has	several
tabs.

7.2 Objects
An	Object	is	a	short	term	for	“astronomical	object”,	and	is	the	fundamental	data	type	in	the	applica-
tion.	It	might	represent	a	particular	galaxy,	double	star,	planet,	etc.	There	are	two	different	types	of	
object:

7.2.1 Plan object
A	Plan	object	resides	in	a	plan	document.	It	has	many	different	attributes,	such	as	an	ID,	coordinates	
(RA	and	Declination),	magnitude,	etc.	It	can	be	added	to	a	plan	manually	(by	typing	in	the	attribut-
es),	importing	from	a	text	File,	or	via	a	catalogue	lookup	(see	below).	You	are	free	to	change	such	
plan	objects	as	you	see	Fit	(for	example,	by	adding	some	notes,	or	modifying	an	attribute)

7.2.2 Catalogue object
A	Catalogue	object	is	also	an	astronomical	object,	except	that	it	resides	in	a	catalogue	(see	below).	
Catalogue	objects	can	be	added	to	plans	manually	(by	dragging	them	from	a	catalogue)	or	via	a	cata-
logue	search.	Once	such	a	catalogue	object	is	added	to	a	plan	it	becomes	a	Plan	object.	

Catalogue	objects	are	effectively	immutable	(i.e.	they	cannot	be	changed	by	a	user).

7.3 Observations
When	you	are	physically	observing	an	object	in	your	plan,	you	can	log	an	Observation	of	that	object.	
This	consists	of	the	date	and	time	of	the	observation,	what	equipment	(resources)	was	used,	and	
notes	on	that	observation.	Observations	are	stored	in	a	central	observation	database.

7.4 Sessions
When	you	create	observations	(above)	you	will	have	an	associated	observing	Session.	This	is	a	
record	of	the	observing	site,	seeing	conditions,	etc.	for	the	observations	made	during	that	session.	
Session	data	are	kept	in	the	central	observation	database.
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7.5 Resources
A	Resource	is	an	item	that	is	applicable	to	planning,	and	is	different	for	each	user.	These	resources	
include,	observing	sites,	telescopes,	eyepieces,	astro-imagers,	etc..	In	order	to	facilitate	planning,	the	
user	must	deFine	and	add	these	resources	to	a	database.	For	example,	in	order	to	be	able	to	deter-
mine	the	current	sky	view,	and	position	of	objects	with	respect	to	the	horizon,	a	Site	resource	must	
be	deFined	(with	latitude,	longitude,	etc.).	In	order	to	be	able	to	visualize	what	you	will	see	through	
your	telescope,	you	must	deFine	a	Telescope	resource	(aperture,	focal	length,	etc.)	and	an	Eyepiece	
resource	(focal	length,	apparent	Field-of-view,	etc.)

7.6 Catalogues
A	Catalogue	is	a	set	of	related	catalogue	objects.	Such	a	catalogue	contains	objects	that	are	typically	
of	a	single	type	(e.g.	the	PGC	(Principal	Galaxy	Catalogue)	Catalogue	contains	several	thousand	
galaxies).	In	some	cases	there	is	a	mixture	of	object	types	that	were	original	catalogued	by	an	ob-
server	(Messier	Catalogue)	or	perhaps	a	well-known	observing	list	(e.g.	the	Herschel	400	Cata-
logue).	There	are	many	catalogues	available		(each	a	separate	File)	that	can	be	installed	into	the	ap-
plication	and	used.	Currently	all	catalogues	are	supplied	by	the	vendor.	Future	releases	may	add	the	
ability	to	construct	your	own	catalogues.

7.7 Scripts
AstroPlanner	has	a	built-in	scripting	language	that	can	be	used	to	add	functionality	to	the	applica-
tion,	automate	some	tedious	tasks,	etc.	A	Script	is	a	single	“program”	in	the	scripting	language.	Such	
a	program	can	access,	say,	the	objects	in	a	plan,	observations,	etc.	You	can	write	your	own	scripts,	or	
download	scripts	created	by	others.
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8 Common user-interface elements
There	are	many	common	user-interface	elements	within	the	AstroPlanner	application,	most	of	
which	share	common	functionality	and	features.

8.1 Text fields
There	are	two	types	of	text	Fields:	single	line	Fields	(e.g.	for	entering	numbers	or	strings)	and	multi-
line	text	areas	for	entering	signiFicant	amounts	of	text	(e.g.	entering	observation	notes,	etc.).

8.1.1 Single-line text fields
Non-numeric text values
This	type	of	Field	is	used	to	enter	text	data.	Generally,	any	text	can	be	entered.

Figure	47:	Text	entry	Field

The	contextual	menu	(attained	by	right-clicking	the	Field)	has	various	operations	available:

• Copy,	Copy	and	Paste.	The	same	operations	that	are	also	found	in	the	main	Edit	menu.

• Check	Spelling.	Check	the	spelling	of	the	text	in	the	Field.	See	Section	8.1.4	on	page	43.

• Select	All.	Select	all	text	in	the	Field.

• Change	Case.	Change	the	case	of	the	text	in	the	Field,	to	all	UPPERCASE,	all	lowercase,	Title	case	
(each	word	is	capitalised),	or	Sentence	case	(each	sentence	starts	with	a	capital	letter).

• Font.	Change	the	font	face	and	size	for	the	Field	(overriding	the	standard	font).	See	Section	8.1.3	
on	page	43.

Figure	48:	Text	Field	contextual	menu

Numeric values
This	type	of	Field	is	used	to	enter	a	single	numeric	value.	This	might	be	a	Floating-point	or	integer	
value,	or	a	formatted	number	(such	as	latitude,	declination,	etc.).	If	the	number	is	valid	it	will	be	dis-
played	in	the	standard	black	colour.	If	it	is	not	a	valid	number	or	falls	outside	the	correct	range,	it	
will	be	displayed	in	red,	and	the	tooltip	below	it	will	display	the	acceptable	range.

Figure	49:	Numeric	value	entry	Field

The	contextual	menu	(attained	by	right-clicking	the	Field)	has	various	operations	available:

- 41 -



• Copy,	Copy	and	Paste.	The	same	operations	that	are	also	found	in	the	main	Edit	menu.

• Select	All.	Select	all	text	in	the	Field.

• Font.	Change	the	font	face	and	size	for	the	Field	(overriding	the	standard	font).	See	Section	8.1.3	
on	page	43.

Figure	50:	Numeric	Field	contextual	menu

8.1.2 Multi-line text fields
Multi-line	text	Fields	are	used	to	enter	substantial	amounts	of	text,	that	might	contain	paragraphs	
and	line	endings.	It	has	a	scroll	bar	on	the	right	which	is	enabled	if	the	text	Fills	more	than	the	visible
bounds	of	the	Field.

Figure	51:	Multi-line	text	Field

The	contextual	menu	(attained	by	right-clicking	the	Field)	has	various	operations	available:

• Spelling	suggestions.	If	a	word	is	selected	then	the	spelling	checker	might	offer	suggestions	to	
correct	that	word	if	it	is	not	in	the	dictionary.	Selecting	one	of	the	suggestions	will	replace	the	of-
fending	word	in	the	text.

• Learn.		If	a	word	is	selected	and	it	is	not	in	the	dictionary,	you	can	tell	the	spell	checker	to	accept	
the	word	as	being	correctly	spelled	using	this	item.

• Copy,	Copy	and	Paste.	The	same	operations	that	are	also	found	in	the	main	Edit	menu.

• Check	Spelling.	Check	the	spelling	of	the	text	in	the	Field.	See	Section	8.1.4	on	page	43.

• Select	All.	Select	all	text	in	the	Field.

• Change	Case.	Change	the	case	of	the	text	in	the	Field,	to	all	UPPERCASE,	all	lowercase,	Title	case	
(each	word	is	capitalised),	or	Sentence	case	(each	sentence	starts	with	a	capital	letter).

• Font.	Change	the	font	face	and	size	for	the	Field	(overriding	the	standard	font).	See	Section	8.1.3	
on	page	43.

• Print....	Print	the	contents	of	the	text	Field	to	your	printer.

• Edit	Window.	If	allowed,	this	will	open	a	larger	window	with	a	text	Field	that	can	be	expanded	as
large	as	you	like.	Entering	text	into	this	window	will	be	the	same	as	entering	directly	into	the	
Field.	This	can	be	convenient	if	the	Field	contains	a	lot	of	text.
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Figure	52:	Multi-line	Field	contextual	menu

8.1.3 Changing fonts
You	can	use	the	Font...	command	in	the	contextual	menu	to	change	the	appearance	of	the	text	in	a	
text	Field.	You	can	choose	the	font	face,	size,	and	style.	The	font	change	is	for	the	targeted	Field	only	
and	is	persistent.

Figure	53:	Font	change	dialog

8.1.4 Spell checking
You	can	manually	spell	check	the	contents	of	a	text	Field	by	using	the	Check	Spelling...	command	
from	the	contextual	(right-click)	menu	for	that	Field.

Figure	54:	Spell	Check	dialog
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Any	incorrectly	spelled	words	are	displayed,	one	by	one,	along	with	a	list	of	suggestions	for	the	
correct	word.	You	can	select	one	of	the	selected	words,	or	enter	your	own,	and	click	Replace	to	re-
place	the	word	in	the	text.	You	can	also	elect	to	Skip	the	word	if	you	don't	know	what	to	do,	or	Ig-
nore	if	you	want	to	take	the	word	as	being	correct.	You	can	also	use	the	+	button	at	the	top	right	to	
add	the	word	to	your	user	dictionary.

Additionally,	if	you	have	the	Inline	checking	option	on	(see	General	Preferences:	Section	20.1.3	on	
page	286),	any	incorrectly	spelled	words	will	be	highlighted.	Right-clicking	the	highlighted	word	will
allow	you	to	select	a	correct	word	to	replace	it,	or	get	the	spell	checker	to	"Learn"	that	the	word	is	
actually	correct.

Figure	55:	Inline	spell	checking

Figure	56:	Correcting	a	bad	word	by	right-clicking

8.2 Lists
Lists	are	used	to	display	tabular	data	and	can	have	one	or	more	columns,	and	can	also	have	column	
headings.

Figure	57:	List
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The	contextual	(right-click)	menu	for	a	list	allows	you	to	export	the	data	and	also	change	the	ap-
pearance	of	the	list.

You	can	Copy	all	rows	or	selected	rows	(where	applicable)	to	the	clipboard.

Figure	58:	List	contextual	menu

You	can	Export	all	rows	or	selected	rows	(where	applicable)	to	either	a	tab-separated	text	File,	or	an	
Excel	File.

Figure	59:	List	contextual	menu

You	can	also	change	the	Appearance	of	the	list,	specifying	the	font,	row	height,	grid	lines,	and	al-
ternate	row	striping.	You	can	elect	to	make	the	change	just	to	the	list	you	right-clicked	on,	or	to	all	
lists.

Figure	60:	List	appearance	settings

On	most	(but	not	all)	list	widgets	in	the	application,	including	the	observation	database	window	
lists,	object	list,	etc.,	there's	now	a	Columns	tab	that	allows	you	set	the	style	separately	for	each	col-
umn	in	the	list:	bold,	italic,	underline,	the	colour	of	the	text,	and	the	colour	of	the	background.
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Figure	61:	Setting	list	column	styles

8.3 Resource choosers
At	various	places	throughout	the	application	you	are	required	to	select	a	resource	(e.g.	a	Telescope	
resource	-	see	Figure	62,	or	Field	of	view	chart	parameters	-	see	Figure	63).	These	are	presented	as	a	
popup	menu	containing	all	active	resources	of	the	pertinent	type.	Resources	are	discussed	in	Section
7.5	on	page	40.

The	resource	chooser	popup	can	also	have	a	button	to	the	right	containing	a	"pencil"	icon.	This	al-
lows	you	to	edit	the	selected	resource	(by	opening	the	Resources	window,	changing	to	the	requisite	
tab	and	selecting	the	resource.	See	).	There	might	also	be	a	button	containing	a	small	globe.	This	will
be	enabled	if	the	particular	resource	deFines	an	Internet	URL.	Clicking	the	button	will	open	the	URL	
in	your	web	browser	application.

Figure	62:	Telescope	chooser

Figure	63:	Field	of	view	chart	resource	choosers

8.4 Hierarchical options lists
At	various	places	in	the	application,	a	hierarchical	widget	is	used	to	display	options.	Sections	of	op-
tions	can	be	expanded	or	collapsed	using	the	small	grey	triangles	(Mac	OS	-	See	Figure	64)	or	small	
"+"	and	"-"	widgets	(Windows	-	See	Figure	65).	Each	option	has	a	checkbox	associated	with	it	that	
controls	whether	that	option	is	enabled	or	not.
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If	a	section	also	has	a	checkbox	associated	with	its	title,	then	that	checkbox	can	be	used	to	enable	or	
disable	all	the	options	within	that	section.	When	the	checkbox	is	switched	off,	all	contained	options	
are	switched	off	and	disabled.

Figure	64:	Field	of	View	chart	display	options	(Mac	OS	style)

If	an	option	has	an	associated	value,	then	it	is	displayed	on	the	right.	Selecting	that	option	will	reveal
a	means	of	editing	the	value	at	the	bottom	of	the	option	panel	(see	Figure	65	for	an	example).
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Figure	65:	Sky	chart	display	options	(Windows	style)

8.5 Date/time selectors
At	various	places	in	the	application's	windows	there	are	date/time	selectors,	allowing	the	entry	of	
the	date	and	(usually)	time.	These	will	be	customised	to	the	date	and	time	settings	of	your	operating
system	by	default.

Figure	66:	Typical	Date/Time	selector

Right-clicking	the	date	selector	widget	(in	most	cases)	will	display	a	popup	menu	containing	various
convenience	date/time	values	(e.g.	Sunset,	Moonrise,	etc.).
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Figure	67:	Date	selector	right-click	menu
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9 Setting up your resources
9.1 Using the Setup wizard
The	simplest	way	to	set	up	your	essential	resources	is	to	use	the	Setup	Wizard	(File	>	Setup	Wiz-
ard...).	This	is	detailed	in	section	4.2	on	page	8.	This	enables	you	to	add	observing	sites,	telescopes,	
and	eyepieces.	However,	it's	fairly	simplistic	and	does	not	allow	setup	of	other	resource	types,	or	the
setup	of	some	of	the	more	esoteric	settings	for	resources.	To	do	that,	you	need	to	do	manual	setup,	
as	detailed	below.

9.2 Manual setup using Resources window
The	Resources	window	allows	you	to	edit	the	resources	database	manually.	It	is	displayed	by	using	
the	Edit	>	Resources...	menu	command.

The	window	contains	a	tab	for	each	type	of	resource	(and	an	additional	Combinations	tab	described	
below).

9.2.1 Common resource elements
Each	resource	tab	contains	various	editing	controls,	some	of	which	are	common	to	all	tabs.	These	
are	described	below.

Resource name list
The	name	list	contains	an	entry	for	each	resource	of	the	type	represented	by	the	tab.

Figure	68:	Resource	name	list

Each	resource	has	a	checkbox	to	the	left	of	the	name.	If	the	checkbox	is	unchecked	then	the	resource	
is	deemed	to	be	no	longer	in	use,	and	will	not	appear	in	any	lists	of	those	resources	elsewhere	in	the	
application.	The	reason	for	disabling	an	unused	resource	rather	than	deleting	it	is	that	it	might	have	
been	used	in,	say,	the	observation	database.	If	such	a	resource	is	deleted,	the	observation	database	
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can	no	longer	access	the	resource	parameters	(e.g.	a	telescope	aperture,	etc.)	for	that	deleted	
resource.

If	a	resource	has	been	marked	as	the	Default	resource	of	this	type	(see	below),	then	its	name	is	dis-
played	in	green.

The	buttons	below	the	list,	from	left	to	right,	are:

• Add	a	new	resource

• Delete	the	selected	resource	(see	above	for	caveats).

• Duplicate	the	selected	resource

• Redraw	the	Field	of	view	chart	in	open	plan	documents.	This	will	update	such	charts	using	any	
changes	to	resources	you	may	have	made.

Resource name
Allows	you	to	change	the	name	of	the	selected	resource.	Note	that	resource	names	must	be	unique,	
and	the	single	quote	character	(')	cannot	be	used	in	the	name.

Figure	69:	Resource	name,	URL,	At	Site	and	Default	settings

URL
An	optional	Field	that	can	contain	an	URL	to	an	external	web	page	for	that	resource	(e.g.	a	login	page	
for	a	remote	telescope	site,	a	page	on	the	telescope	vendor's	web	site	describing	the	particular	tele-
scope	resource,	etc.).	You	can	use	the	button	to	the	right	of	the	Field	to	open	the	URL	in	your	
browser.

At Site/s
(Not	applicable	to	Site	resources)	If	a	resource	is	only	applicable	to	a	particular	observing	Site	or	
Sites,	then	use	this	button	to	select	those	Site/s	in	a	check	list	(Figure	70).	For	example,	if	your	tele-
scope	is	permanently	mounted	at	an	observatory	then	specify	the	observatory	site.	If	your	resource	
is	portable	between	sites	(e.g.	an	eyepiece),	then	select	Common	to	All.	If	you	have	several	sites,	
and	each	of	them	has	the	same	eyepiece,	you	can	select	the	applicable	sites.

When	you	select	a	particular	Site	in	a	plan	document,	any	resources	not	marked	Common	to	All	or	
allocated	to	that	Site	will	not	appear	in	the	resource	popups.
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Figure	70:	Choosing	At	Site/s

Default
One	resource	of	each	type	can	be	marked	as	the	default.	When	a	new	plan	document,	observation	
etc.	is	created	and	a	speciFic	resource	is	not	speciFied,	the	default	will	be	used.	i.e.	you	should	mark	
your	most-often	used	resources	as	Default.

User-defined fields

Figure	71:	User-deFined	Fields

Each	resource	type	has	a	set	of	user-deFined	Field	deFinitions,	and	each	resource	can	deFine	values	
for	those	Fields.	See	Chapter	19	on	page	276	for	more	details.

Comments

Figure	72:	Comments

Each	resource	has	a	comment	Field.	You	can	put	whatever	text	you	like	here.
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9.2.2 Site resources

Figure	73:	Site	resources

Find...
This	button	allows	you	to	search	for	your	town/city	if	it	is	in	the	U.S.A.	or	Canada	(sorry,	no	conve-
nient	databases	are	available	for	other	countries).	You	can	either	select	the	U.S.A.	or	Canada	tab	and	
select	by	State/Province	and	City,	or	use	the	Find	tab	to	search	for	any	cities	containing	a	search	
string.

Once	you've	selected	a	city,	you	can	choose	to	create	a	new	site	(in	which	case	a	new	Site	resource	
with	the	given	name,	latitude	and	longitude	will	be	created),	or	elect	to	modify	the	currently	select-
ed	site	(if	applicable,	in	which	case	the	latitude	and	longitude	will	be	changed).
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Figure	74:	Select	city	by	state

Figure	75:	Find	city

Latitude/Longitude
The	latitude	and	longitude	of	the	Site.	You	can	enter	these	values	manually,	use	the	Find	function	de-
scribed	above,	or	you	can	click	on	the	world	map	to	the	right	to	create	a	rough	position.	The	current	
position	is	marked	on	the	map.

(Macintosh	only)	You	can	right-click	the	map	and	elect	to	Show	location	in	Google	Earth.	This	will	
start	the	Google	Earth	application	(if	available)	and	centre	the	Google	Earth	map	window	on	your	
selected	location.	You	can	also	right-click	and	use	Get	location	from	Google	Earth.	This	will	as-
sume	that	the	Google	Earth	application	is	running	and	the	map	window	is	centred	on	your	required	
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location.	The	latitude/longitude	of	that	centre	will	be	placed	in	the	Fields.	Google	Earth	can	be	down-
loaded	from	http://www.google.com/earth/index.html.

Offset from GMT
This	is	the	offset,	in	hours,	of	your	local	time	from	GMT,	during	standard	time	(i.e.	not	during	the	
daylight-saving	period	if	applicable).	It	is	negative	for	sites	west	of	0°	longitude,	positive	otherwise.	
e.g.	in	the	U.S.A.,	East-coast	time	is	-5	hours,	PaciFic	coast	time	is	-8	hours.

The	offset	is	used	to	draw	a	vertical	green	dashed	line	on	the	world	map.	If	this	coincides	with	GMT	
(a	vertical	red	dotted	line)	then	your	offset	is	most	probably	correct.	However,	it	could	be	within	the	
grey	vertical	stripe	on	the	map	and	still	be	OK.	If	it's	outside	the	grey	stripe,	you	might	want	to	dou-
ble	check	your	coordinates	or	offset.

Daylight Saving rules
If	your	site	does	not	use	daylight	saving	time	during	the	year,	then	set	this	the	None.	If	your	site	is	in	
the	U.S.A.	and	uses	daylight	saving,	the	select	U.S.A.	Similarly	for	the	European	Union.

You	can	also	deFine	up	to	four	different	custom	rules	for	daylight	saving,	and	use	them	by	selecting	
the	appropriate	entry.

Select	the	Edit	Custom...	entry	to	edit	those	custom	rules.

Figure	76:	Editing	custom	daylight	saving	rules

Give	a	rule	an	appropriate	name,	specify	when	daylight	saving	starts	and	ends,	and	specify	the	num-
ber	of	hours	that	are	added	to	standard	time.

If	your	operating	system	allows,	you	can	click	the	Computer	button	and	insert	information	into	the	
rule.

Clock offset
This	speciFies	the	number	of	hours	the	site	is	offset	from	the	computer's	clock.	Normally	your	com-
puter	will	be	present	at	the	observing	site	and	this	offset	will	be	zero.	However,	if	you	are	operating,	
say,	a	remote	observatory	site	and	that	site	is	in	a	different	time	zone,	then	this	offset	should	be	set	
to	the	number	of	hours	offset	between	the	computer's	time	and	the	remote	site's	time.	Then	when	
you	select	that	site	in	a	plan	document	the	local	time,	horizon	and	visibility	will	be	computed	for	
that	site	rather	than	the	local	site.
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The	best	setting	is	to	specify	the	Clock	Offset	from	Site	as	being	your	computer's	site.	Then	the	cur-
rent	offset	is	computed	based	on	daylight	saving	conditions	at	both	sites.

Horizon
The	default	site	horizon	is	completely	Flat	down	to	0°	altitude.	More	often	than	not	the	actual	site	
will	not	have	horizon-to-horizon	viewing	conditions,	but	will	have	obstacles	(e.g.	trees,	buildings,	
observatory	walls,	etc.)	to	contend	with.	You	can	deFine	your	own	horizon	here,	and	the	application	
will	use	that	horizon	information	to	determine	whether	an	object	is	currently	hidden	or	not.

Figure	77:	Horizon	editing	dialog

(Left-)	clicking	the	horizon	picture	opens	the	horizon	editing	dialog.	This	is	a	mapping	of	the	entire	
sky	into	a	rectangular	picture	with	azimuth	along	the	horizontal	and	altitude	on	the	vertical	axis.	
The	horizon	deFinition	is	divided	into	three	parts:

• Lower	horizon.	These	are	obstacles	on	the	horizon	the	reach	up	from	0°	altitude	(the	true	hori-
zon)	up	to	the	zenith	(90°	altitude)	if	necessary.

• Upper	horizon.	These	are	obstacles	that	prevent	you	from	seeing	the	sky	above	a	given	altitude.	
Typically	this	might	be	a	parapet	on	a	balcony	you	are	observing	from.

• Light	dome.	Sky	glow	from	a	distant	light	source	(e.g.	a	city	centre	or	factory)	that	lights	up	the	
sky.	If	the	Light	dome	blocks	visibility	checkbox	is	checked,	then	any	deFined	light	dome	will	be
considered	effectively	to	block	object	visibility.

The	horizontal	scale	is	in	degrees	from	north	through	east.	You	can	also	show	that	scale	in	hours	(0	
to	24)	using	the	Scale	in	hours	checkbox,	and	Reverse	it	if	necessary	(24	to	0).	This	is	useful	if	you	
are	using	an	alt-az	mounted	telescope	to	trace	out	the	horizon.	In	this	case,	the	"polar"	axis	setting	
circles	might	be	calibrated	in	hours	rather	than	degrees.

You	can	use	the	Set	Fixed	Horizon	button	to	set	a	Fixed	altitude	horizon	over	the	entire	width.

If	you	have	a	computerised	telescope,	and	it	is	connected	to	AstroPlanner,	the	current	pointing	of	the
telescope	is	displayed	on	the	chart,	and	you	can	use	the	Get	Point	From	Telescope	button	to	use	
those	pointing	coordinates	to	set	the	horizon.

Site altitude
The	altitude	of	the	Site	above	sea	level.
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Bortle Dark Sky Rating
This	is	a	scale	of	1	through	9	that	deFines	how	good	(or	bad)	your	site	is.	If	you	select	one	of	these	
ratings,	it	will	set	the	Sky	Brightness	to	an	appropriate	estimated	value	(which	can	be	changed	if	
necessary).

Sky Brightness
The	sky	brightness	(magnitudes	per	square	arcsecond)	of	the	site.	This	value	is	used	to	compute	
(advanced)	visibility	ratings	for	the	sky.	The	naked-eye	stellar	magnitude	limit	at	the	zenith	(straight
up)	is	computed	and	displayed	to	the	right	of	this	Field.

Site-owned Resources
A	list	of	resources	available	at	the	site	(and	any	resources	available	at	all	sites	in	grey).

Get from GPS...
If	you	have	a	dedicated	GPS	device	connected	to	a	serial	port	of	your	computer,	you	can	use	this	but-
ton	to	interrogate	the	GPS	device	and	retrieve	current	latitude	and	longitude.

Get Computer Info...
(Macintosh	only)	Retrieves	the	latitude	and	longitude	from	the	operating	system	settings	and	sets	
those	Fields	for	the	Site.

(All	platforms)	Retrieves	the	GMT	offset	and	displays	it.

Figure	78:	GMT	offset	selection

You	select	which	option	is	correct.

Get from Telescope
If	a	telescope	is	connected,	and	allows	the	retrieval	of	latitude,	longitude	and	GMT	offset,	then	you	
can	use	this	button	to	retrieve	that	data	from	the	telescope	and	insert	it	into	the	relevant	Fields.

Set Telescope Info
If	a	telescope	is	connected,	and	allows	the	setting	of	site	latitude,	longitude	and	GMT	offset,	then	this
button	will	set	those	parameters	on	the	telescope.
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9.2.3 Telescope resources

Figure	79:	Telescope	resources

Type
This	is	the	type	of	instrument,	and	might	be	either	a	telescope	or	a	binocular/monocular.

If	the	type	is	Telescope	then	the	following	Fields	are	displayed:

• Aperture.	The	aperture	(diameter	of	front	opening)	in	mm.	You	can	also	enter	the	aperture	in	
inches	by	adding	"	after	the	value	(e.g.	4.5"),	in	which	case	the	conversion	to	mm	will	be	done	for	
you.

• Focal	Ratio.	The	f/Ratio	of	the	telescope1.

• Central	Obstruction.	If	the	telescope	has	a	central	obstruction	(secondary	mirror),	then	this	is	
the	percentage	diameter	of	that	obstruction	(e.g.	if	a	250mm	aperture	telescope	has	a	50mm	di-
ameter	secondary,	then	the	obstruction	value	would	be	20(%).

1. The	equation	for	focal	length	is	Focal	Length	=	Aperture	×	Focal	Ratio,	so	if	you	only	know	the
Aperture	and	Focal	Length	of	the	telescope,	then	Focal	Ratio	=	Focal	Length	÷	Aperture
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If	the	type	is	Binocular/Monocular	then	the	following	Fields	are	displayed:

• MagniOication.	The	magniFication	of	the	instrument	(e.g.	the	magniFication	of	a	8	×	50	binocular	
would	be	8).

• Aperture.	The	aperture	of	the	instrument	in	mm		(e.g.	the	aperture	of	a	8	×	50	binocular	would	
be	50mm).	You	can	also	enter	the	aperture	in	inches	by	adding	"	after	the	value	(e.g.	2.5"),	in	
which	case	the	conversion	to	mm	will	be	done	for	you.

• Actual	FoV.	The	angular	Field	of	of	view	of	the	instrument	in	degrees	(usually	spelled	out	on	the	
instrument's	body).

Optics
SpeciFies	the	optical	conFiguration	(e.g.	refractor,	etc.),	and	how	clean	the	optics	are.

Computerised mount
If	the	telescope	has	a	computerised	mount	(either	Go-To	or	Digital	Setting	Circles),	then	you	can	se-
lect	the	mount	type	here	(if	supported).	The	Edit...	button	allows	you	to	set	up	the	mount	parame-
ters.	This	is	covered	in	more	detail	in	Section	13.2	on	page	197.

Visual magnitude limit
The	theoretical	visual	magnitude	of	the	instrument	is	computed	from	the	speciFied	aperture.	You	can
check	the	checkbox	and	change	that	value	to	something	else	if	you	feel	that	the	theoretical	value	
does	not	represent	reality.

Finder
(Telescopes	only)	If	the	telescope	has	an	attached	Finder	scope,	deFine	it	here.	You	can	specify	its	Field
of	view	(FoV)	in	degrees	if	that	is	known.	Otherwise,	if	you	have	a	Finder	that's	constructed	from	
other	resources	(a	monocular	resource,	or	a	telescope/eyepiece	combination,	you	can	specify	them	
here	and	let	the	application	Figure	out	the	FoV.

If	the	Finder	Flips	the	sky	view	horizontally	and/or	vertically,	use	the	checkboxes	to	specify	that,	so	
that	the	Field	of	view	chart	can	reFlect	this	if	the	Finder	option	is	used.

Custom Alignment Stars
This	feature	allows	you	to	create	your	own	set	of	alignment	stars,	independently	of	any	alignment	
stars	that	might	be	deFined	by	the	telescope	mount.	Any	such	alignment	stars	will	be	used	and	ap-
pear	as	if	they	were	deFined	for	a	mount,	i.e.	you	can	use	the	Best	Pair	mechanism,	display	them	in	
the	Sky	chart,	etc.	Any	star	in	the	(Yale)	Bright	Star	catalogue	can	be	used.	

This	functionality	is	found	in	the	Alignment	Stars	tab	(Figure	80).	When	the	Use	custom	list	check-
box	is	checked,	the	deFined	alignment	stars	will	be	used	when	the	currently-selected	Telescope	is	se-
lected	in	the	plan	document.

The	stars	are	stored	in	"star	sets".	Use	the	"+"	button	to	the	right	of	the	Star	set	popup	to	create	a	
new	star	set.	Once	that	has	been	done	you	can	add	stars	to	the	set	using	the	"+"	button	at	the	bottom
left.	The	presented	dialog	(Figure	81)	allows	you	to	select	one	or	more	stars	from	the	list	and	add	
them	to	the	star	set.	You	can	limit	the	displayed	stars	by	magnitude,	constellation,	or	type	in	a	search
string.
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Figure	80:	Custom	alignment	stars

Figure	81:	Adding	custom	alignment	stars

You	can	also	download	star	sets	from	a	user-contributed	repository	by	clicking	the	down-arrow	but-
ton	at	the	bottom	right.	Select	one	(or	more)	star	sets	from	the	repository	and	download	them	(Fig-
ure	82).	You	can	also	select	your	own	contributions	and	delete	them	as	necessary,	using	the	Delete...
button.

Conversely,	if	you	wish	to	upload	the	currently-selected	star	set	to	the	user-contributed	repository,	
then	use	the	up-arrow	button	and	the	bottom	right	of	the	Alignment	Stars	tab.	This	presents	a	dialog
(Figure	83)	that	lets	you	enter	a	description	and	some	keywords	before	uploading	the	star	set.
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Figure	82:	Download	user-contributed	alignment	star	sets

Figure	83:	Upload	user-contributed	alignment	star	set

Computed Parameters
This	is	a	list	of	computed	values	for	the	telescope,	and	reFlects	the	settings	for	aperture,	etc.

Select from List...
You	can	create	a	new	Telescope	resource	by	selecting	from	a	list	of	common	(and	not-so-common)	
manufacturer's	models	using	this	button.

The	listing	dialog	has	three	tabs,	for	Telescopes,	Binoculars	and	Prime	Camera	Lenses	(which	are	ef-
fectively	telescopes).	Each	tab	lists	as	many	known	telescope	models	as	possible.	Obviously	keeping	
these	lists	up-to-date	is	time-consuming.	Use	the	Update	button	to	check	on-line	and	see	if	there	
have	been	any	updates	to	the	lists.	If	you	still	don't	see	your	commercial	telescope	on	the	list,	feel	
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free	to	send	an	e-mail	message	to	support@ilanga.com	and	complain.	We'll	try	and	get	the	list	up-
dated	as	quickly	as	possible.

You	can	select	one	or	more	entries	manually,	or	use	the	Find	Field	to	specify	a	search	term.

Once	you	have	selected	one	or	more	entries,	click	the	OK	button	to	create	a	new	resource	for	each	of	
them.

Figure	84:	Telescope	listing	dialog

Get info from ASCOM
(Windows	only)	If	your	computerised	mount	is	speciFied	as	an	ASCOM	mount,	you	can	use	this	driver
to	attempt	to	retrieve	some	of	the	telescope	parameters	(e.g.	aperture,	focal	ratio)	from	the	ASCOM	
driver.
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9.2.4 Eyepiece resources

Figure	85:	Eyepiece	resources

Focal Length
The	focal	length	of	the	eyepiece	in	mm.	You	can	also	enter	the	focal	length	in	inches	by	adding	"	after
the	value	(e.g.	4.5"),	in	which	case	the	conversion	to	mm	will	be	done	for	you.

Field of View
Choose	the	Field	of	view	of	the	eyepiece,	either	as	the	Apparent	Field	of	View	(AFoV)	in	degrees,	or	
by	the	Field	Stop	Diameter	in	mm	(e.g.	Televue	Nagler	eyepieces	all	have	an	apparent	FoV	of	82°).

Barrel
The	barrel	size	of	the	eyepiece.

Reticle
If	the	eyepiece	has	a	built-in	reticle,	you	can	deFine	it	here.	It	will	have	one	or	more	components.	Se-
lect	components	using	the	+	button.
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Figure	86:	Sample	eyepiece	reticle

Select from List...
You	can	create	a	new	Eyepiece	resource	by	selecting	from	a	list	of	common	(and	not-so-common)	
manufacturer's	models	using	this	button.

The	dialog	lists	as	many	known	eyepiece	models	as	possible.	Obviously	keeping	these	lists	up-to-
date	is	time-consuming.	Use	the	Update	button	to	check	on-line	and	see	if	there	have	been	any	up-
dates	to	the	lists.	If	you	still	don't	see	your	commercial	eyepiece	on	the	list,	feel	free	to	send	an	e-
mail	message	to	support@ilanga.com	and	complain.	We'll	try	and	get	the	list	updated	as	quickly	as	
possible.

You	can	select	one	or	more	entries	manually,	or	use	the	Find	Field	to	specify	a	search	term.

Once	you	have	selected	one	or	more	entries,	click	the	OK	button	to	create	a	new	resource	for	each	of	
them.
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Figure	87:	Eyepiece	listing	dialog
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9.2.5 Optical Aid resources

Figure	88:	Optical	Aid	resources

Magnification
The	amount	of	magniFication	added	by	using	this	optical	aid.

Additional focal length
The	addition	focal	length	that	the	optical	aid	adds	to	the	optical	path,	in	mm.	You	can	also	enter	the	
focal	length	in	inches	by	adding	"	after	the	value	(e.g.	4.5"),	in	which	case	the	conversion	to	mm	will	
be	done	for	you.

Binocular
Check	if	this	is	a	binoviewer.

Changes field of view orientation
The	the	optical	aid	changes	the	Field	of	view	orientation,	specify	how	here.

Combine button
The	combine	button	(under	the	list	of	resource	names)	lets	you	combine	two	or	more	optical	aid	re-
sources	into	a	new	resource.	The	resulting	resource	will	combine	the	magniFications,	focal	length	ex-
tensions,	etc.	This	is	often	useful	since	it	is	only	possible	to	specify	one	optical	aid	resource	at	a	time.
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Figure	89:	Combining	optical	aid	resources

Select from List...
You	can	create	a	new	Optical	Aid	resource	by	selecting	from	a	list	of	common	(and	not-so-common)	
manufacturer's	models	using	this	button.

The	dialog	lists	as	many	known	optical	aid	models	as	possible.	Obviously	keeping	these	lists	up-to-
date	is	time-consuming.	Use	the	Update	button	to	check	on-line	and	see	if	there	have	been	any	up-
dates	to	the	lists.	If	you	still	don't	see	your	commercial	eyepiece	on	the	list,	feel	free	to	send	an	e-
mail	message	to	support@ilanga.com	and	complain.	We'll	try	and	get	the	list	updated	as	quickly	as	
possible.

You	can	select	one	or	more	entries	manually,	or	use	the	Find	Field	to	specify	a	search	term.

Once	you	have	selected	one	or	more	entries,	click	the	OK	button	to	create	a	new	resource	for	each	of	
them.
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Figure	90:	Optical	Aid	listing	dialog
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9.2.6 Filter resources

Figure	91:	Filter	resources

Minimum Exit Pupil
Minimum	exit	pupil	size	in	mm.

Bandpass wavelengths 
A	list	of	Filter	bandpass	wavelength	ranges	(in	nanometers).	Use	the	+	and	-	buttons	to	add/delete	
entries.	Click	the	values	to	edit	them.	Note	that	these	values	are	not	used	in	the	application	(but	can	
be	accessed	from	scripts	if	necessary).	The	graphic	on	the	right	of	the	list	displays	the	bandpasses,	
as	well	as	some	common	wavelengths	(Hα,	O-III,	etc.).

Select from List...
You	can	create	a	new	Filter	resource	by	selecting	from	a	list	of	common	(and	not-so-common)	man-
ufacturer's	models	using	this	button.

The	dialog	lists	as	many	known	Filter	models	as	possible.	Obviously	keeping	these	lists	up-to-date	is	
time-consuming.	Use	the	Update	button	to	check	on-line	and	see	if	there	have	been	any	updates	to	
the	lists.	If	you	still	don't	see	your	commercial	eyepiece	on	the	list,	feel	free	to	send	an	e-mail	mes-
sage	to	support@ilanga.com	and	complain.	We'll	try	and	get	the	list	updated	as	quickly	as	possible.

You	can	select	one	or	more	entries	manually,	or	use	the	Find	Field	to	specify	a	search	term.

Once	you	have	selected	one	or	more	entries,	click	the	OK	button	to	create	a	new	resource	for	each	of	
them.
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Figure	92:	Filter	listing	dialog
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9.2.7 Observer resources

Figure	93:	Observer	resources

Observer's Name
Observer's	full	name.	For	informational	purposes	only.

Year of Birth
Observer's	year	of	birth.	Use	for	advanced	visibility	calculations.

E-Mail Address
Observer's	e-mail	address.	Currently	not	used.

Latitude/Longitude
The	latitude/longitude	of	the	observer's	home.	Currently	not	used.

Experience
Observer's	relative	experience.	Use	for	advanced	visibility	calculations.

Vision
Observer's	vision	acuity.	Use	for	advanced	visibility	calculations.
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9.2.8 Imager resources

Figure	94:	Imager	resources

Main Sensor Name
The	name	of	the	imager's	main	sensor	chip.

Main Sensor Pixel Size
The	main	sensor's	pixel	size	(in	µm).

Main Sensor Number of Pixels
The	number	of	pixels	in	the	X	and	Y	directions	of	the	main	sensor.

Guide Sensor Name
The	name	of	the	imager's	guide	sensor	chip.	If	the	imager	has	a	built-in	guide	sensor	then	check	the	
checkbox	next	to	this	Field.

Guide Sensor Pixel Size
The	guide	sensor's	pixel	size	(in	µm).

Guide Sensor Number of Pixels
The	number	of	pixels	in	the	X	and	Y	directions	of	the	guide	sensor.

Guide Sensor Offset
The	offset	of	the	centre	of	the	guide	sensor	from	the	centre	of	the	main	sensor	(in	mm)

35mm comparison
The	diagram	on	the	right	shows	the	relative	size	of	the	main	(and	guide	sensor	if	applicable)	com-
pared	to	a	35mm	Film	frame.
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Display Colour
Select	the	default	colour	used	to	display	the	imager	outline	in	the	Field	of	view	and	other	charts.

Select Main Sensor from List...
You	can	create	a	new	Imager	resource	by	selecting	from	a	list	of	common	(and	not-so-common)	
manufacturer's	models	using	this	button.	The	list	includes	imagers	First,	followed	by	sensors	used	
by	those	imagers	at	the	end	(in	green).	Imager	models	with	separate	built-in	guide	sensors	are	dis-
played	in	red.

The	dialog	lists	as	many	known	imager	and	sensor	models	as	possible.	Obviously	keeping	these	lists	
up-to-date	is	time-consuming.	Use	the	Update	button	to	check	on-line	and	see	if	there	have	been	
any	updates	to	the	lists.	If	you	still	don't	see	your	commercial	eyepiece	on	the	list,	feel	free	to	send	
an	e-mail	message	to	support@ilanga.com	and	complain.	We'll	try	and	get	the	list	updated	as	quickly
as	possible.

You	can	select	one	or	more	entries	manually,	or	use	the	Find	Field	to	specify	a	search	term.

Once	you	have	selected	one	or	more	entries,	click	the	OK	button	to	create	a	new	resource	for	each	of	
them.

Figure	95:	Imager	listing	dialog

Select Guide Sensor from List...
Does	the	same	thing	as	the	above,	but	only	replaces	the	guide	sensor	data.	The	Guide	Sensor	check-
box	need	to	be	checked	to	enable	this	button.

- 73 -



9.2.9 Resource combinations
This	tab	allows	you	to	show	a	tabular	display	showing	combinations	of	telescopes	with	eyepieces,	
imagers	and	optical	aids.	In	Figure	96	the	top	table	shows	all	telescope		resources	paired	with	eye-
pieces	and	a	2X	Barlow	lens,	showing	the	magniFication	achieved	in	each	case.	The	lower	table	
shows	various	computed	parameters	for	each	telescope

Figure	96:	Resource	combinations

You	can	show:

• Eyepiece	magniOication.

• Eyepiece	Apparent	FoV.

• Eyepiece	Actual	FoV.

• Eyepiece	exit	pupil.

• Telescope	limiting	magnitude.

• Advanced	Limiting	magnitude	(zenith).	In	this	case	you	specify	a	Site	and	an	Observer.

• Imager	Actual	FoV.

• Imager	pixel	scale.

Wavelength
This	is	used	in	the	computation	of	some	of	the	computed	parameters	(e.g.	depth	of	focus).
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10 Constructing an observing plan
This	chapter	discusses	how	to	go	about	constructing	an	observing	plan	(i.e.	choosing	a	selection	of	
objects	to	observe).	There	are	various	ways	to	do	this,	covered	below.

10.1 Manual construction
The	simplest	way	to	construct	a	plan,	while	not	necessarily	being	the	fastest,	is	to	do	so	manually.	If	
you	have	a	list	of	objects	you	wish	to	observe,	possibly	from	a	book	or	magazine,	then	this	is	the	way
to	go	(unless	someone	else	has	already	done	the	work	-	in	which	case,	see	Section	10.2	on	page	84).

Create	a	new	plan	by	using	File	>	New.

10.1.1 Adding a new object
For	each	object	on	your	list,	click	the	+	button	under	the	object	list,	or	use	Object	>	New	Object....	
This	will	invoke	the	new	object	dialog.

Figure	97:	New	Object	dialog

You	then	have	various	options	to	create	objects	in	your	plan:

Empty	button.	Clicking	this	will	create	an	"empty"	object	in	the	plan,	with	no	ID	or	coordinates.	You	
can	edit	that	object	later	(see	Section	10.4	on	page	88).

Type	in	a	known	ID.	Type	an	ID	into	the	ID	Field	(or	click	the	Clipboard	button	if	the	ID	was	previ-
ously	copied	there).	If	the	ID	preFix	(e.g.	"NGC")	is	found	in	one	or	more	of	your	installed	catalogues,	
then	the	dialog	announces	how	many	catalogues	it	appears	in	and	enables	a	Best	button.	Clicking	
the	Best	button	will	search	the	catalogue	most	likely	to	contain	the	object	and	if	found,	the	object	
will	be	inserted	into	your	plan.	If	not	found,	you'll	be	informed.	

Type	the	abbreviation	or	name	of	a	constellation	in	order	to	add	a	constellation	object.	The	constel-
lation	object	is	created	with	the	ID	equal	to	the	abbreviation,	the	Name	equal	to	the	full	constellation
name,	the	RA/Dec	coordinates	of	the	centre	of	the	constellation,	and	the	Size	equal	to	the	largest	
dimension	of	the	constellation.
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Figure	98:	New	object	based	on	known	ID

SIMBAD	search.	If	you	type	in	an	ID,	and	it	doesn't	appear	in	any	of	your	installed	catalogues,	and	
you	have	Internet	access,	you	can	request	a	search	of	the	on-line	professional	SIMBAD	database	by	
using	the	SIMBAD	button.	This	creates	an	object	with	a	lot	of	information.	You	can	always	edit	out	
what	you	don't	need	afterwards.

Search	all	catalogues.	If	you	want	to	Find	all	entries	in	your	catalogue	collection	that	match	the	ID,	
use	the	All...	button.	This	will	search	all	installed	catalogues	and	create	a	list	of	all	objects	that	match
the	ID.	If	none	is	found,	you'll	be	given	the	chance	to	repeat	the	search	looking	in	the	catalogue	ob-
ject	notes	Fields	for	occurrences	of	the	ID	(Warning:	this	can	take	a	while).	The	search	results	are	
presented	in	a	window.	You	can	select	one	or	more	objects	and	click	the	Add	Selected	(or	Add	All)	
button	to	add	the	object/s	to	your	plan.	If	you	are	feeling	lucky,	you	can	check	the	First	only	check-
box,	in	which	case	the	search	will	stop	after	Finding	the	First	match.

You	can	also	set	the	Synonyms	checkbox,	in	which	case	the	search	will	also	Find	any	synonym	ob-
jects	with	the	same	coordinates.

Figure	99:	Search	results	window

If	you	want	to	add	several	objects	at	once,	you	can	use	the	Multiple	IDs...	button.	This	will	allow	you
to	enter	several	IDs,	in	various	forms,	and	search	for	all	of	them	at	once.	The	results	are	presented	in
the	Search	Results	window	as	shown	above.
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Figure	100:	Lookup	multiple	IDs

The	Multiple	ID	lookup	also	lets	you	select	the	catalogues	to	search.	You	can	choose	to	search	all	the	
catalogues	(the	default),	manually	selected	catalogues,	only	catalogues	containing	certain	types	of	
objects,	only	catalogues	containing	the	ID/s	you	are	searching	for,	or	only	catalogues	where	the	ID	
you	are	searching	for	is	the	primary	ID.

You	can	also	lookup	the	IDs	using	the	on-line	SIMBAD	catalogue	if	you	wish	(SIMBAD	button).	You	
can	also	use	the	Cross-index	ID	Oields	checkbox	to	do	an	exhaustive	search	(which	will	pretty	much
Find	every	ID	and	its	synonyms	in	the	catalogues,	but	might	also	Find	some	false	positives	too).
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Figure	101:	Catalogue	select	dialog

Finally,	when	you	are	entering	the	ID	of	your	object,	the	dialog	can	be	expanded	(using	the	Guides	
widget	at	the	top	right)	to	display	some	useful	aids	to	entering	ID	data.	The	left	hand	table	contains	
the	symbols	of	the	Greek	alphabet.	Clicking	on	a	symbol	enters	the	2-	or	3-character	abbreviation	
for	that	symbol.	The	centre	table	lists	some	common	double-star	discoverer	IDs.	Clicking	an	ID	will	
enter	the	correct	alphabetic	preFix	as	used	in	the	WDS	catalogue	name	Field.

Figure	102:	New	object	dialog	showing	guides

The	Constellation	abbreviation	popup	inserts	the	three-character	abbreviation	for	the	selected	
constellation.	Common	stars	lists	common	names	of	stars,	and	when	selected	will	insert	the	Bayer	
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ID	or	SAO	ID	into	the	ID	Field.	Common	deep-sky	objects	lists	common	names	of	deep-sky	objects	
and	asterisms,	and	when	selected	will	insert	a	suitable	ID	for	searching	into	the	ID	Field.

10.1.2 Adding from a catalogue
You	can	add	objects	to	your	plan	directly	from	an	installed	catalogue.	Open	the	catalogue	display	
window	(usually	via	the	Show	Catalogue	popup	under	the	object	list	in	the	plan	document	window,	
or	via	Object	>	Open	catalogue/s).

Figure	103:	Catalogue	display	window

Select	one	or	more	objects	and	either	drag	the	rows	across	to	the	plan	window's	object	list,	or	click	
the	Add	Selected	button.

10.1.3 Searching the catalogues
You	can	also	perform	a	targeted	search	of	one	or	all	catalogues,	based	on	criteria	you	deFine.	This	is	
done	via	the	Search	Catalogue/s	popup	under	the	object	list	in	the	plan	document	window,	or	via	
Object	>	Search	>	Search	Catalogue/s).

If	you	use	the	menu	command,	or	if	you	select	the	Choose	catalogue/s	from	list...	entry	from	the	
popup,	then	you	will	be	presented	with	a	dialog	that	lets	you	choose	one	or	more	catalogues	to	be	
searched.	The	radio	buttons	at	the	top	of	the	dialog	window	display	your	installed	catalogues	in	var-
ious	ways	(as	a	single	alphabetised	list	by	catalogue	name,	as	a	hierarchical	list	by	object	types	
contained	within	the	catalogues	(e.g.	nebulae,	double	stars,	etc.),	or	as	a	hierarchical	list	by	the	ob-
ject	IDs	supported	by	the	catalogues	(e.g.	M,	NGC,	IC,	etc.)).
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Figure	104:	Select	catalogue	dialog

Once	you	have	identiFied	the	catalogue/s	to	search,	the	Search	dialog	is	presented.	This	dialog	allows
you	to	specify	various	search	parameters	to	use	to	determine	which	objects	are	selected	from	the	
catalogue/s.
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Figure	105:	Catalogue	search	dialog

The	general	approach	is	to	check	the	checkbox	for	the	catalogue	object	parameter	you	wish	to	
search	on.	If	you	choose	more	than	one,	then	all	the	checked	restrictions	must	be	true	for	a	cata-
logue	object	to	be	considered.	Most	of	the	parameters	speciFied	either	deFine	a	range	of	values,	or	a	
character	string	to	look	for.	The	notes	below	describe	those	that	don't	follow	this	pattern,	or	have	
additional	features.

Searches	will	typically	Find	all	matching	objects	in	the	catalogue/s.	However,	if	your	selected	param-
eters	include	a	single	numeric	parameter,	then	the	Find	object	with	Minimum/Maximum	value	
item	appears	at	the	bottom	of	the	dialog.	If	you	select	Minimum	or	Maximum	then	(for	each	
processed	catalogue)	only	a	single	object	will	be	returned	having	the	minimum	or	maximum	value	
of	the	selected	numeric	parameter.

Notes
• Within	x°	of	RA/Dec.	This	option	only	returns	objects	that	are	closer	than	x°	from	the	speciFied	
RA/Dec	coordinates.

• In	Magnitude/2	range.	You	can	use	the	For	telescope...	popup	to	select	the	visual	magnitude	
limit	for	that	telescope	resource.

• In	Magnitude	Diff.	range.	SpeciFies	a	magnitude	difference	between	Magnitude	and	Magnitude2
for	an	object.	This	can	be	used	for	double	or	variable	stars	only,	where	the	Magnitude2	value	is	
available.
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• In	Size	range.	As	the	footnote	speciFies,	you	can	either	specify	m	or	a	string	of	the	form	m	x	n,	
where	m	and	n	are	numbers.	In	the	former	case,	only	the	longest	(First)	size	linear	dimension	in	
arc	minutes	will	be	compared.	In	the	second	case	the	angular	area	in	square	arc	minutes	will	be	
compared.

• Size	ratio.	This	is	one	of	the	options	in	the	parameter	with	the	popup	menu.	The	size	ratio	is	
valid	for	any	object	that	has	a	speciFied	size.	If	that	size	is	a	single	number,	then	the	size	ratio	is	
1.0.	The	size	is	m	x	n,	where	m	≥	n,	then	the	size	ratio	is	m	÷	n.	In	the	example	shown	in	Figure	
105,	the	search	is	for	galaxies	with	a	size	ratio	≥	10,	i.e.	"Flat"	galaxies.

• Spectral	Data/Name/Description	contains.	Returns	any	object	that	has	the	speciFied	parame-
ter	containing	the	character	string.	However,	if	you	use	the	Regex	checkbox,	then	the	Field	is	con-
sidered	to	contain	a	regular	expression,	and	the	object	will	be	returned	if	the	regular	expression	
is	true	for	the	speciFied	object	parameter.

• Limit	to	Visibility.	An	object	is	returned	only	if	it	falls	between	the	given	altitude	values	at	the	
speciFied	site,	on	the	speciFied	date,	somewhere	between	the	speciFied	times.	If	the	Include	site	
horizon	option	is	checked,	then	an	object	will	not	be	returned	if	it	is	behind	the	user-speciFied	
horizon	for	the	speciFied	site.	If	the	Transit	also	occurs	option	is	checked,	then	an	object	is	re-
turned	only	if	it	transits	(reaches	its	highest	altitude	in	the	sky)	during	the	speciFied	time	period.	
Use	the	Set	plan	date/time	option	if	you	want	to	set	the	current	plan's	date	and	time	to	the	be-
ginning	of	the	speciFied	period	when	the	search	is	done	(regardless	of	the	search	results).	
WARNING:	This	search	option	is	very	compute	intensive,	and	should	probably	only	be	used	on	
smaller	catalogues.

• Limit	to	Types.	The	list	contains	only	those	object	types	available	in	the	search	catalogue/s,	to-
gether	with	the	total	number	of	such	objects	available.

• Limit	to	Constellations.	The	constellations	displayed	in	the	list	can	be	limited	to:	All	(88)	con-
stellations,	only	those	constellations	visible	from	the	site,	or	only	those	constellations	visible	
from	the	site	at	the	current	date/time.	You	can	also	elect	to	show	partially	visible	constellations.

• Save...	and	Load...	buttons	allow	you	to	save	the	contents	of	the	search	and	reload	it	at	a	later	
stage.	This	is	convenient	if	you	have	several	complex	search	strategies	you'd	like	to	use	more	
than	once.

10.1.4 Adding "special" objects
Underneath	the	object	list	there	is	an	Add	Special	popup	menu.	This	is	a	convenient	way	of	adding	
common	objects	to	your	plan.	The	planets,	the	moon,	the	Messier	objects,	comets,	and	minor	planets
can	be	inserted	from	here.
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Figure	106:	Add	Special	popup	menu

If	you	choose	Comet...	or	Minor	Planet...	then	you	get	the	choice	to	choose	from	any	cached	data	
that	was	previously	downloaded	(see	Chapter	24	on	page	338).	Alternatively,	you	can	create	a	de-
fault	comet/minor	planet	and	edit	the	elements	manually.

Figure	107:	Add	minor	planet	dialog

The	Constellation/s...	entry	lets	you	add	one	or	more	constellation	objects	to	the	object	list.
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Figure	108:	Adding	constellation/s

10.2 User-contributed plans
A	more	convenient	way	to	create	a	plan	is	to	use	one	that	another	user	has	created	and	uploaded	to	
the	user-contributed	plan	repository.	This	is	described	in	more	detail	in	Section	22.1	on	page	322.

10.3 Plan Creation Wizard
Another	convenient	way	of	creating	an	observing	plan	is	to	use	the	Plan	Creation	Wizard	(PCW).	The
PCW	maintains	a	database	of	observable	objects	that	it	collects	from	whatever	catalogues	you	have	
installed1.	Using	rules	(that	you	can	change	if	you	wish),	the	PCW	rates	the	objects	into	Five	levels,	
from	easy	to	hard.	You	can	then	get	the	PCW	to	create	a	plan	for	you,	based	on	your	desired	level	of	
difFiculty,	the	telescope	you	plan	to	use,	the	place	and	time	you	will	be	observing,	etc.

Objects	are	selected	at	random	from	the	database,	and	wherever	possible	do	not	include	any	objects	
you've	already	selected	in	any	previous	use	of	the	PCW	feature.

To	invoke	the	PCW,	use	File	>	Plan	Creation	Wizard....	The	PCW	dialog	is	presented.

1. Whenever you add, delete or update a catalogue, the PCW database is updated accordingly in the background. You might see the
occasional	message	about	this,	especially	the	First	time	you	use	AstroPlanner,	or	if	you	install	a	number	of	new	catalogues.
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Figure	109:	Plan	Creation	Wizard	dialog	-	page	1

You	then	navigate	through	several	"pages"	using	the	Next	(and	Previous)	buttons,	and	Finishing	with
the	Finish	button.

On	the	second	page	you	specify	who	you	are	and	what	level	of	difFiculty	you	need.	The	plan	will	con-
tain	only	objects	considered	to	be	of	the	difFiculty	rating	you	specify.	You	can	use	the	Include	lower	
levels	checkbox	to	include	objects	from	all	levels	up	to	and	including	the	one	you	specify.	

Figure	110:	Plan	Creation	Wizard	dialog	-	page	2

The	third	"page"	speciFies	where	(your	site)	and	when	(date,	time,	season,	etc.)	you	will	be	ob-
serving.	You	can	specify	a	speciFic	date,	a	speciFic	month,	or	the	season	(summer,	etc.).	Alternatively	
you	can	select	constellations	that	you	are	interested	in	observing.
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Figure	111:	Plan	Creation	Wizard	dialog	-	page	3	(select	by	date/time)

Figure	112:	Plan	Creation	Wizard	dialog	-	page	3	(select	by	constellation/s)

The	fourth	page	lets	you	select	what	telescopes	or	binoculars	you	will	be	using	to	do	your	observing	
(you	don't	want	to	select	objects	that	are	outside	the	limits	of	your	equipment).

- 86 -



Figure	113:	Plan	Creation	Wizard	dialog	-	page	4

The	Fifth	page	is	where	you	specify	what	kinds	of	objects	you	want	to	observe,	how	many	objects	to	
generate,	and	which	catalogues	to	use	(or	not	to	use).	The	PCW	will	attempt	to	generate	as	many	ob-
jects	as	you	specify	in	the	Maximum	objects	in	plan	Field.	You	can	uncheck	any	catalogues	you	
don't	want	to	consider.	There's	also	a	Reject	objects	option	that	will	ignore	any	catalogue	objects	if	
they	were	previously	observed	(have	at	least	one	observation	in	the	observation	database).

Figure	114:	Plan	Creation	Wizard	dialog	-	page	5

The	Final	page	lets	you	choose	whether	the	new	objects	will	be	placed	in	a	new	plan,	or	placed	in	the
open	plan	document.	Clicking	the	Finish	button	will	create	the	new	plan	objects.
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Figure	115:	Plan	Creation	Wizard	dialog	-	Final	page

10.4 Editing objects
Once	you	have	added	objects	to	your	plan	document,	you	might	want	to	edit	them.	There	are	two	
ways	to	do	this.

10.4.1 Editing fields
If	the	edit	Fields	are	not	being	displayed	underneath	the	object	list,	you	need	to	toggle	the	display	
button	(circled	in	Figure	116).

Figure	116:	Object	editing	button

The	editing	Fields	are	populated	and	enabled	when	a	single	object	is	selected	in	the	object	list.	Any	
changes	you	make	in	these	Fields	will	be	accepted	and	displayed	immediately.

The	search	buttons	to	the	right	of	the	ID	and	Name	Fields	will	search	the	catalogues	for	the	entries	in
those	Fields.	If	the	ID	or	Name	Field	is	empty,	then	you'll	be	asked	to	enter	one	or	more	IDs	to	search	
for.

The	annotations	widget	(select	the	Annotations	tab	in	Notes/Annotations)	displays	any	catalogue	
annotations	for	the	selected	object.	See	Section	23.7	on	page	334	for	details.

The	ODM/Eyepiece	tab	displays	the	ODM	information	and	the	best	eyepiece	and/or	eyepiece/visual	
aid	combination	to	use	with	the	current	telescope	in	order	to	detect	the	object	(where	applicable).	
See	Figure	118.
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Figure	117:	Object	editing	Fields

Figure	118:	ODM/Eyepiece	information

10.4.2 In-line editing
If	you	have	in-line	editing	switched	on	(Object	>	Object	List	Preferences	>	Navigation	and	edit-
ing	>	In-line	editing	of	object	Lields)	then	you	also	have	the	option	of	editing	object	data	directly	in	
the	object	list.	WARNING:	after	changing	the	preference	option	you	might	have	to	close	and	reopen	
any	open	plan	document	windows	before	this	feature	functions	correctly.

Any	Field	in	the	selected	object	that	is	editable	will	be	displayed	with	a	small	triangle	on	the	left	and	
right,	as	shown	below.	Fields	without	the	triangles	are	not	editable.

Figure	119:	In-line	object	list	editing

Clicking	on	an	editable	Field	will	allow	you	to	edit	its	value	directly.

Figure	120:	In-line	editing	in	action

10.5 Importing objects from other sources
You	can	import	objects	from	Files	created	by	other	applications.	See	Section	26.1	on	page	349	for	
more	details.

User-contributed	scripts	might	also	exist	that	allow	for	import	from	other	non-supported	formats.	
See	Section	27.2	on	page	371	for	more	details.

You	might	be	able	to	import	and	create	objects	directly	from	an	external	application.	See	Section	
21.2	on	page	321	for	more	details.
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11 Plan document window
The	plan	document	window	is	the	fundamental	place	from	which	you	will	operate	the	application.	
The	window	is	split	into	two	parts:	common	information	and	settings	at	the	top	of	the	window	and	a
set	of	four	tabs	below	that.	This	chapter	documents	all	items	on	the	window.

11.1 Common information and settings
The	common	information	and	settings	are	located	directly	below	the	window	title	bar.

Figure	121:	Common	information	&	settings

Depending	on	the	window	width,	the	date/time	settings	panel	might	be	hidden	(as	shown	above)	
with	a	simple	Fix	Date	button	and	checkbox.	If	the	widow	is	resized	wide	enough,	the	Date/Time	
settings	are	revealed	on	the	right	(as	shown	below).

Figure	122:	Date/time	panel	revealed

11.1.1 Time and other information
Along	the	top	of	the	window	are	a	number	of	displayed	items.	These	include	date,	time,	location	and	
telescope	information.	As	many	items	as	will	Fit	across	the	window	are	displayed.	Any	others	are	
dropped	until	the	window	is	resized	wider.

Figure	123:	Time	and	other	information

Items	that	can	be	displayed:

• Latitude.	Latitude	of	the	current	site.

• Longitude.	Longitude	of	the	current	site.

• GMT	Offset.	Offset	(in	hours)	of	the	current	site,	with	respect	to	GMT.

• Local	Date.	The	local	date	at	the	site.	Typically	this	is	your	computer's	clock	date,	unless	your	
site	has	deFined	a	clock	offset	(i.e.	a	remote	site),	or	you	have	"Fixed"	the	date/time.

• Local	Time.	The	local	time	at	the	site.	Typically	this	is	your	computer's	clock	time,	unless	your	
site	has	deFined	a	clock	offset	(i.e.	a	remote	site),	or	you	have	"Fixed"	the	date/time.

• Local	Sidereal.	The	local	sidereal	time	(LST)	for	the	site.

• Julian	Date.	The	Julian	date.

- 90 -



• GMT/UTC.	Greenwich	mean	time/Universal	time.	This	is	(effectively)	the	time	at	Greenwich	(0°	
longitude),	without	taking	into	account	any	daylight	saving	time.

• GMST.	Greenwich	Mean	Sidereal	Time.	The	Local	sidereal	time	at	Greenwich	(0°	longitude).

• Telescope	RA.	The	current	pointing	RA	of	the	telescope	mount.	This	will	not	be	displayed	unless
a	telescope	is	connected.

• Telescope	Dec.	The	current	pointing	declination	of	the	telescope	mount.	This	will	not	be	dis-
played	unless	a	telescope	is	connected.

• Telescope	Az.	The	current	pointing	azimuth	of	the	telescope	mount.	This	will	not	be	displayed	
unless	a	telescope	is	connected.

• Telescope	Alt.	The	current	pointing	altitude	of	the	telescope	mount.	This	will	not	be	displayed	
unless	a	telescope	is	connected.

• Telescope	HJD.		The	current	Heliocentric	Julian	Date	of	the	telescope	mount's	pointing	coor-
dinates.	This	will	not	be	displayed	unless	a	telescope	is	connected.

• Computer	Date.	The	date	set	on	your	computer.	This	will	typically	be	the	same	as	your	Local	
Date,	unless	your	current	site	has	a	clock	offset	(if	it's	a	remote	site),	in	which	case	the	Local	Date
might	be	different	if	the	remote	site	is	in	a	different	time	zone.

• Computer	Time.	The	time	set	on	your	computer.	This	will	typically	be	the	same	as	your	Local	
Time,	unless	your	current	site	has	a	clock	offset	(if	it's	a	remote	site),	in	which	case	the	Local	
Time	might	be	different	if	the	remote	site	is	in	a	different	time	zone.

• Local	-	Computer.	The	difference	in	time	between	the	Local	Date/Time	and	the	Computer	Date/
Time.	This	will	typically	be	0	hours,	unless	your	current	site	has	a	clock	offset	(if	it's	a	remote	
site),	in	which	case	the	difference	will	be	the	number	of	hours	between	your	time	zone	and	the	
remote	site's	time	zone..

You	can	enable/disable	any	of	the	above	items	by	right-clicking	and	toggling	items	on	and	off	in	the	
menu.	You	can	also	change	the	font	colour.

Figure	124:	Right-click	menu
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11.1.2 Telescope control
The	Telescope	panel	at	the	top	left	is	where	you	select	the	telescope	you	are	using	for	observing.	A	
popup	list	of	active	telescope	resources	lets	you	choose.	This	choice	affects	some	of	the	columns	in	
the	object	list	that	might	depend	on	telescope	aperture	(e.g.	ODM).	

If	the	telescope	has	a	computerised	mount	(see	Chapter	13	on	page	195	for	more	details),	then	you	
will	connect	the	application	to	that	mount	using	the	Connect	to	telescope	checkbox.	Unchecking	
the	checkbox	disconnects	the	application	from	the	mount.

Figure	125:	Telescope	control	-	not	connected

If	you	are	connected	to	a	Go-to	computerised	telescope	mount	then,	once	you	are	connected,	the	
Slew	to	Object	and	Sync	to	Object	buttons	are	revealed.	See	Section	13.5	on	page	203	for	more	info.

Figure	126:	Telescope	control	-	connected	to	a	Go-to	telescope	mount

If	you	are	connected	to	digital	setting	circles	(DSC)	then	a	small	graphic	is	shown	that	indicates	how	
far	from	the	target	object	you	are	pointing.

Figure	127:	Telescope	control	-	connected	to	a	digital	setting	circle	(DSC)	telescope	mount

11.1.3 Sun and moon information
The	sun	and	moon	information	panels	show	information	about	the	current	status	of	the	sun	and	
moon	at	your	speciFied	site.

The	sun	panel	shows	the	current	altitude	of	the	sun	above	or	below	the	horizon,	the	times	of	sunset	
and	sunrise,	and	the	times	at	which	twilight	transitions	between	civil,	nautical,	and	astronomical	
twilight,	and	complete	darkness.

Figure	128:	Sun	&	twilight	information

The	moon	information	panel	shows	time	of	moonset	and	moonrise,	the	age	of	the	moon	in	days,	the	
phase	of	the	moon	and	percentage	of	the	surface	that's	illuminated,	and	the	current	altitude	of	the	
moon	above	or	below	the	horizon.
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Figure	129:	Moon	information

Hover	the	cursor	over	the	widgets	to	see	additional	information	in	a	tool	tip.

Figure	130:	Additional	information

11.1.4 Site & highlighting
The	site	and	highlighting	panel	contains	controls	pertaining	to	the	current	observing	site	and	high-
lighting	features.

Figure	131:	Site	&	highlighting

The	Site	popup	deFines	the	current	observing	site.	This	determines	many	aspects	of	the	objects'	visi-
bility,	since	the	site	location	and	GMT	offset	determine	the	current	positions	of	objects	in	the	local	
sky.

The	Seeing	popup	should	be	set	to	the	current	seeing	conditions.	This	is	only	used	for	the	Lord's	
Rating	column	for	double	stars.	If	you're	not	using	this	column	or	don't	observe	double	stars,	you	
can	largely	ignore	this	setting.

The	Highlight	popup	determines	how	the	object	list	is	highlighted.	See	Section	18.1	on	page	271	for	
more	information.

If	the	plan	document's	window	width	is	smaller	than	a	minimum	size	(roughly	1200	pixels)	then	the
Date/Time	panel	is	hidden	and	a	Fix	Date	button	and	checkbox	displayed.	Clicking	the	button	dis-
plays	a	Floating	date/time	window	that	allows	you	to	select	a	date/time,	stop	the	clock	and	set	the	
date/time	to	the	selected	value	(using	the	Apply	button).	The	Set	time	to...	popup	contains	a	num-
ber	of	preset	times	of	interest	(see	below)	that	can	be	applied.

Figure	132:	Date/time	Floating	window
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11.1.5 Date/time selection
If	the	plan	document's	window	width	is	larger	than	a	minimum	size	(roughly	1200	pixels)	then	the	
Date/Time	panel	is	shown.	The	date	and	time	Fields	automatically	update	with	the	computer	clock.	
If	you	change	any	of	the	Fields	then	the	clock	is	effectively	Fixed	at	that	point,	and	the	Fix	date	check-
box	is	checked.	Unchecking	the	checkbox	will	start	the	time	running	again.

Figure	133:	Date/time	settings

The	UT	checkbox	will	change	the	Fields	so	that	they	display	the	current	date/time	at	Greenwich	(0°	
longitude).	The	popup	widget	to	the	right	of	the	Fix	date	checkbox	contains	a	number	of	preset	
times	of	interest	that	can	be	applied

Figure	134:	Preset	time	popup

You	can	use	the	arrow	buttons	on	the	right	to	step	the	time	backwards	or	forwards	by	the	amount	
speciFied	in	the	popup	below	the	arrow	buttons.

11.2 Objects tab
The	Objects	tab	contains	the	list	of	objects	to	be	observed,	a	means	to	create	and	edit	them,	and	vari-
ous	(optional)	graphical	widgets	to	help	with	visualisation.
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Figure	135:	Objects	tab

11.2.1 Object list
The	object	list	is	a	table	with	one	row	per	object	in	the	plan.	Each	column	represents	a	particular	
attribute	of	the	object	which	can	be	one	of	three	types:

• An	attribute	that	is	Fixed	for	that	object	(e.g.	ID,	RA,	Dec,	Magnitude,	etc.)

• An	attribute	that	is	computed	from	the	Fixed	attributes	(e.g.	Surface	Brightness,	etc.)

• An	attribute	that	is	computed	from	the	Fixed	attributes	and	external	conditions	such	as	date/
time	and	site	(e.g.	Visibility,	Altitude,	Azimuth,	Air	Mass,	etc.)

A	description	of	the	particular	column	attribute	can	be	displayed	by	hovering	the	cursor	over	the	
heading	for	a	column	(or	just	below	the	heading).

You	can	select	one	or	more	rows	of	the	object	list	by	clicking	on	the	First	row	and	then	shift-clicking	
the	last	row	to	select	all	rows	in	between,	or	Ctrl-clicking	(Cmd-clicking	on	Macintosh)	to	select	indi-
vidual	rows.

You	can	sort	the	object	list	by	clicking	on	a	column	heading	cell.	Click	again	to	reverse	the	order.	You	
can	also	sort	on	multiple	columns	using	the	Sort	Objects	feature.	See	Section	11.2.13	on	page	110	for
details.	

Note:	The	Obs	column	(if	visible)	displays	the	number	of	observations	of	that	object	(e.g.	M51	in	
Figure	137).	If	it	is	blank,	it	implies	that	no	observations	have	been	made	(e.g.	M52	in	Figure	137).	
Also,	if	at	least	one	observation	was	made	from	this	plan	document,	then	the	number	is	circled	(e.g.	
M55	in	Figure	137).	Also	if	one	or	more	of	those	observations	were	made	in	the	past	12	hours,	the	
circled	number	is	inverted	(e.g.	M53	in	Figure	137).	This	is	a	way	to	track	which	observations	you	
have	made	in	the	current	observing	session.	If	the	date/time	is	Fixed,	the	the	inversion	is	done	if	any	
observations	were	made	since	the	Fixed	date/time.
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Figure	136:	Hovering	cursor	over	object	list	heading

Figure	137:	Obs	column
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11.2.2 Object list columns
Heading Name Description Dependent	on

Air	Mass Air	Mass The	Air	Mass	of	an	object	is	the	relative	thickness	of	
atmosphere	between	the	observer	and	the	object	be-
ing	observed,	with	1.0	being	the	minimum	(i.e.	
looking	straight	up).	This	will	increase	with	decreas-
ing	Altitude.

Altitude

Altitude Altitude Altitude	is	the	angular	distance	between	the	object	
being	observed	and	the	theoretical	horizon.	0.0	is	
horizontal,	90.0	is	straight	up	(the	zenith),	and	-90.0	
is	straight	down	(the	nadir).

RA,	Declination;	
Site	Latitude,	
Longitude,	GMT	
Offset;	Local	
Date/Time

App	Mag Apparent
Magnitude

Apparent	Magnitude	is	the	Magnitude	(brightness)	of
the	object,	but	taking	into	account	the	effects	of	at-
mospheric	extinction,	especially	near	the	horizon.	It	
is	directly	dependent	on	object	Altitude.	It	is	also	de-
pendent	of	site	altitude	above	sea	level	and	season	of	
the	year.

Magnitude;	
Extinction

Azimuth Azimuth Azimuth	is	the	angular	distance	between	the	object	
being	observed	and	True	North.	0.0	is	due	North,	
90.0	is	due	East,	180.0	is	due	South,	and	270.0	is	due	
West.

RA,	Declination;	
Site	Latitude,	
Longitude,	GMT	
Offset;	Local	
Date/Time

Best	AMag Apparent
Magnitude	at
Best	Time

The	Apparent	Magnitude	(see	above)	of	the	object	at	
the	Best	Time	(see	below).

RA,	Declination,	
Magnitude,	Ext-
inction;	Site	Lati-
tude,	Longitude,	
GMTOffset;	Local
Date/Time

Best	EP Best	Eyepiece The	best	eyepiece	required	to	detect	the	object	using	
the	given	telescope	at	the	given	site.

Magnitude;	Sep-
aration;	Size;	
Site;	Telescope

Best	Mag Best
MagniFication

The	best	magniFication	required	to	detect	the	object	
using	the	given	telescope	at	the	given	site.

Magnitude;	Sep-
aration;	Size;	
Site;	Telescope

Best	Time Best	Time The	local	time	in	the	next	24	hours	(to	the	nearest	15
minutes)	that	the	object	is	best	observed	(based	on	
its	maximum	Observability	value	during	that	period).
If	the	Best	Time	is	less	than	the	current	local	time,	
then	it	refers	to	the	next	evening.

RA,	Declination;	
Site	Latitude,	
Longitude,	
GMTOffset;	Local
Date/Time
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Catalogue Catalogue The	Catalogue	from	which	this	object	was	originally	
extracted.

Catalogue
Notes

Catalogue
Notes

Notes	derived	from	the	catalogue	entry	for	this	object
(where	applicable)

Chart# Chart
Number

The	Chart	number	or	atlas	page	number	that	con-
tains	this	object.	The	charts/atlases	in	use	are	de-
Fined	in	the	object	list	preferences.

RA,	Declination

Comp Components Components	of	a	double/multiple	star	entry	(e.g.	
"AB")

Const Constellation The	Constellation	that	this	object	resides	in.	This	is	
Fixed	for	deep	sky	and	stellar	objects,	but	will	change	
for	solar	system	objects	which	move	in	the	sky	over	
time.

RA,	Declination

Dec Declination The	Declination	of	the	object	(similar	to	Latitude	on	
earth	maps).	This	is	Fixed	for	stellar	and	deep-sky	ob-
jects,	but	will	change	over	time	for	solar	system	ob-
jects.	Has	values	from	-90°	at	the	south	celestial	pole	
to	+90°	at	the	north	celestial	pole.

Diff	Idx DifFiculty
Index

The	DifFiculty	Index	for	double	stars.	This	is	a	num-
ber	between	0	(easy)	and	100	(extremely	difFicult)	
that	gives	an	indication	of	how	difFicult	a	double	star	
will	be	to	split.	

Magnitude;	

Magnitude2;

Separation

Dk	Start Dark	Time
Start

The	start	time	of	the	next	time	the	object	is	in	com-
plete	astronomical	darkness,	and	is	above	the	eleva-
tion	speciFied	in	the	object	list	preferences	(and	is	
also	above	the	user-deFined	horizon	if	one	has	been	
speciFied	for	the	given	site).	This	will	be	the	current	
time	if	the	object	is	currently	in	this	condition.	If	the	
object	is	not	in	this	condition	in	the	next	24	hours,	
the	column	will	be	blank.

Site;	RA,	Declina-
tion;	Date/Time

Dk	End Dark	Time
End

The	end	time	of	the	next	time	the	object	is	in	com-
plete	astronomical	darkness,	and	is	above	the	eleva-
tion	speciFied	in	the	object	list	preferences	(and	is	
also	above	the	user-deFined	horizon	if	one	has	been	
speciFied	for	the	given	site).	If	the	object	is	not	in	this	
condition	in	the	next	24	hours,	the	column	will	be	
blank.

Site;	RA,	Declina-
tion;	Date/Time
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Dk	Dur Dark	Time
Duration

The	duration	(in	hours)	of	the	next	time	the	object	is	
in	complete	astronomical	darkness,	and	is	above	the	
elevation	speciFied	in	the	object	list	preferences	(and	
is	also	above	the	user-deFined	horizon	if	one	has	
been	speciFied	for	the	given	site).

Site;	RA,	Declina-
tion;	Date/Time

E.Lat Ecliptic
Latitude

The	ecliptic	latitude	of	the	object.	This	varies	be-
tween	-90	and	+90	degrees,	with	0	being	on	the	
ecliptic	(passing	through	the	plane	of	the	solar	sys-
tem).	+ve	north	of	the	ecliptic,	-ve	south.

RA,	Declination

E.Long Ecliptic
Longitude

The	ecliptic	longitude	of	the	object.	This	varies	be-
tween	0	and	360	degrees	along	the	ecliptic	(passing	
through	the	plane	of	the	solar	system).	Measured	
from	the	vernal	equinox.

RA,	Declination

Extinct Extinction Atmospheric	Extinction.	This	is	the	effect	the	atmos-
phere	has,	at	the	given	altitude,	on	the	object	in	terms
of	magnitude.	It	will	be	0	if	the	object	is	at	the	zenith,	
and	increases	as	the	object	gets	closer	to	the	horizon.
e.g.	the	value	1.5	means	that	the	object	will	appear	
1.5	magnitudes	dimmer	than	the	given	Magnitude.

Altitude;	Site;	
Date

Found Object	Found True	if	at	least	one	observation	for	this	object	has	its	
Found	status	set	to	true.	False	if	there	are	no	obser-
vations	of	the	object,	or	if	all	observations	have	a	
Found	value	of	false.

ID

G.Lat Galactic
Latitude

The	galactic	latitude	of	the	object.	This	varies	be-
tween	-90	and	+90	degrees,	with	0	being	on	the	
galactic	equator	(passing	through	the	plane	of	the	
Milky	Way).

RA,	Declination

G.Long Galactic
Longitude

The	galactic	longitude	of	the	object.	This	varies	be-
tween	0	and	360	degrees	along	the	galactic	equator	
(passing	through	the	plane	of	the	Milky	Way).

RA,	Declination

Hr	Angle Hour	Angle The	Hour	Angle	is	the	difference	between	the	object's
current	right	ascension	(RA)	and	the	right	ascension	
of	the	meridian.	It	varies	between	-12	hours	and	+12	
hours	and	will	be	zero	when	the	object	transits.	It	
also	represents	the	time	since	the	object	passed	the	
meridian	(e.g.	-2.5	hours	means	the	object	will	reach	
the	meridian	in	2.5	hours),	assuming	the	object	is	a	
DSO	or	a	slow-moving	solar	system	object.

RA;	

Local	Sidereal	
Time
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HJD Heliocentric
Julian	Date

The	Heliocentric	Julian	Date	is	the	Julian	Date	taking	
into	account	light	travel	time	from	the	Sun.	This	date	
is	used	when	measuring	photometric	magnitudes	of	
variable	stars	in	order	to	make	sure	all	readings	are	
standardized	to	the	same	time	scale,	regardless	of	
time	of	year.

RA,	Declination;	
Julian	Date

ID Object	ID The	primary	ID	for	the	object.

Images Images If	the	object	has	associated	Images	in	the	image	data-
base,	this	column	will	contain	an	entry.

Level Plan	Creation
Wizard	DifFi-
culty	Level

The	Plan	Creation	Wizard	difFiculty	level,	1	(easy)	
through	5	(difFicult),	that	the	object	would	be	if	it	was
in	the	Plan	Creation	Wizard	database,	where	
applicable.

Type;	Magni-
tude/s;	Size;	Pe-
riod;	Separation;	
Plan	Creation	
Wizard	criteria.

LOC Log	Object
Contrast

Log	Object	Contrast	(LOC)	is	a	measure	of	the	con-
trast	of	the	(deep-sky)	object	against	the	background	
sky.	It	depends	on	the	brightness	and	size	of	the	ob-
ject,	and	the	brightness	of	the	sky.

Magnitude;	Size;	
Sky	Brightness

L	Rating Lord's	Rating Lord's	Rating	is	applicable	only	to	double	star	objects
(in	particular	double	stars	with	unequal	magni-
tudes).	It	requires	the	Performance	index	to	be	com-
puted,	which	means	the	Current	Telescope	and	Cur-
rent	Seeing	popup	menus	must	be	used.	The	value	is	
based	on	telescope	aperture,	central	obstruction	(if	
any)	and	seeing	conditions.

Magnitude;	Mag-
nitude2;	Separa-
tion;	Telescope;	
Current	Seeing

Mag Magnitude The	Magnitude	of	the	object.	This	is	Fixed	for	stellar	
and	deep-sky	objects,	but	typically	varies	for	solar	
system	objects.	For	variable	stars	this	represents	the	
maximum	brightness	of	the	star.	For	double	stars,	it's	
the	magnitude	of	the	primary	star.

Mag	2 Secondary
Magnitude

The	Magnitude	of	the	secondary	star,	for	double	star	
objects.	For	variable	stars	this	represents	the	mini-
mum	brightness	of	the	star.

Moon Angular	Dis-
tance	to
Moon

The	current	angular	distance	between	this	object	and
the	position	of	the	Moon.	Values	from	0	(the	object	is	
at	the	same	coordinates	as	the	Moon)	to	180	(the	ob-
ject	is	on	the	far	side	of	the	sky	from	the	Moon).

RA,	Declination;	
Site	Latitude,	
Longitude,	GMT	
Offset;	Local	
Date/Time

Name Name/s Additional	Name	or	names	for	the	object.
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Obs Number	of
Observations

The	number	of	observations	of	this	object	resident	in	
the	observation	database.	This	includes	any	syn-
onyms	of	the	object.

ID

Obsvbty Observability The	Observability	value	for	the	object	at	the	current	
local	date/time.	This	value	varies	between	0	(not	ob-
servable)	and	100	(perfect	time	to	observe)	and	de-
pends	on	the	object's	altitude,	distance	from	moon	
and	sun,	moon	phase	and	sky	position,	position	w.r.t.	
the	meridian,	etc.

RA,	Declination;	
Site	Latitude,	
Longitude,	
GMTOffset;	Local
Date/Time

ODM Optimum	De-
tection

MagniFication

The	Optimum	Detection	MagniFication	of	the	(deep-
sky)	object	for	the	currently	selected	telescope.	It	will
be	displayed	for	any	object	that	has	both	magnitude	
and	size	(i.e.	has	a	computable	surface	brightness).	
The	value	represents	the	best	magniFication	to	use	
with	the	selected	telescope	in	order	to	detect	the	
object.

Magnitude;	Size;	
Sky	Brightness;	
Telescope

Opposition Date	of
Opposition

The	date	at	which	the	object	will	be	at	opposition	
(closest	to	the	meridian	at	local	midnight).

RA,	Declination;	
Site

Par	Angle Parallactic
Angle

The	Parallactic	Angle	of	the	object	at	the	current	local
(sidereal)	time.	This	is	the	angle	between	the	great	
circle	passing	through	the	object	and	the	zenith	
point,	and	the	great	circle	passing	through	the	object	
and	the	celestial	poles.	The	angle	is	zero	when	the	
object	crosses	the	meridian.	Often	used	by	Field	
rotators.

RA,	Declination;	
Local	Sidereal	
Time;	Site	
Latitude

Period Period The	Period	of	the	object.	This	is	generally	understood
to	be	the	light	curve	period	(in	days)	for	a	variable	
star.

PosAngle Position
Angle

Position	Angle	of	the	object	with	respect	to	north.	
This	refers	to	the	secondary	component	of	a	double	
star	with	respect	to	the	primary	component,	or	the	
angle	of	the	longer	(major)	axis	for	a	galaxy.	It	has	a	
value	of	0	through	360	degrees,	with	90	being	due	
East.

Prob Probability	of
Detection

Probability	of	visual	detection	of	a	star	of	given	Mag-
nitude	in	the	currently	selected	telescope.	e.g.	if	the	
probability	is	60%	then	the	star	will	be	detectable	
60%	of	the	time	under	ideal	conditions.

Magnitude;	
Telescope
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Prob	2 Probability	of
Detection

Probability	of	visual	detection	of	a	star	of	given	Mag-
nitude	2	in	the	currently	selected	telescope.	e.g.	if	the	
probability	is	60%	then	the	star	will	be	detectable	
60%	of	the	time	under	ideal	conditions.

Magnitude2;	
Telescope

RA Right
Ascension

The	Right	Ascension	of	the	object	(similar	to	Longi-
tude	on	earth	maps,	but	runs	from	0	to	24	hours).	
This	is	Fixed	for	stellar	and	deep-sky	objects,	but	will	
change	over	time	for	solar	system	objects.	

Rating Rating The	average	Rating	for	this	object.	The	rating	is	com-
puted	from	rating	values	in	observations	of	the	ob-
ject.	DeFined	in	the	object	list	preferences.

ID

Rise Time	of	Ob-
ject	Rising

Rise	time	of	the	object.	This	is	the	time	of	the	current	
day	when	the	object	rises	above	the	(theoretical)	
horizon.

RA,	Declination;	
Site	Latitude,	
Longitude,	GMT	
Offset;	Local	
Date/Time

TDist Telescope
Distance

When	a	telescope	is	connected	and	supplying	its	cur-
rent	pointing	coordinates,	this	is	the	angular	distance
of	the	object	from	those	coordinates	in	degrees.	Val-
ues	from	0	(the	telescope	is	pointing	at	the	object)	to	
180	(the	telescope	is	pointing	directly	away	from	the	
object).

RA,	Declination;
Telescope	RA/
Dec	coordinates

SB Surface
Brightness

Surface	Brightness	of	the	(deep-sky)	object,	in	mag-
nitudes	per	square	arcsecond.

Magnitude;	Size

Sep Separation The	object	Separation.	This	is	for	double	star	objects.	
The	value	is	expressed	in	arcseconds	(3600	arcsec	=	
1	degree).

Set Time	of	Ob-
ject	Setting

Set	time	of	the	object.	This	is	the	time	of	the	current	
day	when	the	object	sets	below	the	(theoretical)	
horizon.

RA,	Declination;	
Site	Latitude,	
Longitude,	GMT	
Offset;	Local	
Date/Time

Size Angular	Size The	angular	Size	of	a	deep-sky	object.	Unless	other-
wise	shown	the	size	is	expressed	in	minutes	of	arc	
(60	minutes	=	1	degree).	If	the	object	is	non-circular	
then	the	size	is	given	as	AxB	where	A	is	the	angular	
size	of	the	longer	axis,	and	B	is	the	angular	size	of	the
shorter	axis.

Spect Spectral
Information

Spectral	information	pertaining	to	the	object.

- 102 -



Split Splitability The	"splitability"	of	a	double	star	when	viewed	
through	the	currently-selected	telescope	under	ideal	
conditions.	"Yes"=splittable,	"???"=possible	but	difFi-
cult,	"No"=not	splittable.

Magnitude;	Mag-
nitude2;	Separa-
tion;	Telescope	
Aperture;	Tele-
scope	Obstruc-
tion;	Site	Sky	
Brightness

Split	mm Splitability
Aperture

The	telescope	aperture	required	to	split	a	double	star
with	a	50%	chance	of	success,	when	viewed	through	
the	currently-selected	telescope	under	ideal	
conditions.

Magnitude;	Mag-
nitude2;	Separa-
tion;	Telescope	
Aperture;	Tele-
scope	Obstruc-
tion;	Site	Sky	
Brightness

Sun Angular	Dis-
tance	to	Sun

The	current	angular	distance	between	this	object	and
the	position	of	the	Moon.	Values	from	0	(the	object	is	
at	the	same	coordinates	as	the	Moon)	to	180	(the	ob-
ject	is	on	the	far	side	of	the	sky	from	the	Moon).

RA,	Declination;	
Site	Latitude,	
Longitude,	GMT	
Offset;	Local	
Date/Time

Transit Time	of	Ob-
ject	Transit

The	time	of	the	current	day	when	the	object	transits	
(reaches	its	highest	altitude;	crosses	the	meridian).

RA,	Declination;	
Site	Latitude,	
Longitude,	GMT	
Offset;	Local	
Date/Time

Transit	Alt Transit
Altitude

The	altitude	of	the	object	when	it	transits	(reaches	its
highest	altitude;	crosses	the	meridian).

Declination;	Site	
Latitude

Transit
Date

The	date	of	the	year	when	the	object	transits	(reach-
es	its	highest	altitude;	crosses	the	meridian)	with	the	
greatest	altitude.

RA,	Declination

Type Object	Type The	Type	of	the	object	(e.g.	Star,	Galaxy,	etc.).	If	the	
object	falls	into	more	than	one	category	then	the	
types	will	be	separated	by	"+".

User	Notes User	Notes User	Notes	for	the	object.
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Vis Visibility The	Visibility	of	the	object	at	the	given	site	and	date/
time.	This	takes	on	the	following	possible	values:

blank	-	the	object	is	currently	not	visible.

Yes	-	the	object	is	visible.

Horz	-	the	object	is	behind	the	user-deFined	horizon	
for	the	site.

Light	-	the	object	is	in	the	user-deFined	light	dome	
for	the	site.

Limit	-	the	object	is	outside	the	slewing	limits	of	the	
telescope.

RA,	Declination;	
Site	Latitude,	
Longitude,	GMT	
Offset,	Horizon;	
Local	Date/Time

11.2.3 Object image and constellation map
If	you	select	a	single	object	in	the	object	list,	and	that	object	has	images	associated	with	it	(See	Chap-
ter	17	on	page	254),	then	those	images	are	displayed	to	the	right	of	the	object	list	(the	object	list	be-
ing	resized	to	Fit	the	image).	A	popup	menu	below	the	image	shows	a	description	of	the	currently-
displayed	image	and	allows	to	select	other	images	where	applicable.	

For	DSS	images,	moving	the	cursor	over	the	image	displays	the	cursor's	RA/Dec	coordinates.

The	image	display	feature	can	be	toggled	on	and	off	by	clicking	the	image	button	below	the	image	
(circled	in	Figure	138).

Further	features	are	described	in	Section	17.2	on	page	259.

Figure	138:	Object	list	image

Also	(if	you	have	the	option	turned	on,	which	it	is	by	default	-	Section	20.5.4	on	page	295)	you	will	
see	a	constellation	map	of	the	constellation	containing	the	object.	The	object's	location	within	the	
constellation	will	be	shown	with	a	red	circle.	Any	other	objects	in	the	plan	that	are	in	that	constella-
tion	will	be	shown	with	grey	circles.	See	Figure	139.
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Figure	139:	Constellation	map	for	M70	(in	Sagittarius)

For	Jupiter	and	Saturn,	a	diagram	showing	the	current	positions	of	the	planet's	satellites	is	
displayed.

Figure	140:	Saturn	satellites

For	a	constellation	object,	a	chart	of	the	constellation	is	shown.	Any	plan	objects	that	are	in	that	con-
stellation	will	be	shown	with	their	associated	ID.
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Figure	141:	Constellation	chart	for	a	constellation	object

11.2.4 Object editing fields
(See	Section	10.4.1	on	page	88	for	more	details)	If	revealed,	these	Fields	allow	the	attributes	of	the	
selected	object	to	be	edited	(e.g.	ID,	RA,	Dec,	Notes,	etc.).	The	Fields	appear	below	the	object	list.

11.2.5 Short-term visibility indicator
The	Short-term	visibility	indicator	(optionally)	appears	above	the	object	list.

Figure	142:	Short-term	visibility	indicator

This	indicator	represents	a	chart	of	the	selected	object	in	the	sky	over	a	(conFigurable)	period	of	up	
to	24	hours.	The	horizontal	axis	represents	local	time.	The	vertical	axis	represents	altitude	(0°	to	
90°).	The	current	local	time	is	shown	by	a	vertical	white	line	(13:00	in	the	above	example).	The	
background	colour	represents	sky	darkness,	with	daylight	being	in	light	blue,	twilight	in	dark	
shades	of	blue,	and	complete	darkness	in	black.

If	an	object	is	selected	in	the	object	list,	its	altitude	is	shown	as	a	succession	of	red	crosses	(in	the	
above	example	the	object	rises	c.	14:00	and	reaches	its	zenith	at	at	about	22:30.	Similarly,	the	
moon's	altitude	is	shown	by	small	yellow	circles.	

If	the	site	has	a	user-deFined	horizon,	then	it	is	shown	at	each	time	interval	as	a	green	bar	that	
shows	the	blocking	altitude	in	the	direction	of	the	object.	

Also	shown	are	the	cardinal	points	where	the	object	is	due	north	(N),	etc.	In	the	above	example	the	
object	will	be	at	its	maximum	altitude	(72°)	at	about	22:30	and	is	due	south.
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This	indicator	gives	you	a	visual	indication	of	when	the	best	time	to	observe	the	object	might	be.	In	
the	above	example,	00:00	to	02:00	would	seem	the	best	time,	with	the	object	above	the	horizon	and	
complete	darkness.

The	Observability	value	is	shown	as	a	purple	line,	with	a	vertical	purple	line	where	the	observability
is	at	a	maximum	(just	before	midnight	in	this	case).	You'll	see	the	value	growing	from	zero	after	sun-
set,	and	declining	rapidly	when	the	moon	rises.	

The	dark	time	elevation	(where	applicable)	is	shown	as	a	horizontal	dotted	green	line	extending	
over	the	period	of	astronomical	darkness.	An	object's	Dark	Time	is	deFined	to	be	the	period	during	
astronomical	darkness	when	the	object's	altitude	is	above	this	elevation.

The	right-click	menu	allows	you	to	select	the	start	time	for	the	time	axis,	and	the	period	(up	to	24	
hours).	Visual	astronomers	might	just	want	to	see	the	dark	hours	between	18:00	and	06:00,	but	oth-
ers	(e.g.	radio	astronomers)	would	want	to	see	daylight	hours.	You	can	also	toggle	on/off	the	display	
of	observability	and/or	the	dark	time	elevation	setting.

Figure	143:	Short-term	visibility	indicator	right-click	menu

By	right-clicking	a	particular	spot	on	the	chart	and	choosing	the	Fix	Date/Time	item,	the	date/time	
will	be	Fixed	at	that	point.

You	can	toggle	the	chart	on	or	off	using	the	Short-term	Visibility	Indicator	item.	This,	and	other	
settings	can	also	be	found	in	the	Object	List	Preferences	(see	Section	20.5.1	on	page	293).

11.2.6 Long-term visibility indicator
The	Long-term	visibility	indicator	(optionally)	appears	above	the	object	list.

Figure	144:	Long-term	visibility	indicator	(Altitude	mode)

This	indicator	represents	a	chart	of	the	selected	object	in	the	sky	over	a	(conFigurable)	period	of	up	
to	one	year.	The	horizontal	axis	represents	local	date,	with	the	leftmost	being	the	current	local	date.	
It	is	divided	up	into	intervals	of	1	week	(or	less	for	other	time	periods).	Each	interval	represents	to	
situation	at	a	particular	day	of	the	week	and	a	particular	time	of	the	night	(22:00	on	Saturdays	in	the
above	example).
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The	vertical	axis	(in	Altitude	mode)	represents	altitude	(0°	to	90°).	The	background	colour	repre-
sents	sky	darkness,	with	daylight	being	in	light	blue,	twilight	in	dark	shades	of	blue,	and	complete	
darkness	in	black.

If	an	object	is	selected	in	the	object	list,	its	altitude	is	shown	as	a	succession	of	red	crosses	(in	the	
above	example,	on	the	next	Saturday	at	22:00	the	object	has	just	risen.	The	best	time	to	observe	the	
object	would	be	on	Saturday	nights	in	September,	where	the	sky	is	dark	at	22:00	and	the	object	is	at	
its	maximum	altitude.	Similarly,	the	moon's	altitude	is	shown	by	small	yellow	circles.	If	there	is	no	
moon	for	a	particular	interval,	it	means	that	it	has	not	risen	at	22:00	on	that	Saturday.

If	the	site	has	a	user-deFined	horizon,	then	it	is	shown	at	each	time	interval	as	a	green	bar	that	
shows	the	blocking	altitude	in	the	direction	of	the	object.	In	the	above	example,	The	object	will	not	
be	visible	until	June,	and	after	the	beginning	of	November	it	will	be	below	the	user	horizon	again.	

The	vertical	dotted	red	lines	indicate	transitions	to	and	from	daylight	saving	time,	if	applicable.

This	indicator	gives	you	a	visual	indication	of	when	the	best	time	to	observe	the	object	during	the	
year	might	be.	In	the	above	example,	September	through	October	would	seem	the	best	time,	with	
the	object	well	above	the	horizon	and	in	darkness.

There	is	another	mode	for	this	indicator.	In	this	mode	the	vertical	axis	represents	time	of	night	from	
16:00	at	the	bottom	through	08:00	at	the	top.	The	time	interval	is	the	same	as	for	the	Altitude	mode	
described	above.	The	vertical	axis	is,	effectively,	a	squashed	version	of	the	short-term	indicator	
turned	through	90°.	The	red	line	represents	the	object	above	the	horizon.	The	yellow	line	represents
the	moon	above	the	horizon.

Figure	145:	Long-term	visibility	indicator	(Time-of-night	mode)

In	the	above	example,	one	can	see	that	the	object	starts	out	as	a	morning	object.	By	July	it's	transit-
ing	in	the	middle	of	the	night.	In	October/November	it's	an	evening	object.	It's	pretty	much	not	visi-
ble	between	January	and	March.

The	right-click	menu	allows	you	to	select	the	Chart	type	(Altitude	or	Time-of-night	mode),	the	peri-
od	(from	30	days	to	a	year).

Figure	146:	Long-term	visibility	indicator	right-click	menu
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By	right-clicking	a	particular	spot	on	the	chart	and	choosing	the	Fix	Date/Time	item,	the	date/time	
will	be	Fixed	at	that	point.

You	can	toggle	the	chart	on	or	off	using	the	Long-term	Visibility	Indicator	item.	This,	and	other	
settings	can	also	be	found	in	the	Object	List	Preferences	(see	Section	20.5.1	on	page	293).

11.2.7 Alt/Az indicator
The	Alt/Az	indicator	(optionally)	appears	above	the	object	list.

Figure	147:	Alt/Az		indicator

The	indicator	shows	the	current	azimuth	of	the	selected	object	on	the	left,	and	the	altitude	on	the	
right.	If	the	arrows	are	grey,	it	means	the	object	is	currently	visible.	If	the	arrows	are	red	it	means	
the	object	is	below	the	true	horizon,	or	hidden	behind	the	user-deFined	site	horizon.	The	numeric	
values	of	azimuth	and	altitude	are	also	shown.

The	circle	with	an	S	represents	the	sun.	If	it	Filled	with	black,	then	the	sun	has	set.	If	it	is	white	the	
the	sun	is	above	the	horizon.	The	number	associated	with	it	represents	the	angular	distance	from	
the	selected	object	to	the	sun.

Similarly	the	circle	with	an	M	represents	the	moon.

The	right	click	menu	allows	you	to	Flip	the	azimuth	cardinal	points	vertically	and	or	horizontally	if	
you	wish.	You	can	toggle	the	chart	on	or	off	using	the	Alt/Az	Indicator	item.	This,	and	other	settings
can	also	be	found	in	the	Object	List	Preferences	(see	Section	20.5.1	on	page	293).

11.2.8 Constellation indicator
The	Constellation	indicator	(optionally)	appears	above	the	object	list.

Figure	148:	Constellation	indicator

The	indicator	shows	a	small	rendering	of	the	constellation	containing	the	selected	object,	with	the	
main	stars,	constellation	Figure	lines,	and	boundary	shown.	The	position	of	the	selected	object	is	
shown	by	a	small	red	circle.

Positioning	the	cursor	over	a	star	will	show	that	star's	Bayer	ID,	Flamsteed	ID,	and	common	name,	
where	applicable.
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The	right	click	menu	allows	you	to	Flip	the	chart	vertically	and	or	horizontally	if	you	wish.	You	can	
toggle	the	chart	on	or	off	using	the	Constellation	Indicator	item.	This,	and	other	settings	can	also	
be	found	in	the	Object	List	Preferences	(see	Section	20.5.1	on	page	293).

Double-clicking	the	indicator	causes	the	application	to	switch	to	the	Field	of	View	tab	and	draw	the	
entire	constellation	in	the	Field	of	View	chart.

11.2.9 New Observation
Clicking	the	New	Observation	button	is	a	shortcut	to	create	a	new	observation	for	the	selected	ob-
ject	(rather	than	switching	manually	to	the	observation	tab	and	clicking	the	+	button	under	the	list	
of	observations).	Note	that	you	can't	make	observations	on	an	untitled	plan	document	-	it	must	be	
saved	First.

11.2.10 Lookup
The	Lookup	popup	button	allows	you	to	do	a	catalogue	search	on	either	the	selected	object's	ID	or	
Name	Field.	If	no	object	is	selected,	you	can	enter	text	for	the	search.	Note	that	this	command	will	de-
select	any	selected	object/s	before	beginning	the	search.

11.2.11 Show Catalogue
The	Show	Catalogue	popup	button	lets	you	open	a	window,	for	a	selected	catalogue,	that	shows	all	
the	objects	in	that	catalogue,	allows	you	to	add	catalogues	objects	to	your	plan,	etc.	

See	Section	23.6	on	page	332	for	more	details.

11.2.12 Search Catalogue/s
The	Search	Catalogue/s	popup	button	lets	you	search	one	or	more	catalogues	based	on	various	cri-
teria	that	you	specify.

See	Section	10.1.3	on	page	79	for	more	details.

11.2.13 Sort List
The	Sort	List	popup	button	allows	you	to	sort	the	object	list	by	multiple	columns,	and	save	those	
"sorts"	for	future	use.

Sort	List	>	Sort	By...	(the	same	as	Object	>	Sort	Objects...)	sets	up	a	multiple	column	sort.	You	can	
sort	by	up	to	three	columns	in	ascending	or	descending	order.

If	a	column	is	time-related	(e.g.	rise	time)	then	you	can	also	specify	an	offset	to	use	as	the	lowest	
time	for	sorting	purposes.

Once	set	up,	you	can	add	this	sort	to	the	Sort	List	popup	menu	as	a	"pre-deFined"	sort	by	checking	
the	Add	to	Sort	List	popup	checkbox.

You	can	also	specify	that	this	sort	order	be	used	as	the	default	sort	order	whenever	you	open	a	plan	
document,	using	the	Use	as	default	checkbox.	You	can	subsequently	remove	this	default	sort	order	
by	using	the	Clear	button.
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Figure	149:	Sort	Objects	dialog

You	can	edit	any	predeFined	sorts	added	to	the	Sort	List	menu	by	using	Sort	List	>	Edit...

Figure	150:	Sort	List	Edit	dialog

You	can	delete	or	rename	any	entries.

11.2.14 Add Special
The	Add	Special	popup	button	allows	you	to	add	various	"special"	objects	to	your	plan.	See	Section	
10.1.4	on	page	82	for	details.

11.2.15 Delete
The	Delete	popup	button	gives	you	various	ways	of	deleting	multiple	objects	from	the	object	list.

The	Delete	CONDITIONALLY	entry	allows	you	to	specify	criteria	for	deleting	objects	from	the	object
list.	You	can	specify	up	to	three	columns/attributes	to	match	on,	and	you	can	choose	to	match	on	all	
attributes	(AND)	or	on	any	of	the	attributes	(OR).
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Figure	151:	Delete	popup	menu

Figure	152:	Conditional	delete	dialog

11.2.16 Slew To
If	a	telescope	with	Go-to	capabilities	is	connected,	then	the	Slew	To	popup	button	is	enabled	and	al-
lows	a	quick	slew	to	common	objects.	You	can	also	slew	to	speciFied	coordinates	using	the	RA/Dec...
item,	or	to	the	centre	of	a	speciFied	constellation	using	the	Centre	of	Constellation...	item.

Figure	153:	Slew	To	popup	menu

11.2.17 Customising object list columns
To	customise	the	object	list	columns	(ordering,	formatting,	visibility,	etc.),	use	the	Edit	>	List	
Columns...	menu	command.	

The	editing	dialog	consists	of	a	list	with	one	row	per	column	in	the	list.	You	can	rearrange	the	order-
ing	of	the	list	columns	by	dragging	the	rows	in	the	dialog.
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Figure	154:	Editing	object	list	columns

The	checkbox	in	the	Visible	column	determines	whether	or	not	the	column	is	visible	in	the	object	
list.	

If	a	column	contains	values	that	can	have	different	formats,	then	the	current	format	is	shown	in	the	
Format	column,	and	the	Format	popup	under	the	list	is	enabled	to	allow	changes	if	such	a	row	is	
selected.

If	you	check	the	Save	above	settings	as	default	checkbox,	then	when	you	click	OK	the	settings	are	
saved	as	the	default	for	any	new	plan	windows	that	are	opened.	If	you	edit	the	columns	of	an	object	
list	after	doing	that,	you	can	use	the	Set	to	Saved	Default	button	to	revert	the	settings	to	the	previ-
ously-saved	default.

The	Edit	>	Adjust	List	Columns	to	Fit	Text	menu	command	will	attempt	to	adjust	each	column's	
width	to	Fit	the	text	(and	heading)	in	that	column.

11.3 Observations tab
The	Observations	tab	is	where	you	can	examine	and/or	make	observations	for	objects	in	the	object	
list.
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Figure	155:	Observations	tab

11.3.1 Object list
The	object	list	also	appears	on	the	left	side	of	the	window	in	this	tab,	mainly	so	that	you	can	select	
the	relevant	object	to	see	its	observations,	or	to	make	a	new	observation.	The	window	splitting	con-
trols	below	the	list	and	to	the	right	of	the	list	allow	you	to	resize	the	list	(at	the	expense	of	other	
items	on	the	tab).

11.3.2 Observations list
The	Observations	list	below	the	object	list	shows	all	observations	of	the	currently-selected	object.	
They	are	typically	in	descending	order	of	date/time.	Unless	appended	by	"UT",	the	dates	and	times	
represent	local	time	at	the	observing	site.
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Figure	156:	Observation	list

If	the	entry	is	bold	then	that	observation	was	made	from	the	currently	open	plan	document	(e.g.	the	
11/25/2019	observation	in	Figure	155).

If	the	observation	was	not	"found"	(i.e.	the	observer	was	not	able	to	detect	the	object	and	did	not	
check	the	Found	checkbox	in	any	of	the	resource	combinations	for	the	observation),	then	a	"not	
found"	icon	is	appended	at	the	right	(e.g.	the	observation	for	9/11/2010	in	Figure	155).

Under	the	Observations	list	are	seven	buttons.	The	function	of	these	buttons,	from	left	to	right	are:

• Add	new	observation.	Create	a	new	observation	and	add	it	to	the	list.	The	contents	of	the	new	
observation	are	shown	on	the	right	side	of	the	window	and	can	be	edited	there.	Depending	on	
observation	preference	settings,	the	date/time	of	the	observation	will	either	be	the	current	
date/time,	or	you	will	be	asked	for	the	observation's	date/time	via	a	dialog.	See	Section	12.1	on	
page	179	for	more	details.

• Delete	selected	observation.	The	selected	observation	is	deleted	from	the	database.	If	that	ob-
servation	is	the	last	observation	in	the	observing	session,	you'll	be	given	the	choice	to	retain	or	
delete	the	session	record.

• Duplicate	selected	observation.	Make	a	copy	of	the	selected	observation.	You	will	be	asked	via	
a	dialog	for	that	duplicate	observation's	date/time.

• Edit	the	date/time	of	the	selected	observation.	Uses	the	same	dialog	as	above	to	change	the	
date/time	of	the	selected	observation.

• Set	conditions	for	the	selected	observation.	Sets	the	Site,	Date,	Time,	etc.	to	replicate	the	ob-
serving	conditions	when	the	observation	was	made.	This	can	be	useful	to	see	the	Sky	chart	for	
the	event,	and	to	examine	other	attributes,	such	as	Altitude,	etc.

• Show	the	observation	database.	Display	the	observation	database	window.	See	Section	12.2	on
page	180	for	more	details.

• Show	the	observation	preferences.	Show	the	Observation	preferences	window.	See	Section	
20.9	on	page	309	for	more	details.
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11.3.3 Observing session data

Figure	157:	Observing	session	data

The	Observing	session	data	contains	information	pertaining	to	the	current	observing	session,	
namely:

• Start/End.	The	Start	date	and	time	is	computed	from	the	time	of	the	First	observation	made	in	
the	session	(minus	a	suitable	"set-up"	time	speciFied	in	the	Observation	preferences).	The	End	
date	and	time	is	computed	from	the	time	of	the	last	observation	made	in	the	session	(plus	a	suit-
able	"break-down"	time	speciFied	in	the	Observation	preferences).	The	checkbox	is	checked	
when	the	session	is	over	(this	is	largely	automatic).

• Observer.	The	observer	(resource)	for	the	observer	making	the	observations.

• Site.	The	site	(resource)	where	the	session	occurred.

• Seeing.	An	arbitrary	string	describing	the	Seeing	for	the	session.	The	popup	menu	on	the	right	of
the	Field	allows	you	to	choose	predeFined	strings	from	the	Pickering,	Antoniadi,	or	Danjon	
standard	scales,	or	you	can	deFine	your	own	custom	scale	(Figure	158).

• Transparency.		An	arbitrary	string	describing	the	atmospheric	Transparency	for	the	session.	
The	popup	menu	on	the	right	of	the	Field	allows	you	to	choose	predeFined	strings,	which	can	be	
set	up	as	you	wish.

• User-deOined	Oields.	User-deFined	Fields	common	to	all	sessions.	User-deFined	Fields	are	de-
scribed	in	detail	in	Chapter	19	on	page	276.

• Name.	A	name	Field	for	the	session.	The	default	name	is	the	start	date	and	time,	but	can	be	
changed	to	something	more	meaningful	if	required.

• Notes.	Arbitrary	notes	about	the	observing	session.

Figure	158:	Seeing	popup
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11.3.4 General observation fields
Resource combinations

Figure	159:	Resource	combination	list

This	is	a	list	of	combinations	of	observing	resources	and	the	results	of	using	them.	Each	observation	
has	at	least	one	combination,	deFining	what	telescope	and	eyepiece	or	imager	was	used,	whether	the
object	was	found,	and	a	rating	of	the	observation.

The	columns	have	popup	menus	to	the	right	of	each	entry	allowing	you	to	choose	from	your	re-
source	database.	Where	relevant,	the	magniFication	and	the	actual	FoV	are	computed	and	displayed.	
Also,	some	computed	parameters	are	displayed	below	the	list	for	the	currently-selected	
combination.

The	buttons	below	the	list	on	the	left	allow	you	to	add	a	new	entry,	delete	an	entry,	or	duplicate	an	
entry.	The	fourth	button	copies	the	relevant	details	into	the	insertion	point	in	the	Observation	Notes	
Field	(see	below).

Observation notes
These	are	arbitrary	notes	that	can	be	logged	for	the	observation.

Visibility
A	graphic	is	displayed	that	shows	the	altitude	and	azimuth	of	the	object	at	the	time	of	the	observa-
tion	(as	well	as	the	distance	from	the	sun	and	moon).

Figure	160:	Observation	visibility

Object notes
A	copy	of	the	notes	associated	with	the	object,	as	well	as	ODM	info	where	applicable.	This	is	read-
only	(i.e.	you	can't	change	this	Field,	although	you	can	in	the	Objects	tab).

Object annotations
Displays	any	catalogue	annotations	associated	with	the	object.	See	Section	23.7	on	page	334	for	
details.
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11.3.5 Observation attachments
You	can	attach	Files	of	various	kinds	to	an	observation.	With	the	relevant	observation	selected	in	the	
observation	list,	select	the	Attachments	tab	(the	number	in	parentheses	is	the	number	of	attach-
ments	for	that	observation).

Figure	161:	Observation	attachments	tab

At	the	top	left	is	a	list	of	attached	Files,	showing	the	File	name	and	the	First	part	of	an	arbitrary	de-
scription	assigned	to	the	attached	File.

If	you	select	an	entry,	the	File	contents	(where	possible)	is	displayed	on	the	right,	and	the	File	path,	
optional	description,	and	optional	user-deFined	values	displayed	below	the	list.

To	add	a	new	File	as	an	attachment,	use	one	the	following	techniques:

• Drag	the	File	from	the	Finder	(Mac)	or	Windows	Explorer	(Windows)	to	the	drop	area	on	the	
right	(where	File	contents	are	also	displayed).	You	will	be	asked	via	a	dialog	whether	you	want	to	
link	to	the	existing	File	(which	will	save	space,	but	will	no	longer	be	valid	if	the	original	File	is	
deleted	or	moved),	or	copy	the	File	to	the	database	(in	which	case	a	copy	is	made	into	a	special	
folder,	and	the	original	File	can	be	subsequently	moved	or	deleted	without	issue).

Figure	162:	Link	to	File	dialog

• Use	the	+	button	under	the	list.	The	menu	gives	you	three	options:	link	to	an	existing	File	(which	
will	save	space,	but	will	no	longer	be	valid	if	the	original	File	is	deleted	or	moved),	copy	an	exist-
ing	File	to	the	attachment	database	(in	which	case	a	copy	is	made	into	a	special	folder,	and	the	
original	File	can	be	subsequently	moved	or	deleted	without	issue),	or	copy	an	existing	object	im-
age	(if	one	exists)	to	the	attachment	database.
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Figure	163:	+	button	menu

	 If	you	use	the	third	option,	you'll	be	given	a	list	of	object	images	for	the	current	object.

Figure	164:	Select	image	dialog

The	Show	Oiles	for	all	observations	checkbox,	when	checked,	will	list	all	attached	Files	for	all	obser-
vations	of	the	current	object.

The	button	at	the	bottom	right	of	the	list	of	attachments	will	open	the	selected	File	attachment	with	
an	appropriate	third-party	application	(where	possible).	e.g.	if	the	attached	File	is	an	HTML	File,	then	
it	will	be	opened	in	your	browser,	etc.

If	you	have	an	image	File	selected,	the	image	will	be	displayed	on	the	right,	and	the	buttons	under-
neath	the	image	can	be	used	to	Flip	and/or	rotate	the	image.	You	can	also	right-click	the	image	and	
elect	to	open	it	with	an	external	application,	open	it	in	a	separate	document	window,	or	reveal	it	in	
the	Finder	(Mac)	or	Windows	Explorer	(Windows).

11.3.6 Observation functions
Clear-Sky chart
Observation	>	Forecasts	>	Clear-Sky	Chart	provides	a	chart	from	the	Clear-Sky	Chart	site.	The	lati-
tude	and	longitude	of	your	currently-selected	site	is	used	to	Find	the	closest	Clear-Sky	site	to	that	
site,	and	displays	its	data	(the	distance	to	the	site	is	shown	in	the	title	bar	of	the	window).	Clicking	
on	the	chart	will	take	you	to	the	website	in	your	browser	(if	you	have	an	Internet	connection).	This	
is	only	available	for	North	American	sites.
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Figure	165:	Clear-sky	chart

7Timer chart
Observation	>	Forecasts	>	7Timer	Chart	provides	a	chart	from	the	7Timer.com	site.	The	latitude	
and	longitude	of	your	currently-selected	site	is	used	to	Find	the	observing	conditions.	Clicking	on	the
chart	will	take	you	to	the	website	in	your	browser	(if	you	have	an	Internet	connection).

Figure	166:	7Timer	chart

Site status
The	Site	status	feature	(Observation	>	Site	Status)	shows	you	a	list	of	all	your	deFined	sites	with	
their	current	status	with	respect	to	your	local	site	(chosen	via	the	popup	menu	at	the	upper	left).	
Additionally,	clicking	the	"Site:"	label	next	to	the	current	site	popup	on	the	plan	document	window	
will	open	the	Site	Status	window.

The	columns	are:

• Site.	The	name	of	the	site.	If	the	site	resource	deFines	an	URL,	then	it	will	be	displayed	in	blue	
with	underlining.	The	local	site	is	is	shown	with	bold	text.

• Local	Date/Time.	The	local	time	at	that	site.

• Offset.	The	offset	in	hours	of	the	site	from	the	local	site.

• Darkness.	The	current	state	of	darkness	or	twilight	at	the	site.	Can	be	"Dark",	"Astronomical",	
"Nautical",	"Civil",	or	"Daylight".
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• Next.	The	time	of	the	next	"darkness"	transition	(e.g.	Daylight	to	Sunset,	Dark	to	Astronomical)	
and	how	long	it	will	be.

• Moonrise.	Time	of	moonrise.

• Moonset.	Time	of	moonset.

The	world	map	at	the	bottom	left	shows	the	positions	of	your	local	site	and	the	selected	site	(where	
applicable).	If	the	selected	site	deFines	an	URL,	that	URL	will	be	displayed	at	the	bottom	right.

You	can	use	your	computer	clock	as	the	current	local	date/time,	or	use	an	arbitrary	date/time	using	
the	settings	at	the	top	right.

Figure	167:	Site	status	window

Night Vision Mode
Observation	>	Night	Vision	Mode	toggles	this	mode	on	and	off.	This	causes	the	entire	screen	to	be	
rendered	in	red	(or	green	or	grey)	tones	to	help	when	you	are	using	the	computer	in	the	Field.	This	
works	pretty	well	on	Mac	computers.	Unfortunately	this	is	not	the	case	on	Windows.

On	Windows	the	application	attempts	to	colour	as	much	of	the	interface	as	it	can,	but	does	not	do	a	
good	job	on	some	widgets.	The	work-around	is	to	select	the	Windows	Classic	theme	from	the	Dis-
play	control	panel.	The	UI	is	not	quite	as	fancy	as	the	standard	themes,	but	night	vision	mode	works	
a	lot	better.	

In	general,	you	are	probably	a	lot	better	off	using	a	physical	screen	cover	(made	of	red	plexiglass,	
etc.)
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You	have	quite	a	lot	of	control	over	the	colours	and	darkness	of	the	screen	via	the	Night	Vision	pref-
erences	(see	Section	20.1.2	on	page	286).

11.4 Field of View tab

Figure	168:	Field	of	View	tab

The	Field	of	View	tab	is	designed	to	show	a	chart	that	represents	a	visualisation	of	what	you	are	go-
ing	to	see	through	your	telescope.

11.4.1 Field of View chart
The	chart	is	displayed	on	the	left	of	the	tab	(with	all	the	controls	and	options	on	the	right).	The	de-
fault	chart	shows	a	round	"aperture"	that	represents	the	actual	Field	of	view	of	the	telescope/eye-
piece/optical	aid	combination.	

It	will	display	objects	from	the	catalogues	you	select	on	the	right,	together	with	images,	constella-
tions,	objects	in	your	plan	document	object	list,	etc.	Moving	the	cursor	around	on	the	chart	will	
show	(below	the	chart)	the	coordinates	of	the	mouse	cursor,	and	information	on	objects	you	are	
pointing	at	where	applicable.
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Figure	169:	Field	of	view	chart	right-click	menu

Right-clicking	the	mouse	on	the	chart	allows	several	operations:

• Show	in	another	window.	Creates	a	new	window	containing	a	copy	of	the	current	chart.	That	
chart	will	remain	static	and	will	not	change	when	the	actual	Field	of	view	chart	is	modiFied.

• Centre	FoV	at	coordinates.	Re-centre	the	Field	of	view	chart	at	given	coordinates.	A	dialog	is	
presented	to	enter	the	RA/Dec	coordinates.

Figure	170:	Re-centre	at	coordinates	dialog

• Centre	FoV	at	cursor	position.	Re-centre	the	Field	of	view	chart	at	the	mouse	cursor	coor-
dinates	(where	the	right-click	took	place).

• Centre	custom	reticles	at	cursor	position.	Centre	the	custom	reticle/s	at	the	mouse	cursor	co-
ordinates	(where	the	right-click	took	place).

• Show	FoV	in	{External	Application}.	Show	the	current	Field	of	view	in	the	speciFied	external	
planetarium	application.	i.e.	the	external	application	should	centre	itself	to	the	same	coordinates
as	the	centre	of	the	chart.

• Centre	cursor	position	in	{External	Application}.	Centre	the	speciFied	external	planetarium	
chart	at	the	coordinates	of	the	mouse	cursor	(where	the	right-click	took	place).

• Add	{catalogue	object}	to	plan.	Enabled	if	the	mouse	cursor	(where	the	right-click	took	place)	
is	over	or	close	to	a	displayed	catalogue	object.	This	will	add	that	catalogue	object	to	the	plan	as	
a	plan	object.
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• Lookup	synonyms	of	{catalogue	object}.	Enabled	if	the	mouse	cursor	(where	the	right-click	
took	place)	is	over	or	close	to	a	displayed	catalogue	object.	This	will	search	for	all	synonyms	of	
the	catalogue	object	and	display	them	in	a	results	window.

• Show	{catalogue	object}	in	catalogue.	Enabled	if	the	mouse	cursor	(where	the	right-click	took	
place)	is	over	or	close	to	a	displayed	catalogue	object.	This	will	open	a	window	displaying	the	ob-
ject	in	its	originating	catalogue.

• Copy	information	about	{catalogue	object}	to	the	clipboard.	Enabled	if	the	mouse	cursor	
(where	the	right-click	took	place)	is	over	or	close	to	a	displayed	catalogue	object.	This	will	copy	
text	information	about	that	catalogue	object	onto	the	clipboard	(name,	ID/s,	coordinates,	etc.).

• Sync	to	{catalogue	object}.	Enabled	if	the	mouse	cursor	(where	the	right-click	took	place)	is	
over	or	close	to	a	displayed	catalogue	object,	and	if	a	go-to	telescope	mount	is	connected	and	has
the	capability	of	syncing.	The	telescope	mount	will	be	synced	to	the	coordinates	of	the	object.

• Slew	telescope	to	cursor	position.	Enabled	if	a	go-to	telescope	mount	is	connected.	Slews	the	
telescope	to	the	coordinates	of	the	mouse	cursor	(where	the	right-click	took	place).

• Slew	telescope	and	Centre	FoV	at	cursor	position.	Enabled	if	a	go-to	telescope	mount	is	
connected.	Slews	the	telescope	to	the	coordinates	of	the	mouse	cursor	(where	the	right-click	
took	place),	and	re-centres	the	chart	at	that	position.

• Select	Object	in	observing	list.	Enabled	if	the	mouse	cursor	(where	the	right-click	took	place)	
is	over	or	close	to	a	displayed	plan	object.	If	so,	that	object	will	be	selected	in	the	object	list.

• Select	and	centre	closest	plan	object.	Find	the	plan	object	closest	to	the	mouse	coordinates	
(where	the	right-click	took	place)	and	centre	the	chart	there.

11.4.2 Catalogue selection

Figure	171:	Catalogue	selection	by	Name	and	by	Type

The	catalogue	selector	is	a	list	of	installed	catalogues	and	external	catalogues	that	can	be	displayed	
in	the	Field	of	view	chart.	Each	catalogue	has	a	checkbox	that	determines	if	it	will	be	included	in	the	
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chart.	The	list	of	catalogues	can	be	displayed	in	any	of	four	modes,	determined	by	the	radio	buttons	
along	the	top	(illustrated	in	Figure	171	and	Figure	172):

• By	Name.	An	alphabetical	list	of	installed	catalogues,	by	name.

• By	Type.	A	hierarchical	list	of	installed	catalogues,	ordered	by	the	types	of	objects	in	the	cata-
logues.	e.g.	Clusters	>	Globular	Cluster	will	list	all	catalogues	containing	at	least	one	globular	
cluster	object.	Note	that	this	means	that	a	catalogue	might	appear	at	several	places	in	the	hierar-
chy,	depending	on	what	kinds	of	objects	it	contains.

• By	ID.	An	alphabetic	list	of	IDs.	Each	ID	category	contains	a	list	of	installed	catalogues	containing
objects	with	that	ID.

• By	Selected.	Shows	a	list	of	the	currently-selected	installed	catalogues.

Figure	172:	Catalogue	selection	by	ID	and	by	Selected

If	you	have	any	external	catalogues	deFined	and	enabled	(see	Section	20.6.15	on	page	303	for	more	
details),	then	these	will	be	listed	after	the	installed	catalogues,	in	a	separate	External	Catalogues	
section.

When	you	select	a	catalogue	(by	clicking	on	its	entry)	you	can	toggle	the	Label	column	by	either	
double-clicking	that	column	for	the	catalogue,	or	by	using	the	Label	checkbox	at	the	top	right.	If	the	
Label	is	enabled	for	a	catalogue	then	objects	from	that	catalogue	will	be	labelled	if	the	object's	mag-
nitude	is	brighter	than	the	label	magnitude	settings	(see	Section	11.4.9	on	page	138).

Basic	information	for	a	selected	catalogue	also	appears	at	the	bottom	of	the	list.
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11.4.3 Display Options

Figure	173:	FoV	display	options

The	Display	Options	are	a	list	of	options	for	displaying	the	chart.	Switch	them	on/off	via	the	check-
box.	They	are	deFined	as	follows:

Constellations
These	options	deFine	if	and	how	constellations	are	displayed	in	the	Field	of	view	chart.

Figure	174:	Constellation	display	options	at	work

• Borders.	Draw	the	borders	of	each	constellation	present	in	the	chart,	using	a	grey	dotted	line.

• Colour	constellation	stars.	Give	the	stars	that	deFine	the	constellation	"Figure"	a	distinctive	
colour	(default:	magenta,	can	be	changed	via	the	Field	of	View	preferences.	See	Section	20.6	on	
page	299).
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• Figures.	Draw	the	Figure	of	each	constellation	present	in	the	chart,	using	a	grey	dotted	line.	The	
Figure	is	a	collection	of	lines	joining	the	main	stars	that	represent	the	constellation.

• Names.	Draw	the	3-character	abbreviated	constellation	names,	in	grey.

Display
Change	various	visual	aspects	of	the	chart.

• Aperture.	Draws	a	circular	aperture	on	the	chart	showing	the	extent	of	the	Field	of	view.

Figure	175:	Aperture	(left),	Cardinal	points	(centre),	Crosshairs	(right)

• Cardinal	points.	Draws	the	cardinal	points	(NSEW)	on	the	chart.

• Cross	hairs.	Draws	crosshairs	centred	on	the	Field	of	view,	with	tick	marks	at	regular	intervals.	
The	tick	mark	interval	is	given	at	the	top	left.

• Current	telescope	position.	Turns	on/off	the	ability	to	display	the	current	pointing	coordinates
of	the	connected	telescope	(where	applicable).

• Highlighted	plan	objects	only.	Only	show	plan	objects	that	are	currently	highlighted.

• Images.	Show	any	DSS/SDSS	images	that	overlap	the	Field	of	view.

Figure	176:	Images	in	the	Field	of	view	chart

• Multiple	stars.	Show	stars	with	multiple	components	with	a	horizontal	bar.
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Figure	177:	Multiple	stars	(left),	Variable	stars	(right)

• Number	of	observations.	For	plan	objects,	show	number	of	observations	made,	where	
applicable.

Figure	178:	Number	of	observations

• Objects	with	magnitude	only.	Show	only	catalogue	objects	that	have	an	associated	magnitude.

• Obey	catalogue	min/max	magnitudes.	If	any	displayed	catalogues	have	a	minimum	and/or	
maximum	magnitude	restriction	(See	File	>	Catalogue	Manager	>	Coverage	and	Settings),	then	
those	restrictions	will	be	obeyed	and	any	catalogue	objects	that	have	a	magnitude	outside	the	re-
stricted	range	will	not	appear	in	the	chart.

• Plan	object	at	chart	centre	only. If this option is on then any plan objects that are in the field of 
view, but not at the centre coordinates of the field of view, will not be displayed.

• Show	constellation	sub-chart.	Superimpose	a	small	constellation	chart	at	the	bottom	right	of	
the	main	chart,	showing	the	constellation	at	the	centre	of	the	main	chart.	The	main	chart	centre	
is	shown	as	a	small	red	ring.	See	Figure	180.

• Show	Date/Time	if	date	Oixed.	If	the	date/time	is	currently	Fixed	and	this	option	is	enabled,	the	
current	date/time	will	be	displayed	at	the	bottom	of	the	chart	as	a	warning.	See	Figure	179.
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Figure	179:	Show	Date/Time	if	date	Fixed

Figure	180:	Constellation	sub-chart

• Proper	motion.	Show	the	proper	motion	direction	of	stars	by	adding	a	short	grey	line	pointing	
in	the	direction	of	the	proper	motion,	with	its	length	proportional	to	the	magnitude	of	that	mo-
tion.	Useful	for	looking	for	associated	cluster	stars,	for	example.	Note	that	this	is	only	applicable	
to	stellar	catalogues	that	include	proper	motion.	Note	that	when	this	option	is	on,	appropriate	
catalogues	(those	containing	proper	motion	data)	in	the	catalogue	list	are	marked	with	a	small	
double-headed	arrow	icon.

• Spectral	colours.	Show	the	stellar	spectral	class	by	colouring	stars	in	an	appropriate	colour.	
This	only	applies	to	catalogue	stars	that	have	an	associated	spectral	class.	Note	that	when	this	
option	is	on,	appropriate	catalogues	(those	containing	spectral	data)	in	the	catalogue	list	are	
marked	with	a	small	"spectrum"	icon.
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Figure	181:	Proper	motion	(left),	Spectral	colours	(right)

• Stellar	magnitude	scale.	Show	the	stellar	magnitude	scale	at	the	bottom	left	of	the	chart.

Figure	182:	Stellar	magnitude	scale

• Variable	stars.	Show	any	variable	stars	with	a	circle	around	them.

Labels
These	are	labels	on	any	plan	or	catalogue	objects,	where	applicable.

• Magnitude.	Show	the	magnitude	of	objects	in	the	chart,	assuming	that	they	have	an	associated	
magnitude	and	that	magnitude	is	within	the	magnitude	limits	for	labels.

• Position	angle.	Show	the	position	angle	for	objects	in	the	chart	(double	stars,	galaxies,	etc.),	as-
suming	that	they	have	an	associated	position	angle	and	the	object	magnitude	is	within	the	mag-
nitude	limits	for	labels.

• Separation.	Show	the	separation	for	objects	in	the	chart	(double	stars,	etc.),	assuming	that	they	
have	an	associated	separation	and	the	object	magnitude	is	within	the	magnitude	limits	for	labels.
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Figure	183:	Labels,	showing	magnitude,	position	angle,	separation

Orientation
• Alt/Az	rotation.	The	Field	of	view	is	rotated	to	show	the	Field	as	would	be	seen	by	an	alt/az-
mounted	telescope,	or	a	binocular,	pointed	at	the	Field	at	the	current	date/time	from	the	current	
site.

Figure	184:	Alt-Az	rotation

• Flip	horizontal.	Flip	the	Field	horizontally.

• Flip	vertical.	Flip	the	Field	vertically.

Other
• Ignore	imager	guide	sensor.	If	you	are	sizing	the	Field	of	view	chart	to	Fit	an	imager,	and	the	im-
ager	has	a	integral	off-axis	guide	sensor,	then	the	Field	of	view	is	sized	to	Fit	the	track	of	the	guide	
sensor.	If	this	option	is	checked,	the	guide	sensor	is	ignored	and	the	Field	of	view	is	sized	to	Fit	
the	main	sensor	only.
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Figure	185:	Ignore	imager	guide	sensor	option	off	(left)	and	on	(right)

• Legend.	Displays	a	Floating	window	with	a	legend	for	star	magnitudes	and	DSOs.	If	spectral	star	
colours	are	being	displayed,	a	spectral	colour	legend	is	included.

Figure	186:	Field	of	view		Floating	legend

• Show	object	notes.	Show	the	object	notes,	for	the	object	being	pointed	at	by	the	mouse	cursor,	
in	a	Floating	window.

Figure	187:	Object	notes	Floating	window
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Reticles/FoVs
Controls	the	display	of	reticles	and	Field-of-view	outlines	for	eyepieces,	etc.

• All	binocular	FoVs.	Display	circular	reticles	for	all	active	"binocular"	telescope	resources	in	your
resource	database.

Figure	188:	All	binocular	FoVs

• All	eyepiece	FoVs.	Display	circular	reticles	for	all	active	eyepieces	resources	in	your	resource	
database.	The	diameter	of	the	FoV	reticles	will	depend	upon	the	selected	telescope	resource.

Figure	189:	All	eyepiece	FoVs

• Binocular	FoV.	Display	the	binocular	FoV	extent,	if	the	currently	selected	telescope	resource	is	a
binocular.
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Figure	190:	Binocular	FoV

• Custom	reticles.	Display	any	active	custom	reticles	(see	Section	11.4.13	on	page	140).

Figure	191:	Custom	reticles

• Eyepiece	FoV.	Display	the	eyepiece	FoV	extent,	if	an	eyepiece	resource	and	telescope	resource	
are	currently	selected.

Figure	192:	Eyepiece	FoV
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• Fit	imager	to	FoV	aperture.	When	sizing	the	Field	of	view	to	Fit	an	imager,	then	this	option	will	
size	the	chart	so	that	the	imager	Fits	inside	the	circular	aperture.

Figure	193:	Fit	imager	to	FoV	aperture:	off	(left)	and	on	(right)

• Hide	eyepiece	reticle.	If	the	currently-selected	eyepiece	resource	has	a	reticle,	then	this	option	
will	hide	that	reticle.

Figure	194:	Hide	eyepiece	reticle:	off	(left)	and	on	(right)

• Imager	FoV.	If	this	option	is	on,	and	an	imager	is	selected,	then	display	that	imager's	FoV.

• Rigel	QuickFinder.	Display	a	reticle	for	the	Rigel	QuickFinder,	which	projects	circles	of	diameter
0.5°	and	2°	onto	the	sky.

• Telrad.	Display	a	reticle	for	the	Telrad,	which	projects	circles	of	diameter	0.5°,	2°	and	4°	onto	the
sky.
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Figure	195:	Rigel	QuickFinder	reticle	(left)	and	Telrad	reticle	(right)

• Crosshairs/Grid...	Display	either	crosshairs	or	a	grid	on	the	chart.	The	grid	or	crosshairs	can	be	
rotated	using	the	Reticle	Rotation	slider.	Double-clicking	the	display	option	entry	allow	changing	
of	the	parameters	(Figure	198).

Figure	196:	Crosshairs/Grid

Figure	197:	FoV	showing	5'	grid
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Figure	198:	Changing	grid	parameters

Solar System
Turn	on/off	the	display	of	various	solar	system	objects.

• Show	Comets.	Show/hide	any	comets	that	appear	in	the	plan	document	object	list.

• Show	Minor	Planets.	Show/hide	any	minor	planets	that	appear	in	the	plan	document	object	list.

• Show	Moon.	Show/hide	the	moon	(whether	or	not	it's	a	plan	object).

• Show	Planets.	Show/hide	the	planets	(whether	or	not	they	are	plan	objects).

• Show	Sun.	Show/hide	the	sun	(whether	or	not	it's	a	plan	object).

11.4.4 Field diameter
The	Field	Diameter	speciFies	the	angular	size	of	the	Field	of	view	chart.

Figure	199:	Field	diameter

Figure	200:	Field	diameter	popup	menu

The	popup	menu	determines	how	this	is	calculated:

• Size.	Specify	the	Field	of	view	diameter	(in	degrees)	by	manually	entering	the	diameter	in	the	
text	Field.	Note	that	you	can	enter	the	size	in	arcminutes	by	appending	'	to	number,	or	arcseconds
by	appending	".

• Field	for	Telescope/Eyepiece/Imager/Aid	combination.	Computes	the	FoV	diameter	by	
taking	into	account	the	telescope	and	eyepiece/imager	selection	(and	optical	aid	if	speciFied).
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• Finder	FoV.	If	a	telescope	is	speciFied,	and	that	telescope	resource	has	a	Finder	scope	speciFied,	
then	the	Field	of	view	diameter	is	set	to	the	Finder	scope's	FoV.

• Fixed	60°,	etc.	Various	Fixed	angular	diameters.

• Fit	largest	custom	reticle.	Change	the	diameter	to	Fit	the	largest	active	custom	reticle.

• Fit	smallest	custom	reticle.	Change	the	diameter	to	Fit	the	smallest	active	custom	reticle.

• Edit	custom	FoV	sizes...	Allows	adding	and	removing	additional	Fixed	diameter	entries	to	the	
popup	list.	The	dialog	allows	you	to	select	and	remove	an	entry,	or	adding	a	new	entry	to	the	end
of	the	list.

Figure	201:	Custom	FoV	Sizes	dialog

11.4.5 Telescope/Eyepiece/Imager/Optical Aid
These	specify	the	resources	to	be	used	to	compute	the	diameter	of	the	Field	of	view	chart	(unless	the
Field	Diameter	is	set	to	a	choice	other	than	Size:).

Figure	202:	FoV	resource	selectors

11.4.6 Spiral Scan
Starts	or	continues	a	telescope	spiral	scan,	assuming	a	go-to-controllable	telescope	mount	is	
connected.	See	Section	13.10	on	page	210	for	more	details.

11.4.7 Images
Opens	the	Images	window,	showing	images	for	the	current	Field	of	view	chart	where	applicable.

11.4.8 Get Scope
If	a	computerised	telescope	is	connected,	then	the	Get	Scope	button	is	enabled.	Clicking	the	button	
will	get	the	telescope's	current	pointing	coordinates	and	centre	the	Field	of	view	chart	there.	If	the	
Auto	checkbox	is	checked,	then	this	will	be	done	automatically	at	regular	intervals	and	the	chart	up-
dated	is	the	coordinates	have	changed.

11.4.9 Magnitude limits
These	slider	controls	specify	the	magnitude	limits	for	stars	and	DSOs	(non-stellar	deep-sky	objects)	
in	the	Field	of	view	chart.	e.g.	in	Figure	203,	stars	down	to	magnitude	9.1	will	be	plotted,	with	labels	
shown	for	those	stars	of	magnitude	4.3	or	brighter	(if	the	catalogue	containing	the	star	has	its	Label	
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Flag	enabled).	Similarly,	DSOs	of	magnitude	9.1	or	brighter	will	be	plotted,	with	labels	on	any	with	
magnitude	15.0	or	brighter.	

Figure	203:	Field	of	view	magnitude	limits

Note	that	the	Star/DSO	magnitude	sliders	will	be	automatically	set	to	the	selected	telescope's	visible
magnitude	limit	whenever	that	telescope	is	changed	(assuming	that	the	Default	Limiting	Magnitude	
option	in	the	Field	of	View	preferences	is	set.	See	Section	20.6.10	on	page	302).

11.4.10 FoV rotation
Rotate	the	Field	of	view	chart	by	the	selected	angle	(either	use	the	slider	or	enter	the	angle	manual-
ly).	This	option	will	be	disabled	if	you	are	using	the	Alt/Az	Rotation	display	option.

Figure	204:	FoV	Rotation	slider

The	numerical	angle	Field	is	surrounded	by	a	"warning"	frame	if	the	angle	is	non-zero	to	remind	you	
that	the	Field	is	rotated.

11.4.11 Reticle rotation
Rotate	the	imager	reticle	or	custom	reticle/s	by	the	selected	angle	independently	of	the	Field	of	view	
(either	use	the	slider	or	enter	the	angle	manually).	This	option	will	be	disabled	if	you	are	not	dis-
playing	an	imager	or	custom	reticle.

Figure	205:	Reticle	Rotation	slider

The	numerical	angle	Field	is	surrounded	by	a	"warning"	frame	if	the	angle	is	non-zero	to	remind	you	
that	the	reticle/s	is/are	rotated.

11.4.12 Field of View chart buttons
These	small	buttons	appear	along	the	right	side	of	the	Field	of	view	chart.
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Figure	206:	Field	of	view	chart	buttons

From	top	to	bottom,	these	buttons	are:

• Zoom	In.	Zoom	in	by	a	factor	of	2	(i.e.	halve	the	diameter	of	the	chart),	where	possible.

• Zoom	Out.	Zoom	out	by	a	factor	of	2	(i.e.	double	the	diameter	of	the	chart),	where	possible.

• Refresh.	Force	a	refresh	of	the	chart.	This	is	rarely	necessary.

• Slew	telescope.	If	a	telescope	with	a	go-to	mount	is	currently	connected,	slew	the	telescope	to	
the	coordinates	of	the	centre	of	the	chart.

• Edit	custom	reticles.	Edit	the	custom	reticles	(see	Section	11.4.13	on	page	140).

• Make	the	chart	Oield	the	same	as	the	external	application's	Oield.	If	an	external	application	
has	been	speciFied,	request	the	size	and	central	coordinates	of	the	application's	chart	Field	and,	if	
successful,	set	the	Field	of	view	chart	to	the	same	coordinates	and	size.

• Make	the	external	application's	Oield	the	same	as	the	chart	Oield.	If	an	external	application	
has	been	speciFied,	request	that	the	application	set	the	size	and	central	coordinates	of	its	chart	
Field	to	the	same	coordinates	and	size	as	the	Field	of	view	chart.

• Move	UP	the	object	list.	Select	the	previous	object	in	the	object	list.	If	no	object	is	currently	se-
lected,	or	the	First	object	in	the	list	is	selected,	then	this	button	will	be	disabled.	Clicking	the	but-
ton	will	select	the	previous	object	and	redraw	the	chart.

• Move	DOWN	the	object	list.	Select	the	next	object	in	the	object	list.	If	no	object	is	currently	se-
lected,	or	the	last	object	in	the	list	is	selected,	then	this	button	will	be	disabled.	Clicking	the	but-
ton	will	select	the	next	object	and	redraw	the	chart.

• Show	the	Oield	of	view	preferences.	Show	the	Field	of	view	preferences	(see	Section	20.6	on	
page	299).

11.4.13 Custom reticles
Custom	reticles	are	user-deFined	reticles	that	can	be	superimposed	on	the	Field	of	view	chart,	using	
the	Custom	reticles	display	option	(see	Reticles/FoVs	on	page	133).	All	editing	of	the	custom	reti-
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cles	is	done	via	the	Custom	Reticles	dialog.	This	is	displayed	via	the	Edit	custom	reticles	button	to	
the	right	of	the	Field	of	view	chart	(see	above).

The	Custom	Reticles	dialog	contains	a	list	of	deFined	reticles,	each	of	which	can	be	active	or	inactive	
via	the	associated	checkbox	(only	active	reticles	will	be	displayed).	Buttons	underneath	the	list	al-
low	you	to	create	new	reticles,	and	delete	or	duplicate	existing	reticles.

Figure	207:	Edit		a	Round	custom	reticle

Custom	reticles	can	be	one	of	three	types:	Round,	Rectangular,	and	Imager.

A	Round	reticle	is	deFined	by	its	angular	diameter,	or	as	a	percentage	of	the	Field	diameter	or	radius	
(Figure	207).	It	also	has	an	optional	offset	from	the	centre	of	the	Field.	These	can	be	put	to	use	as	
simple	circular	reticles,	or	as	offset	reticles	(such	as	off-axis	guider	Fields).

A	Rectangular	reticle	is	deFined	by	its	angular	width	and	height	(Figure	208).	It	also	has	an	optional
offset	from	the	Field	of	view	centre.

An	Imager	reticle	is	deFined	by	the	physical	width	and	height	of	the	imager's	sensor	(in	mm)	(Figure
209).	It	also	has	an	optional	offset	from	the	Field	of	view	centre.	If	an	offset	is	speciFied	it	is	assumed	
that	the	sensor	is	an	off-axis	star	tracker	and	you	can	elect	to	show	the	track	of	the	off-axis	tracker	
when	it	is	rotated,	and	the	radii	of	the	limits	of	the	track	(Figure	210).	You	can	specify	a	telescope	to	
determine	the	actual	size	of	the	reticle	when	drawn	(it	will	be	sized	as	if	the	imager	sensor	was	
placed	at	prime	focus	of	that	telescope).	If	you	specify	FoV	Default	then	the	reticle	will	be	resized	to	
match	whatever	telescope	is	currently	selected	for	the	Field	of	view	chart.
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Figure	208:	Edit		a	Rectangular	custom	reticle

Figure	209:	Edit		an	Imager	custom	reticle
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Figure	210:	Offset	image	sensor	example

Common	items	for	all	reticle	types	are:

• Name.	Reticle	name	to	be	displayed	in	the	list.

• Abbreviation.	Abbreviated	name	to	be	displayed	next	to	the	reticle	on	the	Field	of	view	chart.

• Show:	Rotation	track.	Show	the	track	an	offset	reticle	will	make	when	rotated	around	the	cen-
tre	of	the	Field	(Figure	210).

• Show:	Radii.	If	a	rotation	track	is	shown,	annotate	it	with	the	angular	radii	of	the	inside	and	out-
side	of	the	track.

• Colour.	The	colour	to	be	used	to	display	the	reticle	in	the	Field	of	view	chart.

• Cross	hairs.	Check	this	if	the	reticle	has	cross	hairs.	If	the	cross	hairs	are	double,	then	check	the	
Double	checkbox	and	enter	the	spacing	of	the	hairs	as	a	percentage	of	the	reticle	size.

• Rotation	in	Field	of	View	chart.	Custom	reticles	have	three	choices	for	rotation:	Rotate	with	the
Reticle	Rotation	slider,	rotate	with	the	FoV	Angle	slider,	or	no	rotation.	This	is	useful	for,	say,	off-
axis	guiders	where	the	pickoff	mirror	rotates	separately	from	the	main	sensor/reticle.	If	you	
make	your	main	imager	reticle	have	"No	rotation"	and	the	pickoff	mirror	reticle	have	"Reticle	ro-
tation"	then	the	pickoff	mirror	will	be	adjusted	w.r.t.	the	imager	using	the	Reticle	Rotation	slider.	
The	FoV	Rotation	slider	can	be	used	to	rotate	the	FoV	under	the	main	imager	reticle	for	framing.

• Add	special.	A	popup	menu	that	allows	you	to	add	a	new	custom	reticle	based	on	any	Imager	re-
sources,	or	a	list	of	common	Imager	types	(Figure	211).
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Figure	211:	Pre-deFined	reticle	list

11.5 Sky tab
The	Sky	tab	displays	an	all-sky	chart	for	the	current	local	date/time	at	the	current	site.

- 144 -



Figure	212:	Sky	tab
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11.5.1 Sky chart

Figure	213:	Sky	chart
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11.5.2 Display options

Figure	214:	Display	options

Figure	215:	Select	display	option	with	associated	value

Constellations
• Borders.	Show	the	ofFicial	constellation	borders	with	grey	dotted	lines.

• Figures.	Show	the	constellation	Figures	(lines	joining	principal	stars)	using	solid	grey	lines.

• Names.	Show	the	constellation	name	3-letter	abbreviations.

External Catalogues
• xxx	cache	coverage.	If	you	have	one	or	more	external	catalogues	with	caching	enabled	(see	Sec-
tion	20.6.15	on	page	303)	then	there	will	be	an	entry	for	each	of	those	catalogues,	with	"xxx"	re-
placed	by	the	catalogue	name.	Using	this	option	will	show	what	parts	of	the	sky	are	covered	by	
cached	data.
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Figure	216:	Constellations:	Borders	(left),	Figures	(middle),	Names	(right)

Figure	217:	External	catalogue	cache	coverage

Lines
• Air	Mass.	This	option	draws	a	dotted	line	at	the	altitude	representing	the	given	Air	Mass.	Select	
the	entry	and	you	can	change	the	value	just	below	the	Display	Options.

• Alt-Azimuth	grid.	Draws	an	alt-azimuth	grid	(i.e.	grid	of	horizon	coordinates)	

• Ecliptic.	This	option	draws	a	dotted	line	along	the	ecliptic	(the	plane	of	the	Earth's	orbit).
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Figure	218:	Air	Mass	line	(left),	and	Ecliptic	(right)

• Equatorial	grid.	Draws	an	equatorial	grid	(i.e.	grid	of	equatorial	coordinates:	R.A.	and	
Declination).

Figure	219:	Alt-Azimuth	grid	(left),	equatorial	grid	(right)

• Fixed	Altitude.	Draw	a	line	at	a	given	Fixed	altitude.		Select	the	entry	and	you	can	change	the	val-
ue	just	below	the	Display	Options.

• Galactic	equator.	Draw	a	dotted	line	showing	the	Milky	Way	galactic	equator.

• Meridian.	Draw	a	dashed	line	on	the	meridian	(the	great	circle	passing	through	both	celestial	
poles).

• Milky	Way	outline.	Draw	solid	lines	showing	the	extent	of	the	Milky	Way.

• Telescope	RA/Dec.	Draw	a	small	"gun	sight"	icon	at	the	current	pointing	coordinates	of	your	
computerised	telescope	(assuming	one	is	connected).	If	such	a	telescope	is	not	connected,	or	is	
pointing	below	the	horizon,	then	the	icon	is	not	displayed.
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Figure	220:	Fixed	altitude	(left),	Milky	Way	outline	and	galactic	equator	(centre),	Telescope	RA/Dec
(right)

Objects
• Alignment	stars.	Shows	the	alignment	stars	for	the	currently	selected	computerised	telescope	
(where	applicable).	See	Section	11.5.4	on	page	154	for	more	information.

• Bolide	shower	radiants.	Show	the	location	of	possible	bolide	showers	using	random	lines	ema-
nating	from	the	radiant	coordinates.

• Catalogue	objects.	Show	the	position	of	selected	catalogue	objects	on	the	chart	(as	small	
squares).	All	catalogues	that	have	been	marked	as	being	displayable	in	the	sky	chart	will	be	
shown	(see	Section	23.3	on	page	328	for	details).	The	option	has	a	magnitude	limit	value	associ-
ated	with	it,	and	only	catalogue	objects	brighter	than	that	value	will	be	selected	for	display.		Se-
lect	the	entry	and	you	can	change	the	value	just	below	the	Display	Options.	WARNING:	selecting	
catalogues	with	lots	of	objects	might	make	this	option	take	a	long	time	to	redraw.

• Field	of	view	(FoV).	Draw	a	circle	showing	the	size	and	location	of	the	Field	of	View	chart	if	it	is	
above	the	horizon.	This	might	be	virtually	invisible	if	the	Field	of	View	is	small.

• Meteor	shower	radiants.	Show	the	location	of	possible	meteor	showers	using	random	lines	em-
anating	from	the	radiant	coordinates.

Figure	221:	Bolide	and	meteor	shower	radiants	(left),	and	Catalogue	objects	(Messier)	(right)
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• Stars.	Switches	on	the	display	of	stars	(typically	this	will	always	be	on).	The	catalogue	used	is	the
Bright	Star	catalogue,	which	includes	stars	down	to	about	magnitude	6.5.	The	option	includes	a	
magnitude	limit	parameter.	Only	stars	brighter	than	that	value	will	be	displayed.		Select	the	entry
and	you	can	change	the	value	just	below	the	Display	Options.

• Sun/Moon/Planets.	Display	the	positions	of	the	Sun,	the	Moon,	and	any	visible	planets.

Figure	222:	Field	of	view	(5°	around	M44	in	CnC	here)	(left),	Sun/Moon/Planets	(right)

Orientation
• Flip	East/West.	Flip	the	chart	horizontally.

• Flip	North/South.	Flip	the	chart	vertically.

• Rotate	Chart.	Rotate	the	chart	by	an	arbitrary	amount.	Useful	if	you,	say,	visualise	the	sky	at	90°	
to	the	meridian	(looking	east	or	west)	while	observing.

Plan Objects
These	options	control	the	display	of	objects	in	the	current	plan.

• Number	of	observations.	If	an	object	has	associated	observations	then	show	the	number	of	ob-
servations	next	to	the	object.

• Object	sequence.	Show	the	sequence	of	objects	in	the	Object	List	by	drawing	a	dotted	line	be-
tween	each	object	in	succession.	This	is	mainly	useful	if	you	have	sorted	the	objects	using,	say,	a	
minimum	slew	sort,	giving	an	idea	of	where	you	will	be	slewing	the	telescope.

• Objects.	Show	the	plan	objects	as	small	open	circles.	If	one	or	more	objects	are	selected	in	the	
Object	List,	then	they	are	shown	as	a	Filled	circle	with	another	circle	surrounding	each	one.	
There	is	also	a	parameter	allowing	you	to	restrict	the	objects	only	to	those	that	are	selected,	
highlighted,	observed,	or	not	observed.		Select	the	entry	and	you	can	change	the	value	just	below	
the	Display	Options.

• Show	ID.	Show	the	object	ID	next	to	the	object.

• Show	Name.	Show	the	object	Name	next	to	the	object.
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Figure	223:	Plan	objects	with	IDs	and	#	of	observations	(left),	object	sequence	(right)

Visibility
Visibility-related	options	for	the	Sky	chart.

• Contours.	Overlay	contours	on	the	sky	chart	showing	current	sky	brightness	conditions	over	the
sky.	The	parameter	allows	displaying	the	brightness	in	terms	of	NELM	(naked-eye	limiting	mag-
nitude)	or	SB	(sky	brightness	in	nL	or	magnitudes/square	arcsec).	Select	the	entry	and	you	can	
change	the	value	just	below	the	Display	Options.

Figure	224:	NELM	contours	(left),	Sky	Brightness	contours	(right)

• Fixed	horizon.	Draw	a	Fixed	horizon	(i.e.	an	area	coloured	up	to	the	speciFied	altitude).	Select	
the	entry	and	you	can	change	the	value	just	below	the	Display	Options.

• Light	dome.	Show	the	current	site's	deFined	light	dome/s	(where	applicable).

• Limits.	If	the	currently-selected	telescope	has	a	computerised	mount	with	deFined	slewing	lim-
its,	colour	the	out-of-limit	areas.

• Site	horizon.	Show	the	current	site's	deFined	upper	and	lower	horizons	(where	applicable).
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Figure	225:	Fixed	altitude	(20°)	(left),	site	horizon	and	light	dome	(centre),	slewing	limits	(between
5°	and	80°	altitude)	(right)

• Twilight/daylight	colours.	Colour	the	chart	background	with	a	colour	representing	the	current	
time	of	day	(i.e.	day	time,	civil/nautical/astronomical	twilight,	and	complete	darkness).

Figure	226:	Using	twilight/daylight	colours:	daytime	(left),	nautical	twilight	(centre),	total	darkness
(right)

• Use	NELM	for	star	visibility.	Use	the	NELM	(naked-eye	limiting	magnitude)	algorithm	to	deter-
mine	which	stars	will	be	visible	to	the	naked	eye.	i.e.	none	during	daylight,	some	during	twilight,	
most	during	complete	darkness.	Takes	into	effect	horizon	and	moon	conditions.
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Figure	227:	Using	NELM	for	star	visibility:	daytime	(left),	nautical	twilight	(centre),	total	darkness
with	no	moon	(right)

11.5.3 Time offset
The	time	offset	slider	allows	you	to	select	a	time	offset	from	the	current	local	time	(by	up	to	24	
hours	in	either	direction).	This	allows	you	to,	for	example,	see	the	effects	as	the	sun	sets,	moon	rises,
etc.	without	having	to	use	the	Fix	Date	feature.

Figure	228:	Time	offset	slider

11.5.4 Alignment stars
If	you	have	selected	a	telescope,	and	that	telescope	has	a	computerised	mount	that	deFines	a	set	of	
alignment	stars	("standard"	stars	used	by	the	telescope	to	perform	initial	alignment),	then	you	can	
show	those	stars	in	the	Sky	tab,	in	both	tabular	form	and	on	the	chart	if	required.

If	the	selected	telescope	does	not	have	a	mount	with	deFined	alignment	stars,	a	warning	message	is	
shown	(Figure	229).

Alignment star list
Use	the	Show	alignment	star	information	checkbox	to	display	a	table	of	the	alignment	stars	for	
the	telescope	mount.	This	includes	columns:

• Name.	The	common	name	of	the	alignment	star.

• Magnitude.	The	magnitude	of	the	alignment	star.

• Visible.	"Yes"	if	the	star	is	currently	above	the	horizon.

• Reject.	Status	of	the	star	for	inclusion	as	a	candidate	for	use	to	perform	an	alignment.	Blank	if	
the	star	is	not	visible	(and	hence	automatically	rejected),	"Alt"	if	the	star	is	rejected	because	its	
altitude	is	too	low	or	too	high	(as	deFined	in	the	Sky	preferences),	"Lim"	if	the	star	is	rejected	be-
cause	the	telescope	cannot	slew	to	that	position,	"Mag"	if	the	star	is	rejected	because	it	is	too	
dim	(as	deFined	in	the	Sky	preferences),	or	"Hor"	if	the	star	is	hidden	by	the	site	horizon.	Other-
wise	a	checkbox	is	included,	and	the	star	is	not	rejected	unless	that	checkbox	is	checked.

• Always.	Contains	a	checkbox	that,	if	checked,	will	always	reject	that	particular	star.

Stars	that	are	not	visible,	or	are	rejected	are	shown	in	a	grey	colour.
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The	Show	FoV	button	is	enabled	if	a	row	is	selected.	If	clicked	it	will	change	to	the	Field	of	View	tab	
and	move	the	centre	of	the	chart	to	the	coordinates	of	the	selected	star.

The	Slew	to	Star	button	is	enabled	if	a	row	is	selected,	the	selected	star	is	visible,	and	a	telescope	
with	a	Go-to	mount	is	currently	connected.	If	clicked	it	will	slew	the	telescope	to	the	coordinates	of	
the	selected	star.

Figure	229:	Warning	message	if	selected	telescope	does	not	deFine	alignment	stars

If	you	right-click	the	list,	you	can	select	Add	alignment	stars	to	plan...	This	lets	you	create	a	plan	
consisting	of	alignment	star	objects.	You	can	specify	what	is	placed	in	the	ID	and	Name	Fields	of	the	
plan	objects	so	created.

Figure	230:	Add	alignment	stars	to	plan

Sky chart option
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Figure	231:	Alignment	stars

If	the	Display	Options	>	Objects	>	Alignment	stars	option	is	checked	then:

• All	stars	except	for	the	known	alignment	stars	are	dimmed.

• Lower	and	upper	altitude	limits	(where	applicable)	for	alignment	stars	are	drawn.

• Any	rejected	alignment	stars	are	displayed	in	red.

• If	the	alignment	star	selection	algorithm	has	been	used	then	the	two	stars	selected	in	the	best	
pair	list	are	joined	by	a	dotted	line.

Alignment star selection
The button below the alignment star list to perform alignment star selection is labelled as Find	Best	Pair, 
Find	Pairs, or Find	Triples, depending on the type of algorithm selected in the Sky preferences. Clicking
that button will run an algorithm to determine the best pairs or triples of alignment stars to use.

Once the algorithm has finished running, the results are displayed in the lower list, typically in descending
order of "bestness".

Why not trust your telescope controller to make the choice?
In	the	case	of	the	Meade	LX200	(Classic)	Alt-Az-mounted	telescope	(for	which	the	Best	Pair	algo-
rithm	was	speciFically	developed)	the	answer	to	this	question	is	two-fold.	
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Firstly,	the	LX200	Classic	controller	makes	you	choose	two	stars	from	a	list,	and	does	not	make	any	
suggestions	as	to	which	pair	will	be	the	best	candidates.	

Secondly,	the	Meade	engineers	"forgot"	to	take	into	account	atmospheric	refraction	for	low-altitude	
stars,	so	it	is	best	to	avoid	these.	

For	other	telescope	types,	the	need	is	not	so	clear.	The	controllers	typically	will	make	a	choice	of	
stars	for	you,	and	in	most	cases	they	are	pretty	good.	However,	empirical	evidence	seems	to	show	
that	the	Best	Pair	algorithm	works	even	better	at	choosing	optimum	pairs	of	stars.	The	author	has	
found	that	the	following	precautions	are	just	as	important	to	a	good	alignment	than	choosing	the	
optimal	pair	of	stars:
• Make sure the telescope mount is initially level (i.e. the top of the tripod is level) and the RA axis of 

the mount is pointing directly at the zenith. A bubble level will help.

• Make	sure	the	scope	optical	tube	is	exactly	level	and	pointing	north	(or	south	in	the	case	of	the	
LX200	Classic)	before	switching	on.

• While	aligning,	make	sure	the	alignment	stars	are	exactly	in	the	centre	of	the	eyepiece	Field-of-
view.	Using	a	reticle	eyepiece	or	defocussing	the	stars	might	help	here.

• Choose	alignment	stars	that	are	more	than	90°	apart	wherever	possible.

Rejecting potential star candidates
Each	telescope	controller	has	a	list	of	preselected	alignment	stars	it	can	use	for	alignments.	These	
are	typically	(a)	bright	and	(b)	evenly	spaced	over	the	sky.	However,	some	of	these	stars	are	better	
than	others	for	various	reasons.	For	the	Best	Pair	algorithm	to	work	to	your	best	advantage	you	
should	arrange	for	some	stars	to	be	"rejected".	Such	stars	fall	into	six	categories:

1. Non-visible	stars.	These	are	rejected	automatically	by	the	algorithm	since	there	is	no	way	
you	can	align	on	a	star	below	the	horizon.

2. Low	altitude	stars.	Low	altitude	stars	are	typically	non-optimal	because	of	atmospheric	re-
fraction	effects.	These	stars	can	be	rejected	automatically	by	setting	the	"Reject	stars	with	al-
titude	less	than"	check	box	in	the	Sky	chart	preferences.	The	default	value	of	15°	will	reject	all
stars	with	current	altitudes	less	than	that	angle.	This	is	optional.

3. High	altitude	stars.	High	altitude	stars	may	not	be	reachable	owing	to	mount	limitations,	
etc.	These	stars	can	be	rejected	automatically	by	setting	the	"Reject	stars	with	altitude	
greater	than"	check	box	in	the	Sky	chart	preferences.	The	default	value	of	75°	will	reject	all	
stars	with	current	altitudes	greater	than	that	angle.	This	is	optional.

4. Dim	stars.	Dim	alignment	stars,	especially	at	a	light-polluted	site,	can	be	problematical.	
These	stars	can	be	rejected	automatically	by	setting	the	"Reject	stars	with	magnitude	greater	
than"	check	box	in	the	Sky	chart	preferences.	This	is	optional.

5. Slewing	limitations.	Any	stars	that	fall	outside	the	slewing	limits	deFined	for	the	telescope	
mount	will	automatically	be	rejected.

6. Non-optimally placed stars. Some stars are not optimally placed. For example, Polaris can cause 
cord-wrapping problems if you slew to it from the wrong side in the case of the LX200 (Classic) 
telescope. Other stars might be temporarily hidden by a cloud or tree. These can be rejected by us-
ing the checkboxes in the alignment star list.
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2- and 3-Star Polar Alignment
The	algorithm	used	for	two-star	selection1	is:

• Choose	two	stars	that	are	on	the	same	side	of	the	meridian,	and	at	least	3	hours	apart	in	RA	and	be-
tween	3°	and	60°	apart	in	Declination.

For	three-star	selection:

• For	the	Pirst	two	alignment	stars,	follow	the	same	guideline	as	choosing	for	the	two-	star	alignment.	

• For	the	third	star,	choose	a	star	that	is	on	the	opposite	side	of	the	meridian	from	the	Pirst	two	stars.	
Both	Pirst	alignment	star	and	third	alignment	star	should	have	an	absolute	value	of	30°	to	70°	in	Dec-
lination.	If	the	Pirst	chosen	star	has	a	small	Declination	(<	30°),	the	Declination	of	the	third	star	
should	be	at	least	50°.

The	algorithm	does	not	Find	optimal	pairs	or	triples,	but	merely	those	that	Fit	the	criteria	above.

11.5.5 Sky chart buttons
These	small	buttons	appear	along	the	right	side	of	the	sky	chart.

Figure	232:	Sky	chart	buttons

From	top	to	bottom,	these	buttons	are:

• Move	UP	the	object	list.	Select	the	previous	object	in	the	object	list.	If	no	object	is	currently	se-
lected,	or	the	First	object	in	the	list	is	selected,	then	this	button	will	be	disabled.	Clicking	the	but-
ton	will	select	the	previous	object	and	redraw	the	chart.

• Move	DOWN	the	object	list.	Select	the	next	object	in	the	object	list.	If	no	object	is	currently	se-
lected,	or	the	last	object	in	the	list	is	selected,	then	this	button	will	be	disabled.	Clicking	the	but-
ton	will	select	the	next	object	and	redraw	the	chart.

• Sky	chart	preferences.	Show	the	sky	chart	preferences	(see	Section	20.7	on	page	305).

11.6 Object list functions
Most	of	the	functions	that	act	on	the	object	list,	or	on	objects	in	that	list,	exist	in	the	Object	menu.

1. Taken from the SynScan handbook
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Figure	233:	Object	menu

11.6.1 Search
The	Search	submenu	includes	commands	that	search	for	object	information.

Figure	234:	Object	>	Search	menu

Lookup ID
Lookup Name
Lookup	the	ID/Name	of	the	selected	object	(in	the	object	list)	in	the	installed	catalogues.	

Firstly	you	are	asked	to	select	which	catalogues	to	search	(see	Figure	235).	The	initial	selection	is	all
installed	catalogues	(apart	from	those	that	are	marked	as	not	searchable	in	the	Catalogue	Manager	-	
see	Section	23.3	on	page	328).	The	buttons	and	popup	menu	underneath	the	list	of	catalogues	allow	
you	to	select	speciFic	catalogues.

You	can	also	specify	to	stop	the	search	when	the	First	match	is	found,	or	to	continue	looking	for	all	
matches.
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If	you	are	connected	to	the	Internet,	you	can	also	elect	to	lookup	the	object	using	the	SIMBAD	astro-
nomical	database,	by	clicking	the	SIMBAD	button.	In	this	case,	the	installed	catalogues	will	be	
ignored.

The	Cross-index	ID	Oields	option,	if	checked,	will	recursively	check	all	synonym	IDs	found	during	
the	initial	search,	all	synonyms	found	during	the	subsequent	search,	etc.,	until	all	synonyms	have	
been	found.	This	is	an	exhaustive	search,	but	you	need	to	be	aware	that	it	can	(a)	take	time	to	com-
plete,	and	(b)	produce	"false	positives".

Figure	235:	Catalogue	selection	for	Lookup

If	no	object	was	selected,	or	if	the	ID	Field	of	the	selected	object	is	empty,	you	are	prompted	to	enter	
text	for	the	search	(Figure	236).	You	can	type	one	or	more	search	terms,	separated	by	commas	on	
the	same	line,	or	using	multiple	lines.	Ranges	of	IDs	can	be	speciFied	using	"...",	e.g.	the	term	
"M56...71"	will	search	for	M56,	M57,	M58,...,	M70,	M71.

If	you	deFine	a	PreFix,	then	that	will	be	preFixed	to	each	search	item	(e.g.	if	you	are	searching	for	a	lot	
of	NGC	objects,	just	enter	the	object	numbers	and	make	the	preFix	"NGC").	Similarly	for	the	SufFix.

The	Recall	Last	button	will	set	the	text	to	the	last	lookup	you	performed,	if	applicable.

The	Double	Star	IDs	button	displays	a	list	of	well-known	and	historical	double	star	observer	IDs,	
and	also	shows	the	availability	of	double	star	observations	in	the	Washington	Double	Star	(WDS)	
catalogue	for	each	observer.

The	results	of	any	search	is	displayed	in	the	search	results	window
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Figure	236:	Item	selection	for	blank/unselected	Lookup

Figure	237:	Double	Star	IDs

The	Guides	widget	can	be	toggled	to	display	some	useful	aids	to	entering	ID	data	(Figure	238).	The	
left	hand	table	contains	the	symbols	of	the	Greek	alphabet.	Clicking	on	a	symbol	enters	the	2-	or	3-
character	abbreviation	for	that	symbol.	The	centre	table	lists	some	common	double-star	discoverer	
IDs.	Clicking	an	ID	will	enter	the	correct	alphabetic	preFix	as	used	in	the	WDS	catalogue	name	Field.

The	Constellation	abbreviation	popup	inserts	the	three-character	abbreviation	for	the	selected	
constellation.	Common	stars	lists	common	names	of	stars,	and	when	selected	will	insert	the	Bayer	
ID	or	SAO	ID	into	the	ID	Field.	Common	deep-sky	objects	lists	common	names	of	deep-sky	objects	
and	asterisms,	and	when	selected	will	insert	a	suitable	ID	for	searching	into	the	ID	Field.
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Figure	238:	Dialog	with	Guides	revealed

Lookup Synonyms
This	feature	searches	all	installed	catalogues	to	Find	all	objects	at,	or	very	close	to,	the	RA/Dec	coor-
dinates	of	the	selected	object.	Section	20.1.9	on	page	288	describes	the	preference	to	determine	
how	close	an	object	must	be	to	the	RA/Dec	coordinates	for	it	to	be	considered	synonymous.

Note	that	this	feature	ignores	the	ID	or	Type	of	the	object.	

This	is	a	convenient	way	to	Find	a	catalogue	object	if	you	don't	know	the	ID.
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Figure	239:	Lookup	Synonyms	results

Known synonyms using SIMBAD
A	dialog	will	appear	showing	the	known	synonyms	for	the	selected	object.	This	feature	looks	up	the	
ID	in	the	on-line	SIMBAD	database.	It	requires	on-line	Internet	access.

Figure	240:	Known	synonyms	using	SIMBAD

Find Closest Object
Find	the	closest	object	to	the	selected	object	in	the	object	list,	in	a	selected	catalogue.	To	be	consid-
ered,	any	found	object	must	be	within	a	search	radius	of	0.5°	(default)	from	the	selected	object.	The	
search	radius	can	be	increased	or	decreased	via	an	option	in	the	Object	List	preferences.
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Figure	241:	Select	catalogue	for	Find	Closest	Object

Search Catalogue/s
This	performs	the	same	catalogue	search	described	in	Section	10.1.3	on	page	79.

Search for Plans Containing
This	searches	a	given	folder	hierarchy	for	all	plan	documents	that	contain	a	given	search	term.

Figure	242:	Search	for	plans	containing	M1
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You	specify	the	search	term	to	look	for	in	a	plan	document	(in	the	example	here	it	is	"M1")

You	can	specify	which	plan	document	Fields	to	search	(in	the	example	here	just	the	ID	Field	is	
considered).

You	can	specify	whether	the	search	term	has	to	match	the	Field	exactly	(as	is	the	case	in	the	exam-
ple),	is	contained	in	the	Field,	etc.

You	specify	the	root	folder	to	start	the	search	in.	If	you	check	the	Recursive	search	checkbox	then	
the	folder	and	all	of	its	sub-folders	will	be	searched.

Click	the	Search	button	to	start	the	search.	While	the	search	proceeds,	any	plan	documents	found	
that	meet	the	search	criteria	will	be	added	to	the	list.

Once	the	search	is	complete,	you	can	select	a	plan	and	open	it	(Open	button),	reveal	it	in	the	Finder	
(Mac)	or	Windows	Explorer	(Windows)	using	the	Reveal	button,	or	delete	the	document	from	disk	
using	the	Delete...	button.

Find Objects within Radius
Searches	selected	catalogues	for	all	objects	within	a	given	angular	radius	of	the	selected	object.

Figure	243:	Find	objects	within	radius

11.6.2 Select Object
These	are	menu	items	to	navigate	through	the	object	list.	You'll	probably	never	use	them	(since	
clicking	with	a	mouse	or	using	the	arrow	keys	is	easier),	but	they	are	there	with	their	corresponding
keyboard	shortcuts	which	might	prove	useful.
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Figure	244:	Object	>	Select	Object	menu

Select First Object
Select	the	First	object	in	the	object	list.

Select Last Object
Select	the	last	object	in	the	object	list.

Select Next Object
Select	the	next	object	in	the	object	list,	unless	you	are	at	the	last	object.

Select Previous Object
Select	the	previous	object	in	the	object	list,	unless	you	are	at	the	First	object.

11.6.3 Associate
This	submenu	deals	with	object	associations.	This	process	is	explained	in	detail	in	Section	18.2	on	
page	275.

Figure	245:	Object	>	Associate	menu

Associate Selected Objects
If	more	than	one	object	is	selected,	then	associate	those	objects	together.

Disassociate Selected Object/s
If	one	or	more	objects	are	selected	and	one	or	more	of	them	is	part	of	an	association,	then	remove	
those	objects	from	any	associations.

11.6.4 Highlight
This	submenu	deals	with	object	highlighting.	This	process	is	explained	in	detail	in	Section	18.1	on	
page	271.

Figure	246:	Object	>	Highlight	menu

Toggle Forced Highlighting/Unhighlighting
If	the	selected	object	is	not	highlighted,	then	it	will	be	Force	Highlighted.	If	it	is	Force	Highlighted	
then	that	will	be	removed.

If	the	selected	object	is	highlighted,	then	it	will	be	Force	Unhighlighted.	If	it	is	Force	Unhighlighted	
then	that	will	be	removed	(and	it	will	revert	to	being	highlighted).
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Remove Any Forced Highlighting/Unhighlighting
Any	selected	objects	that	are	either	Force	Highlighted	or	Force	Unhighlighted	will	have	that	status	
removed.

Edit Custom Highlighting
Allows	you	to	edit	the	custom	highlighting	rules.	See	Section	18.1.3	on	page	272	for	more	details.

11.6.5 Slew to Object
If	the	selected	object	is	visible	(i.e.	not	below	the	horizon),	a	go-to	telescope	is	connected,	and	the	
object	coordinates	are	within	the	mount's	set	limits	(where	applicable),	then	this	will	slew	the	tele-
scope	to	the	object's	coordinates.	Performs	the	same	action	as	the	Slew	to	Object	button.

11.6.6 Sync to Object
If	the	selected	object	was	slewed	to,	this	will	sync	the	mount	to	the	object's	coordinates.	Performs	
the	same	action	as	the	Sync	to	Object	button.

11.6.7 Show Object Field of View
Switches	to	the	Field	of	View	tab,	and	redraws	the	chart	with	the	selected	object	centred.	Performs	
the	same	action	as	clicking	to	select	the	Field	of	View	tab	using	the	mouse.

11.6.8 Save Object Data to Text File
Saves	the	text	from	the	the	selected	object	to	a	text	File.	The	File	consists	of	one	line	per	column,	with	
the	column	heading	and	the	value	separated	by	a	comma.	e.g.
ID, M6
Name, Butterfly Cluster
Type, Open
RA, 17h 40m 20s
Dec, -32° 15.2'
Azimuth, 277.6°
Altitude, -52.7°
Rise, 9:04 PM
Transit, 11:42 PM
Set, 2:50 AM
ODM, 28x
Mag, 4.50
Size, 15
Const, Sco
Catalogue, Messier.apcat
HJD, +0.00532
Hr Angle, 08.978
Chart#, CDSA: 24a, MSA: V3-1416
SB, 19.0
PosAngle, 0
LOC, 0.0
Transit Date, 8/3/2011
Moon, 51°
Sun, 157°
Transit Alt, 10°
Notes, Rating:SU
Prob, > 98%

11.6.9 New Object
Creates	a	new	object	in	the	object	list.	Operates	the	same	as	clicking	the	button	under	the	object	list.	
See	Section	10.1.1	on	page	75	for	details.
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11.6.10 Delete Object/s
Deletes	the	selected	objects	from	the	object	list.

11.6.11 Duplicate Object/s
Makes	duplicates	of	the	selected	object	or	objects.	You	can	then	edit	those	duplicate	entries	
manually.

11.6.12 Change Epoch
All	AstroPlanner	objects	are	assumed	to	be	in	Epoch	J2000.0	RA/Dec	coordinates.	i.e.	the	coor-
dinates	that	they	would	have	had	on	1/1/2000.	This	is	a	common	epoch	and	you'll	Find	that	the	co-
ordinates	of	most	object	data	that	you'll	Find	on-line	or	in	books	are	from	this	epoch.	However,	oc-
casionally	you'll	Find	older	data	that	are	in	the	coordinate	system	from	another	epoch	(B1950	is	
relatively	common)	or	the	current	epoch	(JNow).	In	order	to	match	up	the	coordinates,	they	need	to	
be	precessed	to	the	J2000.0	epoch.	This	command	will	allow	you	to	do	that.

Figure	247:	Change	Epoch	dialog

You	can	choose	to	change	the	epoch	for	the	selected	objects	or	all	objects.	You	can	also	specify	to	
change	the	epoch	for	manually	entered	objects	only	(all	objects	in	AstroPlanner	catalogues	are	
J2000.0,	and	so	should	never	need	precessing	to	J2000.0).

11.6.13 Change Coordinates
If	you	want	to	change	the	RA/Dec	(Equatorial)	coordinates	of	an	object,	you	just	edit	in	the	new	
ones.	However,	if	you	have	coordinates	for	the	object	in	Ecliptic	or	Galactic	coordinates,	you	can	use	
this	convenient	feature	to	convert	the	coordinates	to	equatorial.

Figure	248:	Change	coordinates	dialog
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11.6.14 Refresh Objects from Catalogues
If	you	create	plan	objects	and	modify	them,	you	might	at	a	later	stage	wish	to	restore	one	or	more	of	
the	modiFied	Fields	from	the	original	catalogue	entries.	If	you	have	comet	or	minor	planet	objects	in	
your	plan,	you	might	wish	to	update	their	orbital	elements	from	the	latest	catalogues.

Object	>	Refresh	Objects	from	Catalogues...	allows	you	to	select	which	objects	you	want	to	update	
in	the	plan	document	and	which	Fields	are	to	be	updated/restored	to	the	catalogue	values.

In	the	event	that	the	original	catalogue	is	no	longer	available,	or	the	object	was	originally	added	
manually,	you	can	also	specify	what	to	do:	ignore	the	object,	Find	a	catalogue	containing	the	ID	of	the
object	and	use	that,	or	use	a	speciFic	catalogue	to	lookup	the	ID.

You	can	also	specify	if	you	want	to	update	any	comet	or	minor	planet	objects	found	in	the	plan.

Figure	249:	Refresh	objects	from	catalogues

11.6.15 Sort Objects
This	has	the	same	function	as	the	Sort	List	popup	(see	Section	11.2.13	on	page	110).

11.6.16 Cross-Reference Objects to ID
The	Object	>	Cross-Reference	Objects	to	ID	feature	allows	you	to	match	plan	objects	to	objects	in	a	
speciFied	catalogue,	and	to	replace	or	modify	one	or	more	Fields	of	the	plan	object	if	a	match	is	
found.	This	feature	is	useful	if	you	have	input	a	number	of	objects	where	you	only	know	the	ID	or	the
RA/Dec	coordinates,	and	would	like	to	replace	these	objects	with	"ofFicial"	ones	from	an	installed	
catalogue.	The	dialog	(Figure	250)	allows	control	over	this	process	using	the	following	options:

• Objects	to	process.	Select	the	objects	in	the	plan	to	which	you	would	like	to	apply	this	process.

• ID	to	cross-reference.	Select	the	object	ID	that	you	would	like	to	cross-reference	against.	The	
popup	menu	contains	all	know	IDs	in	the	installed	catalogues.	Then	select	the	particular	cata-
logue	you	would	like	to	compare	against	(containing	the	ID).

• Where	to	add	matched	ID.	When	a	match	is	found,	this	identiFies	the	object	Field	where	the	cat-
alogue	object	ID	should	be	placed.
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• Method	of	adding	matched	ID	to	existing	entry.	This	is	how	to	treat	that	catalogue	object	ID.	
You	can	replace	the	existing	Field,	or	prepend/append	the	ID	to	it.

• Assume	same	object	if.	How	to	match	the	plan	objects	with	the	catalogue	objects.	This	is	either	
by	position	(coordinate	matching),	or	by	comparing	the	IDs.

• Also	replace	these	Oields.	You	can	additionally	elect	to	replace	these	Fields	of	the	plan	object	
with	the	same	Fields	from	the	matched	catalogue	object.

Figure	250:	Cross-reference	Objects	to	ID	dialog

11.6.17 Eliminate Duplicates
The	Object	>	Eliminate	Duplicates	feature	looks	for	potential	duplicate	pairs	of	plan	objects	and	
allows	you	to	choose	which	ones	to	delete.	The	dialog	speciFies	a	minimum	separation	value.	Any	
pair	of	plan	objects	whose	coordinates	are	within	this	separation	distance	are	considered	as	candi-
dates	and	are	listed	in	the	dialog,	together	with	their	actual	separation	distance.
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Figure	251:	Eliminate	duplicates	dialog

Each	object	(listed	by	its	ID	and	Name)	has	a	checkbox	next	to	it.	Checking	that	checkbox	Flags	the	
object	for	deletion	(and	its	text	colour	is	set	to	red).	Clicking	the	Delete	Selected	Objects	button	will	
delete	any	checked	objects.

Note	that	if	you	have	three	or	more	duplicate	objects,	you	might	have	to	use	this	feature	more	than	
once	to	eliminate	all	of	the	duplicates.

11.6.18 Minimum Slew Order
Sort	the	object	list	in	such	an	order	as	to	minimise	the	total	slewing	distance	to	visit	each	object	in	
turn.	If	an	object	is	selected	in	the	list,	it	will	be	considered	to	be	the	First	in	the	sequence.	This	algo-
rithm	is	an	approximation	of	the	optimum	algorithm	(known	as	the	Travelling	Salesman	Problem),	
and	is	guaranteed	to	produce	a	sequence	that	is	2X	the	optimum	slewing	distance	or	less.

Figure	252:	Minimum	slew	order

The	dialog	allows	you	to	select	the	objects	to	include	in	the	sorted	sequence,	the	sort	method	(which
differs	for	different	mount	types),	and	whether	or	not	to	reorder	objects	within	any	associations	
(see	Section	18.2	on	page	275)	if	necessary.
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11.6.19 Statistics

Figure	253:	Statistics

Display	statistical	and	tabular	information	regarding	the	objects	in	your	plan	document.

11.6.20 Object Properties vs. Time
This	feature	lets	you	examine	various	dynamic	properties	of	an	object	over	a	period	of	time,	in	both	
chart	and	tabular	form.

To	get	these	charts/data,	select	one	or	more	objects	in	the	object	list,	and	choose	Object	>	Object	
Properties	vs.	Time	(also	available	in	the	object	list	right-click	menu).	This	opens	a	window	and	al-
lows	you	to	chart	and	tabulate	data	for	the	selected	object/s.

The	properties	are	all	"dynamic"	and	change	with	time.	You	can	choose	one	or	more	of	these	proper-
ties	using	the	check	list	at	the	top	left	of	the	window.	Currently,	these	properties	include:

• Air	Mass

• Altitude

• Apparent	Magnitude

• Azimuth

• Extinction

• Heliocentric	Julian	Date

• Hour	Angle

• Moon	Distance

• Observability

• Parallactic	Angle

• Sun	Distance
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• Visibility

Additionally,	if	any	of	the	objects	are	solar	system	objects	(e.g.	planets,	comets,	etc.)	then	the	follow-
ing	properties	are	also	available:

• Right	Ascension

• Declination

• Magnitude

• Ecliptic	Latitude

• Ecliptic	Longitude

Figure	254:	Object	properties	vs.	time	charts,	for	a	single	object

You	can	specify	a	time	period	from	a	start	local	date/time	to	an	end	local	date/time,	or	from	a	start	
local	date/time	for	a	given	period	in	seconds,	minutes,	hours,	or	days.	Specify	the	number	of	inter-
vals	you	desire	and	they	will	be	uniformly	spread	over	the	speciFied	time	period.	You	can	also	speci-
fy	the	units	in	the	time	(horizontal)	axis.
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For	each	checked	property,	a	small	chart	of	that	property	over	time	will	be	displayed	(Figure	254).	
Moving	the	cursor	over	a	chart	will	display	the	value	of	the	property	at	the	pointed-to	time,	at	the	
bottom	of	the	window.

These	charts	can	be	printed	(File	>	Print...).

The	tabular	data	can	be	displayed	in	the	Data	tab	(Figure	255).	Select	the	property	you	want	to	tabu-
late	using	the	Property	popup.	You	can	also	show	a	differences	(∆)	column	using	the	Show	differ-
ences	checkbox.	This	shows	the	difference	in	values	between	each	row	and	row	before	it.

Figure	255:	Object	properties	vs.	time	data,	for	a	single	object

If	more	than	one	object	is	selected,	there	will	be	multiple	lines	on	each	chart,	one	for	each	object,	to-
gether	with	a	suitable	legend.	Similarly,	the	tabular	data	will	have	one	column	for	each	object.	See	
Figures	below.
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Figure	256:	Object	properties	vs.	time	charts,	for	multiple	objects

Figure	257:	Object	properties	vs.	time	data,	for	multiple	objects
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11.6.21 Copy IDs
Edit	>	Copy	IDs	copies	the	ID	column	of	the	object	list	to	the	clipboard.	You	can	then	paste	it	into	a	
text	File	of	your	own	choosing.

11.6.22 Add User Image
You	can	use	the	Image	>	Add	User	Image...	command	to	associate	an	arbitrary	image	with	the	se-
lected	object	in	the	object	list.	If	you	know	the	image	centre	coordinates,	orientation,	and	the	scale	
of	the	image,	then	entering	those	values	will	allow	the	image	to	be	displayed	in	the	Field	of	view	
chart.

Figure	258:	Add	User	Image

11.7 Field of View functions
These	are	functions	that	act	on	the	Field	of	View	chart

11.7.1 Select Field of View to Include
Object	>	Select	Field	of	View	to	Include	selects	a	Field	of	view	size	and	centre	coordinates	to	include
the	selected	objects.	If	the	required	Field	of	view	required	is	greater	than	60°	then	this	feature	will	
not	work.

- 176 -



Figure	259:	Select	Field	of	view	to	include

11.7.2 Get Field of View Objects
Object	>	Get	Field	of	View	Objects	shows	the	plan	and	catalogue	objects	displayed	in	the	Field	of	
View	chart	as	a	table	of	objects	in	the	Search	Results	window.

Figure	260:	Field	of	View	objects

11.7.3 Show Constellation in Field of View
Set	the	Field	of	View	chart	to	show	the	selected	constellation	in	its	entirety.	Also	sets	the	stellar	
magnitude	to	a	suitable	"naked	eye"	limit	to	avoid	showing	too	many	stars.
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Figure	261:	Show	Constellation	in	Field	of	View
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12 Observations
12.1 Logging observations
Observations	are	logged	from	the	Observations	tab	on	the	plan	document	window.	This	is	described	
in	Section	11.3	on	page	113.

In	order	to	create	a	new	observation,	you	must	have	an	object	selected	in	the	object	list	(on	the	Ob-
jects	or	Observations	tab).	That	selected	object	will	be	the	one	for	which	the	observation	will	be	
logged.	To	create	a	new	observation,	use	one	of	the	following	methods:

• Click	the	New	Observation	button	under	the	object	list	on	the	Objects	tab.	This	switches	you	to	
the	Observations	tab	and	creates	a	new	observation.

• Click	the	+	button	under	the	Observations	list	at	the	bottom	left	of	the	Observations	tab.

• Right-click	the	object	in	the	object	list	and	select	New	Observation.

• Use	the	Observation	>	New	Observation	menu	command.

What	happens	next	depends	on	the	New	observation	date/time	source	setting	in	Observation	
preferences	(Section	20.9.1	on	page	309).	

If	the	setting	is	Computer	(or	Telescope),	then	the	logged	date/time	of	the	observation	is	set	to	the	
computer's	clock	(or	the	telescope	-	if	one	is	connected	and	the	date/time	can	be	retrieved	from	it).	
This	is	only	really	useful	if	you	are	logging	observations	in	"real	time"	while	you	are	actually	
observing.

If	the	setting	is	Ask	User,	then	you	are	asked	to	enter	the	date/time	of	the	observation	via	a	dialog.

Figure	262:	Observation	date/time	dialog

You	can	enter	the	local	date/time,	GMT/UT	(using	the	checkbox),	or	Julian	date.	You	can	also	click	
the	mouse	on	the	chart	at	the	top	of	the	dialog	to	enter	an	approximate	time.	

If	you	don't	have	a	date/time	for	the	observation	(e.g.	it's	an	old	observation	from	the	days	before	
you	logged	that	information),	you	can	click	the	No	Date/Time	button	to	mark	the	observation	as	
such.

The	observation	is	logged,	added	to	the	Observations	list,	and	you	can	now	add	the	details	in	the	
Fields	on	the	right	side	of	the	Observations	tab,	or	change	them	there	at	any	time	in	the	future.
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If	you	need	to	change	the	date	and/or	time	of	the	observation	in	the	future,	you	can	do	it	by:

• Select	the	observation	in	the	Observations	list	and	use	the	Observation	>	Change	Observation	
Date/Time...	menu	command.

• Right-click	the	observation	in	the	Observations	list	and	use	the	Edit	date/time	of	selected	ob-
servation	menu	command.

The	dialog	shown	above	is	presented	and	you	can	change	the	observation's	date	and/or	time.

12.1.1 Quick observations
Sometimes	you	just	want	to	log	that	an	observation	was	made	on	an	object,	without	worrying	about	
making	notes,	selecting	the	date/time,	noting	what	telescope	you	used,	etc.	This	is	a	"quick	observa-
tion",	and	consists	of	a	normal	observation,	using	the	current	local	time,	and	with	no	other	input.	
You	can	edit	the	other	stuff	in	later	if	you	wish.

To	make	a	quick	observation,	select	an	object	(or	more	than	one)	in	the	object	list	and	click	the	
Quick	Obs	button	under	the	object	list.	Alternatively	you	can	use	the	Observation	>	New	Quick	
Observation	menu	command,	or	right-click	the	object	list	and	use	Make	Quick	Observation.

Once	you	have	made	a	quick	observation,	the	Quick	Obs	button	changes	its	caption	to	Delete	Obs,	
which	offers	a	convenient	way	to	delete	the	last	quick	observation.	However,	after	two	minutes	it	re-
verts	back	to	Quick	Obs.	You	can	also	use	Observation	>	Delete	Last	Quick	Observation	to	delete	
the	last	quick	observation	you	made	on	the	selected	object	(this	menu	command	does	not	have	a	2	
minute	time	window).

12.2 Observation database
All	observations	and	observing	session	data	are	kept	in	a	central	observation	database.	You	can	view
and	manipulate	this	data	from	the	Observation	Database	window.	This	is	accessed	by	one	of	the	fol-
lowing	methods:

• Use	the	Observation	>	Show	Observation	Database	menu	command.

• Click	the	Show	Observation	Database	button	under	the	Observations	list	on	the	Observations	
tab	of	a	plan	document	window	(the	second	button	from	the	right).
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Figure	263:	Observation	database	window

The	following	sections	describe	the	functionality	of	this	window.

12.2.1 Sessions list
The	left	side	of	the	database	window	contains	the	Session	data.	At	the	top	left	is	the	Sessions	list,	
which	contains	a	list	of	observing	sessions	in	the	database.	The	columns	in	this	list	can	include1:

• Name.	The	name	given	to	the	session.	The	default	name	given	to	a	newly-created	session	is	
"ddddd	at	ttttt"	where	ddddd	is	the	date	and	ttttt	is	the	time	of	the	start	of	the	session.	You	can,	
however,	name	your	sessions	manually	as	you	please	(e.g.	"Vacaville,	Aug	23,	2012").

• Start.	The	start	date/time	of	the	session.

• Duration.	The	duration	of	the	session	in	hours	and	minutes.

• Obs.	The	number	of	observations	made	in	the	session.

• Site.	The	observing	site	name.

• User.	User-deFined	Field	values,	where	applicable.

• Observer.	The	observer	name.

• Transparency.	The	Transparency	value	for	the	session.

• Seeing.	The	Seeing	value	for	the	session.

• Plan/s.	The	plan	document/s	used	to	make	the	observations.

• Notes.	The	observing	notes	for	the	session.

1. See	Section	12.2.18	on	page	193	for	details	on	how	to	select	and	order	these	columns.
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Figure	264:	Sessions	list

The	+	button	under	the	list	creates	a	new	session	manually	(normally	this	is	done	for	you	automati-
cally	when	you	create	a	new	observation	that	isn't	in	an	existing	session).

Figure	265:	Create	observing	session	dialog

A	new	session	is	created	with	no	associated	observations.

The	–	button	deletes	the	selected	session/s,	and	all	associated	observations.	You	might	want	to	think
twice	before	clicking	Yes	in	the	subsequent	alert	dialog.

Figure	266:	Session	deletion

The	third	button	under	the	list	edits	the	selected	session.	See	Section	12.2.3	on	page	183	for	more	
information.

The	All	button	selects	all	of	the	sessions	in	the	list.

The	Find	Field	above	the	list	limits	the	visible	sessions	only	to	those	containing	the	given	search	
string	in	one	of	the	Fields.

Note	that	sessions	list	may	not	contain	all	sessions	in	the	database	if	there	are	session	restrictions	in
effect	(see	Section	12.2.15	on	page	189).
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12.2.2 Session data
When	a	single	session	is	selected	in	the	list,	its	data	are	summarised	in	the	Fields	below	the	list.	Note
that	you	are	not	able	to	edit	these	values	directly	-	see	the	section	below	on	how	to	edit	a	session's	
data.

Figure	267:	Session	data

12.2.3 Editing session data
To	edit	an	observation	session's	data,	select	the	session	in	the	sessions	list,	and	either

• Right-click	the	session	entry	in	the	list	and	choose	Edit	selected	session	item,	or

• Click	the	edit	button	under	the	list	(third	from	the	left).

The	session	edit	dialog	allows	you	to	change	various	data	for	that	session.	Any	changes	are	saved	
when	the	OK	button	is	clicked.	If	the	session	is	longer	than	it	should	be	(i.e.	has	excess	time	before	
the	First	observation,	or	after	the	last	observation,	the	Trim	Session	button	is	enabled,	and	using	it	
will	trim	off	that	excess	time.

If	you	choose	an	observation	other	than	the	First	or	last	in	the	list	of	observations,	you	can	use	the	
Split	Session	button	to	split	the	session	into	two	separate	sessions	at	that	observation	time.

Figure	268:	Session	edit	dialog
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12.2.4 Merging sessions
If	you	select	two	adjacent1	sessions	in	the	sessions	list,	you	can	merge	those	two	sessions	together	
into	a	single	session,	by	right-clicking	and	choosing	the	Merge	Sessions	menu	item.

12.2.5 Session find-and-replace
Right-clicking	the	sessions	list	and	choosing	Find	and	Replace...	allows	you	to	Find	and	replace	a	giv-
en	string	in	all	sessions	currently	displayed	in	the	sessions	list.	This	will	only	take	place	in	the	ses-
sion	Fields	that	you	specify.

Figure	269:	Session	Find-and-replace	dialog

12.2.6 Observations list

Figure	270:	Observations	list

The	observations	list	displays	observations	contained	in	whatever	sessions	are	currently	selected	in	
the	sessions	list.

Note	that	sessions	list	may	not	contain	all	sessions	in	the	database	if	there	are	session	restrictions	in
effect	(see	Section	12.2.15	on	page	189).

The	columns	in	this	list	can	include2:

1. adjacent	in	so	much	as	that	no	other	session	falls	between	them	in	time.

2. See	Section	12.2.18	on	page	193	for	details	on	how	to	select	and	order	these	columns.
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• ID.	Object	ID.

• Local	Date/Time.	Local	date	and	time	the	observation	was	made.

• UT/GMT.	The	UT	date	and	time	the	observation	was	made.

• Name.	Object	name.

• Type.	Object	type.

• R.A.	Object	right	ascension.

• Dec.	Object	declination.

• Telescope.	The	First	resource	combination	Telescope	entry.

• Eyepiece.	The	First	resource	combination	Eyepiece	entry	(if	applicable).

• Imager.	The	First	resource	combination	Imager	entry	(if	applicable).

• Filter.	The	First	resource	combination	Filter	entry	(if	applicable).

• Optical	Aid.	The	First	resource	combination	Optical	Aid	entry	(if	applicable).

• Rating.	The	First	resource	combination	Rating	entry	(if	applicable).

• Plan.	The	originating	plan	document	from	whence	this	observation	was	made.

• Const.	The	constellation	containing	the	object.

• #	Combos.	Number	of	resource	combinations	used	in	the	observation.

• Found.	Whether	or	not	the	object	was	found	during	the	observation.

• Notes.	Observation	notes.

• User.	Any	user-deFined	Field	values.

12.2.7 Observation data

Figure	271:	Observation	data

The	data	for	a	selected	observation	are	displayed	under	the	observations	list.	The	tabs	display	dif-
ferent	aspects	of	the	data.	Note	that	it	is	not	possible	to	edit	the	values	in	these	Fields,	apart	from	the
Table	tab.	To	edit	the	data,	see	the	next	section.

12.2.8 Editing observation data
Edit	an	observation	by	selecting	it	in	the	observations	list	and	either	right-clicking	and	selecting	
Edit	selected	observation,	or	clicking	the	edit	button	under	the	observations	list	(second	from	left).

The	dialog	lets	you	edit	most	aspects	of	the	observation,	including	the	date/time.
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Figure	272:	Observation	editing	dialog

12.2.9 Observation Tabular Data
A	table	of	data	can	be	attached	to	each	observation.	Such	tables	are	viewed	and	edited	in	the	Table	
tab	below	the	observation	list.	The	tables	can	have	as	many	columns	and	rows	as	you	like	(within	
reason).	This	feature	is	designed	for	more	advanced	applications,	and	has	full	scripting	support.

Initially	the	tables	are	undeFined.	You	must	deFine	at	least	one	table	column.	All	observation	tables	
share	the	same	columns,	but	each	observation's	table	row	data	is	unique	to	that	observation.

Figure	273:	Empty	observation	table

Edit	the	column	deFinitions	by	clicking	on	the	edit	button	at	the	bottom	right.
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Figure	274:	Edit	table	columns

You	specify	the	column	title,	the	type	of	data,	and	its	range	of	values	(if	appropriate).	Once	you've	set
up	the	columns,	you	can	use	the	+	button	to	add	rows	to	the	table	(or	use	scripting	to	do	the	job).

Figure	275:	Adding	data	to	an	observation	table

12.2.10 Select session
If	you	have	multiple	sessions	selected,	then	the	observations	list	will	contain	the	observations	asso-
ciated	with	those	selected	sessions.	If	you	select	an	observation,	right-click,	and	select	Select	ses-
sion	for	selected	observation,	then	only	the	session	that	contains	that	observation	will	be	selected	
in	the	sessions	list.

12.2.11 Known synonyms
The	observation	database	keeps	a	list	of	synonyms	for	each	observed	object.	If	you	select	an	obser-
vation,	right-click	and	select	Known	synonyms...,	a	dialog	will	appear	showing	the	known1	syn-
onyms	for	that	observed	object.

1. The set of known synonyms is dependent on the installed set of catalogues. More installed catalogues will give a wider set of
synonyms.	
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Figure	276:	Known	synonyms

12.2.12 Known synonyms using SIMBAD
If	you	select	an	observation,	right-click	and	select	Known	synonyms	using	SIMBAD...,	a	dialog	will	
appear	showing	the	known	synonyms	for	that	observed	object.	This	feature	looks	up	the	ID	in	the	
on-line	SIMBAD	database,	and	hence	gives	a	better	coverage	of	synonyms	than	the	above	feature.	It	
requires	on-line	Internet	access.

Figure	277:	Known	synonyms	using	SIMBAD

12.2.13 Merge selected observations of xxx
If	more	than	one	observation	is	selected	in	the	observations	list,	and	if	in	those	selected	observa-
tions,	two	or	more	observations	of	the	same	ID	in	the	same	session	exist,	then	you	will	be	given	the	
opportunity	of	merging	those	observations	into	a	single	observation.

This	can	be	useful	for	observations	made	using	AstroPlanner	V1,	where	the	lack	of	multiple	re-
source	combinations	meant	multiple	observations	of	an	object	were	required	if	more	than	one	eye-
piece,	telescope,	etc.	was	used.	

12.2.14 Observation find-and-replace
Right-clicking	the	observations	list	and	choosing	Find	and	Replace...	allows	you	to	Find	and	replace	
a	given	string	in	all	observations	currently	displayed	in	the	observations	list.	This	will	only	take	
place	in	the	observation	Fields	that	you	specify.
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Figure	278:	Observation	Find-and-replace	dialog

12.2.15 List restrictions
Normally,	the	sessions	list	displays	all	the	sessions	present	in	the	database,	and	the	observations	list	
displays	all	the	observations	associated	with	selected	sessions.	You	can	use	the	restrictions	widget	
below	the	observations	list	to	restrict	what	sessions	and/or	observations	are	shown.

Figure	279:	List	restrictions

The	widget	is	divided	into	two	sections,	one	for	Sessions	and	the	other	for	Observations.	If	the	
checkbox	next	to	any	restriction	is	checked	then	displayed	sessions/observations	will	be	limited	to	
those	that	pass	the	checked	restrictions.

For	example,	in	Figure	279,	only	observations	that	contain	"Phantom"	in	their	Name	Field	will	be	
displayed.

Note	that	the	heading	of	each	section	is	highlighted	in	red	if	any	restrictions	are	checked	as	a	
warning	(so	that	you	don't	think	that	observations	have	mysteriously	gone	missing	when	they	are	
just	not	being	displayed).
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12.2.16 Location chart

Figure	280:	Observation	database	window	Location	Chart

The	Location	chart	is	located	on	a	separate	tab	of	the	database	window.	It	shows	the	location	of	the	
displayed	observations	on	a	whole-sky	map.	Additionally,	any	selected	observations	are	circled	in	
red.	You	can	double-click	an	observed	object	on	the	chart	and	the	associated	record	will	be	selected	
in	the	observations	list.

12.2.17 Statistics
The	Statistics	tab	shows	one	or	more	tables	and	pie	charts	of	statistics	related	to	the	observations	in
your	observation	database.	The	window	can	have	up	to	3	x	3	independent	table/charts,	automatical-
ly	determined	by	the	size	of	the	window	(Figure	282).
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Figure	281:	Statistics	tab

Above	each	table/chart	are	three	popup	menus	that	control	what	is	displayed.	The	First	determines	
what	observations	are	to	be	used:	

• All.	All	observations	in	the	database.

• Displayed.	Only	the	observations	currently	being	displayed	in	the	Observations	tab.

• Selected.		Only	the	observations	currently	selected	in	the	list	in	the	Observations	tab.	

The	second	popup	determines	the	observation	parameter	to	use	to	summarise	the	statistics	values:

• Constellation.

• Day	of	Week.

• Eyepiece.

• Filter.

• Found.

• Hour	of	Day.

• ID.

• Imager.

• Month.
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• Object	Type.

• Observer.

• Optical	Aid.

• Plan	File.

• Rating.

• Seeing.

• Site.

• Telescope.

• Transparency.

• Year.

The	third	popup	determines	the	period	over	which	observations	are	to	be	included:

• All	time.

• This	year.

• Last	year.

• This	month.

• Last	month.

• xxxx,	where	xxxx	is	each	year	for	which	observations	were	made.	e.g.	2000,	2001,	etc.

The	tables	represent	the	different	values	of	the	parameter,	the	number	of	observations,	and	the	per-
centage	of	the	total,	in	descending	order.

The	pie	chart	is	a	graphical	depiction	of	the	First	12	rows	of	the	table,	and	a	13th	"slice"	representing
the	rest	of	the	table's	rows	combined.

At	the	bottom	of	the	tab	are	some	settings	that	alter	the	table	contents	and/or	the	pie	charts:

• Include	Counts	in	labels.	The	contents	of	the	#	Obs	column	is	included	in	the	pie	"slice"	labels.

• Include	Percentages	in	labels.		The	contents	of	the	%	column	is	included	in	the	pie	"slice"	labels.

• Combine	observations	of	the	same	object.	Observations	of	the	same	object	are	counted	as	one.

• Font.	Customise	the	font	and	size	used	in	the	pie	charts.
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Figure	282:	Statistics	tab	in	a	larger	window,	show	2	x	2	table/charts

12.2.18 Settings
The	Settings	tab	allows	you	to	set	up	some	observation	database	options.

Sessions list columns
Choose	what	columns	you	want	to	see	in	the	Sessions	list	(by	checking	or	unchecking	the	checkbox-
es),	and	drag	the	entries	to	determine	the	order	of	the	columns.	Note	that	the	"User"	entry	repre-
sents	any	user-deFined	session	Fields	(and	hence	might	consist	or	zero	or	more	columns).

Observations list columns
Choose	what	columns	you	want	to	see	in	the	Observations	list	(by	checking	or	unchecking	the	
checkboxes),	and	drag	the	entries	to	determine	the	order	of	the	columns.	Note	that	the	"User"	entry	
represents	any	user-deFined	observation	Fields	(and	hence	might	consist	or	zero	or	more	columns).

Synonyms
Sometimes	the	application	fails	to	realise	that	two	IDs	are	in	fact	synonymous	(i.e.	they	represent	
the	same	object	in	two	different	catalogues).	You	can	"force"	two	IDs	to	be	synonymous	by	listing	
then	here	as	pairs	of	comma-separated	IDs.

Non-synonyms
Sometimes	the	application	believes	that	two	IDs	are	synonymous	(i.e.	they	represent	the	same	ob-
ject	in	two	different	catalogues),	when	they	are	not	actual	synonyms.	This	can	happen	if	catalogues	
have	errors,	or	IDs	are	duplicated.	You	can	"force"	two	IDs	to	be	non-synonymous	by	listing	then	
here	as	pairs	of	comma-separated	IDs.
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Figure	283:	Observation	database	window	Settings

12.2.19 Printing
You	can	print	your	object	database	(or	subsets	thereof)	using	the	File	>	Print...	menu	command.	
This	is	covered	in	the	Printing	chapter	(Section	15.6	on	page	242).

- 194 -



13 Controlling a computerised 
telescope

AstroPlanner	allows	for	the	connection	and	control	of	many	popular	types	of	computerised	tele-
scope	mounts.	These	can	be	digital	setting	circle	(DSC)	mount	controllers	(the	computer	can	only	
read	the	current	pointing	coordinates	of	the	telescope),		or	Go-to	mounts	(the	computer	can	both	
read	the	current	pointing	coordinates	of	the	telescope,	and	command	the	mount	to	slew	the	tele-
scope	to	given	coordinates).

Each	Telescope	resource	(see	Section	9.2.3	on	page	58)	can	specify	a	computerised	mount,	which	
can	be	conFigured	to	suit.

13.1 Choosing a mount type
With	your	Resources	window	open	(Edit	>	Resources...)	and	telescope	selected	in	the	Telescope	tab,
use	the	Computerised	Mount	popup	menu	to	select	the	mount.

Figure	284:	Computerised	mount	popup	menu
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All	of	the	mounts	listed	are	supported	on	both	Mac	and	Windows	(apart	from	ASCOM,	which	will	
only	appear	in	Windows).	Of	special	interest	are	the	two	AstroPlanner	Emulated	mounts,	which	con-
trol	internally	"simulated"	telescopes,	and	which	can	be	used	for	testing	or	practice	purposes	if	a	
real	mount	is	not	available	(see	Section	13.11	on	page	211).	The	AstroPlanner	scripted	mount	uses	a
script	to	control	the	mount	(see	Section	#.#	on	page	#).

At	the	bottom	of	the	menu	is	Auto-Detect....	This	option	can	be	used	to	Find	any	connected	tele-
scopes	and	attempt	to	determine	what	kind	of	mount	is	connected.	This	is	done	by	scanning	each	
known	serial	port	and	attempting	to	get	an	expected	response	for	each	type	of	known	telescope	
mount	(not	for	ASCOM	however).

The	Auto-Detect	dialog	allows	you	to	select	the	serial	ports	(and/or	SkyFi/StarSeek	adapter)	to	
scan,	and	the	expected	type/s	of	telescope	to	check	for.	If	you're	not	sure,	check	as	many	as	you	like,	
understanding	that	it	might	take	a	while	to	check	for	and	Find	the	correct	one.

Note:	If	you	plug	in	a	USB-to-serial	adapter	then	you	might	have	to	use	the	Refresh	button	(just	to	
the	right	of	the	Serial	ports	checkbox)	in	order	to	Find	the	serial	port.

Figure	285:	Auto-Detect	dialog

The	application	scans	the	speciFied	serial	ports	until	a	telescope	mount	responds	correctly.		The	tele-
scope	mount	type	(or	types	if	the	algorithm	cannot	disambiguate	more	than	one	possible	mount	
type)	is	displayed	in	a	dialog	(e.g.	Figure	286),	and	lets	you	choose.	If	the	chosen	mount	(or	mounts)	
is	incorrect,	you	can	click	the	Ignore	and	Keep	Looking	button	to	continue	scanning	and	checking	
for	other	mounts	and/or	other	serial	ports.
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Figure	286:	Choose	mount	dialog

13.2 Configuration
Once	the	mount	type	is	selected,	you	will	need	to	conFigure	the	software	for	your	particular	mount.	
This	is	done	by	clicking	the	Edit...	button	next	to	the	Computerised	Mount	popup	for	the	Telescope	
resource.

Figure	287:	Mount	parameters	edit	dialog
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For	most	mounts,	a	serial	port	is	required,	and	that	is	selected	via	the	Serial	port	popup	at	the	top	
left.	If	a	choice	of	bit	rates	is	allowed,	the	Bit	Rate	popup	will	be	enabled.

The	list	below	contains	a	number	of	conFigurable	parameters.	Some	of	those	common	to	most	
mount	types	are	listed	below.	Clicking/selecting	a	parameter	allows	you	to	edit	its	value,	where	
applicable.

		

13.2.1 Miscellaneous
• Show	data	Olow	to	and	from	telescope.	When	you	connect	a	telescope,	a	window	opens	and	
shows	all	the	data	trafFic	to	and	from	the	mount.	This	is	often	useful	for	troubleshooting	connec-
tions.	The	window	is	closed	when	you	disconnect.	The	window	has	a	checkbox	which,	when	
checked,	will	log	the	window's	data	and	any	subsequent	data	to	a	log	File.	The	Action	column	is	
the	action	requested	by	the	computer.	The	To	Telescope	column	is	the	actual	text	command	sent
to	the	telescope	mount.	The	From	Telescope	column	is	the	actual	response	text	received	back	
from	the	mount	(where	applicable).	The	Result	column	is	the	interpreted	value	or	meaning	of	
the	response	from	the	mount	(where	applicable).

Figure	288:	Data	Flow	window

• Log	data	Olow	to	a	text	Oile	on	the	desktop.	Similar	to	the	above,	but	the	trafFic	data	is	automat-
ically	logged	to	a	text	File	on	your	desktop	(with	the	same	name	as	your	telescope	resource).	You	
can	choose	to	overwrite	any	existing	log	File,	append	to	the	existing	log	File,	or	create	a	new	File	
each	time	you	connect	(in	which	case,	the	Files	will	be	numbered).

• Show	telescope	"mimic"	window.	Displays	a	small	window	(Figure	289)	that	shows	the	cur-
rent	pointing	coordinates	of	the	telescope.	Useful	if	your	telescope	is	remote	from	your	comput-
er.	Emulated	mounts	also	display	this	window.	If	your	current	Site	has	a	user	horizon	deFined,	it	
will	be	displayed.
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• Show	telescope	control	palette	after	connecting.	Shows	the	telescope	control	palette	(see	
Section	13.8	on	page	204)	when	you	connect.	Otherwise	the	control	palette	remains	hidden	until
requested	(Telescope	>	Telescope	Control	Palette).

• Leave	serial	port	open	when	disconnecting.	Normally,	when	the	telescope	is	disconnected,	the
serial	port	is	closed.	This	option	allows	the	serial	port	to	remain	open	when	the	telescope	is	dis-
connected,	and	re-used	when	the	telescope	is	reconnected.	This	might	avoid	some	delays	with	
certain	serial	ports	(e.g.	Bluetooth)	that	take	some	time	to	connect	and	open	each	time.

• Use	WiFi-to-Serial	adapter.	If	you	are	using	a	SkyFi,	StarSeek,	Nexus,	or	other	WiFi-to-Serial	
adapter,	then	select	this	option.	If	the	IP#/port	for	the	unit	has	been	changed	from	the	default,	
you	can	specify	it	here.

• WiFi-to-Serial	adapter	address.	The	IP	number	and	port	for	the	WiFi-to-Serial	adapter.

• Hardware/software	Olow	control.	You	can	choose	XON/XOFF	and/or	Data	Terminal	Ready	
(DTR)	Flow	control	if	your	telescope	mount	demands	it	(this	will	rarely	be	required).

Figure	289:	Telescope	"mimic"	window

13.2.2 Commands
• Minimum	time	between	commands.	The	computer	issues	various	commands	to	the	mount.	
Some	mounts	cannot	take	more	than	a	maximum	number	of	commands	per	second.	This	setting	
allows	you	to	specify	a	minimum	time	to	wait	between	issuing	commands.

• Do	not	check	mount	type	when	connecting.	The	computer	typically	checks	to	make	sure	that	
the	correct	type	of	mount	is	connected	before	continuing	on	and	communicating	with	it.	This	op-
tion	will	avoid	doing	that	check	and	assume	that	the	mount	is	correct.	This	can	be	of	use	if	you	
are,	say,	using	the	LX200	Classic	mount	protocol	with	a	non-LX200	Classic	mount,	that	might	not	
support	the	commands	that	the	LX200	mount	driver	uses	for	recognition.

• Set	Site	after	connecting.	After	connecting	the	telescope,	send	the	site	information	for	the	cur-
rent	site	(latitude,	longitude,	GMT	offset)	to	the	telescope	mount,	if	supported.

• Set	Date	after	connecting.	After	connecting	the	telescope,	send	the	local	date	to	the	telescope	
mount,	if	supported.

• Set	Time	after	connecting.	After	connecting	the	telescope,	send	the	local	time	to	the	telescope	
mount,	if	supported.

• Start	tracking	after	connecting.	If	the	mount	allows	tracking	to	be	set	on	and	off,	this	will	force	
the	mount	to	start	tracking	when	you	connect.

• Beep	when	connection	made.	Beep	the	computer	when	connection	is	made.
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• Number	of	connection	attempts.	Sometimes	it	might	require	more	than	one	attempt	to	
connect	to	the	telescope	mount.	This	speciFies	the	maximum	number	of	attempts	to	make	before	
giving	up.

13.2.3 Coordinates
• Minimum	coordinate	acquisition	rate.	Minimum	time	between	asking	the	mount	for	its	cur-
rent	RA/Dec	coordinates.	The	lower	this	value,	the	more	often	the	mount	is	interrogated,	which	
can	slow	down	operation	of	the	application.

• Convert	coordinates	between	J2000.0	and	current	epoch.	Normally	the	computer	assumes	
the	telescope	uses	epoch	J2000.0	coordinates.	If	your	telescope	requires	coordinates	in	the	cur-
rent	epoch	(JNow),	then	use	this	option.	Very	few	telescopes	have	accurate	enough	pointing	that	
this	makes	much	difference	in	practice.

• Use	controller's	internal	database	where	possible.	Some	mounts	have	an	internal	database	of
objects	that	can	be	accessed	via	the	computer.	If	so,	use	this	option.	It	is	recommended	that	you	
don't	use	this	option.

13.2.4 Slewing and Movement
• Maximum	Slew	Rate.	If	your	mount	allows,	you	can	set	the	maximum	slew	rate	(°/sec)	for	Go-to
operations.

• Timeout.	When	slewing,	if	the	mount	does	not	report	back	that	it	has	completed	the	slew	within
this	time,	it	will	report	a	timeout	error.	For	mounts	with	slow	slewing,	you	might	need	to	bump	
this	up.

• Minimum	wait	time	between	consecutive	slews.	Some	mounts	can	get	confused,	or	even	dam-
aged,	if	a	slew	is	started	before	the	current	slew	has	completed,	or	for	a	short	settling	time	after-
wards.	This	option	sets	that	required	settling	time.

• Slew	accuracy	(to	determine	completion).	Some	mounts	report	when	a	slew	is	complete	and	
some	do	not.	In	order	to	ascertain	that	the	slew	has	completed,	the	computer	asks	the	mount	for	
its	current	pointing	coordinates,	and	if	they	are	within	this	angular	distance	of	the	target,	the	
slew	is	assumed	to	have	Finished.

• After	initiating	slew,	issue	no	commands	for	at	least	n	seconds.	Some	mounts	do	not	like	any
commands	to	be	issued	after	a	slew	has	started.	This	will	make	sure	that	no	commands	are	is-
sued	before	a	speciFied	time	has	passed.

• Do	not	use	controller's	method	to	determine	end-of-slew.	For	mounts	that	have	a	special	
command	to	determine	if	the	telescope	is	currently	slewing,	this	will	override	that	method	
(which	can	sometimes	be	unreliable),	and	use	the	comparison	of	pointing	coordinates	to	deter-
mine	slew	completion	instead.

• Switch	E/W	motion.	When	using	the	E/W	movement	buttons	in	the	control	palette,	this	option	
swaps	the	button	actions	around.

• Switch	N/S	motion.	When	using	the	N/S	movement	buttons	in	the	control	palette,	this	option	
swaps	the	button	actions	around.

• Home	Azimuth.	SpeciFies	the	azimuth	of	the	Home	position	for	the	mount.

• Home	Altitude.	SpeciFies	the	altitude	of	the	Home	position	for	the	mount.
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13.2.5 Digital Setting Circles
• Mount	Type.	For	digital	setting	circle	(DSC)	mount	controllers,	this	speciFies	the	type	of	mount	
in	use.

13.2.6 Script
• Driver	Script.	If	your	mount	is	using	a	scripted	driver	(see	Section	27.10	on	page	377),	then	this	
option	speciFies	the	script	to	use.

13.3 ASCOM configuration
(Windows	only)	If	you	want	to	use	an	ASCOM	driver	to	control	your	telescope	mount,	choose	"AS-
COM:	ASCOM	Driver"	as	your	Computerised	Mount	type.	Edit	the	mount	(Edit...	button).	

Click	the	ASCOM	ConLigure...	button	to	select	the	particular	driver	you	want	to	use,	and	conFigure	its
properties	(serial	port,	etc.).

Figure	290:	ASCOM	mount	-	before	selecting	driver	type
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Figure	291:	Selecting	the	ASCOM	telescope	type

Figure	292:	ASCOM	Mount	-	after	selecting	driver	type

You	can	also	use	the	Capabilities...	button	to	examine	the	capabilities	available	for	that	mount	(not	
all	of	which	might	be	available	to	you	in	AstroPlanner).

Figure	293:	ASCOM	Capabilities
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NOTE:	It	would	seem	that	in	order	to	connect	AstroPlanner	to	a	shared	ASCOM	mount	via	the	ASCOM	
POTH	feature,	AstroPlanner	must	be	run	in	Administrator	mode.	To	do	this,	right-click	on	the	applica-
tion	icon,	or	a	shortcut	to	the	application,	and	choose	Run	as	administrator.	You	may	only	have	to	do	
this	once.

13.4 Connecting & disconnecting
To	connect	to	a	telescope,	use	the	Connect	to	telescope	checkbox	on	a	plan	document	window.

Figure	294:	Telescope:	disconnected	(left),	connecting	(middle),	connected	(right)

If	another	plan	window	is	connected	to	the	same	telescope,	the	two	windows	will	share	the	
connection.

Uncheck	the	Connected	to	telescope	checkbox	to	disconnect.

13.5 Slewing
In	order	to	slew	the	connected	go-to	telescope	to	a	target,	that	target	must	be	above	the	(theoreti-
cal)	horizon	(i.e.	have	an	altitude	>	0°),	and	must	be	within	any	set	slewing	limits	for	that	telescope	
mount.

Slewing	to	a	given	target	can	be	done	from	various	places	in	the	application:

• Slew	to	Object	button	on	plan	window.

• Object	>	Slew	to	Object	menu	command.

• Right-click	object	list	and	use	Slew	to	Object.

• Right-click	Field	of	view	chart	and	use	Slew	to	cursor	position.

• Right-click	sky	chart	and	use	Slew	to....

• Choose	a	visible	alignment	star	in	the	list	on	the	Sky	tab	and	click	Slew	to	Star.

• Use	the	Slew	To	popup	underneath	the	object	list.

• Slew	to	Object	button	in	a	catalogue	display	window.

• Slew	to	Object	button	in	a	search	results	window.

Typically,	there	is	a	progress	bar	that	shows	you	how	far	the	slew	has	progressed,	and	the	Slew	To	
button	typically	changes	to	an	Abort	Slew	button	while	the	slew	is	taking	place	(if	the	telescope	al-
lows	for	the	aborting	of	a	slew	operation).

After	slewing,	the	ID	of	the	object	that	was	the	target	of	the	slew	is	reported	just	below	the	Slew	
button.

13.6 Syncing
Some	telescope	mounts	allow	you	to	"sync"	the	controller	of	a	go-to	telescope	mount	to	the	current	
position.	i.e.	you	slew	to	a	known	position,	but	the	mount	needs	to	be	moved	slightly	using	arrow	
buttons	to	line	up	the	known	object	position	with	the	centre	of	the	Field	of	view.	The	sync	operation	
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will	tell	the	controller	to	adjust	its	alignment	parameters	to	match	the	coordinates.	This	typically	
makes	slewing	more	accurate,	at	least	in	the	vicinity	of	the	sync	coordinates.

In	AstroPlanner,	there	is	a	Sync	to	Object	button	in	the	telescope	section	of	the	plan	document	win-
dow.	After	slewing,	and	adjusting	the	pointing	of	the	telescope	with	the	hand	controller,	you	can	
click	the	button	to	perform	the	sync	operation.

Figure	295:	Sync	to	Object

Syncing	is	also	used	in	other	telescope-related	features	such	as	high-precision	slewing	(Section	13.9	
on	page	208),	iterative	polar	alignment	(Section	14.1	on	page	219),	and	in	the	telescope	control	
palette	(Section	13.8.1	on	page	204).

13.7 Tracking
If	the	telescope	mount	allows	you	to	turn	tracking	on	and	off,	then	you	can	toggle	this	using	Tele-
scope	>	Toggle	Tracking.

13.8 Control palette
The	telescope	control	palette	is	a	small	Floating	window	that	allows	direct	control	over	several	go-to	
telescope	mount	features	(if	they	are	implemented	by	the	telescope	mount	and	its	associated	proto-
col).	The	palette	is	available	when	the	telescope	is	connected	via	the	Telescope	>	Telescope	Control	
Palette	menu	command.	It	can	also	be	automatically	opened	via	the	appropriate	mount	option	(see	
Section	13.2.1	on	page	198).	The	palette	closes	automatically	when	the	telescope	is	disconnected.

The	palette	window	has	multiple	tabs,	each	one	covering	various	features	of	the	telescope.

13.8.1 Motion
This	tab	contains	controls	pertaining	to	telescope	motion	and	slewing.

Figure	296:	Telescope	control	palette:	Motion

The	N,	E,	W,	S	buttons	allow	the	mount	to	be	moved	in	the	four	directions.	The	round	button	in	the	
centre	reveals	a	popup	menu	when	clicked.	This	menu	allows	you	to	select	the	rate	of	motion	when	
the	direction	buttons	are	used	(which	is	mount-dependent,	but	is	typically	guide	speed	(2x	sidere-
al),	centre	speed,	Find	speed,	and	slew	speed).	You	can	also	set	how	the	direction	buttons	operate:

• Momentary.	The	motion	occurs	as	long	as	the	button	is	held	down.
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• Toggle	on/off.	One	click	of	the	button	starts	the	motion.	A	second	click	stops	the	motion.

• Fixed	duration.	Clicking	a	direction	button	starts	motion	in	the	given	direction	for	a	Fixed	
amount	of	time,	after	which	the	motion	stops.	The	Option...	menu	entry	allows	you	to	change	the
duration.

Figure	297:	Motion	popup	menu

Figure	298:	Motion	control	options

The	Slew	to	Home	button	will	slew	the	telescope	to	the	home	position	(either	speciFied	as	a	mount	
option,	or	Fixed	for	the	mount	type)	and	disconnects	the	telescope	from	AstroPlanner.

The	Park	button,	if	implemented,	will	park	the	telescope.	The	Set	Park	button	will	set	the	park	posi-
tion	to	the	current	Alt/Az	position	of	the	telescope.

The	Sync	button	does	a	sync	operation.

The	Sleep	button	puts	the	scope	to	sleep	(typically	ththis	puts	the	mount	in	a	low-	or	no-power	
mode	from	which	it	can	be	woken	without	losing	its	alignment).	The	Wake	button	wakes	up	a	previ-
ously-sleeping	mount.

The	PEC	(Periodic	Error	Correction)	controls	allow	you	switch	PEC	on	or	off,	and	where	applicable,	
to	select	whether	RA	PEC,	Dec	PEC,	or	both	are	enabled.

13.8.2 Focus
This	tab	contains	controls	pertaining	to	telescope	focusing	(some	mounts	allow	you	to	plug	in	an	
electronic	focuser,	or	have	one	built-in	as	part	of	the	mount/OTA).

The	In	and	Out	buttons	control	the	focuser,	moving	the	focus	either	in	or	out.	This	motion	is	con-
trolled	by	the	popup	to	the	right:

• Momentary.	The	focus	motion	occurs	as	long	as	the	In	or	Out	button	is	held	down.

• Toggle	on/off.	One	click	of	the	In	or	Out	button	starts	the	motion.	A	second	click	stops	the	
motion.
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• Fixed	duration.	Clicking	the	In	or	Out	button	starts	motion	in	the	given	direction	for	a	speciFied	
Fixed	amount	of	time,	after	which	the	motion	stops.

Figure	299:	Telescope	control	palette:	Focus

The	Focus	Speed	(where	applicable)	allows	you	to	select	the	speed	of	the	focuser	motor.

If	your	mount	allows	it,	you	can	use	the	Focus	Presets	controls	to	set	one	or	more	preset	focuser	
positions.	You	set	a	preset	by	selecting	the	preset	number	in	the	Preset	popup	and	clicking	the	De-
Line	button.	To	move	the	focus	to	a	preset	position	select	the	preset	number	in	the	Preset	popup	
and	click	the	Use	button.

The	Collimation	buttons,	where	applicable	will	move	the	collimation	motors	for	the	speciFied	
sector.

13.8.3 Reticle
This	tab	contains	controls	pertaining	to	illuminated	reticle	eyepiece	control	(some	mounts	allow	
you	to	plug	in	an	eyepiece	with	an	externally-powered	illuminated	reticle).

Figure	300:	Telescope	control	palette:		Reticle

The	Brightness	control	adjusts	the	reticle	illumination	up	or	down.	The	Flash	Rate	allows	you	to	
specify	the	rate	at	which	the	illumination	LEDs	are	turned	on	and	off.	The	Duty	Cycle	adjusts	the	
proportional	on/off	time	of	the	illuminator.

13.8.4 Tracking
This	tab	contains	controls	pertaining	to	telescope	mount	tracking	(the	motion	used	to	track	the	
stars,	etc.	when	the	telescope	is	not	slewing).

Where	applicable,	the	tracking	can	be	turned	On	or	Off.	The	Tracking	Rate	allows	you	to	specify	the
rate	at	which	the	tracking	motion	occurs:

• Sidereal.	The	tracking	rate	to	keep	the	stars	stationary.
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• Solar.		The	tracking	rate	to	keep	the	sun	stationary.

• Lunar.		The	tracking	rate	to	keep	the	moon	stationary.

• Manually	increment.	Increment/decrement	the	current	rate.

• Manual	rate.	Set	the	current	rate	to	a	Fixed	value.	The	rate	is	measured	in	Hz.	60Hz	will	move	
the	scope	such	that	it	makes	one	complete	revolution	of	the	sky	in	24	hours.	Sidereal	rate	is	
slightly	fast	(typically	60.1Hz).

Figure	301:	Telescope	control	palette:	Tracking

13.8.5 Heat
This	tab	contains	controls	pertaining	to	controlling	telescope	heaters,	where	applicable.

Figure	302:	Telescope	control	palette:	Heat

The	Corrector	Plate	Heater	setting	speciFies	the	amount	of	heating	(as	a	percentage	of	full	power)	
to	apply	to	the	corrector	plate	on	Schmidt-	or	Maksutov-type		telescopes.

The	Corrector	Plate	Temperature	and	OTA	Temperature	can	be	measured	and	displayed	by	click-
ing	the	relevant	Get	button.

13.8.6 Advanced
This	tab	contains	controls	pertaining	to	controlling	advanced	telescope	features,	available	on	some	
mounts.

The	telescope	Tube	exhaust	fan	can	be	turned	On	or	Off.

The	De-rotator	on	some	Alt/Az	mounted	telescopes	can	be	turned	On	or	Off.

Power	Reset	will	(effectively)	cycle	the	power	to	the	mount,	causing	it	to	restart.

Start	Alignment	will	start	or	restart	the	telescope	alignment	procedure.

The	Anti-backlash	settings	can	be	changed	for	the	two	rotational	axes.
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12V	Panel	Power	(for	accessories)	can	be	switched	On	or	Off.

Figure	303:	Telescope	control	palette:	Advanced

13.9 High-precision slewing
When	you	slew	a	go-to	telescope	to	given	coordinates,	the	precision	of	that	slew	to	the	actual	sky	co-
ordinates	is	dependent	on	how	well	the	mount	was	aligned	initially,	the	orthogonality	of	the	mount	
axes,	and	several	other	parameters.	Typically,	the	alignment	algorithm	is	accurate	only	for	small	an-
gular	distances	across	the	sky.	If	you	make	a	large	slew,	the	precision	of	the	slew	drops	off.

This	can	be	a	problem	if	you	are,	for	example,	slewing	to	a	dim	object	which	might	be	difFicult	to	Find
unless	the	slew	is	spot	on.	If	you	are	slewing	remotely,	with	an	imager	attached	to	the	telescope,	this	
can	also	be	problematic.

However,	some	mounts	allow	a	sync	operation	that	corrects	the	local	alignment	(in	and	around	the	
current	pointing	coordinates).	This	can	be	used	to	improve	the	precision	of	a	slew	by	doing	the	
following:

• Slew	to	a	known	bright	object	(a	bright	star)	fairly	close	to	the	target	object.

• Centre	the	bright	object	in	the	eyepiece	(or	imager)	using	movement	commands.

• Do	a	sync	operation	to	improve	the	slew	precision	in	the	vicinity	of	the	bright	object.

• Do	a	slew	to	the	target	object,	which	should	then	be	pretty	close	to	the	centre	of	the	eyepiece/
imager.

This	can	also	be	improved	for	very	long	slews	(from	one	side	of	the	sky	to	the	other),	by	repeating	
the	First	three	steps	with	smaller	slews	(say	10°	at	a	time)	until	you're	close	enough	to	the	target,	
and	then	do	the	Final	step.

The	high-precision	slew	feature	of	AstroPlanner	allows	you	to	automate	this	procedure	whenever	
you	do	a	slew.

The	feature	is	toggled	on	and	off	via	the	Telescope	>	High-Precision	Slewing	menu	command.

If	the	feature	is	on	and	you	start	a	slew,	then	the	High-Precision	Slewing	Floating	window	is	
displayed.

At	any	time	you	can	abandon	this	procedure	and	just	slew	straight	to	the	target	by	clicking	the	Slew	
to	target	button,	or	cancel	the	slew	altogether	with	the	Cancel	button.

At	the	top	of	the	window	is	a	list	of	bright	stars	close	to	the	target,	in	decreasing	order	of	their	dis-
tance	to	the	target.	Pick	one	of	these	stars	you	know,	and	click	the	Slew	to	Star	button.
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Figure	304:	High-precision	slewing	window

The	window	shrinks	down	(since	the	star	list	is	no	longer	required),	and	the	slew	to	the	bright	star	
begins.	You	can	abort	the	slew	if	necessary	using	the	Abort	Slew	button.

Figure	305:	Slewing	to	a	bright	star

Once	the	slew	has	completed,	centre	the	bright	star	in	the	eyepiece/imager	using	the	telescope	hand
controller	or	the	direction	motion	buttons	on	the	window,	and	the	click	the	Sync	on	star	button.	
Then	click	the	Slew	to	target	button	to	complete	the	slew.

Figure	306:	Ready	to	slew	to	target

There	are	some	controls	to	customise	this	procedure:

• Maximum	single	slew.	By	default	this	is	set	to	Unlimited,	which	means	all	slews	will	consist	of	a	
single	slew	to	a	bright	star	near	the	target,	followed	by	a	slew	to	the	target.	This	could	be	proble-
matic	for	long	slews	since	the	bright	star	might	be	outside	of	the	eyepiece/imager	Field	of	view.	
You	can	also	specify	a	maximum	angular	distance	for	a	single	slew.	For	example,	if	you	set	this	to	
20°	and	the	target	is	47°	away,	then	the	operation	will	hop	to	at	least	three	bright	stars	en-route	
to	the	target,	improving	the	chances	that	each	bright	star	will	be	in	the	Field	of	view	after	each	
sub-slew.

• Magnitude	limit.	Limits	the	list	of	stars	to	those	brighter	than	this	magnitude	setting.
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• Direct	if	closer	than	x°.	If	the	target	is	less	than	x°	away	then	just	do	a	direct	slew.

13.10 Spiral Scan
The	spiral	scan	mechanism	allows	you	to	conduct	a	search	starting	at	your	telescope's	current	point-
ing	coordinates,	in	an	overlapping	"spiral"	path.	This	is	useful	if	you	are	looking	for	an	object	but	
only	have	rough	coordinates.

The	spiral	scan	requires	a	go-to	telescope	to	be	connected.	Start	the	scan	using	the	Spiral	Scan...	
button	on	the	Field	of	View	tab,	or	by	using	the	Telescope	>	Start	Spiral	Scan...	menu	item.	This	dis-
plays	the	spiral	scan	dialog.

Figure	307:	Spiral	scan	dialog

The	dialog	allows	you	to	specify	the	Field	of	view	of	the	eyepiece	(or	imager)	you	are	using.	Either	
you	can	specify	a	Fixed	Field	of	view,	or	you	can	specify	the	telescope/eyepiece/optical	aid	and	let	the
application	work	it	out.	

You	also	specify	the	motion	steps	as	a	percentage	of	the	Field	of	view	diameter.	e.g.	50%	implies	a	
50%	overlap.

The	Draw	track	on	FoV	option	draws	the	track	of	the	"spiral"	path	on	the	Field	of	view	chart,	as	
shown	in	the	Figure	below.

Clicking	the	Start	button	moves	the	telescope	to	the	coordinates	of	the	First	step	of	the	path.

To	move	to	the	next	step	of	the	path,	click	the	Spiral	Scan	button	on	the	Field	of	View	tab,	or	use	the	
Telescope	>	Continue	Spiral	Scan	menu	command.

To	end	the	spiral	scan	process,	Shift-click	the	Spiral	Scan	button	on	the	Field	of	View	tab,	or	use	the	
Telescope	>	Stop	Spiral	Scan	menu	command.
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Figure	308:	Spiral	scan	progress	shown	on	Field	of	view	chart

13.11 Emulated mounts
For	testing	purposes,	and	to	allow	you	to	get	a	feel	for	how	a	telescope	connects	and	is	used	without	
actual	hardware	connected,	AstroPlanner	deFines	two	special	computerised	mounts:

• AstroPlanner	Emulated	Go-to.	This	emulates	a	go-to	telescope	that	allows	slewing,	syncing,	
etc.

• AstroPlanner	Emulated	DSC.	This	emulates	digital	setting	circles	on	a	"push-to"	telescope,	that	
can	only	display	the	current	pointing	coordinates.

To	emulate	these	mounts,	a	telescope	"mimic"	window	is	displayed,	showing	the	current	pointing	
coordinates	(RA/Dec	and	Alt/Az).

Figure	309:	Emulated	go-to	telescope	mimic	window

13.12 Other features
13.12.1 Test telescope communication
This	feature	can	be	used	to	check	your	telescope	mount	communication	manually,	if	you	have	an	un-
derstanding	of	the	serial	commands	used	for	communication.	This	can	only	be	used	if	the	telescope	
is	currently	disconnected	from	the	application.	It	can	also	only	be	used	for	wired	serial	port	commu-
nication,	or	communication	that	appears	as	a	serial/COM	port	to	the	application.	i.e.	it	won't	work	

- 211 -



for	Ethernet	(e.g.	Vixen	Star	Book),	direct	USB	connections,	or	SkyFi-type	device	communications.	It	
also	assumes	8-bit,	no	parity,	1	stop	bit	settings.

In	the	window	you	need	to	set	up	the	serial	port	you	will	be	using	and	the	bit	rate	to	use.	You	can	
also	slow	down	communication	(to	the	mount)	by	using	the	Delay	between	characters	option,	and	
also	elect	to	add	a	carriage	return	character	($0D)	at	the	end	of	each	transmitted	command.

Enter	the	text	you	wish	to	send	into	the	Input	command	Field	and	click	Send	to	transmit	it	to	the	
mount.	If	every	command	you	send	has	an	identical	preFix	and/or	sufFix,	then	you	can	set	those	
Fields	up	too.	e.g.	in	the	illustration	below,	clicking	Send	will	transmit	#:GZ#	to	the	mount	(this	is	the
Meade	command	to	return	the	current	telescope	azimuth).

The	Telescope	response	Field	lists	any	characters	returned	from	the	telescope	mount.

Figure	310:	Test	Telescope	Communication	window

13.12.2 Synchronise telescope to computer clock
If	your	telescope	mount	supports	it,	this	command	will	send	your	computer's	current	date	and/or	
time	values	to	your	telescope	mount	so	that	the	telescope	will	be	synchronised	with	the	computer	
(to	within	a	few	seconds,	since	there	might	be	a	time	lag).

Figure	311:	Synchronising	telescope	date/time

13.12.3 Compare computer-telescope settings
This	feature	will	compare	equivalent	settings	between	what	AstroPlanner	knows	or	computes	and	
what	the	telescope	mount	knows	or	computes.	If	the	settings	differ	widely	between	the	two,	then	it	
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could	cause	issues	with	slewing	(the	computer	tries	to	slew	to	an	object	that	the	mount	thinks	is	be-
low	the	horizon,	for	example).

Figure	312:	Compare	computer-telescope	settings

Note	that	not	all	mounts	will	be	able	to	compare	all	settings.	

The	Computer	and	Telescope	columns	show	the	values	being	compared.	The	Difference	column	
shows	the	difference	between	the	two.	If	the	value	is	coloured	green	it	means	that	the	values	are	
within	acceptable	bounds.	If	the	text	is	coloured	red,	it	means	that	there	is	a	substantial	difference	
between	the	two	that	should	be	investigated.

13.12.4 Display OTA temperature
Some	telescopes	are	capable	of	measuring	the	temperature	of	their	OTA	(optical	tube	assembly).	
This	information	can	be	collected	and	displayed.	If	the	telescope	mount	can	collect	this	information,	
and	if	the	collection	of	temperature	is	switched	on	in	the	mount	options,	then	the	ongoing	tempera-
ture	can	be	displayed	via	the	Telescope	>	Display	OTA	Temperature	menu	command.

The	information	is	displayed	in	both	tabular	and	graphical	form.

Figure	313:	Display	OTA	temperature	window

There	is	also	an	option	to	beep	when	the	temperature	falls	below	a	given	temperature.
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13.12.5 Go to
The	Telescope	>	Go	To...	menu	command	allows	a	slew	to	speciFied	RA/Dec	coordinates	(assuming	
they	are	above	the	horizon).

Figure	314:	Go	to	dialog

The	dialog	includes	a	list	of	bright	stars.	Clicking	on	a	star	entry	will	insert	its	coordinates	into	the	
RA/Dec	Fields.

13.12.6 Sync to
The	Telescope	>	Sync	To...	menu	command	allows	a	sync	to	speciFied	RA/Dec	coordinates.	This	
might	be	useful	to	do	a	simple	one-star	alignment	of	a	polar-mounted	go-to	telescope.

Figure	315:	Sync	to	dialog

The	dialog	includes	a	list	of	bright	stars.	Clicking	on	a	star	entry	will	insert	its	coordinates	into	the	
RA/Dec	Fields.

13.12.7 Set telescope location/date/time
If	it	is	possible	to	set	your	telescope	mount's	location	(latitude,	longitude,	GMT	offset)	and	its	local	
date	and	time,	then	the	Telescope	>	Set	Telescope	Location/Date/Time	menu	command	will	do	
just	that.
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13.12.8 Add alignment stars to plan
If	your	telescope	mount	includes	a	list	of	alignment	stars,	then	the	Telescope	>	Add	Alignment	
Stars	to	Plan...	menu	command	will	add	all	of	those	stars	to	the	current	plan	document	as	plan	ob-
jects.	The	dialog	allows	you	to	specify	what	appears	in	the	ID	and	Name	Fields	for	each	object.

Figure	316:	Add	alignment	stars	dialog

13.12.9 Slew telescope to home
Use	the	Telescope	>	Slew	Telescope	to	Home	menu	command	to	slew	the	telescope	to	the	home	po-
sition	speciFied	in	the	mount	options.

13.12.10 Slew to Sky Flat Position...
When	taking	sky	Flats	for	astrophotography	one	needs	to	point	the	telescope	towards	the	zenith,	or	
close	to	the	zenith	(if,	say,	a	dome	slit	or	mount	doesn't	allow	slewing	to	the	zenith),	with	the	az-
imuth	opposite	to	the	sun's	azimuth.

This	command	slews	the	telescope	to	such	a	position,	based	on	the	sun's	current	position	and	an	al-
titude	speciFied	by	the	user.

Figure	317:	Slew	to	Sky	Flat	Position

13.13 Vendor-specific features
13.13.1 Argo Navis
The	Argo	Navis	controller	is	a	sophisticated	digital	setting	circle	device	(i.e.	not	a	go-to	controller).

Download plan to Argo Navis
It	is	possible	to	download	a	list	of	target	objects	to	the	controller.	Using	the	Telescope	>	Download	
Plan	to	Argo	Navis...	menu	command,	when	the	mount	is	not	connected,	displays	the	download	
dialog.
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Figure	318:	Argo	Navis	download	dialog

Note	that	the	Argo	Navis	unit	must	be	in	“navis”	mode	in	order	to	be	seen	by	AstroPlanner.	You	must
put	the	Argo	Navis	into	SETUP	LOAD	CAT	mode	prior	to	connecting.	On	the	Argo	Navis	unit:	Dial	up	
MODE	SETUP,	SETUP	LOAD	CAT	and	press	ENTER.

When	you	open	the	dialog	via	the	menu	command,	AstroPlanner	connects	to	the	Argo	Navis	unit	
and	retrieves	its	current	status.	Since	user	objects,	comets	and	minor	planets	(asteroids)	are	treated	
separately,	there	are	controls	for	each	type.

The	Purge	buttons	will	send	commands	to	the	Argo	Navis	unit	to	eliminate	all	objects	of	the	given	
type.	Download	will	download	the	objects	of	the	given	type	in	your	plan	document	to	the	Argo	
Navis	unit.

There	is	a	PreOix	ID	with	Field	associated	with	each	object	type.	The	text	will	be	preFixed	to	the	ID	
before	each	object	is	downloaded.	This	can	help	keep	plan	objects	together	when	listed	on	the	Argo	
Navis	screen.	Some	special	text	items	can	be	used	in	these	preFixes	to	help	order	the	items	in	the	
Argo	Navis	unit.	These	text	items	are:

[c] Replace	with	the	three-character	constellation	for	the	object	(e.g.	UMA,	CEN).	

[n] Replace	with	a	three-digit	number	specifying	the	order	in	which	the	plan	is	sorted.	(e.g.	020,	
021).

[a] Replace	with	a	two-character	identiFier	specifying	the	order	in	which	the	plan	is	sorted	i.e.	
AA,	AB,	AC,...	ZZ.

[k] Replace	with	the	catalogue	from	whence	the	object	came	(if	applicable).	
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[t] Replace	with	the	object	type.

In	addition	to	adding	a	preFix	to	the	downloaded	objects,	you	can	also	modify	the	plan	document	to	
match	those	downloaded	objects.	You	specify	which	Field	is	to	be	modiFied	(ID,	Name,	etc.)	and	how	
it	will	be	modiFied.

13.13.2 Sky Commander
The	Sky	Commander	controller	is	a	digital	setting	circle	device	(i.e.	not	a	go-to	controller).

Download plan to Sky Commander
The	Telescope	>	Download	Plan	to	Sky	Commander...	menu	command	will	download	the	plan	ob-
ject	RA/Dec	parameters	to	the	Sky	Commander	(or	Sky	Tracker)	controller,	starting	at	object	0.	If	
there	are	more	than	59	objects	(the	maximum	allowable),	then	the	First	59	will	be	transferred.	Note	
that	the	controller	must	not	be	connected	for	this	to	work.

Figure	319:	Download	plan	to	Sky	Commander	dialog

Send object coordinates to Sky Commander
The Telescope	>	Send	Object	Coordinates	to	Sky	Commander menu command is enabled if you are 
connected to a Sky Commander and an object is selected in the object list. It will place that object’s RA/
Dec coordinates directly into object #99, allowing the user to then use the Sky Commander to “zero” that 
object on the DSCs.

13.13.3 Orion Intelliscope
AstroPlanner	supports	the	Orion	IntelliScope	Computerized	Object	Locator.	This	is	a	digital	setting	
circle	system	based	on	the	Tangent	BBox	design.	Since	the	IntelliScope	system	returns	Azimuth	and	
Altitude	readings	only,	this	system	works	a	little	differently	from	other	controllers	supported	by	
AstroPlanner.

In	particular,	it	is	important	that	the	following	parameters	be	set	correctly,	in	order	that	AstroPlann-
er	can	convert	the	Alt-Azimuth	readings	to	correct	RA/Dec	readings:

• Local	Date	and	Time

• Site	Latitude	and	Longitude

• Site	offset	from	GMT

After	alignment,	the	IntelliScope	Computerized	Object	Locator	returns	an	Azimuth	reading	with	re-
spect	to	the	azimuth	when	the	system	was	powered-up.	For	this	reason	it	is	necessary	to	calibrate	
the	azimuth	with	a	known	star.	Each	time	you	connect,	a	calibration	dialog	appears.
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Figure	320:	Intelliscope	calibration	dialog

The	sky	chart	shows	the	location	of	the	stars	in	grey,	with	the	selected	one	in	white.	The	meridian,	
equator	and	user	site	horizon	(if	deFined)	are	also	displayed.

Select	a	star	from	the	list,	point	the	telescope	at	the	selected	star	and	click	the	Calibrate	button.	If	
you	pointed	the	telescope	exactly	at	North	(0°)	before	power-	up,	you	can	click	the	North	button	in-
stead.	The	calibration	star	method	is	probably	the	more	accurate	of	the	two.

The	second	and	subsequent	times	you	connect,	an	Already	Calibrated	button	appears.	If	you	have	
not	changed	the	alignment	of	the	IntelliScope	Computerized	Object	Locator,	or	powered	it	down	and
up	again,	you	can	bypass	the	calibration	step	by	clicking	this	button.

Figure	321:	Intelliscope	calibration	dialog	on	subsequent	connection
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14 Telescope alignment
AstroPlanner	includes	various	methods	to	help	with	polar-mounted	telescope	alignment	(i.e.	
aligning	the	polar	or	R.A.	axis	with	the	celestial	pole	so	that	the	telescope	only	has	to	be	driven	in	
R.A.	and	the	Declination	remains	constant.	Some	of	these	require	a	computerised	Go-to	mount	with	
applicable	functionality.

14.1 Iterative polar alignment
This	procedure	helps	you	through	an	iterative	polar	alignment	process	for	your	computerised	
mount.	It's	especially	useful	if	your	telescope	mount	is	mounted	on	a	wedge.	It	assumes	that	before	
you	start	you	have	already	polar	mounted	your	telescope,	done	a	rough	polar	alignment	on	your	
pole	star	(Polaris	or	Sigma	Octantis),	and	done	a	one-star	polar	alignment.

Figure	322:	Iterative	polar	alignment	dialog

AstroPlanner	produces	a	list	of	suitable	non-polar	alignment	stars.	These	stars	are	chosen	according
to	the	criteria:

• Magnitude	4.0	or	brighter.

• Altitude	more	than	40°	above	horizon	(and	not	hidden	by	obstacles).

• More	than	30°	from	the	pole.

• Not	close	to	the	same	RA	as	the	pole	star,	or	the	pole	star's	RA	+	12	hours.

A	Rating	column	shows	how	"ideal"	the	star	is.	The	lower	the	number,	the	better	the	star	will	be	for	
the	polar	alignment	process.
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The	sky	chart	at	the	right	shows	the	pole	star	and	the	selected	star	in	white,	and	other	suitable	stars	
in	grey.	The	40°	altitude	is	marked	by	a	dashed	circle.	The	user	horizon	is	shown.

If	you	have	a	telescope	capable	of	performing	the	Sync	operation	programmatically	then	you	can	use
this	dialog	to	do	all	the	slewing	back	and	forth	to	the	stars	for	you.

The	method	used	is	this:

Step	1:	Click	the	button	to	slew	the	telescope	to	the	chosen	alignment	star.

Step	2:	Use	the	telescope	hand	controller	only	to	centre	the	alignment	star	in	the	eyepiece	(a	reticle	
eyepiece	might	help	here).	Once	you've	done	that,	click	on	the	Sync	Star	button.	The	amount	of	the	
error	is	displayed	in	the	list	on	the	right.

Step	3:	Click	the	button	to	slew	the	telescope	to	the	pole	star.

Step	4:	Now	use	your	wedge	physical	adjustments	only	to	centre	the	star	in	the	eyepiece.	In	fact	it	is	
safer	to	adjust	halfway	to	the	pole	star,	and	not	all	the	way.	Do	not	use	the	hand	controller.	Click	the	
Centred	button	when	you've	done	that.

Now	repeat	steps	1	through	4	until	the	error	displayed	in	the	list	on	the	right	is	minimal.	Click	the	
Finish	button	whenever	you're	happy.

Warning.	This	procedure	is	only	as	accurate	as	your	telescope's	encoder	accuracy,	so	don't	expect	to
get	much	better	than	1	minute	of	arc	accuracy	in	your	alignment,	and	probably	less	with	a	less	capa-
ble	telescope.

You	can	use	the	Choose...	button	to	select	a	suitable	pole	star	if	the	default	one	is	unacceptable.	Note:
only	visible	stars,	and	those	that	are	not	outside	telescope	limits,	are	shown.

Figure	323:	Select	the	pole	star

14.2 Polar drift alignment
In	order	best	to	utilise	the	method	of	polar	drift	alignment,	you	need	to	pick	two	stars	to	test	drift	
on:
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• A	star	close	to	the	meridian	(the	great	circle	passing	through	the	poles	and	the	zenith)	and	near	
the	celestial	equator	(Declination	0°)

• A	star	above	the	eastern	horizon	(there’s	also	a	“Western	horizon”	option	for	those	who	can’t	see
the	eastern	horizon)	and	near	the	celestial	equator.

The	polar	drift	alignment	helper	locates	such	stars	for	you	and	allows	you	to	slew	your	telescope	to	
those	stars.	Use	Telescope	>	Polar	Drift	Alignment	Helper.

Figure	324:	Polar	drift	alignment	dialog

The	dialog	presents	you	with	two	lists	of	stars	based	on	the	two	criteria	above.	Above	each	list	are	
popup	menus	that	allow	you	to	adjust	constraints	on	the	stars	in	the	list.

If	no	stars	appear	in	the	lists,	it	means	that	the	speciFied	restraints	are	too	tight,	or	perhaps	you	have
an	obstacle	deFined	for	your	eastern/western	horizon.	Try	expanding	the	criteria	using	the	popup	
menus.

Since	the	current	meridian	moves	at	a	sidereal	rate,	you	might	want	to	click	the	Recompute	star	
lists	button	occasionally.

There	is	a	built-in	timer	to	remind	you	to	check	the	alignment	when	a	Fixed	time	is	up.	Selecting	the	
time	from	the	popup	menu	at	bottom	centre	will	start	the	timer	counting	down.	The	Sound	at	end	
checkbox	will	beep	the	computer	after	the	period	is	over.

The	sky	charts	show	the	selected	star	in	white,	and	other	suitable	stars	in	grey.	The	equator,	meridi-
an	and	altitude	lines	are	marked.	The	user	horizon	is	shown.
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14.3 Polar alignment scope tool
With	a	suitable	plan	document	at	the	front,	choose	Telescope	>	Polar	Alignment	Scope	View	to	dis-
play	a	window	showing	the	view	you	would	hope	to	see	through	a	polar	alignment	scope	at	the	cur-
rent	local	date/time	and	the	currently-selected	site.	A	polar	alignment	scope	is	a	small	telescope	
that	sits	inside,	or	parallel	to,	the	R.A.	axis	tube	of	a	polar	mount	(typically	a	German	equatorial	
mount).	The	scope	has	a	reticle	that	is	designed	speciFically	to	align	on	the	pole	star	(Polaris	in	the	
northern	hemisphere,	Sigma	Octantis	in	the	southern	hemisphere).	If	the	pole	star	is	placed	at	a	par-
ticular	spot	on	the	reticle,	the	mount	should	(theoretically)	be	aligned	with	the	celestial	pole.

Figure	325:	Polar	alignment	scope	view

The	view	shows	the	pole	star	and	some	brighter	stars	near	it	that	should	be	visible	through	the	
scope.	The	chart	can	be	customised	by	right-clicking.	The	popup	menu	allows	you	to	select	the	Field	
of	view	of	your	polar	scope	(in	degrees),	whether	the	reticle	is	sized	for	Polaris	(Alpha	UMi)	or	Sig-
ma	Oct,	and	how	the	scope	inverts	the	view.

14.4 1-star polar alignment
If	you	have	a	polar-mounted	telescope	with	a	computerised	mount	that	allows	syncing	to	given	RA/
Dec	coordinates,	then	you	can	use	this	feature	to	do	a	1-star	alignment.	Use	Telescope	>	1-star	Po-
lar	Alignment...	and	select	a	suitable	star	to	align	to	(the	list	should	contain	all	visible	stars	down	to	
about	magnitude	3).	Move	your	telescope	until	the	selected	star	is	centred	in	the	eyepiece	and	click	
the	Sync	button.	The	telescope	will	be	commanded	to	sync	the	mount	to	the	coordinates	of	star.	

This	alignment	procedure	assumes	that	your	telescope	mount	is	exactly	aligned	with	the	celestial	
pole.

- 222 -



Figure	326:	1-star	polar	alignment	dialog
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15 Printing
Printing	is	typically	instigated	by	using	File	>	Print....	If	it	is	the	First	time	you	are	using	that	menu	
command	during	the	application	run,	then	the	Page	Setup	dialog1	will	appear	before	the	Print	dia-
log.	You	can	also	manually	display	the	Page	Setup	dialog	using	File	>	Page	Setup....

15.1 Sky and Field of View Charts
If	you	are	viewing	a	chart	on	the	Sky	or	Field	of	View	tabs	of	the	plan	document	window,	then	
choosing	File	>	Print...	will	print	that	chart	on	a	single	printer	page.	A	chart	printing	dialog	is	dis-
played	before	the	standard	system	Print	dialog.

Figure	327:	Chart	printing	dialog

• Print	black	on	white	background.	Print	the	chart	in	black	(stars,	lines,	etc.)	with	a	white	back-
ground.	This	is	typically	always	on,	unless	you	own	a	printer	ink/toner	cartridge	company.

• File	name.	Print	the	plan	File	name	in	the	page	footer.

• Date	and	time.	Print	the	current	plan	local	date	and	time	in	the	page	footer.	If	the	date/time	is	
Fixed,	that	value	will	be	printed.	This	could	be	useful	to	determine	the	date/time	for	which	the	
chart	was	printed,	when	viewed	at	a	later	date.

• Print	legend.	(Field	of	View	only)	Print	a	legend	for	the	various	types	of	objects	and	star	sizes	
printed.

• Print	object	info.	(Field	of	View	only)	Print	information	about	the	central	object.

• Resolution.	Normal	resolution	prints	the	chart	scaled	so	that	it	is	roughly	WYSIWYG	(What	You	
See	Is	What	You	Get).	You	can	also	elect	to	increase	the	"resolution"	(to	150%,	200%,	300%	
500%,	or	Highest).	This	will	decrease	the	size	of	objects	and	text	correspondingly.	This	might	
look	better	on	your	printer,	but	also	might	require	a	magnifying	glass	to	read.

15.2 Objects
When	the	Objects	tab	of	the	plan	document	window	is	foremost,	you	can	use	File	>	Print...	to	print	
a	list	of	those	objects	present	in	the	plan.

1. The Page Setup dialog allows you to set up a number of printer-speciFic parameters, such as margins, portrait vs. landscape
printing, page size, scale factor, and so on. These settings stay in effect for the rest of the application run, unless modiFied via File >
Page	Setup...
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The	printing	dialog	prints	to	a	"preview"	window,	allowing	the	report	to	be	examined	before	it	is	
printed.

Figure	328:	Print	Objects	dialog

Printing	of	objects	(and	observations)	is	done	via	a	script.	This	script	is	selected	in	the	Printing	
script	popup	menu	at	the	top	left.	Unless	you	have	downloaded	an	alternative	user-contributed	
printing	script,	this	menu	will	only	contain	the	built-in	Default	script.	The	Task	popup	menu	con-
tains	a	list	of	the	various	printing	tasks	you	can	perform.	For	this	section,	we	are	only	concerned	
with	the	Object	data	task.	The	other	lists	and	options	pertain	to	the	task	at	hand	(where	applicable).

• Page	header	includes.	These	are	items	that	can	be	included	in	the	page	header	area	for	each	
printed	page.

• Page	Footer	includes.	These	are	items	that	can	be	included	in	the	page	footer	area	for	each	
printed	page.

• Restrictions.	These	are	restrictions	on	which	objects	are	to	be	included	in	the	printed	report.	If	
no	checkboxes	are	checked,	all	objects	in	the	list	will	be	included.	If	any	checkboxes	are	checked,	
then	only	those	objects	that	fall	into	that	category	will	be	included	(e.g.	if	Not	Observed	and	Vis-
ible	are	checked,	then	only	those	objects	that	are	currently	above	the	horizon	and	haven't	been	
observed	will	be	included).

• Object	Oields.	A	list	of	object	Fields	to	be	included	in	the	printed	report	for	each	object.	Checking	
an	entry	includes	it.	Dragging	the	entries	with	the	mouse	allows	them	to	be	ordered.	All	the	
Fields	are	data	Fields,	computed	Fields,	or	user-deFined	Fields	for	the	object.	The	Sequence	#	Field	
prints	a	number,	representing	the	order	of	the	objects	in	the	object	list.

• Options.	Various	formatting	options	for	the	printed	report.	These	are	currently	listed	below.
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• Load	&	Save.	Any	option	or	Field	settings	you	make	are	saved	with	the	plan	document.	You	can	
also	use	the	Save...	and	Load...	buttons	to	save	those	settings	in	a	separate	settings	File.	This	is	
useful	to	transfer	settings	between	plan	documents,	for	example.

15.2.1 Object options

Figure	329:	Object	printing	options

• New	page	per	object.	Start	a	new	page	for	each	object.

• Include	all-blank	object	Oields.	If	a	particular	object	Field	(e.g.	Size)	is	blank	for	all	relevant	ob-
jects,	then	this	option	will	stop	that	Field	from	being	printed.

• Compressed	mode.	Print	a	single	line	for	each	object,	Field	Field	headings	at	the	top	of	each	
page.	There	are	two	checkbox	options	associated	with	this	mode:	Multi-line	-	allow	the	object	
Fields	to	be	printed	over	several	lines	(to	avoid	truncation	on	a	single	line).	Separator	lines	-	
draw	a	horizontal	line	between	each	object	entry.

• Start	sequence	#	from.	An	integer	number	to	start	the	First	Sequence	#	entry.	i.e.	the	First	object
in	the	list	will	be	printed	with	this	number,	which	will	be	incremented	for	the	second	object,	etc.

• Maximum	column	width.	The	maximum	width	of	a	column	as	a	percentage	of	page	width.

• Grid	lines.	Draw	grid	lines	around	the	text.

• Headings	>	Use	abbreviated	headings.	Use	shortened	forms	of	headings	(e.g.	"Dec"	instead	of	
Declination").

• Headings	>	Heading	format.	Whether	the	heading	is	printed	using	a	bold,	italic	or	underlined	
font,	whether	it	is	inverted	(black	background	with	white	text),	etc.

• Mark	object	IDs	>	Selected	objects.	How	to	print	object	IDs	for	selected	objects	in	the	list,	using
a	bold,	italic	or	underlined	font,	inverted	(black	background	with	white	text),	etc.

• Mark	object	IDs	>	Highlighted	objects.	How	to	print	object	IDs	for	highlighted	objects	in	the	
list,	using	a	bold,	italic	or	underlined	font,	inverted	(black	background	with	white	text),	etc.

• Images	and	Charts	>	Object	images.	Display	any	images	associated	with	the	object,	and	how	to
print	those	images	(inverted	colours,	E/W	Flipped,	etc.).

• Images	and	Charts	>	Jupiter/Saturn	satellite	graphic.	If	the	object	is	Jupiter	or	Saturn,	print	a	
graphic	showing	the	current	positions	of	the	satellites.
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• Images	and	Charts	>	Constellation	chart.	Print	a	graphic	showing	the	constellation	containing	
the	graphic,	and	a	small	circle	showing	the	object's	position	within	the	constellation.

15.2.2 Examples

Figure	330:	Standard-mode		object	report	with	images	and	constellation	charts
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Figure	331:	Compressed-mode	object		report

15.3 Objects & observations
When	the	Objects	tab	of	the	plan	document	window	is	foremost,	you	can	use	File	>	Print...	to	print	
a	list	of	those	objects	present	in	the	plan,	together	with	observations	associated	with	those	objects.

Figure	332:	Print	Objects	&	Observations
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The	operation	is	almost	identical	to	that	described	in	Section	15.2	on	page	224,	except	that	you	use	
the	Observation	data	task,	and	with	the	addition	of	session	and	observation	Fields	and	some	addi-
tional	options.	Those	additional	items	are	described	below.

• Session	Oields.	A	list	of	observing	session	Fields	to	be	(optionally)	included	in	the	printed	report	
for	each	object.	Checking	an	entry	includes	it.	Dragging	the	entries	with	the	mouse	allows	them	
to	be	ordered.	All	the	Fields	are	data	Fields,	computed	Fields,	or	user-deFined	Fields	for	the	session.

• Observation	Oields.	A	list	of	observation	Fields	to	be	included	in	the	printed	report	for	each	ob-
ject.	Checking	an	entry	includes	it.	Dragging	the	entries	with	the	mouse	allows	them	to	be	or-
dered.	All	the	Fields	are	data	Fields,	computed	Fields,	or	user-deFined	Fields	for	the	observation.	

15.3.1 Object + Observation options

Figure	333:	Object	+	Observation	printing	options

Similar	to	Object	options	above,	with	the	following	differences:

• Include	all-blank	session/observation	Oields.	If	a	particular	session	or	observation	Field	(e.g.	
Name)	is	blank	for	all	relevant	sessions/observations,	then	this	option	will	stop	that	Field	from	
being	printed.

• Headings	>	Object	heading	format.	Whether	the	headings	for	object	Fields	are	printed	using	a	
bold,	italic	or	underlined	font,	whether	they	are	inverted	(black	background	with	white	text),	etc.

• Headings	>	Session	heading	format.	Whether	the	headings	for	session	Fields	are	printed	using	
a	bold,	italic	or	underlined	font,	whether	they	are	inverted	(black	background	with	white	text),	
etc.

• Headings	>	Observation	heading	format.	Whether	the	headings	for	observation	Fields	are	
printed	using	a	bold,	italic	or	underlined	font,	whether	they	are	inverted	(black	background	with
white	text),	etc.

• Images	and	Charts	>	Attached	observation	images.	Display	any	images	attached	to	the	ob-
ject's	observations,	and	how	to	print	those	images	(inverted	colours,	E/W	Flipped,	etc.).

• Images	and	Charts	>	Number	of	attached	images	per	row.	How	many	images	should	be	print-
ed	across	the	width	of	the	page.
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15.3.2 Examples

Figure	334:	Object+Observation	example

15.4 Observing forms
When	the	Objects	tab	of	the	plan	document	window	is	foremost,	you	can	use	File	>	Print...	to	print	
a	list	of	those	objects	present	in	the	plan,	together	with	observation	templates	(empty	observation	
Fields,	sketching	templates,	etc.).	This	form	is	designed	to	be	printed	out	and	Filled	in	at	the	telescope
with	a	pencil	or	pen.

The	operation	is	almost	identical	to	that	described	in	Section	15.2	on	page	224,	except	that	you	use	
the	Observing	forms	task,	and	with	the	addition	of	session	and	observation	Fields	and	some	addi-
tional	options.	Those	additional	items	are	described	below.
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Figure	335:	Printing	observing	forms

• Session	Oields.	A	list	of	observing	session	Fields	to	be	(optionally)	included	in	the	printed	report	
for	each	object.	Checking	an	entry	includes	it.	Dragging	the	entries	with	the	mouse	allows	them	
to	be	ordered.	All	the	Fields	are	data	Fields,	computed	Fields,	or	user-deFined	Fields	for	the	session.
The	Fields	will	all	be	empty	of	data	so	that	they	can	be	manually	entered	in	the	Field.

• Observation	Oields.	A	list	of	observation	Fields	to	be	included	in	the	printed	report	for	each	ob-
ject.	Checking	an	entry	includes	it.	Dragging	the	entries	with	the	mouse	allows	them	to	be	or-
dered.	All	the	Fields	are	data	Fields,	computed	Fields,	or	user-deFined	Fields	for	the	observation.	
The	Fields	will	all	be	empty	of	data	so	that	they	can	be	manually	entered	in	the	Field.

15.4.1 Observing form options
Similar	to	Object	options	above,	with	the	following	differences:

• Observation	templates	per	object.	How	many	observation	templates	to	draw	for	each	object.	
Set	to	1	if	you	only	plan	to	make	a	single	observation	of	each	object.

• Headings	>	Object	heading	format.	Whether	the	headings	for	object	Fields	are	printed	using	a	
bold,	italic	or	underlined	font,	whether	they	are	inverted	(black	background	with	white	text),	etc.

• Headings	>	Session	heading	format.	Whether	the	headings	for	session	Fields	are	printed	using	
a	bold,	italic	or	underlined	font,	whether	they	are	inverted	(black	background	with	white	text),	
etc.

• Headings	>	Observation	heading	format.	Whether	the	headings	for	observation	Fields	are	
printed	using	a	bold,	italic	or	underlined	font,	whether	they	are	inverted	(black	background	with
white	text),	etc.

• Images	and	Charts	>	Number	of	attached	images	per	row.	How	many	images	should	be	print-
ed	across	the	width	of	the	page.
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• Sketching	templates.	Include	circular	sketching	templates	for	sketching	the	Field	of	view	at	the	
telescope.

• Sketching	templates	>	Template	diameter.	The	diameter	of	the	circles,	in	cm.

• Sketching	templates	>	Template	background.	The	colour	to	use	outside	the	circles,	to	improve
contrast	(white	(none),	black,	or	grey).

• Data	from	previous	observations	>	Include	observation	data.	You	can	also	include	data	from	
previously-logged	observations	for	comparison	reasons,	if	you	wish,	using	this	option.

• Data	from	previous	observations	>	Show	attached	observation	images.	Include	any	images	
attached	to	previously-logged	observations.

Figure	336:	Observing	form	options
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15.4.2 Examples

Figure	337:	Observing	form	example

15.5 Finder charts
When	the	Objects	tab	of	the	plan	document	window	is	foremost,	you	can	use	File	>	Print...	to	print	
Finder	charts	for	those	objects	present	in	the	plan,	together	with	object	information,	images,	and	
sketching	templates,	etc.	This	report	is	designed	to	be	used	in	the	Field	to	determine	where	to	look	in
the	sky	for	the	object/s.

The	operation	is	almost	identical	to	that	described	in	Section	15.2	on	page	224,	except	that	you	use	
the	Finder	charts	task,	with	the	addition	of	additional	options.	Those	additional	items	are	de-
scribed	below.

Note	that	there	are	many	options	to	customise	this	report	to	your	liking.	Try	the	defaults	First,	and	
then	start	Fiddling	with	the	options	until	you	get	what	you	want.
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Figure	338:	Printing	Finder	charts

15.5.1 Finder chart options
The	options	have	been	broken	into	sections	here	for	convenience.

Resources
This	section	describes	the	resources	you	will	be	observing	with.

Figure	339:	Finder	chart	options:	Resources

• Resources:	Telescope.	The	telescope	(resource)	you	will	be	observing	with.

• Resources:	Finder	scope.	The	telescope	Finder	scope	to	be	used	for	the	Finder	scope	chart	
(where	applicable).	This	can	be	one	of:	

	 Use	the	telescope's	Linder.	The	Telescope	resource	is	assumed	to	deFine	a	Finder	scope,	and	
that	scope's	FoV	will	be	used.

	 Use	binocular/monocular	resource.	Select	and	use	a	binocular/monocular	type	Telescope	re-
source	as	the	Finder.
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	 Use	Linder	scope	FoV.	Specify	a	Finder	scope	Field	of	view	in	degrees.

• Default	Eyepiece.	The	default	Eyepiece	to	use	for	the	Eyepiece/imager	chart.	This	might	not	get	
used,	depending	on	the	value	of	the	Choice	option	below.

• Default	Imager.	The	default	Imager	to	use	for	the	Eyepiece/imager	chart.	This	might	not	get	
used,	depending	on	the	value	of	the	Choice	option	below.

• Default	Optical	Aid.	The	default	Optical	Aid	resource	to	be	used.	If	the	checkbox	is	checked	then
it	will	be	used	together	with	the	chosen	eyepiece	or	imager.

• Eyepiece/Optical	Aid	choice.	How	to	choose	what	eyepiece	or	imager	is	used	for	the	Eyepiece/
imager	chart.	The	choice	will	be	one	of	the	following:

	 Use	eyepiece	defaults	above.	The	Eyepiece/imager	chart	will	use	the	speciFied	default	eye-
piece	and	(optionally)	the	speciFied	default	optical	aid.

	 Use	imager	defaults	above.	The	Eyepiece/imager	chart	will	use	the	speciFied	default	imager	
and	(optionally)	the	speciFied	default	optical	aid.

	 Best	eyepiece	using	ODM.	The	Eyepiece/imager	chart	will	use	an	eyepiece	which	will	be	cho-
sen	by	the	ODM	computation	to	determine	the	best	magniFication	to	detect	the	object.

	 Best	eyepiece+optical	aid	using	ODM.	The	Eyepiece/imager	chart	will	use	an	eyepiece	and		
possibly	an	optical	aid	which	will	be	chosen	by	the	ODM	computation	to	determine	the	best	
magniFication	to	detect	the	object.

	 Best	eyepiece	to	frame	object	size	by.	The	Eyepiece/imager	chart	will	use	an	eyepiece	which	
will	be	chosen	to	frame	the	object	by	a	factor	speciFied.	e.g.	if	the	factor	is	200%,	the	eyepiece	
will	be	chosen	to	get	a	Field	of	view	twice	the	diameter	of	the	object's	size.

	 Best	eyepiece+optical	aid	to	frame	object	size	by.	The	Eyepiece/imager	chart	will	use	an	eye-
piece	and	possibly	an	optical	aid	which	will	be	chosen	to	frame	the	object	by	a	factor	speciFied.	
e.g.	if	the	factor	is	200%,	the	eyepiece/optical	aid	will	be	chosen	to	get	a	Field	of	view	twice	the	
diameter	of	the	object's	size.
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Charts: All-sky & Naked-eye

Figure	340:	Finder	chart	options:	All-sky	and	Naked-eye	charts

• All-sky	chart.	Check	this	to	include	an	all-sky	chart	(same	as	that	found	in	the	Sky	tab	of	the	
plan	document	window).

• All-sky	chart	>	Main	chart.	If	you	are	displaying	three	charts,	the	third	chart	is	typically	sized	
larger	than	the	other	two.	Check	this	option	if	you	want	the	All-sky	chart	to	be	the	third	chart.

• All-sky	chart	>	Magnitude	limit.	Magnitude	limit	for	stars	in	the	chart.

• All-sky	chart	>	Flip	E/W	orientation.	Flip	the	East/West	orientation	of	the	chart.

• All-sky	chart	>	Flip	N/S	orientation.	Flip	the	North/South	orientation	of	the	chart.

• All-sky	chart	>	Display	options.	These	options	are	a	subset	of	those	found	in	the	Display	Op-
tions	for	the	Sky	chart.

• Naked-eye	chart.	Check	this	to	include	a	naked-eye	chart.	This	is	a	wide-angle	view	of	the	sky,	
up	to	60	degrees	across.
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• Naked-eye	chart	>	Main	chart.	If	you	are	displaying	three	charts,	the	third	chart	is	typically	
sized	larger	than	the	other	two.	Check	this	option	if	you	want	the	Naked-eye	chart	to	be	the	third
chart.

• Naked-eye	chart	>	Field	of	view.	The	Field	of	view	(in	degrees)	of	the	chart.

• Naked-eye	chart	>	Magnitude	limit.	Magnitude	limit	for	stars	in	the	chart.

• Naked-eye	chart	>	Flip	E/W	orientation.	Flip	the	East/West	orientation	of	the	chart.

• Naked-eye	chart	>	Flip	N/S	orientation.	Flip	the	North/South	orientation	of	the	chart.

• Naked-eye	chart	>	Orientate	for	Alt-Az	mount.	Orientate	the	chart	as	it	would	be	seen	through
an	alt-az	mounted	scope,	or	indeed,	by	the	naked	eye	with	respect	to	the	horizon.

• Naked-eye	chart	>	Star	label	density.	The	density	of	stars	with	labels	(a	lower	percentage	will	
label	only	brighter	stars).

• Naked-eye	chart	>	Also	show	objects	from	catalogue.	Show	objects	from	another	non-stellar	
catalogue	on	the	chart.	You	can	also	specify	whether	to	show	labels	(IDs)	and	magnitudes	for	
those	catalogue	objects.

• Naked-eye	chart	>	Display	options.	These	options	are	a	subset	of	those	found	in	the	Display	
Options	for	the	Field	of	View	chart.

Charts: Finder scope and Eyepiece/imager

Figure	341:	Finder	chart	options:	Finder	scope	chart

• Finder	scope	chart.	Check	this	to	include	a	Finder	scope	chart.
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• Finder	scope	chart	>	Main	chart.	If	you	are	displaying	three	charts,	the	third	chart	is	typically	
sized	larger	than	the	other	two.	Check	this	option	if	you	want	the	Finder	scope	chart	to	be	the	
third	chart.

• Finder	scope	chart	>	Magnitude	limit.	Magnitude	limit	for	stars	in	the	chart.	Can	be	either	of:

	 Compute	for	aperture.	Compute	the	theoretical	magnitude	limit	for	the	speciFied	aperture.

	 Specify.	Specify	the	magnitude	limit.

• Finder	scope	chart	>	Stellar	catalogue.	Specify	the	stellar	catalogue	to	use	to	plot	stars.	Make	
sure	it	contains	stars	down	to	the	magnitude	limit	speciFied	above.

• Finder	scope	chart	>	Flip	E/W	orientation.	Flip	the	East/West	orientation	of	the	chart.

• Finder	scope	chart	>	Flip	N/S	orientation.	Flip	the	North/South	orientation	of	the	chart.

• Finder	scope	chart	>	Orientate	for	Alt-Az	mount.	Orientate	the	chart	as	it	would	be	seen	
through	an	alt-az	mounted	scope.

• Finder	scope	chart	>	Star	label	density.	The	density	of	stars	with	labels	(a	lower	percentage	
will	label	only	brighter	stars).

• Finder	scope	chart	>	Zoom	factor.	The	chart	will,	by	default,	show	a	Field	of	view	of	100%	of	
the	actual	Finder	FoV.	You	can	increase	this,	in	which	case	the	Finder	FoV	will	be	shown	as	a	circle
on	the	chart.

• Finder	scope	chart	>	Also	show	objects	from	catalogue.	Show	objects	from	another	non-stel-
lar	catalogue	on	the	chart.	You	can	also	specify	whether	to	show	labels	(IDs)	and	magnitudes	for	
those	catalogue	objects.

• Finder	scope	chart	>	Display	options.	These	options	are	a	subset	of	those	found	in	the	Display	
Options	for	the	Field	of	View	chart.
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Figure	342:	Finder	chart	options:	Imager/eyepiece	chart

• Eyepiece/imager	chart.	Check	this	to	include	a	Finder	scope	chart.

• Eyepiece/imager	chart	>	Main	chart.	If	you	are	displaying	three	charts,	the	third	chart	is	typi-
cally	sized	larger	than	the	other	two.	Check	this	option	if	you	want	the	eyepiece/imager	chart	to	
be	the	third	chart.

• Eyepiece/imager	chart	>	Magnitude	limit.	Magnitude	limit	for	stars	in	the	chart.	Can	be	either
of:

	 For	telescope.	Use	the	telescope	resource's	magnitude	limit.

	 Specify.	Specify	the	magnitude	limit.

• Eyepiece/imager	chart	>	Stellar	catalogue.	Specify	the	stellar	catalogue	to	use	to	plot	stars.	
Make	sure	it	contains	stars	down	to	the	magnitude	limit	speciFied	above.

• Eyepiece/imager	chart	>	Flip	E/W	orientation.	Flip	the	East/West	orientation	of	the	chart.

• Eyepiece/imager	chart	>	Flip	N/S	orientation.	Flip	the	North/South	orientation	of	the	chart.

• Finder	scope	chart	>	Orientate	for	Alt-Az	mount.	Orientate	the	chart	as	it	would	be	seen	
through	an	alt-az	mounted	scope.

• Eyepiece/imager	chart	>	Star	label	density.	The	density	of	stars	with	labels	(a	lower	percent-
age	will	label	only	brighter	stars).

• Eyepiece/imager	chart	>	Zoom	factor.	The	chart	will,	by	default,	show	a	Field	of	view	of	100%	
of	the	actual	FoV.	You	can	increase	this,	in	which	case	the	Finder	FoV	will	be	shown	as	a	circle	on	
the	chart.

- 239 -



• Eyepiece/imager	chart	>	Also	show	objects	from	catalogue.	Show	objects	from	another	non-
stellar	catalogue	on	the	chart.	You	can	also	specify	whether	to	show	labels	(IDs)	and	magnitudes	
for	those	catalogue	objects.

• Eyepiece/imager	chart	>	Display	options.	These	options	are	a	subset	of	those	found	in	the	
Display	Options	for	the	Field	of	View	chart.

Other options

Figure	343:	Finder	chart	options:	Other	options

• Images	and	Charts.	Additional	charts	and	images	to	add	(assuming	there's	space	on	the	page).

	 Show	DSS	images.	Show	any	cached	DSS	images	of	the	object.

	 Show	Jupiter/Saturn	satellite	graphic.	If	the	object	is	Jupiter	or	Saturn,	show	a	chart	of	the	
satellite	positions.

	 Show	constellation	chart.	Show	a	chart	of	the	constellation	containing	the	object.

	 Number	of	images	per	row.	How	many	images	across	the	space	used	for	images.

• Display	object	Oield	information.	Include	a	table	of	useful	object	data	Fields.

• Sketching	templates.	Diameter.	Include	sketching	templates,	with	the	speciFied	diameter.

	 Sketching	template	background.	Specify	the	template	sketching	area	background	(the	area	
outside	the	circle).

	 Maximum	number	of	templates.	Maximum	number	of	sketching	templates	to	include.

• Printing	options.

	 Black	stars	on	white	background.	Unless	you	have	a	lot	of	ink,	keep	this	switched	on.

	 Images	and	object	info	on	new	page.	If	there	isn't	enough	space	for	images,	etc.,	they	can	be	
placed	on	a	second	page	using	this	option.

	 Limit	print	area	width	to.

	 Limit	print	area	height	to.	Limit	the	area	on	the	page	used	for	printing	to	a	speciFied	size.	This
is	useful	if	you	are,	say,	printing	4	x	6	index	cards.
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15.5.2 Examples

Figure	344:	Finder	charts	-	Page	1

Figure	345:	Finder	charts	-	Page	2
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15.6 Observing sessions & observations
Observation	and	session	data	can	also	be	printed	from	the	Observation	database	window	(Observa-
tion	>	Show	Observation	Database)	via	File	>	Print....

15.6.1 Print session data only
Select	the	Session	data	only	task.	Select	the	session	Fields	you	wish	to	print	in	the	Session	Oields	
list.	Reorder	the	Fields	by	dragging	the	entries.

Figure	346:	Print	session	data	only

Page header and footer options
• Page	Number.	Page	number	starting	at	1.

• Date/Time.	The	current	local	date/time.

• Session	Name/s.	The	session	Name	Field	data.

• Session	Start	Date/s.	The	session	start	date.

• Session	Start	Date-Time/s.	The	session	start	date	and	time.

Restrictions
The	Restrictions	list	speciFies	which	sessions	to	include	in	the	report.	If	all	the	entries	are	
unchecked,	all	sessions	in	the	database	will	be	printed.	Restrictions	are:

• Session	Selected.	Report	includes	only	those	sessions	selected	in	the	database	window	sessions	
list.

• Session	not	Selected.	Report	includes	only	those	sessions	not	selected	in	the	database	window	
sessions	list.
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• Session	Displayed.	Report	includes	only	those	sessions	displayed	in	the	database	window	ses-
sions	list.	i.e.	if	you	have	used	the	display	restrictions	underneath	the	observations	list	in	the	
database	window	to	eliminate	some	sessions	from	the	list,	then	these	will	not	be	included	in	the	
report.

• Session	not	Displayed.	Report	includes	only	those	sessions	not	displayed	in	the	database	win-
dow	sessions	list.	i.e.	if	you	have	used	the	display	restrictions	underneath	the	observations	list	in
the	database	window	to	eliminate	some	sessions	from	the	list,	then	these	will	be	included	in	the	
report.

Options
• Session	statistics.	Print	a	summary	of	the	printed	sessions	at	the	end	of	the	report.

• New	page	per	session.	Start	a	new	page	for	each	session.

• Include	all-blank	session	Oields.	If	a	particular	session	Field	(e.g.	Observer)	is	blank	for	all	rele-
vant	sessions,	then	this	option	will	stop	that	Field	from	being	printed.

• Compressed	mode.	Print	a	single	line	for	each	session,	with	Field	headings	at	the	top	of	each	
page.	There	are	two	checkbox	options	associated	with	this	mode:	Multi-line	-	allow	the	session	
Fields	to	be	printed	over	several	lines	(to	avoid	truncation	on	a	single	line).	Separator	lines	-	
draw	a	horizontal	line	between	each	session	entry.

• Headings	>	Use	abbreviated	headings.	Use	shortened	forms	of	headings	(e.g.	"Start"	instead	of
"Start	Date").

• Headings	>	Session	heading	format.	Whether	the	heading	is	printed	using	a	bold,	italic	or	un-
derlined	font,	whether	it	is	inverted	(black	background	with	white	text),	etc.

• Maximum	column	width.	The	maximum	width	of	a	column	as	a	percentage	of	page	width.

• Mark	selected	session	Names.	How	to	print	session	Names	for	selected	sessions	in	the	list,	us-
ing	a	bold,	italic	or	underlined	font,	inverted	(black	background	with	white	text),	etc.

• Grid	lines.	Draw	grid	lines	around	the	text.

Figure	347:	Session	data	print	options
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Examples

Figure	348:	Session	data	example
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Figure	349:	Session	statistics	example1

15.6.2 Print observation data only
Select	the	Observation	data	only	task.	Select	the	session	Fields	you	wish	to	print	in	the	Observa-
tion	Oields	list.	Reorder	the	Fields	by	dragging	the	entries.

Page header and footer options
• Page	Number.	Page	number	starting	at	1.

• Date/Time.	The	current	local	date/time.

• Observation	ID/s.	The	ID	Fields	for	observations	displayed	on	the	page.

Restrictions
The	Restrictions	list	speciFies	which	observations	to	include	in	the	report.	If	all	the	entries	are	
unchecked,	all	observations	in	the	database	will	be	printed.	Restrictions	are:

• Observation	Selected.	Report	includes	only	those	observations	selected	in	the	database	window
observations	list.

• Observation	not	Selected.	Report	includes	only	those	observations	not	selected	in	the	database	
window	observations	list.

• Observation	Found.	Report	includes	only	those	observations	marked	as	having	been	found.

• Observation	not	Found.	Report	includes	only	those	observations	not	marked	as	being	found.

• Observation	Displayed.	Report	includes	only	those	observations	displayed	in	the	database	win-
dow	observations	list.	i.e.	if	you	have	used	the	display	restrictions	underneath	the	observations	

1. The	black	"bar"	is	redacted	information	(the	observation	database	used	for	illustration	contains	real	third-party	data).

- 245 -



list	in	the	database	window	to	eliminate	some	observations	from	the	list,	then	these	will	not	be	
included	in	the	report.

• Observation	not	Displayed.	Report	includes	only	those	observations	not	displayed	in	the	data-
base	window	observations	list.	i.e.	if	you	have	used	the	display	restrictions	underneath	the	ob-
servations	list	in	the	database	window	to	eliminate	some	observations	from	the	list,	then	these	
will	be	included	in	the	report.

Figure	350:	Print	observation	data	only

Options
• Observation	statistics.	Print	a	summary	of	the	printed	observations	at	the	end	of	the	report.

• New	page	per	observation.	Start	a	new	page	for	each	observation.

• Include	all-blank	observation	Oields.	If	a	particular	observation	Field	(e.g.	Name)	is	blank	for	
all	relevant	observations,	then	this	option	will	stop	that	Field	from	being	printed.

• Compressed	mode.	Print	a	single	line	for	each	observation,	with	Field	headings	at	the	top	of	
each	page.	There	are	two	checkbox	options	associated	with	this	mode:	Multi-line	-	allow	the	ob-
servation	Fields	to	be	printed	over	several	lines	(to	avoid	truncation	on	a	single	line).	Separator	
lines	-	draw	a	horizontal	line	between	each	observation	entry.

• Headings	>	Use	abbreviated	headings.	Use	shortened	forms	of	headings	(e.g.	"Julian"	instead	
of	"Julian	Date").

• Headings	>	Observation	heading	format.	Whether	the	heading	is	printed	using	a	bold,	italic	or
underlined	font,	whether	it	is	inverted	(black	background	with	white	text),	etc.

• Maximum	column	width.	The	maximum	width	of	a	column	as	a	percentage	of	page	width.
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• Mark	selected	observation	IDs.	How	to	print	observation	IDs	for	selected	observations	in	the	
list,	using	a	bold,	italic	or	underlined	font,	inverted	(black	background	with	white	text),	etc.

• Grid	lines.	Draw	grid	lines	around	the	text.

• Images	and	Charts	>	Show	attached	observation	images.	Display	any	images	attached	to	the	
observations,	and	how	to	print	those	images	(inverted	colours,	E/W	Flipped,	etc.).

• Images	and	Charts	>	Number	of	attached	images	per	row.	How	many	images	should	be	print-
ed	across	the	width	of	the	page.

• Images	and	Charts	>	Show	constellation	chart.	Display	a	constellation	chart	showing	the	con-
stellation	containing	the	observed	object.

Figure	351:	Observation	data	print	options
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Examples

Figure	352:	Observations	only	example
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Figure	353:	Observation	statistics	example
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15.6.3 Print session & observation data

Figure	354:	Print	session	and	observation	data

This	is	a	combination	of	the	above	two	report	types.	For	each	session,	the	session	data	is	printed,	
followed	by	observations	made	in	that	session.	See	above	for	deFinition	of	the	options,	etc.

Figure	355:	Session	and	observation	print	options
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Examples

Figure	356:	Session+observations	example
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16 Journal
The	journal	feature	(Observation	>	Journal)	is	a	convenient	place	to	keep	bits	of	textual	informa-
tion,	stories,	observing	reports,	etc.	It	consists	of	a	linear	collection	of	entries,	each	entry	having	a	
date,	a	subject,	and	some	associated	notes.

Figure	357:	Journal	window

The	list	of	journal	entries	on	the	left	can	be	sorted	(by	clicking	the	column	headings).	Buttons	be-
neath	the	list	allow	you	to	add	a	new	journal	entry,	delete	an	existing	journal	entry,	or	duplicate	an	
existing	entry.

If	a	journal	entry	is	selected	in	the	list,	the	entry	and	all	others	on	the	same	date	are	displayed	in	a	
bold	face.

The	date	of	a	journal	entry	can	be	changed,	either	by	using	the	Date	selector,	or	by	double-clicking	
the	appropriate	day	on	the	mini-calendar	widget.

The	mini-calendar	highlights	the	date	of	the	currently-selected	entry.	Additionally	any	dates	in	the	
displayed	month	that	have	one	or	more	entries	will	be	underlined	in	red.	Single-clicking	a	date	will	
select	and	display	the	First	journal	entry	for	that	date.

The	Find	widget	under	the	list	of	entries	can	be	used	to	search	all	journal	entries	and	display	only	
those	entries	containing	the	search	text	in	either	the	subject	or	notes	part.
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Figure	358:	Searching	the	journal

It	is	possible	to	create	journal	entries	from	various	places	in	the	application:

• Text	Fields	have	a	Create	New	Journal	Entry	from	Text	entry	in	their	right-click	menu.

• Right-clicking	the	list	of	observations	allows	you	to	create	a	new	journal	entry	containing	a	text	
summary	of	the	observation.

• Right-clicking	the	list	of	observation	sessions	allows	you	to	create	a	new	journal	entry	containing	a
text	summary	of	the	selected	session/s	and	observations.

Figure	359:	Create	journal	entry	from	a	text	Field
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Figure	360:	Create	journal	entry	from	an	observation	list	entry

Figure	361:	Create	journal	entry	from	a	session	list	entry

17 Downloading and using sky 
images

AstroPlanner	has	the	ability	to	download	images	of	your	plan	objects,	which	can	be	used	for	pre-vi-
sualization	of	the	objects	before	observing	or	imaging	them,	or	comparing	what	you	imaged	or	ob-
served	through	the	telescope	with	a	“standard”	image.

The	images	are	downloaded	from	a	number	of	on-line	sky	survey	databases.	These	are	primarily	
monochrome	images	from	the	First	or	second	generation	Palomar	Digital	Sky	Survey	(DSS)	or	colour
images	from	the	Sloan	Digital	Sky	Survey	(SDSS)1.	

See	Figure	362	through	Figure	364	for	some	examples.

1. 	Note	the	SDSS	currently	only	includes	coverage	of	part	of	the	northern	sky.
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The	images	are	stored	in	a	database	and	are	typically	accessed	via	their	associated	ID	and/or	coor-
dinates	of	the	centre	of	the	image.	You	can	download	images	in	different	angular	sizes.	The	down-
loaded	images	are	all	square	(i.e.	the	same	angular	size	vertically	and	horizontally).

Note:	for	DSS	(POSS)	images,	the	downloaded	images	are	stored	at	full	resolution.	This	means	that	
the	larger	the	angular	size	of	the	image,	the	greater	the	amount	of	disk	space	required	to	store	them,
and	the	slower	they	will	be	to	download	and	to	retrieve	from	the	database.

Image	preferences	can	be	changed	to	suit	the	user.	They	are	described	in	detail	on	page	312.

Figure	362:	DSS	Image	(POSS	1G	Red)	of	M13

Figure	363:	DSS	Image	(POSS	2G	Red)	of	M13

Figure	364:	SDSS	Image	of	M13
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17.1 Downloading
Downloading	is	typically	done	manually,	as	described	below.	You	can	also	set	up	preferences	to	
download	images	automatically	(where	possible).	See	Image	preferences	(page	312)	for	details	on	
setting	this	up.

17.1.1 Opening the download window
In	order	to	download	images,	you	must	have	a	plan	document	open	and	it	must	contain	at	least	one	
object.	To	download	images	for	one	or	more	of	the	objects	in	the	plan,	use	the	Image	>	Download	
images...	menu	command.	Alternatively,	select	one	or	more	objects	in	the	plan's	object	list,	right-
click	and	choose	Other	>	Download	images....

If	you	are	viewing	the	Field	of	View	chart,	you	can	also	download	an	image	centred	on	the	current	
Field	of	View	coordinates	by	clicking	the	Images	button	to	the	right	of	the	chart.	When	the	Field	of	
View	Images	window	opens,	select	the	Download	tab.

Note	that	the	left	hand	pane	of	the	window	might	show	existing	images	of	the	object	where	
applicable.

Figure	365:	Image	download	window
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17.1.2 Image download options
Select	images	to	download:	Select	which	of	the	plan	objects	you	want	to	download	images	for.	This
can	be	the	currently	selected	object/s	in	the	plan,	all	of	the	objects	in	the	plan,	the	highlighted	ob-
jects,	all	the	objects	in	the	plan	that	currently	have	no	images	associated	with	them	or,	in	the	case	of	
the	Field	of	View	chart,	images	centred	on	that	chart.

Replace	any	existing	images:	If	this	option	is	checked,	then	any	existing	images	of	the	same	size	
and	data	source	will	be	replaced	by	newly-downloaded	copies.	You	can	also	select	to	replace	only	
the	newest	or	oldest	image	if	there	are	multiple	copies.

Select	image	size	from	object,	where	possible:	If	the	object	being	targeted	for	an	image	download
has	a	deFined	size	(e.g.	15'x10'),	then	this	option	(if	checked)	will	use	that	object	size	to	determine	
the	angular	size	of	the	downloaded	image/s.	The	image	size	is	then	speciFied	as	a	percentage	of	the	
object	size	(in	order	to	allow	a	gap	around	the	object).	If	the	object	does	not	deFine	a	size,	the	the	de-
fault	image	size	is	used	(see	below).

Data	source/s:	You	need	to	check	at	least	one	data	source	(sky	survey)	from	whence	the	image/s	
will	be	downloaded.	If	you	check	more	than	one,	the	same	image	(i.e.	the	same	size	and	centre	coor-
dinates)	will	be	downloaded	from	each	data	source.	This	is	useful	if,	say,	you	always	want	a	red	and	
blue	image,	and	possibly	a	colour	SDSS	image	where	applicable.

Default	image	size:	This	is	the	size	of	image	that	will	be	downloaded.	If	the	Select	image	size	from
object,	where	possible	setting	is	checked	then	this	size	will	be	used	if	the	object	does	not	have	a	
speciFied	size.

Minimum	image	size:	If	the	Select	image	size	from	object,	where	possible	setting	is	used,	then	
this	represents	the	minimum	size	of	image	that	will	be	downloaded.

17.1.3 Starting and monitoring image downloads
Click	the	Start	Download	button	to	queue	up	the	speciFied	image	downloads.	The	speciFied	images	
are	added	to	the	download	queue,	and	if	the	queue	was	previously	empty,	downloading	begins.	All	
downloading,	decompressing,	decoding,	etc.	takes	place	in	a	background	thread	and	you	can	contin-
ue	working.
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Figure	366:	Image	download	queue

The	queue	in	the	Status	tab	shows	the	list	of	images	being	downloaded	(object	ID,	the	source	cho-
sen,	the	image	size	to	be	downloaded,	the	stage	of	the	download	(e.g.	download,	decompress,	con-
vert,	etc.),	and	the	progress	of	the	current	stage	as	a	percentage.

The	Stop	All	button	is	used	to	abandon	all	downloads	currently	in	the	queue.	If	an	error	is	detected	
while	downloading	or	converting	an	image,	an	error	is	logged,	and	the	next	image	in	the	queue	is	
downloaded.	If	there	are	errors,	the	Errors...	button	is	enabled	and	can	be	used	to	get	a	summary	of	
the	errors.

The	Show	last	downloaded	image	checkbox	can	be	used	to	show	a	preview	of	the	last	image	to	be	
downloaded	(see	Figure	367).
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Figure	367:	Showing	last	downloaded	image

17.2 Object list
You	can	show	any	images	associated	with	an	object	in	the	object	list	by	clicking	on	and	selecting	that
object.	If	the	selected	object	has	any	images	(i.e.	any	images	in	the	database	that	contain	the	coor-
dinates	of	the	object)	then	they	will	be	displayed	to	the	right	of	the	object	list.

Figure	368:	Images	associated	with	selected	objects
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The	popup	menu	underneath	the	image	contains	a	list	of	all	known	images	of	that	object.	Selecting	
any	entry	in	the	menu	will	display	the	applicable	image.

This	display	of	images	can	be	turned	on	and	off	by	toggling	the	small	square	button	to	the	lower	
right	of	the	image	display,	to	the	right	of	the	Slew	To	popup	button.

Figure	369:	Right-click		image	menu

Right-clicking	the	image	displays	a	popup	menu	with	various	options	(not	all	of	which	are	necessari-
ly	enabled):

• Delete	Image.	Delete	the	currently-displayed	image	from	the	image	database.

• Enhance	Image	Contrast.	Enhance	the	contrast	of	the	currently-displayed	image.	This	will	dark-
en	the	background	sky,	possibly	at	the	expense	of	subtle	detail.	Since	this	operates	on	the	image	
itself,	it	cannot	be	undone.

• Display	Images.	Open	the	image	display	window	for	the	selected	object	(see	Section	17.4	on	
page	263).

• Download	Images.	Opens	the	image	download	window	ready	to	download	images	for	the	se-
lected	object	(see	Section	17.1.1	on	page	256).

• Image	Manager.	Open	the	Image	Manager	(see	Section	17.5	on	page	265).

• Image	Preferences.	Open	the	Image	Preferences	window	(see	Section	20.10	on	page	312).

• Save	Image	As.	Opens	a	dialog	that	lets	you	save	the	currently-displayed	image	as	an	image	File	
in	one	of	several	formats	(Figure	370).	Some	File	formats	might	not	be	available	depending	on	
your	OS	platform	and/or	installed	software.	You	can	choose	to	save	the	image	as	its	original	size	
(default)	or	you	can	change	the	size	settings	to	suit.	The	JPEG	File	format	also	allows	you	to	speci-
fy	quality,	etc.

• Invert	image	colours.	This	toggles	the	display	of	images	with	either	a	white	or	black	sky	
background.

• Flip	to	match	FoV.	This	toggles	the	display	of	images	to	match	the	orientation	of	the	Field	of	
view	chart	(i.e.	the	N,S,E,W	cardinal	points).

• Rotate	to	match	FoV.	This	toggles	the	display	of	images	to	match	the	rotation	angle	of	the	Field	
of	view	chart.

- 260 -



• Centre	FoV	chart	at	these	coordinates.	The	Field	of	view	chart	will	be	redrawn,	centred	at	the	
coordinates	of	the	point	where	the	mouse	was	right-clicked.

• Create	new	object	at	these	coordinates.	A	new	object	will	be	created	in	the	plan,	with	the	co-
ordinates	of	the	point	where	the	mouse	was	right-clicked.

• Mark	object	centre.		This	toggles	the	display	of	red	cross	hairs	on	the	image	marking	the	coor-
dinates	of	the	selected	object.

• Find	Catalogue	Objects.	Search	the	installed	catalogues	for	any	objects	that	appear	in	the	dis-
played	image.	Once	that	is	done,	hovering	the	cursor	over	such	an	object	in	the	image	will	dis-
play	the	ID	of	the	object	below	the	image	(Figure	371).

• Find	and	Mark	Catalogue	Objects.	Does	the	same	as	Find	Catalogue	Objects,	but	also	circles	the
found	objects	in	red	on	the	image	(Figure	372).

• Mark	Catalogue	Objects.	After	doing	a	Find	Catalogue	Objects,	this	will	then	mark	the	objects	in
red.

• Unmark	Catalogue	Objects.	Removes	the	marked	objects	added	as	described	above.

• Show	Catalogue	Entry.	Displays	a	sub-menu	containing	the	catalogue	entries	for	marked	ob-
jects	as	described	above.	Selecting	an	object	with	open	the	relevant	catalogue	and	display	the	
object.

Figure	370:	Save	Image	As	dialog
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Figure	371:	After	Find	Catalogue	Objects

Figure	372:	Find	and	Mark	Catalogue	Objects

17.3 Field of View chart
It	is	possible	to	include	images	in	the	Field	of	view	chart.	Any	images	that	overlap	the	current	Field	of	
view	will	be	displayed	(by	default).
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Figure	373:	Images	displayed	in	the	Field	of	view	chart

This	feature	is	enabled	by	using	the	Display	>	Images	option	in	the	Display	Options	panel.

17.4 Images window
To	display	images	of	an	object	in	a	separate	window,	select	the	object	in	the	object	list	and	choose	
Image	>	Display	Images...,	or	right-click	and	choose	Display	Images.

The	images	are	displayed	in	a	panel	with	controls	on	the	right.	You	can	hide	the	controls	by	clicking	
the	Hide	Controls	button	(which	changes	to	Show	Controls).

The	controls	in	the	Images	tab	allow	you	to	select	the	image	being	displayed	(if	the	object	has	more	
than	one	image	associated	with	it).	There's	also	a	popup	menu	that	contains	a	list	of	objects	(Other	
IDs)	in	the	current	plan	document	that	also	have	associated	images.	Choosing	from	this	list	allows	
you	to	display	images	from	other	objects.

The	FoV	Overlay	tab	will	overlay	the	image	with	one	or	more	circular	Field	of	view	reticles,	centred	
on	the	image.	These	can	be	of	Fixed	size,	or	computed	from	the	telescope/eyepiece/imager/optical	
aid	resources	selected	(see	Figure	375).

The	Fit	to	Window	checkbox,	when	checked,	will	resize	the	image	to	Fit	into	the	given	space.	Other-
wise,	the	image	is	displayed	at	full	resolution,	and	scroll	bars	provided	where	necessary	so	that	you	
can	navigate	around	the	image.

The	Custom	Reticles	tab	does	the	same	thing	with	any	custom	reticles	you	might	have	deFined.

The	Angle	slider	allows	you	to	rotate	(non-circular)	reticles	on	the	image	in	order	to	frame	the	im-
age,	where	necessary.
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Figure	374:	Image	display	window

Figure	375:	Field	of	view	overlay

Right-clicking	an	image	offers	a	number	of	options:

Delete	Image.	Deletes	the	currently-displayed	image	from	the	image	database	(and	displays	another
image	associated	with	the	current	object	if	possible).
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Enhance	Image	Contrast.	Enhances	the	current	image's	contrast.	This	will	only	work	if	the	contrast	
has	not	yet	been	enhanced	for	the	current	image.

Centre	FoV/Imager/Reticle	here.

Centre	the	FoV	overlay	or	custom	reticle	overlays	at	the	point	where	the	cursor	was	when	you	right-
clicked.	Useful	for	experimenting	with	imager	framing,	etc.

Save	Image	as....	Save	the	currently-displayed	image	to	an	external	File	in	a	common	format	(e.g.	
JPEG,	PNG,	etc.)

Invert	image	colours.	This	setting	toggles	on	and	off.	When	on,	the	image	colours	will	be	inverted.	
In	particular,	if	the	image	is	white	on	black	(the	default)	then	the	image	will	be	displayed	as	black	on
white.	Note	that	this	does	not	affect	the	image	in	the	database.

Flip	to	match	FoV.	This	setting	toggles	on	and	off.	When	on,	the	image	will	be	inverted	horizontally	
and/or	vertically	to	match	the	settings	for	the	plan	document's	Field	of	view	chart.	Note	that	this	
does	not	affect	the	image	in	the	database.

Rotate	to	match	FoV.	This	setting	toggles	on	and	off.	When	on,	the	image	will	be	rotated	to	match	
the	orientation	of	the	plan	document's	Field	of	view	chart.	Note	that	this	does	not	affect	the	image	in	
the	database.

Centre	FoV	chart	at	these	coordinates.	Centre	the	plan	document's	Field	of	view	chart	at	the	point	
where	the	cursor	was	when	you	right-clicked.

Create	new	object	at	these	coordinates.	Create	a	new	object	in	the	plan	document,	with	RA/Dec	co-
ordinates	at	the	point	where	the	cursor	was	when	you	right-clicked.

Mark	object	centre.	This	setting	toggles	on	and	off.	When	on,	small	red	cross-hairs	will	mark	the	
centre	of	the	underlying	object	in	the	image.	This	might	not	be	at	the	centre	of	the	image	itself.

Find	Catalogue	Objects.	Searches	your	collection	of	catalogues	and	Finds	any	objects	the	exist	with-
in	the	bounds	of	the	displayed	image.	Once	this	has	completed,	you	can	move	the	cursor	around	in-
side	the	image	and	any	known	objects	will	be	displayed	in	a	help	tag.

Find	and	Mark	Catalogue	Objects.	Same	as	for	Find	Catalogue	Objects,	but	the	objects	are	also	
marked	with	a	red	circle	on	the	image.

Mark	Catalogue	Objects.	If	Find	Catalogue	Objects	was	previously	used,	the	objects	are	marked	
with	a	red	circle	on	the	image.

Show	Catalogue	Entry.	If	the	cursor	is	over	a	known	object,	a	hierarchical	list	of	catalogue	entries	is
shown.	Selecting	one	of	them	will	open	the	relevant	catalogue	and	display	the	object	entry.

17.5 Image Manager
The	image	manager	is	a	feature	that	allows	you	to	examine	the	contents	of	your	image	database	in	a	
structured	fashion.	Access	to	the	manager	window	is	via	the	Image	>	Image	Manager...	menu	com-
mand,	and	is	also	available	via	right-clicking	any	image	being	displayed	from	the	database	and	
choosing	the	Image	Manager...	entry.

The	Image	Manager	window	consists	of	a	hierarchical	list	of	images	(in	various	subcategories)	on	
the	left	side,	and	an	image	display	area	on	the	right	side	where	any	images	you	select	are	displayed.
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Figure	376:	Image	Manager	window

Figure	377:	Hierarchical	image	list

The	image	list	splits	the	database	images	into	various	categories:

• By	Source.	The	source	data	set	from	where	the	image	was	downloaded	(e.g.	SDSS).

• By	ID.	The	ID	of	the	image	object,	where	applicable	(e.g.	all	Messier	object	images	would	be	in	
the	"M"	category).

• By	Size.	Each	different	image	size	has	a	category	(e.g.	15'	X	15').

• By	Constellation.	Images	are	sorted	into	categories	by	constellation	(e.g.	Cepheus).

• By	RA.	Images	are	sorted	into	category	by	right	ascension	hour	(i.e.	00h,	01h,	...	,23h).
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• By	Dec.	Images	are	sorted	into	category	by	declination	in	10°	steps	(i.e.	-90°	to	-80°,	...	,	+80°	to	
+90°).

Selecting	a	single	image	displays	that	image	on	the	right	side	of	the	window.	Selecting	more	than	one
image	tiles	the	images.	You	can	also	select	a	category	(a	node	in	the	hierarchy	with	a	folder	icon)	and
all	images	within	that	category	will	be	displayed	(with	an	upper	limit	of	120	images).

Figure	378:	Image	display

Figure	379:	Location	chart
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When	one	or	more	images	are	selected	you	can	also	use	the	Location	Chart	tab	to	show	an	all-sky	
chart	with	the	position	of	the	selected	images	shown.	Double-clicking	an	image	on	the	chart	will	se-
lect	that	image	and	display	it.

The	Delete...	button	can	be	used	to	delete	any	selected	images	from	the	database.

The	Enhance/Enhance	All	button	can	be	used	to	"enhance"	the	image	(improve	its	contrast),	and	
the	Save	button	will	make	those	enhancements	permanent	if	desired.

The	Show	FoV	checkbox,	if	checked,	will	superimpose	a	circle	the	size	of	the	Field	of	view	chart	in	
the	topmost	plan	window.

Figure	380:	FoV	on	image

If	the	selected	image	is	a	User	Image	(one	added	via	the	Image	>	Add	User	Image...	feature,	see	Sec-
tion	11.6.22	on	page	176),	the	an	Edit...	button	appears	under	the	image	and	the	parameters	of	that	
user	image	can	be	changed.
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Figure	381:	Editing	a	User	Image	(Edit...	button)

Figure	382:	Editing	a	User	Image
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18 Highlighting & associating list 
objects

18.1 Highlighting objects
Highlighting	is	the	act	of	changing	the	background	colour	of	objects	in	the	object	list	based	on	some	
rules.	Note	that	this	is	different	from	the	act	of	selecting	one	or	more	objects	in	the	list	using	the	
mouse.

Many	actions	and	scripts	can	operate	on	highlighted	objects	only.	so	this	can	be	useful	to	narrow	
down	objects	to	process.

Highlighting	can	change	over	time.	For	example,	if	the	highlighting	rule	is	true	if	the	object	is	Visible,
then	the	highlighting	status	will	change	if	the	object	drops	below	or	rises	above	the	horizon.

18.1.1 Simple highlighting
There	are	some	simple	highlighting	scenarios	that	cover	most	users'	needs.	You	select	the	highlight-
ing	scenario	via	the	Highlight	popup	just	above	the	tabs	on	the	plan	document	window.	In	Figure	
383	the	scenario	is	"Visible".	This	will	highlight	any	object	that	is	currently	visible	(i.e.	the	Vis	col-
umn	is	"Yes").

Figure	383:	Simple	highlighting

The	available	simple	highlighting	scenarios	are:

• Observed.	Highlighted	if	at	least	one	observation	of	the	object	has	been	made	previously	(i.e.	the
Obs	column	value	is	greater	than	zero).

• Not	Observed.	Highlighted	if	no	observations	of	the	object	have	been	made	previously	(i.e.	the	
Obs	column	value	is	blank/zero).

• Visible.	Highlighted	if	the	object	is	currently	visible	(i.e.	the	Vis	column	is	"Yes").

• Not	Visible.	Highlighted	if	the	object	is	not	currently	visible	(i.e.	the	Vis	column	is	not	"Yes").

- 271 -



• Visible	and	not	Observed.	Highlighted	if	the	object	is	currently	visible	(i.e.	the	Vis	column	is	
"Yes")	and	no	observations	of	the	object	have	been	made	previously	(i.e.	the	Obs	column	value	is	
blank/zero).

• Visible	in	Current	Telescope.	Highlighted	if	a	telescope	is	selected	and	if	the	object's	magnitude
is	brighter	than	the	limiting	magnitude	for	that	telescope	(i.e.	it	is	theoretically	visible).

• Not	Visible	in	Current	Telescope.	Highlighted	if	a	telescope	is	selected	and	if	the	object's	mag-
nitude	is	dimmer	than	the	limiting	magnitude	for	that	telescope	(i.e.	it	is	not	theoretically	
visible).

You	can	change	the	default	highlight	background	colour	via	the	Object	List	preferences.	See	Section	
20.5.8	on	page	296.

18.1.2 Forced highlighting & unhighlighting
You	can	"force"	an	object	to	be	highlighted	if	it	is	currently	not	highlighted.	Similarly,	you	can	"force"	
an	object	which	is	currently	highlighted	to	be	unhighlighted.

Use	Object	>	Highlight	>	Toggle	Forced	Highlighting/Unhighlighting	to	change	the	status	of	se-
lected	object/s	(or	right-click	and	use	Toggle	Forced	Highlighting/Unhighlighting).

You	can	also	remove	this	"forced"	status	from	selected	objects.	Use	Object	>	Highlight	>	Remove	
Any	Forced	Highlighting/Unhighlighting	(or	right-click	and	use	Remove	Any	Forced	Highlight-
ing/Unhighlighting).

The	Forced	status	is	represented	by	special	colours.	You	can	change	those	default	background	
colours	via	the	Object	List	preferences.	See	Section	20.5.8	on	page	296.

18.1.3 Custom highlighting
For	more	complex	highlighting	situations,	you	can	create	your	own	custom	highlighting	scenarios.

A	custom	scenario	consists	of	between	one	and	four	rule	sets.	Each	rule	set	consists	of	a	number	of	
rules.	For	an	object	to	be	highlighted,	at	least	one	(or	perhaps	all)	of	the	rule	sets	must	be	triggered.	
For	a	rule	set	to	be	triggered,	the	object	must	satisfy	at	least	one	(or	perhaps	all)	of	the	rules	in	the	
rule	set.

The	various	rules	that	are	triggered	are	summarised	underneath	the	object	list	in	the	Objects	tab	of	
the	plan	document	window.	If	more	than	one	rule	set	is	triggered	for	an	object,	the	object	entry	is	
striped	with	the	relevant	colours.	For	example,	in	Figure	384	two	rule	sets	are	active.	The	First,	in	
blue,	is	triggered	if	the	object's	altitude	is	greater	than	30°.	The	second,	in	pink,	is	triggered	if	the	ID	
starts	with	"M".	M97	and	M108	trigger	both	rule	sets.	M102	triggers	only	the	second	rule	set.

Figure	384:	Custom	highlighting	with	multiple	rule	sets

To	create	or	edit	custom	highlighting	scenarios,	choose	Edit	Custom	Highlighting...	from	the	High-
lighting	popup,	or	use	Object	>	Highlight	>	Edit	Custom	Highlighting...

The	editing	dialog	(Figure	385)	edits	various	predeFined	scenarios	you	have	created	(in	the	list	at	
the	lower	right	of	the	dialog	window).	The	Custom	Default	is	always	present	and	cannot	be	re-
named.	To	create	a	new	scenario,	click	the	+	button.	To	delete	an	existing	scenario	(apart	from	the	
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Custom	Default),	use	the	-	button.	The	scenario	selected	in	the	list	is	the	one	being	edited.	If	you	use	
the	+	button	to	create	a	new	scenario,	it	will	duplicate	the	settings	of	the	currently	selected	scenario.

A	scenario	consists	of	one	to	four	rule	sets,	listed	along	the	top	of	the	window.	Use	the	radio	button	
next	to	each	rule	set	to	choose	that	set	for	editing.	The	colour	used	for	highlighting	a	particular	rule	
set	is	shown	and	can	be	changed	by	clicking.	A	rule	set	is	active	only	if	it	has	one	or	more	rules	se-
lected.	In	the	example	in	Figure	385	only	Rule	Set	#1	would	be	active.

For	each	rule	set	you	specify	which	(selected)	rules	are	used	to	determine	whether	the	rule	set	is	
triggered.	The	popup	for	this	function	can	be:

• All	rules	true.	Effectively	a	logical	AND	of	all	the	selected	rules.

• Any	rule	true.	Effectively	a	logical	OR	of	all	the	selected	rules.

• All	rules	false.	Effectively	a	logical	NOR	of	all	the	selected	rules.

• Any	rule	false.	Effectively	a	logical	NAND	of	all	the	selected	rules.

• Ignore	all	rules.	Effectively	disables	this	rule	set.	Useful	for	temporarily	disabling	the	rule	set.

Figure	385:	Custom	highlighting	editor	dialog

If	you	specify	a	rule	on	an	Observation,	then	for	any	object,	each	associated	observation	is	consid-
ered.	The	popup	at	the	top	then	speciFies	which	observations	the	rule	is	applicable	to:

• Any	observation.	The	rule	is	true	if	any	associated	observation	matches	the	rule	condition.

• All	observations.	The	rule	is	true	if	all	associated	observations	match	the	rule	condition.

• Oldest	observation.	The	rule	is	true	if	the	oldest	associated	observation	matches	the	rule	
condition.
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• Latest	observation.	The	rule	is	true	if	the	latest	associated	observation	matches	the	rule	
condition.

For	example,	in	Figure	386	highlighting	of	an	object	will	occur	only	if	(a)	the	object	type	is	a	Galaxy,	
and	(b)	at	least	one	observation	of	that	object	was	made	using	a	Plössl	eyepiece.

Editing	of	rules	is	done	by	selecting	the	rule	in	the	hierarchical	list	at	the	lower	left	of	the	window.	
An	editing	pane	for	that	rule	appears	on	the	right	and	allows	editing	of	the	conditional	part	of	the	
rule.

Figure	386:	Custom	highlighting	with	observation	rule

Options	at	the	top	right	are:

Only	highlighted	if	ALL	rule	sets	triggered.	If	this	is	unchecked	(default),	the	highlighting	will	oc-
cur	if	any	rule	set	is	triggered.	If	it	is	checked	then	all	(active)	rule	sets	must	be	triggered	for	high-
lighting	to	occur.

Stop	checking	when	Oirst	rule	set	triggered.	Stop	the	rule-testing	as	soon	as	the	First	rule	set	is	
triggered,	and	colour	the	object	entry	appropriately	with	a	single	colour.

Only	show	colour	of	Oirst	triggered	set.	If	multiple	rule	sets	were	triggered,	only	show	the	colour	
for	the	First	one	triggered.

Sort	by.	Also	sort	the	object	list	by	the	selected	sort	order	when	this	scenario	is	selected	for	use.	
Sort	orders	are	created	using	the	Sort	List	popup	under	the	object	list	(see	Section	11.2.13	on	page	
110).

Saving	and	loading	the	contents	of	the	custom	rule	sets	can	be	done	using	the	Save...	and	Load...	but-
tons.	This	is	convenient	for	transferring	custom	scenarios	between	plan	documents.
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18.2 Associating objects
Sometimes	it	is	convenient	to	associate	two	or	more	objects	as	being,	say,	part	of	a	larger	entity	or	
association.	For	example,	you	might	want	to	associate	a	number	of	galaxy	objects	as	being	part	of	a	
cluster	(e.g.	Virgo	cluster).	When	these	objects	are	associated	they	should	always	remain	together	in
the	object	list,	in	the	same	original	order,	regardless	of	the	sort	ordering	of	the	rest	of	the	object	list.	
If	a	sort	order	is	chosen	for	the	list,	then	the	objects	will	be	not	be	sorted	within	the	association,	but	
will	be	ordered	within	the	whole	object	list	by	the	First	object	in	the	association.

For	example,	Figure	387	shows	a	number	of	associated	galaxies	(M58,	59,	60,	84,	86,	87,	89,	and	90)	
that	have	been	associated.	The	list	has	been	sorted	by	Declination,	but	the	associated	galaxies	stay	in
ID	order	within	the	association.

Figure	387:	Associated	objects

Associated	objects	are	displayed	with	connecting	lines	on	the	left	side	of	the	ID	column.

You	initially	create	an	association	by	selecting	two	or	more	objects	in	the	object	list.	Then	associate	
them	by	choosing	Object	>	Associate	>	Associate	Selected	Objects	(or	right-clicking	and	choosing	
Associate	selected	objects).

You	can	add	additional	objects	to	the	association	by	dragging	the	entry	in	the	object	list	onto	the	ob-
jects	currently	associated.

You	can	reorder	the	objects	within	the	association	by	dragging	the	member	objects	up	or	down	
with	the	mouse.

To	remove	one	or	more	objects	from	an	association,	use	one	of	these	methods:

• Drag	the	object/s	to	a	point	outside	of	the	association.

• Select	the	object/s	and	use	Object	>	Associate	>	Disassociate	Selected	Object/s.

• Select	the	object/s,	right-click	and	use	Disassociate	selected	object/s.

Object	associations	are	stored	with	the	object	data	in	the	plan	document.
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19 User-defined fields
For	many	items	that	are	handled	by	the	application,	you	can	add	your	own	user-deFined	Fields.	In	
particular,	you	can	deFine	user-deFined	Fields	for:

• Objects

• Observations

• Observation	sessions

• Observation	attachments

• Resources

• Plan	documents

All	of	these	user-deFined	Fields	are	globally	applicable	to	the	items	for	which	they	are	deFined,	apart	
from	the	Object	user-deFined	Fields,	which	are	local	to	the	plan	document	in	which	they	are	deFined.

There	is	no	limit	to	the	number	of	user-deFined	Fields	you	can	deFine	(within	reason).

Some	examples:	you	might	want	to	add	a	Weight	Field	to	Telescope	resources,	a	Quantum	EfFiciency	
Field	to	Imager	resources,	a	Weather	or	Temperature	Field	to	observation	sessions,	etc.

The	Fields	are	typically	displayed	in	a	two-column	list	(Figure	388).	You	can	edit	the	values	by	click-
ing	on	the	entry	in	the	right-hand	column.

Figure	388:	User-deFined	Field	list

19.1 Field values vs. field definitions
Each	user-deFined	Field	entry	or	value	attached	to	an	item	has	two	parts:	a	Field	name	and	a	corre-
sponding	value	(e.g.	"Temperature"	and	"48").	Both	are	stored	as	strings.

Additionally,	there	should	also	be	a	user-deFined	Field	dePinition	corresponding	to	the	Field	name.	
This	deFinition	contains	information	pertaining	to	then	type	of	the	Field	(number,	string,	etc.),	how	
the	Field	value	should	be	displayed,	units,	range	of	valid	values,	etc.

You	can	delete	a	Field	deFinition	without	deleting	the	underlying	values.	In	this	case,	the	entries	will	
be	displayed	in	a	blue	colour	(e.g.	Temperature	in	Figure	388)	and	will	be	treated	as	simple	charac-
ter	strings	(i.e.	no	range	checking,	etc.	will	be	done	if	the	value	is	edited).

19.2 Field types
Each	user-deFined	Field	is	deFined	to	be	one	of	several	possible	types.
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Figure	389:	User-deFined	Field	types

19.2.1 Boolean value
This	is	a	Field	that	can	only	have	two	states:	on/off,	yes/no,	true/false,	etc.	A	checkbox	is	displayed	in
the	value	column.

19.2.2 Character string
This	is	the	default.	Any	string	of	characters	is	valid.

19.2.3 Choice
Choose	one	of	several	Fixed	values.	e.g.	an	"OTA"	Field	for	telescope	resources	might	have	the	choices:
"Metal	tube",	"Truss",	"Carbon	Fibre	tube",	"Cardboard	tube".	The	values	are	selected	by	a	popup	
menu	containing	the	choices.

19.2.4 File reference
A	reference	to	a	File	on	your	hard	disk.	Clicking	the	value	Field	allows	you	to	select	a	File.	The	File	
name	is	displayed,	and	an	Open	button	shown.	Clicking	that	button	will	open	the	File	with	an	appro-
priate	application.

19.2.5 Floating-point number
A	Floating-point	number.	You	can	specify	range	of	valid	values,	decimal	places	to	display,	etc.

19.2.6 Folder reference
A	reference	to	a	folder	on	your	hard	disk.	Clicking	the	value	Field	allows	you	to	select	a	folder.	The	
folder	name	is	displayed,	and	an	Reveal	button	shown.	Clicking	that	button	will	reveal	the	folder	in	
the	Finder	(Mac)	or	Windows	Explorer	(Windows).

19.2.7 Integer number
An	integer	number.	You	can	specify	range	of	valid	values,	etc.

19.2.8 Internet URL
A	valid	URL	can	be	put	in	this	Field.	A	Show	button	is	displayed.	Clicking	Show	will	load	the	page	into
your	browser.

19.2.9 Script
The	value	is	computed	by	means	of	a	script.	See	Section	27.10	on	page	377	for	more	information.

19.3 Creating and editing a user-defined field
Right-click	the	user-deFined	Field	list	and	choose	Edit	User-deLined	Fields....	The	user-deFined	Field	
editor	(See	Figure	391	for	example)	has	a	list	of	Fields	on	the	left.	Click	the	+	button	to	create	a	new	
user-Field	deFinition.	Give	the	Field	a	title	(this	appears	on	the	left	side	of	the	user-deFined	Field	list),	
and	choose	a	Field	type.	Different	types	might	have	additional	Fields.

- 277 -



You	can	select	a	non-standard	text	colour	and	background	colour,	by	using	the	colour	checkboxes	
and	clicking	the	colour	swatches	to	choose	an	appropriate	colour.	You	can	also	specify	the	style	of	
the	displayed	text	(bold,	italic	and/or	underline).

If	you	want	a	tooltip	to	appear	when	you	hover	the	mouse	cursor	over	the	Field,	you	can	enter	it	
here.	This	might	be	useful	as	a	memory	device	if	the	Field	can	contain	certain	values.

The	Load...	and	Save...	buttons	allow	you	transfer	the	set	of	deFinitions	between	computers,	or	be-
tween	plan	documents	(plan	documents	each	deFine	their	own	set	of	user-deFined	Fields).

19.3.1 Boolean value
In	addition	to	the	common	Fields,	you	need	to	specify	the	following:

• Text.	This	is	the	text	that	appears	in,	for	example,	the	object	list	to	show	the	value	of	the	Field.	e.g.
Yes/No,	True/False,	On/Off,	etc.	Note	that	if	the	value	has	not	yet	been	selected	(see	below),	the	
displayed	text	will	be	blank.

• First	click.	If	the	value	of	a	boolean	user-deFined	Field	Field	has	not	yet	been	set,	the	checkbox	is	
shown	in	an	"indeterminate"	state.	To	enter	a	value,	you	click	the	checkbox.	The	First	time	you	do
that,	this	setting	determines	which	state	the	checkbox	takes	on.

Figure	390:	Edit	boolean	user-deFined	Field

19.3.2 Character string
There	are	no	additional	values	to	enter	here.
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Figure	391:	Edit	character	string	user-deFined	Field

19.3.3 Choice
In	addition	to	the	common	Fields,	you	need	to	specify	the	following:

• Choices.	These	are	the	values	that	will	appear	in	the	popup	menu,	one	choice	per	line.

Figure	392:	Edit	choice	user-deFined	Field

19.3.4 File reference
There	are	no	additional	values	to	enter	here.
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Figure	393:	Edit	File	reference	user-deFined	Field

19.3.5 Floating-point number
In	addition	to	the	common	Fields,	you	need	to	specify	the	following:

• Units.	If	your	numbers	have	units	(e.g.	°F,	kph,	arcsec,	etc.)	then	this	string	will	be	displayed	after
the	number	in	the	list.	It	will	not	appear	when	you	edit	the	number	value	however.

• Decimals.	The	number	of	decimal	places	to	display	after	the	decimal	point.	A	negative	number	
speciFies	the	maximum	number	of	decimal	places.	e.g.	if	Decimals	=	3	and	the	value	is	123.4,	then	
123.400	will	be	displayed.	If	Decimals	=	-3	and	the	value	is	123.4,	then	123.4	will	be	displayed.

• Range.	You	can	specify	lower	and/or	upper	bounds	for	the	numbers	you	enter.	If	the	numbers	
are	outside	these	bounds,	they	will	be	displayed	in	red.
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Figure	394:	Edit	Floating-point	number	user-deFined	Field

19.3.6 Folder reference
There	are	no	additional	values	to	enter	here.

Figure	395:	Edit	folder	reference	user-deFined	Field

19.3.7 Integer number
In	addition	to	the	common	Fields,	you	need	to	specify	the	following:
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• Units.	If	your	numbers	have	units	(e.g.	°F,	kph,	days,	etc.)	then	this	string	will	be	displayed	after	
the	number	in	the	list.	It	will	not	appear	when	you	edit	the	number	value	however.

• Range.	You	can	specify	lower	and/or	upper	bounds	for	the	numbers	you	enter.	If	the	numbers	
are	outside	these	bounds,	they	will	be	displayed	in	red.

Figure	396:	Edit	integer	number	user-deFined	Field

19.3.8 Internet URL
There	are	no	additional	values	to	enter	here.
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Figure	397:	Edit	Internet	URL	user-deFined	Field

19.3.9 Script
In	addition	to	the	common	Fields,	you	need	to	specify	the	following:

• Script.	The	script	that	is	to	be	run	to	compute	the	value	of	the	user-deFined	Field.	Only	special	
User	Field	scripts	are	listed.	See	Section	27.10	on	page	377	for	more	details.

• Parameter.	User	Field	scripts	accept	an	optional	parameter	that	can	be	used	to	determine	what	
information	they	should	compute	or	return.	If	required	enter	the	parameter	value	here.	e.g.	A	
script	might	compute	the	position	of	an	object.	By	setting	the	parameter	to	"RA"	it	will	return	the
R.A.	value,	and	"Dec"	would	return	the	Declination.

• Returns	numeric	result.	Set	this	if	the	script	returns	a	numeric	result.
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Figure	398:	Edit	script	user-deFined	Field

19.4 Deleting a user-defined field & values
A	user-deFined	Field	deFinition	can	be	deleted	from	the	editor	dialog	as	shown	above.	Although	the	
deFinition	is	then	deleted,	the	underlying	values	are	not	automatically	deleted.	If	such	values	exist,	
they	will	be	displayed	in	a	blue	colour	after	any	Fields	with	corresponding	deFinitions.	You	can	delete
the	values	by	right-clicking	and	using	Delete	xxx	value	or	Delete	all	xxx	values,	where	xxx	is	the	
user-deFined	Field	name.

19.5 Object list user-defined fields
Right-clicking	the	object	list	user-deFined	Fields	listbox	shows	"Show	Column:	xxxx"	or	"Hide	Col-
umn:	xxxx"	(for	deFined	Fields	xxxx).	Selecting	one	of	these	toggles	the	column's	visibility	in	the	ob-
ject	list.	Note	that	it	doesn't	change	the	position	of	the	column	-	to	do	that	you'll	still	need	to	go	to	
Edit	>	List	Columns...

- 284 -



20 Preferences
20.1 General preferences
General	preferences	refer	to	settings	that	do	not	fall	into	any	speciFic	area	covered	by	the	other	pref-
erences	listed	below.	They	are	accessed	by	the	AstroPlanner	>	Preferences	menu	command	(Mac-
intosh)	or	Edit	>	Preferences	menu	command	(Windows),	and	selecting	the	General	tab.

Figure	399:	General	preferences

20.1.1 Formats
Time.	The	default	time	display	format.	If	you	choose	OS	Settings	then	time	will	be	displayed	the	
same	way	as	it	is	set	in	your	operating	system	Date/Time	control	panel	or	System	Preferences.	Oth-
er	you	can	set	the	application	to	force	a	24	hour	clock	(i.e.	3:15pm	would	be	displayed	as	15:15).

Date.	The	default	date	display	format.	If	you	choose	OS	Settings	then	dates	will	be	displayed	the	
same	way	as	it	is	set	in	your	operating	system	Date/Time	control	panel	or	System	Preferences.	Oth-
er	you	can	set	the	application	to	force	various	date	formats.

Excel.	When	exporting	to	Excel	you	can	deFine	which	File	format	you	wish	to	use:

• Old	style.	Compatible	with	older	versions	of	Excel.	However,	Fields	are	limited	to	255	characters	
maximum.	If	this	limit	is	exceeded	for	a	Field,	it	will	be	split	over	two	or	more	rows.

• Old	style	with	truncation.	As	above,	but	if	a	Field	exceeds	255	characters	it	will	be	truncated	at	
255	characters.	

• New	style.	Compatible	with	newer	versions	of	Excel.	No	Field	length	limits.
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Add	spaces	to	DMS	values.	When	angular	values	are	displayed,	they	are	typically	displayed	without
spaces	(e.g.	123°45'12").	If	this	option	is	selected,	spaces	are	added	for	readability	(e.g.	123°	45'	
12").

20.1.2 Night Vision mode settings
Colour.	The	fundamental	colour	to	use.	Red	(traditional),	Green	(preferred	by	some	since	green	is	
more	visible	at	low	light	intensities	than	red),	and	Grey.

Brightness.	This	slider	changes	the	maximum	colour	intensity.

Remember	mode	when	quitting.	Remember	if	you	were	in	night	vision	mode	when	you	quit,	and	
re-instate	that	mode	next	time	you	run	AstroPlanner.

Disable	night	vision	when	inactive.	Disable	night	vision	when	another	application	is	brought	to	
the	front.

Invert	Sky	and	FoV	chart	colour.	Change	the	Sky	and	Field	of	View	charts	to	display	black	stars	on	
a	red/green/grey	background.

Also	attempt	gamma	colour	control.	Windows	only.	It	is	theoretically	possible	to	adjust	the	video	
gamma	to	display	tones	of	red/green/grey	on	Windows.	In	reality,	only	some	Windows	graphics	
cards	allow	this,	and	even	then	it's	not	particularly	effective.	Try	this	option	and	see	what	happens.

Test.	Tests	the	night	vision	mode	for	5	seconds	and	then	switches	back	to	normal	(in	case	you	can't	
see	what	you're	doing	when	everything	goes	dim).

20.1.3 Spelling checker
AstroPlanner	has	a	built-in	spelling	checker	that	operates	on	all	text	Fields	(those	that	allow	multiple
lines	of	text).	These	settings	deFine	how	the	system	functions.

Language.	Choose	the	language	you	wish	to	use.	English	is	the	default	and	is	immediately	available.	
French,	German,	Italian	and	Spanish	are	available,	but	need	to	be	downloaded	from	the	Internet.

Status.	Whether	the	selected	language	is	available,	or	needs	to	be	downloaded.

Download.	Download	the	spelling	dictionary	for	the	selected	language.

Remove.	Remove	the	selected	language	dictionary	from	disk.

Suggestions.	The	maximum	number	of	spelling	suggestions	per	error.

Edit	User	Dictionary....	Edit	the	supplemental	user	dictionary.	Add,	remove	or	change	words	from	
the	custom	user	dictionary.	Use	the	Add	Astro	Words	button	to	populate	the	list	with	a	number	of	
common	(and	not-so-common)	astronomical	terms.
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Figure	400:	Edit	user	dictionary

Inline	checking.	Mark	errors	"on	the	Fly"	by	changing	the	colour	of	the	word	in	error.

Error	colour.	The	colour	of	words	in	error.	Click	the	swatch	to	change	the	colour.

20.1.4 Opening plan documents
Remember	open	documents.	If	any	(non-untitled)	plan	documents	are	open	when	you	quit	Astro-
Planner,	then	this	option	makes	sure	they	are	remembered,	and	next	time	you	run	the	AstroPlanner	
application	those	documents	will	be	re-opened	automatically	(assuming	they	were	not	subsequently
moved	or	deleted).

Note:	(Windows	only)	If	you	close	the	last	plan	document	and	that	in	turn	closes	the	application,	that
last	plan	document	will	be	remembered.

Open	documents	to	Oill	screen.	Normally,	the	size	and	position	of	plan	document	windows	are	re-
membered	when	they	are	closed	and	restored	when	the	document	is	reopened.	This	setting	will	al-
ways	open	a	document	to	Fill	the	screen.

Make	backup	copy.	Whenever	you	open	a	document,	a	backup	copy	is	made	in	the	same	folder	as	
the	original,	but	with	"_Backup"	appended	to	the	name.	If	such	a	File	already	exists	it	will	be	over-
written.	This	is	useful	if	you	make	changes	to	the	document,	and	then	decide	you	didn't	want	to	do	
that.

Create	untitled	plan	document	on	launch.	(Macintosh	only)	The	normal	behaviour	when	an	appli-
cation	is	started	is	to	open	an	untitled,	empty	document	if	no	other	documents	were	opened.	This	
option	allows	you	to	disable	that	behaviour	and	not	create	an	empty	document.

20.1.5 Computations
Consider	atmospheric	refraction.	Take	into	account	the	effects	of	atmospheric	refraction	when	
computing	object	altitude	above	the	horizon.	This	can	increase	the	amount	of	computation	needed,	
but	gives	better	results	for	objects	close	to	the	horizon.
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20.1.6 Plan auto-save
Automatically	save	the	open	plan	document	to	disk	periodically	(if	changes	have	been	made).

20.1.7 Closing last plan document
(Windows	only)	What	to	do	when	you	close	the	only	remaining	plan	document	window.	Typically	
this	will	cause	the	application	to	quit,	but	another	option	is	to	display	an	empty	background	window
with	a	menu	that	allows	you	to	open	another	plan	document	without	quitting.

20.1.8 Creating new plans
Normally	a	new	untitled	plan	document	is	opened	with	default	settings.	You	can	use	the	Based	on	
template	option	to	base	the	new	document	on	the	settings	found	in	an	existing	plan	document	
(which	you	specify).	Settings	include	object	list	column	settings,	Field	of	view	and	sky	chart	settings,	
etc.	You	can	apply	this	template	to	new	plans,	downloaded	user-contributed	plans,	and/or	plans	that
are	converted	from	old	V1.x	AstroPlanner	plan	documents.

20.1.9 Synonym search
When	you	do	synonym	searches	(e.g.	Object	>	Search	>	Lookup	Synonyms...),	this	setting	speciFies	
how	close	a	plan	object	needs	to	be	from	a	catalogue	object	(in	arcseconds)	for	those	objects	to	be	
considered	(potential)	synonyms.

20.1.10 Default site location
If	you	don't	set	the	Site	for	a	plan	document,	this	setting	speciFies	a	default	site	to	use	(to	compute	
visibility	of	objects,	etc.).	You	can	select	an	existing	site	resource,	or	you	can	select	"No	site.	Use	val-
ues	below"	and	enter	the	latitude,	longitude	and	GMT	offset	manually.

20.1.11 GUI interface font
The	GUI	(Graphical	User	Interface)	normally	uses	fonts	and	sizes	deFined	by	the	operating	system.	
You	can	deFine	your	own	font	and	size	settings	here.	Warning:	the	GUI	will	not	resize	to	handle	larg-
er	or	smaller	fonts,	so	you	might	experience	user	interface	anomalies	if	you	stray	from	the	standard	
settings.

20.1.12 Extra documentation folder
If	you	have	extra	documentation	(HTML	and	PDF	documents)	that	you	might	access	while	using	As-
troPlanner,	you	can	use	this	option	to	deFine	a	folder	that	contains	those	documents.	Any	relevant	
documents	found	in	that	folder	will	be	added	to	the	end	of	the	Help	menu.

20.1.13 Reset Warnings
Many	alert	dialogs	give	you	the	option:	"Don't	show	this	again".	If	you	select	that	option,	that	alert	
will	not	be	shown	the	next	time	the	alert	is	called.	This	reset	button	effectively	turns	all	those	set-
tings	off,	so	that	all	alerts	will	be	seen	again.

20.2 Printing preferences
Printing	preferences	are	settings	applicable	to	any	printing	done	from	AstroPlanner.	They	are	ac-
cessed	by	the	AstroPlanner	>	Preferences	menu	command	(Macintosh)	or	Edit	>	Preferences	
menu	command	(Windows),	and	selecting	the	Printing	tab.
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Figure	401:	Printing	preferences

20.2.1 Print margins
These	represent	margins	(measured	in	mm)	to	be	used	on	each	printed	page.	Note	that	these	mar-
gins	are	in	addition	to	any	margins	you	deFine	in	File	>	Page	Setup...

20.2.2 Printing fonts
These	are	fonts	and	sizes	used	(by	default)	when	print	charts	and	reports.	Headings,	Body	and	Foot-
er	refer	to	printed	reports	(objects	and	observations),	Chart	and	Legend	to	printed	Field	of	view	or	
sky	charts,	and	Script	to	any	tables	or	text	created	by	a	script.

20.2.3 Images
Always	print	DSS	images	black-on-white.	Whenever	a	DSS	image	is	printed	from	the	image	dis-
play	window,	invert	the	grey-scale	so	that	stars	are	printed	black	and	the	background	sky	in	white.	
Apart	from	saving	ink,	such	printed	images	might	be	easier	to	view	under	low	light.

Always	print	colour	SDSS	images	in	grey-scale.	Whenever	a	colour	SDSS	image	is	printed	from	
the	image	display	window,	convert	the	colours	to	monochrome.

20.2.4 Printer scaling
If	your	printer	consistently	prints	either	too	big	or	too	small,	it	could	be	because	the	printer	driver	is
not	returning	the	correct	scaling	or	resolution	information	to	the	application.	The	printer	scaling	
value	can	be	used	to	increase	or	decrease	the	size	of	the	printed	information.	e.g.	if	the	factor	is	1.5,	
the	page	will	be	printed	at	150%.	The	default	value	is	1	(print	at	the	scale	the	printer	reports	to	the	
application).
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20.3 Web preferences
Web	preferences	are	settings	applicable	to	any	Internet	access	from	AstroPlanner.	They	are	accessed
by	the	AstroPlanner	>	Preferences	menu	command	(Macintosh)	or	Edit	>	Preferences	menu	com-
mand	(Windows),	and	selecting	the	Web	tab.

Figure	402:	Web	preferences

20.3.1 E-Mail
Your	full	name	and	address.	These	settings	will	be	used	to	create	an	e-mail	return	address	for	any	
outgoing	e-mail	messages.

Allow	outgoing	e-mail	via	SMTP.

If	you	are	able	to	send	e-mail	from	your	computer	via	SMTP	(the	most	common	e-mail	protocol),	
then	select	this	option	and	Fill	in	the	settings	below	it.	If	you	don't	select	this	option	you	will	still	be	
able	to	send	bug	reports,	but	will	be	unable	to	attach	any	Files,	screenshots,	etc.

GMail.	If	you	are	using	a	GMail	address	(@gmail.com)	then	this	button	will	set	the	correct	settings	
for	you	(apart	from	your	password).

Server	address	&	port.	The	SMTP	server	address	and	port	number.	Typically,	if	your	e-mail	address
is	xxxxx@yyyyy,	then	the	server	address	will	be	mail.yyyyy	or	smtp.yyyyy,	but	this	varies	with	Inter-
net	providers.

User	name	&	password.	If	your	SMTP	server	requires	a	login	(most	do)	then	this	will	be	your	user	
ID	and	password	(typically	this	is	the	same	as	the	ID	and	password	you	use	for	checking	for	incom-
ing	e-mail).

Security.	The	kind	of	secure	connection	to	use.	If	in	doubt,	use	None.
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Test.	Clicking	this	attempts	to	send	a	brief	test	e-mail	message	to	yourself	to	see	if	the	settings	work.

20.3.2 Web Services
This	(somewhat	specialised)	feature	causes	the	AstroPlanner	application	to	act	as	a	web	(HTTP)	
client,	and	it	can	listen	for	and	react	to	certain	commands	sent	from	another	application,	browser,	or
another	instance	of	AstroPlanner	on	another	computer.	You	can	specify	the	port	number	to	listen	on,
and	you	can	log	transactions	to	a	File.	The	Authentication	string,	if	present,	is	required	to	be	passed
in	incoming	messages.	Such	messages	will	be	ignored	if	the	authentication	string	does	not	match.

Currently	all	operations	are	script-based	(e.g.	running	a	script	on	the	computer,	etc.).	If	you	click	the	
Start	Listening	button	and	then	click	the	Default	page	link,	your	browser	should	show	a	list	of	
commands	and	the	command	format,	including	links	to	test	the	functionality.	

The	commands	and	responses	are	all	JSON	encoded.

20.4 External applications preferences
External	applications	preferences	are	settings	applicable	to	selected	applications	that	can	be	ac-
cessed	or	controlled	from	AstroPlanner.	The	preferences	are	accessed	by	the	AstroPlanner	>	Pref-
erences	menu	command	(Macintosh)	or	Edit	>	Preferences	menu	command	(Windows),	and	select-
ing	the	External	tab.

Figure	403:	External	applications	preferences

20.4.1 Planetarium application
AstroPlanner	is	able	to	communicate	with	selected	3rd-party	planetarium	applications	(see	Section	
21.2	on	page	321).	These	settings	let	you	choose	the	planetarium	application	you	wish	to	use,	and	
how	you	want	to	communicate	with	it.
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The	popup	menu	lists	all	possible	applications.	These	are,	currently:

• Cartes	du	Ciel	(Sky	Charts)	V2	(Windows-only)

• Cartes	du	Ciel	(Sky	Charts)	V3	(Macintosh	&	Windows)

• C2A	(Windows-only)

Others	might	be	introduced	in	future	releases.

There	are	a	number	of	checkboxes	to	enable	communication	features	(where	applicable).	xxx	repre-
sents	the	name	of	the	planetarium	application:

• Synchronise	AstroPlanner	FoV	centre	coordinates	with	xxx's	FoV.	Asks	the	planetarium	ap-
plication	for	the	current	coordinates	of	the	Field	of	view	being	shown,	and	changes	AstroPlann-
er's	Field	of	view	chart	to	be	centred	at	the	same	coordinates.

• Synchronise	AstroPlanner	FoV	angular	diameter	with	xxx's	FoV.	Asks	the	planetarium	appli-
cation	for	the	current	size	of	the	Field	of	view	being	shown,	and	changes	AstroPlanner's	Field	of	
view	chart	to	be	the	same	size	(where	possible1).

• Create	new	object	in	current	plan	when	object	is	clicked	in	xxx.	This	is	a	way	to	identify	ob-
jects	in	the	planetarium	application,	and	AstroPlanner	will	create	a	new	object	in	the	plan's	ob-
ject	list.	Note	that	"clicking"	might	be	qualiFied	in	the	planetarium	application,	e.g.	control-click-
ing,	shift-clicking,	etc.

• Synchronise	xxx's	FoV	centre	coordinates	with	AstroPlanner's	FoV.	Whenever	AstroPlann-
er's	Field	of	view	chart	changes	its	centre	coordinates,	the	planetarium	application	is	asked	to	
change	its	centre	to	the	same	coordinates.

• Synchronise	xxx's	FoV	angular	diameter	with	AstroPlanner's	FoV.	Whenever	AstroPlanner's	
Field	of	view	chart	changes	its	diameter,	the	planetarium	application	is	asked	to	change	its	diam-
eter	to	the	same	size.

• Synchronise	xxx's	FoV	centre	coordinates	with	AstroPlanner's	telescope	coordinates.	If	As-
troPlanner	has	a	computerised	telescope	connected,	then	whenever	the	telescope	pointing	coor-
dinates	change,	the	planetarium	application	is	asked	to	change	its	centre	to	the	same	
coordinates.

• Manual	control	of	FoV.	If	this	is	checked	then	the	"→E"	and	"←E"	buttons	next	to	the	Field	of	
view	chart	are	enabled,	allowing	manual	control	of	the	above	features.

• Refresh	rate.	The	rate	at	which	the	above	synchronisations	are	done	automatically.	If	this	set-
ting	is	"Never"	(recommended),	then	the	manual	control	option	should	be	checked.

• Debug.	If	this	setting	is	checked,	debugging	information	is	output	to	a	debug	window.	This	is	
only	really	necessary	if	you	are	not	getting	a	response	from	the	planetarium	application.

20.4.2 Digital DomeWorks compatibility
The	Digital	DomeWorks	control	software	can	check	a	text	File	for	new	pointing	coordinates	in	order	
to	rotate	a	dome	to	reFlect	the	current	telescope	pointing	coordinates.	These	settings	enable	this	op-
tion,	specify	the	name	and	path	of	the	File	on	your	disk,	and	specify	how	often	to	change	the	text	File.

1. AstroPlanner	has	a	maximum	Field	of	view	chart	diameter	of	60°.	Most	planetarium	applications	allow	larger	values	than	this.
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20.5 Object list preferences
Object	list	preferences	can	be	accessed	from:

• Main	menu:	Object	>	Object	List	Preferences...

• Right-clicking	the	object	list	and	choosing	Other	>	Object	List	Preferences...	from	the	popup	
menu.

• By	clicking	the	preferences	button	under	the	object	list	in	the	Objects	tab	of	a	plan	document	
window	(marked	in	Figure	404).

• Using	the	AstroPlanner	>	Preferences	menu	command	(Macintosh)	or	Edit	>	Preferences	menu
command	(Windows),	selecting	the	Other	tab,	and	clicking	the	relevant	Open	button.

Figure	404:	Object	List	Preferences	button

Figure	405:	Object	List	preferences	window

20.5.1 Visibility, Alt/Az and Constellation indicators
These	indicators	are	(optionally)	displayed	above	the	object	list.
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Display	short-term	visibility	indicator.	The	checkbox	toggles	on	and	off	the	display	of	the	short-
term	visibility	indicator.	The	indicator	shows	the	altitude	of	the	selected	object	over	a	short	period	
(≤	24	hours).	The	Start	and	Length	values	determine	the	start	time	of	the	chart	and	the	number	of	
hours	duration.	These	items	can	also	be	selected	by	right-clicking	the	chart	in	question.

Display	long-term	visibility	indicator.	The	checkbox	toggles	on	and	off	the	display	of	the	long-
term	visibility	indicator.	The	indicator	shows	the	altitude	of	the	selected	object	over	a	long	period	(≤
12	months,	determined	by	the	Period	value).	The	altitude	is	shown	for	a	particular	day	of	the	week	
and	time	(the	For	values).	The	chart	y-axis	can	either	show	altitude	above	the	horizon	(marked	by	a	
red	cross),	or	a	time-of-night	indication	of	when	the	object	is	above	the	horizon	(shown	as	a	vertical	
yellow	line).	These	items	can	also	be	selected	by	right-clicking	the	chart	in	question.

Display	Alt/Az	indicator.	This	checkbox	toggles	on	and	off	the	display	of	the	alt/az	indicator.	The	
indicator	shows	the	azimuth	and	altitude	of	the	selected	object,	as	well	as	the	distance	of	the	object	
from	the	sun	and	moon	(in	degrees).	This	item	can	also	be	selected	by	right-clicking	the	chart	in	
question.

Display	Constellation	indicator.	This	checkbox	toggles	on	and	off	the	display	of	the	constellation	
indicator.	The	indicator	shows	a	graphical	representation	of	the	constellation	containing	the	select-
ed	object.	This	item	can	also	be	selected	by	right-clicking	the	chart	in	question.

Show	site	horizon.	Show	the	user-deFined	site	horizon	(if	available)	in	applicable	indicators	(short-	
and	long-term	visibility	and	alt/az).

Display	apparent	magnitude.	Display	the	apparent	magnitude	of	the	object	in	the	short-	and	long-
term	visibility	indicators.	If	the	cursor	is	moved	over	the	indicators,	the	apparent	magnitude	of	the	
object	is	displayed	for	the	time	given	by	the	x-axis.

20.5.2 Visibility update rate
This	slider	controls	how	often	the	visibility	is	recalculated	for	objects	in	the	object	list.	Faster	calcu-
lation	will	improve	the	accuracy	of	the	altitude/azimuth	and	visibility,	at	the	expense	of	slowing	
down	overall	response	and	possible	Flickering	effects.

Update	when	in	background.	When	another	application	is	brought	to	the	front,	visibility	calcula-
tions	are	typically	suspended	until	AstroPlanner	is	once	more	the	active	application.	This	checkbox	
allows	visibility	calculations	to	continue	while	the	application	is	deactivated.	This	might	affect	other	
applications,	and	laptop	battery	life.

20.5.3 Visibility restrictions
When	computing	the	current	visibility	of	an	object,	this	setting	allows	you	to	consider	an	object	non-
visible	based	on	sky	darkness:

• None.	Sky	darkness	is	not	considered	(i.e.	if	the	object	is	above	the	horizon,	it	is	considered	
visible).

• Civil	Twilight.	During	the	daytime	(between	sunrise	and	sunset),	all	objects	are	considered	
invisible.

• Nautical	Twilight.	Objects	are	consider	invisible	before	the	start	of	nautical	twilight	in	the	
evening	and	after	the	end	of	nautical	twilight	in	the	morning.

• Astronomical	Twilight.	Objects	are	consider	invisible	before	the	start	of	astronomical	twilight	
in	the	evening	and	after	the	end	of	astronomical	twilight	in	the	morning.
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• Full	Darkness.	Objects	are	consider	invisible	after	the	end	of	astronomical	twilight	in	the	
evening	and	before	the	start	of	astronomical	twilight	in	the	morning.

20.5.4 Constellation chart display
Display	constellation	charts	for	objects.	This	is	on	by	default	and	determines	if	a	constellation	chart	
is	generated	and	displayed	when	an	object	is	selected.	If	the	Display	1st	when	object	selected	op-
tion	is	selected,	then	the	chart	will	be	initially	displayed	in	front	of	any	images	associated	with	the	
object.

20.5.5 Sorting
Re-sort	dynamic	columns	every	30	seconds.	If	this	option	is	checked,	then	if	you	have	sorted	on	a	
dynamic	column	(i.e.	one	containing	an	object	parameter	that	can	change	over	time,	such	as	altitude,
visibility,	etc.),	that	column	will	be	sorted	again	automatically	every	30	seconds.

Re-sort	object	list	after	insertion.	If	an	object	is	inserted	at	the	end	of	the	list,	it	could	affect	the	
sort	order	of	the	list.	If	this	option	is	checked	then	the	list	will	be	re-sorted	after	such	an	insertion,	
where	necessary.

Group	highlighted	objects	at	top	after	sorting.	When	this	option	is	checked,	every	time	the	list	is	
sorted,	all	highlighted	objects	(where	applicable)	will	appear	before	all	unhighlighted	objects.

Show	groupings	after	sorting	a	column.	If	this	option	is	set	then	whenever	you	sort	the	object	list,	
a	black	line	will	appear	between	groupings	(e.g.	sort	on	Constellation	-	the	line	appears	between	
constellation	changes;	sort	on	R.A.	-	the	line	appears	on	every	hour	change,	etc.).	See	Figure	406	for	
an	example.

Figure	406:	Object	list	sorted	by	constellation

Secondary	visibility	sort	Oield.	When	sorting	on	the	Visibility	(Vis)	column,	this	setting	chooses	a	
secondary	parameter/column	to	sort	on	if	the	Visibility	values	are	the	same:	Altitude,	Azimuth,	R.A.,	
Declination,	Rise	time,	Transit	time,	or	Set	time.
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Sort	object	size	on.	When	sorting	the	Size	column,	you	can	choose	to	sort	an	object	with	Size	=	a	x	b
on	angular	area	(a	multiplied	by	b),	longest	dimension	(a),	or	shortest	dimension	(b).	If	the	size	is	
given	as	a	single	dimension,	A,	then	both	dimensions	are	considered	to	be	equal	to	A.

20.5.6 Navigation and editing
Left/Right	arrow	key	navigation.	This	option	determines	what	effect	the	left-	and	right-arrow	
keys	have	when	navigating	the	object	list:

• None.	No	effect.

• Previous/next	object.	Left-arrow	moves	to	the	previous	object	in	the	list;	right-arrow	moves	to	
the	next	object	in	the	list.

• Previous/next	highlighted	object.	Left-arrow	moves	to	the	previous	highlighted	object	in	the	
list;	right-arrow	moves	to	the	next	highlighted	object	in	the	list.

• Previous/next	observed	object.	Left-arrow	moves	to	the	previous	object	with	associated	ob-
servations	in	the	list;	right-arrow	moves	to	the	next	object	with	associated	observations	in	the	
list.

• Previous/next	non-observed	object.	Left-arrow	moves	to	the	previous	object	with	no	associat-
ed	observations	in	the	list;	right-arrow	moves	to	the	next	object	with	no	associated	observations	
in	the	list.

• Previous/next	visible	object.	Left-arrow	moves	to	the	previous	currently-visible	object	in	the	
list	(i.e.	Vis	=	Yes);	right-arrow	moves	to	the	next	currently-visible	object	in	the	list.

• Previous/next	object	with	images.	Left-arrow	moves	to	the	previous	object	with	associated	
images	in	the	list;	right-arrow	moves	to	the	next	object	with	associated	images	in	the	list.

• Previous/next	object	of	the	same	type.	Left-arrow	moves	to	the	previous	object	with	the	same
Type	in	the	list;	right-arrow	moves	to	the	next	object	with	the	same	Type	in	the	list.

In-line	editing	of	object	Oields.	When	this	option	is	checked,	in-line	editing	of	object	Fields	in	the	
object	list	is	permitted	(i.e.	clicking	on	an	editable	column	will	allow	instant	editing	of	the	object	
value).

20.5.7 Show alert badge for object
These	items	deFine	alert	"badges"	to	be	displayed	in	the	ID	column	of	the	object	list	if	an	object	is	
within	the	given	angular	distance	of	the	sun,	the	moon,	or	a	bright	planet	(Mercury	through	Saturn).

Figure	407:	Alert	badges	in	ID	column

20.5.8 Colours
These	colours	are	used	to	shade	the	background	of	a	row	in	the	object	list.	Clicking	the	colour	
swatch	allows	the	colour	to	be	changed.

Default	Highlight	colour.	If	an	object	is	highlighted	(but	not	Custom	highlighted),	this	colour	is	
used.

Force	Highlight	colour.	If	an	object	has	been	Force	Highlighted,	this	colour	is	used.
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Force	Unhighlight	colour.	If	an	object	has	been	Force	Unhighlighted,	this	colour	is	used.

Last	Slew	Target	colour.		If	an	object	was	the	target	of	the	last	telescope	slew,	this	colour	is	used.

20.5.9 Dark Time
The	minimum	object	elevation	setting	speciFies	the	minimum	altitude	that	an	object	can	have	dur-
ing	astronomical	darkness	in	order	for	it	to	be	considered	in	Dark	Time.	This	is	used	by	the	Dark	
Start,	Dark	End,	and	Dark	Duration	object	list	columns	(page	98).

20.5.10 Charts/Atlases for Chart# column
This	is	found	in	the	Chart	#	tab	of	the	preferences	window.

Figure	408:	Chart	#	atlas	list

This	is	a	list	of	supported	charts/atlases.	By	checking	one	or	more	of	these	entries,	the	relevant	
chart	number/s	for	an	object	will	be	displayed	in	the	Chart	#	column.

The	default	is	to	show	all	of	the	chart	numbers	for	each	selected	chart/atlas,	separated	by	commas.	
However,	if	you	right-click	the	object	list	and	choose	the	Chart/s	submenu,	you	can	elect	just	to	
show	the	chart	numbers	for	one	of	them.	This	is	useful	if	you	own	and	use	more	than	one	atlas.
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Figure	409:	Chart/s	submenu

Creating a custom chart definition
If	you	have	a	set	of	charts	or	an	atlas	that	is	not	built-in	to	the	application,	you	can	create	your	own	
custom	deFinition.	Use	the	"+"	button	under	the	list	of	charts	to	create	a	new	deFinition.	This	creates	
a	new	deFinition	and	displays	the	deFinition	on	the	right	of	the	window.

Figure	410:	Creating	a	new	custom	chart	deFinition

Change	the	Description	and	Abbreviation	Fields	to	suitable	values.	Use	the	"+"	button	under	the	deFi-
nition	to	add	lines	to	the	deFinition,	"-"	to	delete	a	line,	or	"++"	to	duplicate	a	line.	

Each	line	of	the	deFinition	represents	an	area	of	sky	bounded	by	RA	and	Dec	bounds.	The	chart	num-
ber	containing	that	area	of	sky	is	part	of	the	line.	Edit	the	values	directly	in	the	list.	When	you've	Fin-
ished,	click	the	Save	button.

Note	the	following:

• When	the	application	looks	up	a	chart	number	for	a	given	RA/Dec,	it	searches	the	deFinition	se-
quentially	from	the	First	line	until	it	Finds	one	where	RA	from	≤	RA	≤	RA	to	and	Dec	from	≤	Dec	≤	
Dec	to.	When	it	Finds	such	a	line	it	returns	the	corresponding	chart	number.
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• Chart	numbers	can	be	any	string	of	one	or	more	characters,	e.g.	5,	11a,	V2-15,	etc.	See	the	example	
column	in	the	main	chart	list.

• RA	from	must	be	less	than	RA	to,	and	Dec	from	must	be	less	than	Dec	to.

• If	a	chart	covers	the	RA	=	0	boundary,	then	create	two	lines.	e.g.	if	chart	6	covers	RA=20h	to	RA=4h,
Dec=-10°	to	Dec=+10°,	then	create	a	line	for	chart	6	that	covers	RA	=	20h	to	24h,	Dec	=	-10°	to	
+10°,	and	a	second	line	for	chart	6	that	covers	RA	=	0h	to	4h,	Dec	=	-10°	to	+10°.

• Overlapping	areas	are	Fine.

• If	there's	a	small	detail	chart	then	make	sure	its	deFinition	appears	before	the	larger	chart/s	con-
taining	it	so	that	any	coordinates	in	that	small	chart	get	chosen	First.	

You	can	use	the	Custom	Chart	Coverage	tab	to	check	that	the	charts	you've	deFined	cover	the	re-
quired	area	of	sky.

Figure	411:	Custom	Chart	Coverage

User-contributed custom chart definitions
You	can	use	the	down-arrow	button	under	the	list	of	chart	deFinitions	to	download	user-contributed
chart	deFinitions,	and	the	up-arrow	button	to	upload	your	own	deFinitions.

20.6 Field of View chart preferences
Field	of	view	chart	preferences	can	be	accessed	by:

• Clicking	the	preferences	button	at	the	bottom-right	of	the	chart	in	the	Field	of	View	tab	of	a	plan	
document	window	(marked	in	Figure	412).
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• Using	the	AstroPlanner	>	Preferences	menu	command	(Macintosh)	or	Edit	>	Preferences	menu
command	(Windows),	selecting	the	Other	tab,	and	clicking	the	relevant	Open	button.

Figure	412:	Field	of	View	chart	preferences	button

Figure	413:	Field	of	View	chart	preferences

20.6.1 FoV Spectral Star Colours
These	are	the	colours	used	to	show	catalogue	stars	in	the	chart	if	such	stars	include	spectral	class	
information	and	if	the	Display	>	Spectral	Colours	option	is	selected	in	the	Display	Options	for	the	
chart.	Clicking	the	colour	swatches	allows	changing	the	colour.

20.6.2 Star style
This	option	deFines	how	stars	are	drawn	in	the	chart.	There's	a	separate	option	for	printing.

20.6.3 Default Reticle Colours
DeFines	colours	that	are	used	for	various	reticle	types.	If	checked,	these	will	override	the	colours	in-
dividually	assigned	to	the	reticles.	Clicking	the	colour	swatches	allows	changing	the	colour.

20.6.4 Solar System Object Motion
If	the	Show	motion	track	in	FoV	option	is	selected,	then	any	solar	system	object	(planets,	comets	and
minor	planets)	will	show	a	track	of	its	motion	in	time	across	the	sky.	The	time	span	is	speciFied	in	

- 300 -



hours,	with	a	step	interval.	The	Show	magnitude	option	will	show	the	object's	magnitude	at	each	
step.	The	Show	time	option	will	show	the	relative	time	in	hours	at	each	step.	Figure	414	shows	the	
motion	track	of	a	comet	over	48	hours	(from	-24	to	+24	hours	in	steps	of	6	hours),	with	the	Show	
time	option	used.

Figure	414:	Motion	track	in	Field	of	view	chart

20.6.5 FoV Display Font
Select	the	font	and	size	used	to	display	text	in	the	chart.	Default	is	System	11.

20.6.6 Star Magnitude Scale
This	option	allows	selection	of	how	the	stars	in	the	FoV	are	scaled:

• Fixed.	Always	scale	stars	on	a	Fixed	scale.	This	might	be	useful	to	compare	charts	across	multiple
telescopes,	parts	of	the	sky,	etc.

• Down	to	magnitude	limit.	This	is	the	default.	Assume	the	magnitude	limit	(determined	by	the	
slider	to	the	right	of	the	chart)	determines	the	smallest	stars	to	show	on	the	chart.	This	generally
renders	a	chart	that	is	close	to	reality	for	a	given	telescope	(assuming	the	magnitude	limit	is	that	
of	the	selected	telescope).

• Within	catalogue	limits.	Determine	the	magnitude	limits	by	the	dimmest/brightest	stars	in	the	
catalogues	being	displayed.

• Within	FoV	limits.	Determine	the	magnitude	limits	by	the	dimmest/brightest	stars	in	the	dis-
played	Field	of	view	chart.

Bigger	size	differences.	Make	the	differences	between	star	sizes	for	different	magnitudes	larger.

20.6.7 Other colours
Background	colour	for	printing.	This	is	the	colour	used	to	print	the	background	sky	(unless	you	
are	printing	black-on-white).	You	can	choose	a	suitable	colour	to,	for	example,	save	on	ink	car-
tridges.	Click	the	colour	swatch	to	choose	the	colour.
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Constellation	star	colour.	If	you	are	displaying	constellation	Figures	in	the	chart	(by	way	of	the	Dis-
play	Options),	then	this	colour	deFines	the	colour	for	stars	considered	part	of	the	"standard"	constel-
lation.	Click	the	colour	swatch	to	choose	the	colour.

20.6.8 Object Labelling
Use	common	name.	If	a	star	has	a	known	common	name,	then	display	that	rather	than	the	stars	ID	
(e.g.	display	"Polaris"	rather	than	"α	UMi").

Use	double	star	discoverer	ID.	When	labelling	double	stars,	use	the	discoverer	ID	rather	than	the	
catalogue	ID	(e.g.	HJ2414	rather	than	WDS07459+2000).

Display	magnitudes.	How	to	display	magnitudes	in	the	chart.	Either	one	decimal	place,	two	deci-
mal	places,	or	one	decimal	place	without	the	decimal	point	(some	like	to	do	this	to	avoid	the	decimal
point	being	mistaken	for	a	star).

Solar	system	objects.	For	any	displayed	solar	system	objects,	you	can	elect	to	display	the	ID	or	the	
Name,	or	both.

Deep-sky	objects.	For	any	displayed	non-solar-system	objects,	you	can	elect	to	display	the	ID	or	the
Name,	or	both.

20.6.9 Image Display
How	to	handle	multiple	images	in	the	Field	of	view	chart:

• All	images	overlapping	the	FoV.	Default.	Any	and	all	images	that	overlap	the	chart	will	be	
displayed.

• Largest	image	centred	in	FoV	only.	Only	the	largest	image,	centred	at	the	coordinates	of	the	
chart's	centre,	will	be	displayed.

• Image	selected	in	Objects	tab	only.	Only	the	image	currently	being	displayed	next	to	the	object	
list	(i.e.	for	the	selected	object)	will	be	displayed.

20.6.10 Default Limiting Magnitude
How	to	determine	the	initial	settings	for	the	Star	and	DSO	magnitude	limits	for	the	Field	of	view	
chart.	If	Stars	and/or	DSOs	are	checked	then	the	corresponding	magnitude	limit	sliders	will	be	set	
Based	on:

• Telescope	aperture	only.	Uses	the	computed	(or	manually	set)	magnitude	limit	value	for	the	
selected	Telescope	resource.

• Telescope	+	Eyepiece	+	Aid.	Bases	the	magnitude	limit	on	a	formula	that	is	dependent	on	mag-
niFication	(or	defaults	to	the	above	if	an	eyepiece	isn't	speciFied).

• Schaefer's	Algorithm.	Uses	Schaefer's	comprehensive	algorithm	to	determine	actual	magnitude
limit,	which	also	takes	into	account	the	observer's	age,	eyesight,	etc.	(speciFied	as	an	Observer	
resource).

20.6.11 Star labels
Determines	which	IDs	are	used	for	labelling	stars.	If	Any	IDs	can	be	shown	is	selected,	then	the	
chart	will	use	any	ID	available.	Otherwise	you	can	choose	one	or	more	of	the	speciFied	ID	types.	If	
the	star	has	one	or	more	of	the	selected	IDs,	a	label	will	be	shown,	otherwise	it	won't.

20.6.12 Mouse Dragging
What	happens	when	you	(left)	click	and	drag	the	mouse	with	the	cursor	in	the	chart:
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• Moves	sky.	The	background	sky	is	effectively	dragged.	i.e.	if	you	drag	from	left	to	right,	the	coor-
dinates	of	the	centre	of	the	chart	will	move	to	the	left.

• Moves	telescope.	The	telescope	or	chart	centre	is	effectively	dragged.	i.e.	if	you	drag	from	left	to	
right,	the	coordinates	of	the	centre	of	the	chart	will	move	to	the	right.

20.6.13 FoV Angular Display
When	you	option-drag	(Macintosh)	or	Alt-drag	(Windows)	on	the	chart,	the	angular	distance	you	
have	dragged	(as	well	as	the	angle	w.r.t.	north)	is	displayed.	This	setting	determines	whether	the	dis-
tance	is	displayed	in	decimal	degrees,	or	degrees/minutes/seconds.

20.6.14 Other Options
Remove	duplicate	objects.	If	duplicate	catalogue	objects	are	found	(if	more	than	one	stellar	cata-
logue	is	being	displayed),	then	this	option	will	Find	any	duplicate	objects	and	remove	them.	Objects	
from	larger	catalogues	will	be	preferentially	removed.	e.g.	If	you	display	the	Bright	Star	catalogue	as	
well	as	the	Hubble	GSC	catalogue,	then	the	Bright	Star	objects	will	be	preferred	over	any	equivalent	
Hubble	objects.	The	downside	is	that	this	can	take	some	computation	if	many	objects	are	being	
displayed.

Show	FoV	after	slewing.	When	telescope	slewing	is	instigated	from	the	plan	document,	automati-
cally	switch	to	the	Field	of	View	tab	after	slewing.

Show	plan	objects.	Determines	if	plan	objects	are	displayed	in	the	chart,	and	if	so,	in	what	colour.	
You	can	select	different	colours	for	objects	that	have	no	associated	observations	(Unobserved),	ob-
jects	that	have	one	or	more	associated	observations	logged	(Observed),	and	those	objects	that	have	
observations	logged,	but	which	were	not	found	in	any	of	the	observations	(Obs	but	not	found).	
Click	the	colour	swatches	to	change	colours.

20.6.15 External Catalogues
External	catalogues	are	non-AstroPlanner	stellar	catalogues	that	might	be	available	to	the	user.	The	
contents	of	these	catalogues	can	be	displayed	in	the	Field	of	view	chart,	but	not	searched	or	used	
elsewhere.	They	are	also	not	available	to	unregistered	users.	

These	catalogues	are	typically	available	on	CD-ROM,	DVD-ROM,	or	on-line	via	the	Internet.	There	is	a
tab	for	each	available	catalogue	type.	Currently	these	are:

• USNO	A2.0.	The	USNO	A2.0	Stellar	Catalog,	is	a	catalogue	of	526,280,881	stars	covering	the	
entire	sky,	with	coverage	down	to	magnitude	19+.	It	is	available	as	a	set	of	11	CD-ROMs	or	2	
DVD-ROMs.

• USNO	SA2.0.	The	USNO	SA2.0	is	a	catalogue	of	55,368,239	stars	intended	to	provide	a	grid	of	as-
trometric	reference	stars	covering	the	whole	sky.	It	is	a	spatially	sub-sampled	version	of	the	full	
USNO	A2.0	catalogue,	designed	for	folk	who	are	doing	astrometric	work.	It	is	available	on	a	sin-
gle	CD-ROM.

• USNO	B1.0.	The	USNO	B1.0	catalogue	is	an	all-sky	catalogue	that	presents	positions,	proper	mo-
tions,	magnitudes	in	various	optical	passbands,	and	star/galaxy	estimators	for	1,042,618,261	
objects.	The	catalogue	is	believed	to	be	complete	down	to	magnitude	21.	Currently	it	is	available	
either	on-line	or	accessed	directly	from	hard	disk	(80GB+).

• UCAC2.	The	UCAC2	or	Second	U.S.	Naval	Observatory	CCD	Astrograph	Catalog,	is	a	catalogue	of	
48,330,571	stars	covering	the	sky	from	-90	to	+40	degrees	in	declination	and	going	up	to	+52	de-
grees	in	some	areas.	It	covers	magnitudes	down	to	17+.	It	is	available	on	3	CD-ROMs.
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• UCAC3.	The	UCAC3	or	Third	U.S.	Naval	Observatory	CCD	Astrograph	Catalog,	is	a	catalogue	of	
100,766,420	stars	covering	the	sky	from	-90	to	+90	degrees	in	declination.	It	covers	magnitudes	
down	to	17+.	It	is	available	on	a	double-sided	DVD-ROM.

• UCAC4.	The	UCAC4	or	Fourth	U.S.	Naval	Observatory	CCD	Astrograph	Catalog,	is	a	catalogue	of	
113,780,093	stars	covering	the	sky	from	-90	to	+90	degrees	in	declination.	It	covers	magnitudes	
down	to	16+.	It	is	available	on	a	double-sided	DVD-ROM.	It	corrects	many	errors	in	UCAC3.

• NOMAD.The	Naval	Observatory	Merged	Astrometric	Dataset	(NOMAD)	catalogue	is	an	all-sky	
catalogue	that	presents	positions,	proper	motions,	magnitudes	in	various	optical	passbands,	and	
star/galaxy	estimators	for	over	a	billion	objects.	All	bright	stars	are	included.	Only	available	on-
line.	It	is	a	combination	of	objects	derived	from	the	following	catalogues:

	 1.	Hipparcos	Catalogue,	else	

	 2.	UCAC2	catalog	(for	stars	of	magnitude	10	or	fainter),	else	

	 3.	Tycho-2	Catalogue,	else	

	 4.	USNO-B1.0	catalog.

	

Figure	415:	External	Catalogues	preferences

In	order	to	enable	an	external	catalogue	for	display,	you	need	to	check	the	Catalogue	Available	
checkbox.	Once	this	is	done,	the	catalogue/s	will	appear	at	the	end	of	the	list	of	AstroPlanner	cata-
logues	on	the	Field	of	View	tab	(in	the	External	Catalogues	section).
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Each	catalogue	type	has	a	number	of	settings,	typically	specifying	where	the	catalogue	is	stored,	
how	to	interpret	the	magnitude	data,	and	what	kind	of	media	is	being	used.

20.7 Sky chart preferences
Sky	chart	preferences	can	be	accessed	by:

• Clicking	the	preferences	button	at	the	bottom-right	of	the	chart	in	the	Sky	tab	of	a	plan	docu-
ment	window	(marked	in	Figure	416).

• Using	the	AstroPlanner	>	Preferences	menu	command	(Macintosh)	or	Edit	>	Preferences	menu
command	(Windows),	selecting	the	Other	tab,	and	clicking	the	relevant	Open	button.

Figure	416:	Sky	preferences	button

Figure	417:	Sky	preferences	window

20.7.1 Alignment Stars
Reject	stars	with	altitude	less	than/greater	than.	These	settings	will	ensure	that	alignment	stars	
that	are	too	close	to	the	horizon,	or	too	close	to	the	zenith,	will	be	marked	as	"rejected"	and	shown	
in	red	on	the	Sky	chart	(when	alignment	stars	are	selected	in	the	Display	Options).

Reject	stars	with	magnitude	greater	than.	Similarly,	stars	that	are	too	dim	can	be	rejected.	Useful	
if	you	are	in	a	particularly	bright	sky	situation,	or	are	unfamiliar	with	the	dimmer	stars.
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Algorithm.	This	is	the	algorithm	used	to	determine	the	"optimum"	pairs	or	triples	of	alignment	
stars.	The	LX200	Best	Pair	algorithm	was	designed	speciFically	for	the	LX200	Classic	telescope,	but	
some	folk	believe	that	it	works	well	for	any	alt-az	telescope	mount	that	needs	a	2-star	alignment.	
The	Polar	2-star	and	Polar	3-star	algorithms	are	simpliFied	algorithms	for	alignment	of	polar	
mounts	based	on	the	SynScan	mount	controller.

20.7.2 Colours
These	colour	swatches	can	be	used	to	customise	all	the	colours	used	in	the	Sky	chart.	Click	on	any	
swatch	to	change	the	colour.

20.7.3 Default Orientation
Set	the	default	orientation	of	the	chart.	This	orientation	is	the	one	used	to	display	the	chart	in	any	
plan	document	by	default.	You	can	subsequently	invert	E/W	or	N/S	via	the	Display	options	if	
necessary.

20.7.4 Constellation Figures
Choose	between	traditional	constellation	"stick	Figures",	and	those	used	by	H.	A.	Rey	in his book: The 
Stars: A New Way to See Them (http://www.amazon.com/exec/obidos/tg/detail/-/0395248302/)

20.7.5 Sky Display Font
Select	the	font	and	size	used	in	the	Sky	chart.

20.7.6 Left-click on Sky chart
Specify	what	happens	when	you	(left)	click	on	the	Sky	chart.	If	you	click	on	a	displayed	plan	object,	a
non-plan	object	(e.g.	a	star	or	catalogue	object),	or	open	sky,	you	can	specify	what	to	select	in	the	
plan	object	list,	which	tab	to	change	to,	and	whether	to	slew	the	telescope	to	the	object	in	question.

You	can	choose	to	select	the	plan	object	(if	a	plan	object	was	clicked	on)	or	closest	plan	object.

For	example,	in	Figure	417,	if	you	click	on	a	plan	object	in	the	sky	chart,	that	object	will	be	selected	
and	you	will	change	to	the	Observations	tab.	If	you	click	on	a	non-plan	object	in	the	chart,	the	closest
plan	object	will	be	selected,	and	its	Field	of	view	chart	displayed.	If	you	click	open	sky	in	the	chart,	
the	telescope	will	slew	to	the	cursor	position	(assuming	a	suitable	telescope	is	currently	connected).

20.8 Catalogue preferences
Catalogue	preferences	can	be	accessed	by:

• Using	the	File	>	Catalogue	Manager...	menu	command	and	choosing	the	Preferences	tab.

• Using	the	AstroPlanner	>	Preferences	menu	command	(Macintosh)	or	Edit	>	Preferences	menu
command	(Windows),	selecting	the	Other	tab,	and	clicking	the	relevant	Open	button.
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Figure	418:	Catalogue	preferences

20.8.1 Maximum search results
When	searching	catalogues	for	matching	objects,	this	is	the	maximum	number	of	hits	that	will	be	
processed.	If	the	limit	is	exceeded,	a	warning	is	displayed	and	you	can	choose	to	continue	the	search	
or	abandon	it.

20.8.2 Include objects with no magnitude in magnitude-range searches
When	searching	catalogues	using	a	magnitude	range	as	part	of	the	search	terms,	this	option	will	also
include	objects	that	have	no	deFined	magnitude,	but	that	would	otherwise	satisfy	the	search	terms.

20.8.3 Ignore objects with no coordinates (i.e. RA = Dec = 0)
Some	catalogues	contain	the	occasional	object	that	has	no	coordinates	(RA	=	Dec	=	0).	Generally	you	
would	want	to	ignore	these	when	searching,	but	turning	off	this	option	will	include	them	in	any	
searches.

20.8.4 FoV Defaults
Each	catalogue	has	an	associated	FoV	Default	Flag	that	can	be	set	(see	the	Coverage	and	Settings	
tab	of	the	Catalogue	Manager	window).	This	section	deFines	when	and	how	that	Flag	is	used.

Use	FoV	Default	on	new	plan	documents.	For	any	new	plan	document,	select	all	catalogues	for	the	
Field	of	View	chart	that	have	the	FoV	Default	set.

Use	FoV	Default	on	existing	plan	documents.	When	opening	any	existing	plan	document,	select	all
catalogues	for	the	Field	of	View	chart	that	have	the	FoV	Default	set.
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Enable	Labels	on	FoV	Default	catalogues.	In	addition	to	selecting	catalogues	above,	also	set	the	
Label	Flag	for	those	catalogues,	so	that	labels	are	displayed	in	the	Field	of	view	chart.

20.8.5 Creating plan objects from catalogue entries
Add	additional	IDs	to.	When	a	catalogue	entry/object	is	added	to	a	plan,	and	it	has	more	than	one	
associated	ID,	this	setting	allows	you	(optionally)	to	add	those	additional	IDs	to	the	object	Name	
Field,	the	object	Notes	Field,	or	a	User-deFined	Field	called	"More	IDs".

Add	additional	Oields	to.	When	a	catalogue	entry/object	is	added	to	a	plan,	and	it	has	Field	items	
that	do	not	correspond	to	columns	in	the	object	list	(e.g.	proper	motion,	etc.),	this	setting	allows	you	
(optionally)	to	add	those	additional	Fields	to	the	object	Name	Field,	the	object	Notes	Field,	ors	User-
deFined	Fields	with	appropriate	names.

Give	priority	to	IDs.	When	a	catalogue	entry/object	is	added	to	a	plan,	and	it	has	more	than	one	as-
sociated	ID,	this	setting	allows	you	to	give	priority	to	certain	selected	IDs.	e.g.	"M,	NGC,	IC"	would	
use	the	Messier	(M)	ID	as	the	primary	ID	if	present,	NGC	otherwise,	or	IC	otherwise.	If	none	of	those	
IDs	are	present,	then	the	First	available	ID	is	used	(typically	the	primary	ID	for	the	catalogue).

20.8.6 Plan Creation Wizard catalogue processing
The	Plan	Creation	Wizard	creates	its	own	database	based	on	the	catalogues	you	have	installed.	It	
uses	a	background	thread	to	create	the	database	(when	you	First	run	the	application	after	installa-
tion,	or	whenever	you	add,	delete	or	update	a	catalogue).	This	thread	can	take	a	while	to	process	
catalogues,	and	during	that	time	the	application	can	become	unresponsive,	especially	on	Windows.	
This	settings	allow	you	to	change	how	this	process	is	done.

Aggressiveness.	The	more	aggressive	the	setting,	the	faster	the	background	thread	will	process	cat-
alogues,	at	the	expense	of	application	responsiveness.

Size	cutoff.	This	determines	what	catalogues	are	included.	Typically	only	catalogues	with	fewer	
than	a	few	hundred	thousand	relevant	objects	are	processed.	You	can	adjust	this	maximum,	at	the	
expense	of	potentially	missing	out	on	some	objects	for	the	database.

Rebuild....	Rebuild	the	Plan	Creation	Wizard	database	from	scratch.	This	is	not	typically	necessary,	
but	you	never	know...	This	does	not	reset	the	criteria.	See	below	if	you	need	to	reset	the	criteria.

20.8.7 Alternate Catalogue Folders
Catalogues	are	generally	kept	in	a	special	location	on	your	hard	disk	(you	can	use	Help	>	Where's	
My	Stuff...	to	Find	out	where).	You	can	also	specify	up	to	four	additional/alternate	folders	containing	
catalogue	Files.	This	is	useful	if	you're	sharing	catalogues	from	an	older	version	of	AstroPlanner,	or	if	
you	want	to	install	a	larger	catalogue	(e.g.	USNO	A2.0)	on	another	disk,	etc.

20.8.8 Plan Creation Wizard reset
Reset	Objects.	As	the	plan	creation	wizard	is	used,	it	marks	any	objects	it	retrieves	from	its	data-
base	as	"used"	so	that	they	will	not	get	retrieved	a	second	time.	Using	this	Reset	button	will	mark	all	
objects	in	the	plan	creation	wizard's	database	as	"unused".	

Reset	Criteria.	Resetting	the	criteria	will	return	the	criteria	for	selecting	objects	back	to	"factory	
settings".
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20.9 Observation preferences

Figure	419:	Observation	preferences	window

20.9.1 Date/Time
New	observation	date/time	source.	When	you	create	a	new	observation,	the	source	of	that	date	
and	time	is	determined	by	this	setting.

• Computer.	The	current	local	date/time	is	used.

• Telescope.	If	a	telescope	is	connected,	and	has	the	capability	of	being	interrogated	for	its	date/
time,	then	that	is	used.	If	not,	the	current	local	date/time	is	used.

• Ask	user.	The	user	is	asked	to	supply	the	current	date/time	via	a	dialog.

Always	log	observations	with	respect	to	UT.	If	the	above	setting	is	Computer	or	Telescope,	this	
option,	if	checked,	will	make	the	observation	with	respect	to	UT	(Universal	Time	or	GMT).

Display	observation	date/time	as.	Whenever	an	observation	date	and/or	time	is	displayed,	these	
settings	are	used	to	determine	the	format.	The	current	date	and	time	is	displayed	in	the	selected	for-
mat	at	the	right.	The	date	can	be:

• System.	Use	the	operating	system	settings	to	display	the	date.

• Fixed:	YYYY/MM/DD.	Always	show	the	date	as	YYYY/MM/DD.

• Fixed:	YYYY.YYY.	Show	the	date	as	the	year	and	fraction	of	the	year.

• Fixed:	YYYY-MM-DD.	Always	show	the	date	as	YYYY-MM-DD.
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The	time	can	be:

• System	(short).	Use	the	operating	system	settings	to	display	the	time	in	short	format	(hours	and
minutes).

• System	(long).	Use	the	operating	system	settings	to	display	the	time	in	long	format	(hours,	min-
utes	and	seconds).

• Fixed:	HH:MM.	Display	hours	and	minutes.	24-hour	clock.

• Fixed:	HH:MM.M.	Display	hours	and	minutes+fraction.	24-hour	clock.

• Fixed:	HH:MM:SS.	Display	hours,	minutes	and	seconds.	24-hour	clock.

20.9.2 Copy items from previous observation in session
When	you	create	a	new	observation,	this	setting	gives	you	the	option	of	copying	data	from	the	previ-
ous	observation	in	the	current	session	into	the	new	observation.	You	choose	one	or	more	of:	Notes,	
any	user-deFined	Field	values	(where	applicable),	and/or	resource	combinations.

20.9.3 Observation Database
Database	File	Path.	If	you	wish	to	use	a	database	located	somewhere	other	than	the	standard	fold-
er	location,	you	can	use	this	setting	to	do	so.	Use	the	Default	button	to	reset	this	to	the	default	
location.

Save	changes	whenever	plan	documents	are	saved.	When	you	start	up	the	application,	the	obser-
vation	database	is	copied	to	a	temporary	location.	When	the	application	is	quit,	the	temporary	data-
base	automatically	overwrites	the	existing	one	(if	changes	were	made).	The	setting	will	also	do	the	
overwrite	operation	every	time	a	plan	document	is	saved.

Rebuild	Cross	References....	The	observation	database	maintains	a	list	of	cross-references	between	
IDs	of	observed	objects.	If	you	add	additional	catalogues,	the	list	might	be	incomplete.	This	button	
allows	you	to	rebuild	the	cross-reference	list,	using	all	available	catalogues.	Warning:	this	can	take	a	
while	if	you	have	lots	of	observations.	Be	prepared	to	take	a	coffee	break.

20.9.4 Initialise observation notes with object notes
When	creating	a	new	observation,	this	option	will	initialise	the	observation	notes	with	the	contents	
of	the	Notes	Field	for	the	observed	object,	where	applicable.

20.9.5 Check for bad observation plan paths at startup
The	observation	database	is	(by	default)	checked	at	startup	for	any	observations	that	are	associated	
with	a	plan	document	that	is	no	longer	available	at	the	previously-deFined	path.	You	are	given	the	
choice	to	re-attach	a	plan	document,	etc.	You	are	also	given	the	choice	never	to	see	that	irritating	di-
alog	again.	This	option	re-enables	the	path	checking	at	startup.

20.9.6 Session Management
Assume	observation	is	in	a	session.	If	a	new	observation	is	created	that	has	a	date/time	that	is	lat-
er	than	the	speciFied	time	before	the	current	beginning	of	a	session,	and	earlier	than	the	speciFied	
time	after	the	current	end	of	the	session,	then	that	observation	is	assumed	to	be	in	that	session.	The	
session	start	or	end	time	will	be	adjusted	to	include	the	observation	date/time.

Create	a	new	session.	If	a	new	observation	is	created	that	has	a	date/time	that	is	earlier	than	the	
speciFied	time	before	any	existing	session,	and	later	than	the	speciFied	time	after	the	current	end	of	
any	existing	session,	then	a	new	session	is	started.	The	session	start	or	end	time	will	be	adjusted	to	
include	the	observation	date/time.	If	the	date/time	falls	between	the	above	limits,	the	user	is	asked	
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via	a	dialog	whether	a	new	session	should	be	started,	or	whether	an	existing	one	should	be	
extended.

Session	start	time/session	Oinish	time.	These	values	are	added	to	the	beginning	or	end	of	a	ses-
sion	(i.e.	the	date/time	of	the	First	and	last	observation.	This	could	be	construed	as	the	time	required
to	set	up	the	telescope,	break	it	down,	etc.

Trim	session	if	observations	change.	If	you	delete	the	First	or	last	observation	in	a	session,	this	
option	will	trim	the	session	start	or	Finish	time	to	compensate.

Display	session	start/Oinish	times	as	UT.	Determines	if	the	session	date/times	should	displayed	
as	UT	(Universal	Time/GMT),	based	on	the	session's	observations.	The	choices	are:

• Never

• Always

• If	any	session	observation	is	UT

• If	all	session	observations	are	UT

Rebuild	Sessions....	If	the	need	arises,	this	button	will	delete	all	existing	sessions	and	rebuild	them	
based	on	the	underlying	observations.	It	will	attempt	to	keep	any	observation	names,	notes,	and/or	
user-deFined	Field	values,	but	this	is	not	guaranteed	in	all	cases.

Reload	V1	Database....	This	action	will	request	the	location	of	an	AstroPlanner	V1	database	File	and	
convert	it	for	use	in	V2.	This	will	destroy	any	existing	V2	observations	and	sessions.

20.9.7 Ratings
The	Ratings	Field	can	have	multiple	numeric	values,	starting	at	1.	These	settings	allow	you	to	set	up	
the	values	that	are	valid,	and	an	alphanumeric	rating	to	go	with	each	numeric	value.	Use	the	+	but-
ton	to	add	a	new	entry,	and	-	to	delete.	Click	on	the	entries	to	edit.	If	you	want	to	include	values	that	
shouldn't	be	included	in	computing	rating	values	(e.g.	"Was	not	observed",	"Seeing	not	adequate",	
etc.),	then	assign	a	value	of	-1.

Display	computed	ratings	numerically.	If	a	computed	rating	(e.g.	average	rating	for	a	given	object)
is	displayed,	then	it	can	be	displayed	numerically	(e.g.	3.5)	or	alphanumerically	(e.g.	"Nice")	-	in	
which	case	the	numeric	value	will	be	rounded.

For	each	observation,	compute.	When	displaying	the	rating	for	an	observation,	the	individual	rat-
ings	logged	for	each	resource	combination	(e.g.	eyepiece/telescope	combination)	is	computed	as	
one	of:

• Average

• Minimum

• Maximum

• Median

For	each	object,	compute.	When	displaying	the	rating	for	an	object,	the	individual	ratings	logged	
for	each	resource	combination	(e.g.	eyepiece/telescope	combination)	of	each	observation	for	that	
object	is	computed	as	one	of:

• Average

• Minimum
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• Maximum

• Median

20.10 Image preferences
Image	preferences	can	be	accessed	from	various	places:

• Via	main	menu:	Image	>	Image	Preferences...

• Right-clicking	an	image	and	choosing	Image	Preferences...	from	the	popup	menu.

• By	clicking	the	preferences	button	in	the	Images	display	window	(marked	in	Figure	420).

Figure	420:	Image	preferences	button

- 312 -



Figure	421:	Image	Preferences	window

20.10.1 Image display
Automatically	enhance	contrast	of	DSS	images.	When	DSS	images	are	downloaded	the	contrast	
might	be	such	that	the	background	sky	is	not	black	when	it	should	be.	This	option	automatically	ad-
justs	the	contrast	of	images	so	that	the	sky	background	is	black.	Note	that	this	might	cause	loss	of	
any	faint	detail	in	the	image.

Flip	images	horizontally	and/or	vertically	to	match	FoV.	The	images	are	Flipped	to	match	the	E/
W	and	N/S	orientation	of	the	plan	document's	Field	of	view	chart.

Rotate	images	to	match	FoV.	The	displayed	images	are	rotated	to	match	the	rotational	orientation	
of	the	plan	document's	Field	of	view	chart,	where	applicable.

Annotate	images	with	N,	S,	E	and	W.	Annotate	the	edges	of	the	images	to	indicate	the	cardinal	di-
rections.	Click	the	colour	swatch	to	change	the	text	colour.

20.10.2 Object list click
When	you	select	an	object	in	the	plan	document's	object	list,	and	it	has	more	than	one	associated	
image,	this	setting	determines	which	of	those	images	is	displayed	by	preference:

	 Don't	show	cached	images
	 Show	previously	selected	image,	if	applicable
	 Show	5'	x	5'	image,	if	applicable
	 Show	10'	x	10'	image,	if	applicable
	 Show	30'	x	30'	image,	if	applicable
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	 Show	1°	x	1°	image,	if	applicable
	 Show	2°	x	2°	image,	if	applicable
	 Smallest	size	image
	 Largest	size	image
	 Smallest	size	image	≥	object	size,	if	applicable
	 Colour	image,	if	applicable

20.10.3 Object types for catalogue marking
The	types	of	objects	that	will	show	an	image	"badge"	when	you	display	a	catalogue.	This	allows	you	
to	ignore,	say,	stars	(that	appear	in	many	images	and	can	slow	down	catalogue	display	if	enabled).

20.10.4 DSS image quality
DSS	images	are	downloaded	and	saved	as	JPEG	images.	This	setting	deFines	the	quality	of	those	
saved	images.	Since	JPEG	images	utilise	"lossy"	compression,	lower	quality	images	take	up	a	lot	less	
space	on	hard	disk.	To	see	the	effects	of	changing	image	quality,	click	the	Example	button.

The	example	window	shows	an	original	image	on	the	left,	and	a	modiFied	quality	image	on	the	right.	
Use	the	Zoom	slider	to	zoom	in,	and	use	the	Quality	slider	to	show	the	effect	of	making	the	image	
quality	a	particular	value.	You'll	see	that	the	quality	of	the	image	doesn't	change	much	as	you	de-
crease	its	value	below	100%,	but	once	you	get	below	20%	the	artifacts	become	more	apparent.

Figure	422:	Image	quality	example	window

20.10.5 Default reticle colours
These	settings	allows	you	to	override	the	colour	that	the	various	reticle	types	use	by	default.	Select	
the	checkbox	to	override	the	colours	(note	that	the	Other	category	is	always	overridden).	Click	the	
colour	swatches	to	edit	the	colours.
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20.10.6 SDSS image options
These	are	options	for	SDSS	colour	images	only.	The	list	of	checkboxes	offers	several	options	avail-
able	for	the	downloaded	images	from	the	SDSS	web	site.	Typically	they	will	all	be	off,	unless	you	
have	a	speciFic	need.

Store	a	dummy	black	image	if	no	coverage.	SDSS	currently	only	covers	part	of	the	northern	sky.	If	
you	try	and	retrieve	an	SDSS	image	from	a	non-covered	part	of	the	sky,	you	typically	get	an	error	and
no	image	is	stored.	This	setting	will	store	a	special	(and	small)	all-black	image.	This	has	the	advan-
tage	that	the	application	will	not	try	and	re-download	the	same	SDSS	image	again	(assuming	you	
have	that	option	set	when	downloading).

20.10.7 Image caching in memory
Images	are	stored	in	a	disk-based	database.	If	you	are	Flipping	between	a	few	images	this	can	cause	
delays	while	the	image	is	retrieved	from	the	database.	This	is	particularly	noticeable	for	large	angu-
lar	size	images.	This	setting	will	cache	those	retrieved	images	in	memory,	on	a	First-come-First-
served	basis	which	will	improve	access	and	display	time.

20.10.8 Image database maintenance
These	are	actions	that	you	can	use	where	necessary	to	maintain	the	database.	Typically	you	would	
only	use	these	if	a	problem	exists.

Regain	disk	space	by	compressing	database.	Over	time,	if	images	are	deleted,	the	database	does	
not	automatically	re-use	that	space	for	new	images,	since	retrieving	the	space	takes	a	non-trivial	
amount	of	time.	If	you	have	that	time	to	spare,	use	this	action.	It	has	no	effect	on	the	database	con-
tents	apart	from	doing	an	internal	reshufFling,	and	is	safe	to	do	whenever	you	like.

Destroy	and	reload	image	database	from	cache.	When	you	move	from	AstroPlanner	V1	to	Astro-
Planner	V2	and	beyond,	the	image	database	is	built	from	the	old	image	caching	technique	used	in	
the	older	versions.	If	you	want	to	start	again	and	rebuild	the	database	from	the	older	cache,	use	this	
action.	Warning:	it	will	destroy	all	images	and	image	data	in	the	current	database.

Merge	images	from	an	external	database.	If	you	are	operating	AstroPlanner	on	more	than	one	
computer	and	you	want	to	merge	new	images	from	another	image	database,	you	can	use	this	action.	
Use	Help	>	Where's	My	Stuff...	on	the	secondary	computer	to	locate	the	image	database	that	you	
want	to	merge.

Recreate	the	image	index	Oile	to	resolve	issues.	To	speed	up	image	access,	a	cache	File	is	created.	
This	can,	on	occasion	get	out	of	sync	with	the	database.	This	option	will	recreate	the	File.	It	should	
have	no	adverse	effects.

20.10.9 Automatic image download
Normally,	image	downloading	is	done	manually	upon	request,	but	these	options	allow	for	automatic	
download	of	objects	in	the	background	(assuming	suitable	Internet	access	is	available).	Note	that	
these	settings	only	apply	to	non-solar-system	objects	(i.e.	stars	and	DSOs)

Initiate	download	when	a	plan	document	is	opened.	Whenever	you	open	a	plan	document,	and	
objects	exist	in	that	document	without	associated	images	in	the	database,	then	images	will	be	down-
loaded	for	those	objects.	This	will	be	done	silently,	unless	the	Always	ask	checkbox	is	checked,	in	
which	case	you'll	be	asked	if	you	want	to	proceed	with	the	download.
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Initiate	download	when	objects	are	added	to	a	plan	or	changed.	When	an	object	is	added	to	an	
open	plan	document,	or	an	object	in	that	plan	is	changed	(its	coordinates	are	changed),	start	an	
automatic	download	for	that	object.

Deep-sky	objects/Stars.	SpeciFies	what	kind	of	objects	will	have	images	downloaded.	Typically	you
would	probably	only	want	images	of	DSOs.	However,	double	star	observers	might	disagree.

Images	are	xxx	%	of	object	Size,	or	yyy	arcmin	if	no	Size.	If	the	object	has	a	deFined	size	(e.g.	15	x
10),	then	the	downloaded	image	will	be	xxx	%	of	the	largest	dimension	of	that	size.	If	the	object	
does	not	have	a	deFined	size,	then	the	image	will	default	to	being	yyy'	X	yyy'.

20.11 Scripting preferences
Scripting	preferences	can	be	accessed	from	various	places:

• Via	main	menu:	Script	>	Script	Preferences...

• By	clicking	the	preferences	button	in	the	script	editor	window	(marked	in	Figure	423).

Figure	423:	Script	preferences	button

20.11.1 Editor Settings
These	are	settings	that	inFluence	how	the	dedicated	script	editor	behaves.

Figure	424:	Script	preferences	window	-	Editor	Settings

- 316 -



The	Sample	is	a	mini-editor	that	reFlects	any	changes	you	make	to	the	settings,	so	that	you	can	see	
the	effects	of	doing	so.

Use	syntax	highlighting.	If	this	option	is	on,	then	the	text	is	coloured	according	to	syntax.	The	list	
below	the	checkbox	gives	the	various	syntactical	items	that	can	be	highlighted	together	with	the	
colours	to	be	used,	and	bold/italic/underline	options.	Click	the	colour	swatches	to	change	the	
colours.

Default	text	colour.	Normally	black,	but	you	might	prefer	another	colour	(especially	if	you	change	
the	next	setting).	Click	the	colour	swatch	to	change	the	colour.

Background	colour.	Normally	white,	but	some	might	prefer	a	blue	or	black	background.	Click	the	
colour	swatch	to	change	the	colour.

Automatically	close	brackets.	When	this	option	is	selected,	then	whenever	you	type	an	open	
bracket	(	"(",	"[",	or	"{"),	a	matched	closing	bracket	will	be	inserted	automatically	immediately	after	
the	text	cursor.

Automatically	indent	new	lines.	Automatically	indent/outdent	new	lines	according	to	the	syntax.	
e.g.	if	you	type	an	"if...then"	statement	and	hit	Enter,	the	next	line	will	be	indented	with	respect	to	the
"if...then"	line.	If	you	subsequently	type	a	matching	"end	if"	statement,	it	will	be	outdented.

Display	invisible	characters.	Characters	that	are	normally	invisible	(e.g.	space,	newline,	etc.)	will	
be	displayed	with	a	visible	character.

Allow	block	folding.	Blocks	(e.g.	if...then	-	end	if,	do...until,	while...wend,	etc.)	will	have	special	fold-
ing	widgets	displayed	in	the	left	margin.	Clicking	on	such	a	widget	will	"collapse"	the	block	down	to	
a	single	line	as	an	editing	convenience.	Clicking	again	"expands"	or	restores	the	block.

Auto-completion.	When	you	type	a	reserved	word	or	commonly-used	framework	class	name,	it	will
be	auto-completed	(i.e.	as	you	type	the	start	of	the	word,	the	rest	is	displayed	after	the	cursor).		If	
you	hit	the	speciFied	trigger	key/s,	the	displayed	word	will	be	automatically	completed.	If	there	is	
more	than	one	possible	word,	a	popup	menu	will	let	you	select	the	correct	choice.

Display	line	numbers.	Line	numbers	are	displayed	to	the	left	of	the	text.

Thick	insertion	point.	If	the	standard	blinking	insertion	point	character	is	difFicult	to	see,	you	can	
opt	for	a	thicker	character.

Tab	indents.	For	tabbing,	or	auto-indenting,	this	speciFies	the	number	of	spaces	to	insert	for	each	
tab/indent.

Home/End	on	current	line.	Normally	the	Home	key	moves	to	start	of	the	text	(on	the	First	page),	
and	then	End	key	to	end	of	the	text	on	the	last	page.	This	setting	makes	Home	go	to	the	beginning	of
the	current	line,	and	End	to	the	end	of	the	current	line.

Page	up/down	moves	insertion	point.	When	you	use	the	Page	Up	or	Page	Down	keys,	the	
standard	behaviour	is	to	scroll	to	the	next	page	without	moving	the	insertion	point.	This	option	
moves	the	insertion	point	to	the	beginning	of	the	page	currently	shown.

Display	dirty	lines.	"Dirty"	lines	(i.e.	those	that	have	been	changed	by	editing)	are	shown	by	
marking	them	in	the	left	margin	with	the	speciFied	colour.	Click	the	colour	swatch	to	change	the	
colour.

Highlight	code	blocks.	If	this	option	is	selected	then	moving	the	cursor	to	the	left	margin	of	any	
code	block	(e.g.	if...then	-	end	if,	do...until,	while...wend,	etc.)	will	temporarily	highlight	the	extent	of	
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that	block.	If	this	option	is	not	selected,	then	this	behaviour	only	happens	if	you	click	the	mouse	in	
the	margin	next	to	a	block.

Font.	The	font	and	size	of	the	text	being	edited.

Text	selection	colour.	When	you	select	text	(e.g.	by	dragging	the	mouse,	or	using	shift-click,	etc.)	
this	is	the	colour	used	for	the	selection	background.	The	System	colour	setting	uses	the	standard	
operating	system	setting	for	this.	However,	the	Custom	colour	setting	can	be	used	to	customise	that
colour.	Click	the	colour	swatch	to	change	the	colour.

20.11.2 Script Settings

Figure	425:	Script	preferences	window	-	Script	Settings

Cache	compiled	scripts	for	speed.	When	this	option	is	selected,	a	script	is	pre-compiled	the	First	
time	it	is	used,	but	not	thereafter	(unless	a	change	is	made	to	the	script).	If	the	option	is	not	selected,
the	script	is	compiled	every	time	it	is	run.	This	can	add	signiFicant	delays	to	each	run.

Script	Oiles	folder.	The	standard	location	for	scripts	is	in	the	Application	Support	folder.	This	set-
ting	lets	you	select	another	folder	to	use.	This	can	be	useful	if	you	want	to	share	a	scripting	folder	
with	another	editing	application,	etc.

Include	scripts	in	Framework	Reference.	You	can	add	your	own	script	Files	to	the	Framework	Ref-
erence	window	if	this	option	is	selected.	Only	scripts	that	start	with	the	given	preFixes	will	be	
included.

Check	for	updates	to	downloaded	user-contributed	scripts.	If	you	download	a	user-contributed	
script,	there's	a	chance	that	it	will	be	updated.	This	setting	allows	you	to	check	the	on-line	inventory	
to	see	if	there's	a	more	recent	version	of	any	script	you	previously	downloaded.	The	choices	specify	
when	this	check	is	done.

Script	Compiler	Optimisation	Level.	For	the	various	types	of	scripts,	these	settings	specify	the	
compiler	optimisation	level	to	use.	The	more	optimisations	used,	the	slower	the	initial	compile,	but	

- 318 -



the	faster	the	script	running	speed.	Typically	a	fast	compile	is	more	desirable	than	a	(relatively	
small)	increase	in	run	speed	-	unless	you	have	a	very	compute-intensive	script.

20.12 Other preferences
Other	preferences	consist	of	some	shortcuts	to	get	to	the	various	preferences	windows,	as	well	as	a	
way	to	move	your	application	support	location	to	a	non-standard	location.	They	are	accessed	by	the	
AstroPlanner	>	Preferences	menu	command	(Macintosh)	or	Edit	>	Preferences	menu	command	
(Windows),	and	selecting	the	Other	tab.

Clicking	the	Open	button	for	any	of	the	listed	preferences	will	open	the	corresponding	preferences	
editing	window.

Use	alternate	application	support	data	path.	Normally	all	the	common	support	Files	(observation	
database,	catalogues,	etc.)	for	AstroPlanner	reside	in	a	folder	in	your	Application	Support	folder.	
This	setting	allows	you	to	select	an	alternative	location	for	this	folder	if	you	so	desire	(perhaps	for	
sharing	purposes	across	computers).	You'll	also	be	given	the	chance	to	copy	existing	Files	across	
where	applicable.	It	is	recommended	that	you	use	this	setting	only	if	you	really	need	to.

Figure	426:	Other	preferences

Syncing	data	and	settings	between	computers.	This	feature,	if	enabled,	will	sync	data	and	set-
tings	between	AstroPlanner	running	on	two	or	more	computers.	It	is	assumed	that	you	are	not	run-
ning	AstroPlanner	on	more	than	one	of	those	computers	at	any	one	time.	

The	feature	uses	a	folder	that	is	common	to	all	the	computers	to	be	synced.	This	might	be	a	folder	
synced	by	a	service	such	as	DropBox	or	iCloud,	a	common	networked	drive,	or	a	NAS	drive	on	your	
local	network.

- 319 -



On	each	synced	copy	of	AstroPlanner,	you	select	the	path	to	to	the	common	sync	folder	(which	must	
be	the	same	synced	folder	on	each).	Then	chose	the	items	you	want	to	sync	(noting	that	some	of	
these	might	be	quite	large	(e.g.	Catalogues	and	Image	Database).	You	can	also	sync	plan	documents	
in	a	folder	and	all	its	subfolders	(by	specifying	the	root	folder	containing	the	plan	documents).

Once	this	is	enabled,	the	following	happens:

• When	you	quit	from	AstroPlanner,	it	compares	the	Files	you	asked	to	be	synced	with	the	copies	in	
the	common	sync	folder.	If	the	Files	don't	exist	or	have	been	changed	during	the	current	run	of	As-
troPlanner,	then	they	are	copied	to	the	sync	folder.	This	is	done	automatically	and	requires	no	
intervention.

• When	you	start	AstroPlanner,	the	First	thing	it	does	(if	syncing	is	enabled)	is	compare	the	chosen	
Files	with	those	in	the	sync	folder.	If	the	synced	Files	are	newer	then	it	will	list	any	new	Files	and	
ask	if	you	want	to	refresh	the	older	Files	before	continuing.

Note:

• The	mechanism	does	not	handle	File	deletion.	i.e.	if	you,	say,	delete	a	File	on	computer	A,	it	will	not	
automatically	be	deleted	on	computer	B.	This	will	need	to	be	done	manually.

• Make	sure,	if	you're	using	a	service	such	as	DropBox	that	syncs	over	the	Internet,	that	the	Files	
have	had	a	chance	to	permeate	to	your	computer	before	you	Fire	up	AstroPlanner.
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21 Communicating with other 
applications

There	are	various	ways	you	can	communicate	with	applications	other	than	AstroPlanner	itself.

21.1 Importing & exporting data
You	can	import	data	from	other	applications	by	importing	that	data	from	within	AstroPlanner	itself	
(see	Section	26.1	on	page	349	for	more	details).	

Other	applications	might	be	able	to	accept	data	in	a	format	exportable	by	AstroPlanner	(see	Section	
26.2	on	page	359	for	more	details).

21.2 Direct control
AstroPlanner	allows	direct	control	of,	and	by,	selected	external	applications	(primarily	planetarium-
style	applications).	In	order	for	such	an	external	application	to	be	supported	it	must	have	a	means	of
communicating	with	it	from	AstroPlanner,	via	various	technologies	such	as	TCP/IP,	AppleScript,	etc.	
Also,	the	protocol	for	doing	so	must	be	published	by	the	authors	of	those	external	applications.	

You	can	support	one	of	these	applications	at	a	time.	The	application	is	chosen	in	the	External	prefer-
ences	(see	Section	20.4	on	page	291)

Currently,	the	following	external	applications	are	supported	by	AstroPlanner.

21.2.1 Cartes du Ciel (SkyChart)
http://www.ap-i.net/skychart/

This	is	a	freeware	planetarium	application.	AstroPlanner	supports	both	V2	(Windows-only)	and	V3	
(Windows	and	Macintosh).

AstroPlanner	can	control	the	pointing	of	the	Field	of	view	in	Cartes	du	Ciel,	and	vice	versa.

21.2.2 C2A
http://www.astrosurf.com/c2a/english/

This	is	a	planetarium	application	(Windows-only).

AstroPlanner	can	control	the	pointing	of	the	Field	of	view	in	C2A,	and	vice	versa.
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22 User-contributed observing plans
As	well	as	creating	your	own	observing	plans,	you	can	also	beneFit	from	the	efforts	of	other	users	
and	download	ready-to-use	plan	documents	that	have	been	uploaded	to	an	online	database	by	oth-
ers.	This	database	is	common	to	all	registered	users,	and	you	are	free	to	upload	your	own	plans	to	
this	database	to	beneFit	others.	Obviously	this	feature	requires	a	live	connection	to	the	Internet.

22.1 Downloading plans
Use	the	File	>	User-Contributed	Plans	>	Download...	menu	command	to	bring	up	a	window	show-
ing	the	inventory	of	available	plans.

Figure	427:	User-contributed	plan	download	window

The	ten	most	recently	uploaded	plans	are	displayed	First,	since	these	are	the	most	commonly	down-
loaded	plans.	The	inventory	of	available	plans	can	be	displayed	in	various	orders	in	a	hierarchical	
fashion.	In	particular:

• My	Plans.	A	list	of	all	plans	that	were	uploaded	by	you.	Only	you	can	delete	or	replace	these	
plans	(see	below).

• All	Plans.	Can	be	displayed	By	Date	(by	year	of	submission),	By	File	Name	(alphabetically),	By	
Number	of	Objects	(number	of	objects	in	the	plan	document),	or	By	Author	(the	person	origi-
nally	submitting	the	plan).

• By	Category.	Plans	are	stored	by	category	and	sub-category.	e.g.	there's	a	Magazines	category	
that	contains	plans	derived	from	magazine	articles.	That	category	has	sub-categories	for	Sky	&	
Telescope,	Astronomy,	Sky	at	Night,	etc.	You	can	"drill	down"	until	you	Find	the	plan	you	want.
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• By	Object	Type.	A	list	of	object	types	(e.g.	galaxies)	and	which	plans	contain	those	types	of	
objects.

Each	plan	entry	includes	the	File	name,	the	date	of	submission,	the	number	of	objects	in	the	plan,	
(part	of)	the	description,	and	the	author.

Clicking	on	a	particular	plan	entry	displays	the	complete	description,	the	category,	and	a	list	of	ob-
ject	types	present	in	that	plan	document.

You	can	also	search	for	particular	plan	documents	by	typing	a	search	string	into	the	Find	Field	and	
clicking	the	Find	button.

Selecting	a	plan	for	download	consists	of	checking	the	checkbox	to	the	left	of	the	plan	File	name.	You	
can	select	more	than	one	plan	to	download.

Clicking	the	Download	button	starts	the	download	process	for	each	selected	plan.	Each	plan	is	
opened	into	a	separate	plan	document	window.	It	will	then	be	up	to	you	to	save	the	plan	somewhere
convenient.

You	can	also	elect	to	download	the	plan	documents	directly	to	a	speciFied	folder	(select	the	Down-
load	to	folder	checkbox,	and	use	the	Browse...	button	to	choose	a	suitable	folder).	The	plans	will	be
downloaded	directly	to	Files	in	the	speciFied	folder,	with	the	same	name	as	the	original	plan.	This	is	a
lot	quicker	than	the	First	method,	especially	if	you	are	downloading	several	plan	documents	at	once.

22.2 Uploading a plan
You	can	upload	the	frontmost	plan	document	by	using	the	File	>	User-Contributed	Plans	>	Up-
load...	menu	command.

Figure	428:	User-contributed	plan	upload	dialog

You	will	need	to	enter	a	description	and	select	a	category	for	the	plan	document	(this	information	
comes	from	the	plan	document	information	(Section	#.#	on	page	#)	and	might	already	be	set	up.
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The	document	will	be	uploaded	under	your	registered	name.	You	can	use	the	Anonymous	checkbox	
to	ensure	your	identity	remains	hidden	from	other	users	(your	plan	will	have	the	author	set	to	
"Anon."	or	"Anonymous").

You	also	need	to	give	the	plan	a	File	name.	This	should	be	unique.	If	it	is	already	in	use	by	another	
user,	then	you'll	be	asked	to	choose	another	name.	If	it	is	the	same	name	as	one	of	your	uploaded	
plans,	then	you'll	be	given	the	option	to	overwrite	the	previously-uploaded	plan.

Finally,	you	can	use	the	Announce	plan	availability	to	AstroPlanner	Yahoo	Group	checkbox	to	
send	an	automated	e-mail	message	to	the	user's	group	to	let	them	know	of	the	upload.

22.3 Deleting a plan
You	can	delete	any	plan	document	you	previously	uploaded	by	using	the	File	>	User-Contributed	
Plans	>	Delete...	menu	command.	Select	the	plans	scheduled	for	deletion	with	the	checkboxes,	click	
Delete,	and	they	will	be	permanently	removed	from	the	on-line	database.

Figure	429:	User-contributed	plan	deletion	dialog
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23 Managing catalogues
Catalogues	are	Files	containing	collections	of	objects	that	are	typically	related.	Most	of	the	catalogues
available	for	AstroPlanner	are	derived	from	professional	astronomical	catalogue	data.	This	chapter	
is	about	managing	these	catalogues.

You	always	have	at	least	one	catalogue	(Bright	Star	Catalogue)	in	your	application's	catalogue	collec-
tion.	Additionally,	you	might	have	a	CD/DVD-ROM	or	USB	Flash	drive	from	the	vendor	containing	As-
troPlanner	catalogues.	Most	of	the	catalogues	(apart	from	the	bigger	ones)	are	also	available	on-line	
and	can	be	downloaded	from	the	repository	there.

23.1 Using the Setup Wizard
The	simplest	way	to	manage	catalogues	is	with	the	Setup	Wizard	(File	>	Setup	Wizard...),	although	
you	are	pretty	much	limited	to	adding	catalogues	to	your	collection,	either	from	a	CD-	or	DVD-ROM,	
or	by	downloading	them	from	the	on-line	repository.	

The	wizard	dialog	appears	the	First	time	you	run	AstroPlanner,	but	can	be	used	any	time	to	add	
more	catalogues.	Click	the	Next	button	until	the	Catalogues	page	appears	(Figure	431).	You	will	be	
asked	if	you	want	to	install	catalogues	from	a	CD/DVD-ROM	or	USB	Flash	drive,	and	to	mount	that	
disk/drive	if	necessary.

Figure	430:	CD/DVD-ROM/USB	Flash	drive	warning

The	available	catalogues	are	listed	in	the	Suggested	Catalogues	list.	You	can	select	any	catalogues	
you	like	from	the	list	using	the	checkbox	next	to	each	one	(already-installed	catalogues	excepted).	
You	can	also	use	the	User	Survey	check	list	on	the	left	and	let	AstroPlanner	make	suggestions	(in	
green)	for	you.	Once	you've	made	your	selection,	click	the	Finish	button.	The	catalogues	will	then	be
installed	into	your	collection.
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Figure	431:	Setup	Wizard	Catalogues	page

23.2 Installing, updating and removing catalogues
The	most	Flexible	way	to	manage	your	catalogue	collection	is	by	using	the	Catalogue	Manager	(File	>
Catalogue	Manager...).	The	manager	window	lists	all	available	catalogues	in	a	list.	The	First	column	
is	the	current	Status	and	can	be:

• Not	installed.	The	catalogue	is	not	currently	installed	in	your	collection,	and	can	be	installed	if	
desired	using	the	Install	checkbox	in	the	Action	column.

• Installed.	The	catalogue	is	currently	installed	in	your	collection,	and	can	be	removed	if	desired	
using	the	Remove	checkbox	in	the	Action	column.

Additionally,	if	the	source	is	the	on-line	repository,	the	Status	can	also	be:

• New.	This	is	a	new	catalogue	created	since	the	last	time	you	used	the	Catalogue	Manager,	and	
can	be	installed	if	desired	using	the	Install	checkbox	in	the	Action	column.
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• Deprecated.	This	is	a	catalogue	that	exists	in	your	collection,	but	that	has	been	deprecated	
(made	redundant	or	replaced	by	another	catalogue)1	since	you	installed	it.	It	can	be	removed	if	
desired	using	the	Discard	checkbox	in	the	Action	column.

• Updated.	This	is	a	catalogue	that	exists	in	your	collection,	but	that	has	been	updated	or	revised	
since	you	installed	it.	It	can	be	updated	if	desired	using	the	Update	checkbox	in	the	Action	
column.

Figure	432:	Catalogue	manager	with	catalogue	list

If	you	check	any	of	the	checkboxes	in	the	Action	column	then	the	button	at	the	lower	right	will	be	
enabled.	If	you	have	multiple	catalogue	folders	(see	below)	then	you	will	need	to	select	the	folder	
that	you	wish	to	install	to,	using	the	Install	in	popup.	The	button	at	the	lower	right	will	change	its	
caption	to	to	reFlect	what	you	want	to	do	(e.g.	Install,	Remove,	Process,	etc.).	Clicking	it	will	start	the	
installation/update/removal	process.

The	F	column	speciFies	what	folder	the	catalogue	is	installed	into	(useful	if	you	have	alternate	cata-
logue	folders.	The	S	column	contains	an	entry	if	the	catalogue	includes	spectral	information	for	the	
contained	objects.	The	P	column	contains	an	entry	if	the	catalogue	includes	proper	motion	informa-
tion	for	the	contained	stellar	objects.

1. This often happens with some older catalogues that are found to be too full of bugs or inconsistencies. Such catalogues are no
longer supported by the vendor. You don't have to remove them, but you will no longer be able to download them from the on-line
repository.	i.e.	when	they're	gone,	they're	gone.
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Right-clicking	the	list	of	catalogues	gives	you	some	options	for	selecting	catalogues	(i.e.	turning	on	
the	checkbox	in	the	Action	column).	You	can	select	all	installed	catalogues,	all	deprecated	cata-
logues,	etc.

Figure	433:	Catalogue	Manager	list	options

The	Find	catalogues	containing	ID...	item	allows	you	to	enter	an	object	preFix,	and	it	will	list	any	
available	catalogues	that	have	that	ID	preFix	as	a	primary	ID	(i.e.	catalogues	that	probably	have	all	
objects	with	that	ID	preFix),	or	as	a	secondary	ID	(i.e.	catalogues	that	have	at	least	some	of	the	ob-
jects	with	that	ID	preFix).	If	the	catalogues	are	not	installed,	you	can	then	select	one	or	more	of	them	
for	installation.

Figure	434:	Find	catalogues	containing	ID

23.3 Catalogue settings and coverage
The	Coverage	and	Settings	tab	of	the	Catalogue	Manager	lets	you	set	some	Flags	on	the	catalogues,	
and	also	show	the	sky	coverage	of	each	catalogue	on	an	all-sky	map.	The	list	contains	an	entry	for	
each	installed	catalogue	in	your	collection.	Clicking	on	a	catalogue	entry	shows	the	sky	coverage.	It	
also	allows	you	to	set	the	following	Flags	on	each	catalogue:

• Preferred	(P).	When	catalogues	are	searched,	those	marked	as	Preferred	are	searched	First.

• Don't	search	(D).	When	catalogues	are	searched,	those	marked	Don't	search	are	skipped.
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• FoV	default	(F).	When	a	new	plan	window	is	created,	each	catalogue	marked	as	FoV	default	will
be	switched	on	in	the	Field	of	View	chart	catalogue	list1.	This	is	only	done	initially,	and	any	such	
selected	catalogues	can	be	switched	off	thereafter.

• Sky	chart	(S).	Any	catalogue	marked	as	Sky	chart	will	be	displayed	in	the	Sky	chart	if	the	Ob-
jects	>	Catalogue	objects	display	option	is	used.

• Use	Name	(N).	Use	the	Name	Field	of	the	catalogue	entry	instead	of	the	ID	when	displaying	ob-
jects	in	the	Field	of	View	chart	(if	the	Name	is	non-blank).	This	is	useful	if	the	catalogue	Name	is	
more	“meaningful”	than	the	primary	ID.	e.g.	the	SAC	DSO	catalogue:	NGC20	(Name)	is	better	than
SAC6	(ID).

• FoV	Min	and	FoV	Max.	The	minimum	and/or	maximum	magnitudes	to	be	used	to	limit	which	
objects	in	the	catalogue	are	displayed	in	the	Field	of	view	chart.

Figure	435:	Catalogue	coverage	and	settings

1. If	you	create	a	new	plan	using	another	plan	document	as	a	template,	this	setting	will	be	ignored.
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23.4 Catalogue Types & IDs
The	Types	and	IDs	tab	of	the	Catalogue	Manager	displays	information	about	what	IDs	are	support-
ed	by	what	catalogues,	and	what	object	types	are	present	in	the	catalogues,	together	with	their	mag-
nitude	range	(where	applicable).	The	displayed	information	is	selected	by	the	radio	buttons	at	the	
top.

• Catalogue	vs.	ID.	For	each	catalogue	there's	a	matrix	of	IDs	with	a	bullet	where	an	ID	is	support-
ed	by	the	catalogue.

• Catalogue	+	ID.	For	each	catalogue	there's	a	list	of	IDs	supported	by	the	catalogue.

• Catalogue	vs.	Types.	For	each	catalogue	there's	a	matrix	of	Types	with	a	bullet	where	a	cata-
logue	contains	objects	of	that	type.

• Catalogue	+	Types.	For	each	catalogue	there's	a	list	of	Types	contained	in	that	catalogue.

Figure	436:	Catalogue	vs.	ID
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Figure	437:	Catalogue	+	ID

Figure	438:	Catalogue	vs.	Types

Figure	439:	Catalogue	+	Types

23.5 Plan Creation Wizard catalogues
The	Plan	Creation	Wizard	tab	contains	a	list	of	the	installed	catalogues	that	contribute	to	the	Plan	
Creation	Wizard's	database.	The	top	list	shows	the	installed	catalogues	and	a	count	of	the	number	of
objects	they	contribute	to	the	database,	including	a	total	line	at	the	bottom.

The	second	list	shows	uninstalled	catalogues	that	could	contribute	to	the	wizard's	database.	By	se-
lecting	the	checkbox	next	to	those	catalogues,	you	can	use	the	Install...	button	to	install	them	(and	
thus	add	the	objects	to	the	database).
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Figure	440:	Plan	Creation	Wizard	catalogues

23.6 Displaying catalogue contents
The	contents	of	catalogues	can	be	displayed	in	a	window.	There	are	various	ways	to	do	this:

• Object	>	Open	Catalogue/s.

• The	Show	Catalogue	popup	button	under	the	object	list.

• Double-clicking	a	catalogue	entry	on	the	Field	of	View	tab.

• Double-clicking	an	installed	catalogue	entry	in	the	Catalogue	Manager	window.

The	catalogue	display	window	has	two	tabs.	

The	Catalogue	tab	shows	all	of	the	objects	in	a	table	form.	

The	Obs	column	reports	the	number	of	observations	of	the	associated	object	in	the	observation	
database,	and	the	Found	column	is	"Yes"	if	any	of	those	observations	reports	that	the	object	was	
found.	

The	Annotations	widget	displays	any	catalogue	annotations	for	the	selected	object.	See	Section	23.7
on	page	334	for	details.

You	can	Find	a	particular	object	by	typing	its	ID	into	the	Find	Field.	The	popup	lists	the	valid	IDs	sup-
ported	by	the	catalogue.	
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If	a	telescope	with	Go-To	capability	is	currently	connected,	the	Slew	to	Object	button	will	slew	the	
telescope	to	the	selected	object	(assuming	it's	visible).

The	Add	Selected	button	will	add	the	selected	object/s	to	the	plan	document	from	whence	the	win-
dow	was	opened.	If	the	Don't	add	if	observed	checkbox	is	checked,	then	any	selected	objects	that	
have	already	been	observed	will	not	be	added	to	the	plan.	Clicking	the	button	will	close	the	window,	
unless	the	Keep	window	open	checkbox	is	checked.

Figure	441:	Catalogue	display	window

The	?	button	(bottom	left)	displays	information	about	the	catalogue.	The	various	types	of	objects	in	
the	catalogue	are	enumerated,	together	with	the	count	and	magnitude	range.	If	a	description	is	
available	for	the	catalogue,	then	it	is	displayed	in	the	bottom	half	of	the	window.
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Figure	442:	Catalogue	information	window

The	Coverage	Chart	tab	shows	all	of	the	catalogue	objects	on	an	all-sky	Aitoff	map.	If	one	or	more	
objects	are	selected	in	the	Catalogue	tab,	then	those	objects	are	circled	in	red	on	the	map	and	the	
constellation	boundary	for	the	enclosing	constellation	is	shown.

Figure	443:	Catalogue	coverage	sky	map

23.7 Catalogue annotations
Catalogue	annotations	are	text	that	the	user	can	add	to	speciFic	catalogue	entries,	by	ID.	These	anno-
tations	are	kept	in	a	separate	database	and	are	displayed	in	various	places.	In	each	place	the	widget	
has	the	same	form.
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Figure	444:	Annotation	widget

The	annotation	widget	consists	of	a	list	on	the	left	containing	the	IDs	of	all	relevant	objects.	Note	
that	synonyms	of	objects	will	also	be	shown.	e.g.	if	the	annotations	for	M20	are	being	shown,	then	
any	annotations	for	NGC6514	(the	same	object)	will	also	be	shown.

On	the	right	is	a	text	editor	Field	containing	the	annotation	text.

There	are	buttons	for	adding	a	new	annotation,	deleting	the	selected	annotation/s,	and	duplicating	
the	selected	annotation.

The	Other	IDs	Field	contains	any	other	known	IDs	for	the	annotation,	separated	by	commas.

Places	the	catalogue	annotation	widget	is	found:

23.7.1 Catalogue display window
This	allows	you	to	edit	annotations	for	the	selected	catalogue	object.

Figure	445:	Annotation	editing:	Catalogue	display	window

23.7.2 Object list editor
When	the	object	editing	Fields	for	the	object	list	are	being	displayed,	you	can	examine	and	edit	anno-
tations	for	the	currently-selected	object.
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Figure	446:	Annotation	editing:		Object	list	editor

23.7.3 Observation data entry
When	an	observation	is	being	entered,	the	annotations	for	the	selected	object	are	displayed.

Figure	447:	Annotation	editing:	Observation	data	entry

23.7.4 Annotation editor
The	Annotation	editor	can	be	reached	via	the	Object	>	Edit	Annotations...	menu	command.	This	
displays	all	annotations,	and	is	a	convenient	way	to	do	bulk	editing,	deleting,	etc.	

The	Export...	button	exports	all	the	annotations	in	the	database	to	a	tab-separated	text	File.

The	Import...	button	imports	annotations	that	were	previously	exported	(perhaps	on	another	
computer).

Note	that,	in	the	case	of	the	editor	only,	any	changes	you	make	will	not	be	saved	back	to	the	annota-
tion	database	until	the	Save	button	is	used.
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Figure	448:	Annotation	editing:	Annotation	editor
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24 Comets & Minor Planets
Comets	and	minor	planets,	being	solar	system	objects,	do	not	have	a	Fixed	position	in	the	sky,	and	
rely	on	orbital	elements	(a	bunch	of	weird-sounding	numbers)	to	determine	their	current	position	
in	the	sky.	Those	elements	are	typically	retrieved	from	an	on-line	source	as	explained	below.	As	the	
orbits	for	these	objects	are	reFined,	the	elements	might	also	change	over	time.

24.1 Downloading comet elements
Use	the	File	>	Import	>	Comet	Data...	menu	command	to	retrieve	orbital	element	data.	The	dialog	
lets	you	choose	the	source	of	the	data	to	import.

Figure	449:	Select	comet	data	source

The	First	two	options	load	data	from	text	Files.	The	second	two	download	the	latest	data	from	the	In-
ternet	(assuming	you	have	a	connection).	If	you	have	previously	downloaded	from	a	source,	the	Use	
cached	checkbox	will	be	enabled.	Checking	this	will	used	the	cached	copy	rather	than	requiring	a	
download.

In	some	instances	you	can	check	the	Save	downloaded	data	to	disk	checkbox	and	the	downloaded	
data	will	be	saved	in	the	"standard"	Meade	Autostar	format	for	comet	elements.

Once	you've	selected	the	source,	and	clicked	OK,	you	will	be	presented	with	a	list	of	comet	objects	
for	which	elements	are	available	(Figure	450).	Select	one	or	more	comets	to	be	added	to	your	plan	
by	checking	the	checkbox	to	the	left	of	the	entry	in	the	list.	The	All	and	None	buttons	select	all	dis-
played	comets,	or	clears	all	selections,	respectively.

The	list	includes	the	ID	of	the	comet	and	some	other	parameters	computed	from	the	comet	elements
and	based	on	the	current	local	date/time:

• Mag.	The	current	estimated	magnitude	of	the	comet.	This	is	not	available	in	all	cases	(e.g.	the	JPL
download	does	not	include	parameters	to	compute	the	magnitude).

• Motion/hr.	The	current	motion	per	hour	of	the	comet	across	the	sky,	in	either	arcminutes	or	
arcseconds.

• Bearing.	The	current	bearing	of	the	motion	of	the	comet	with	respect	to	north	(via	east)	in	
degrees.

• RA.	The	current	R.A.	of	the	comet.
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• Dec.	The	current	Declination	of	the	comet.

• E.Lat.	The	current	ecliptic	latitude	of	the	comet.

• E.Long.	The	current	ecliptic	longitude	of	the	comet.

• Const.	The	current	constellation	that	the	comet	is	travelling	through.

Figure	450:	Comet	listing	dialog

The	Location	Map	tab	(Figure	451)	shows	all	comets	on	an	all-sky	map,	with	any	selected	comets	
circled	in	red.	Double-clicking	a	comet	on	the	chart	will	select	that	line	in	the	list.

When	a	comet	entry	is	selected,	the	orbital	parameters	(elements)	of	the	comet	is	displayed	in	a	ta-
ble	under	the	list	of	comets.

By	default	the	list	of	comets	shows	all	available	comets.	However,	you	can	use	the	Display	restric-
tions	table	to	select	only	those	comets	that	obey	the	restrictions.	For	example,	in	Figure	452,	the	list	
has	been	restricted	to	comets	whose	current	magnitude	is	16	or	brighter,	and	whose	declination	is	
-25°	or	greater.	This	reduces	the	list	from	250	total	down	to	26	displayed.
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Figure	451:	Comet	location	map

Figure	452:	Comet	list	with	display	restrictions

24.2 Downloading minor planet elements
Use	the	File	>	Import	>	Minor	Planet	Data...	menu	command	to	retrieve	orbital	element	data.	The	
dialog	lets	you	choose	the	source	of	the	data	to	import.
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Figure	453:	Select	minor	planet	data	source

The	First	three	options	load	data	from	text	Files.	The	rest	download	the	latest	data	from	the	Internet	
(assuming	you	have	a	connection).	If	you	have	previously	downloaded	from	a	source,	the	Use	
cached	checkbox	will	be	enabled.	Checking	this	will	used	the	cached	copy	rather	than	requiring	a	
download.

In	some	instances	you	can	check	the	Save	downloaded	data	to	disk	checkbox	and	the	downloaded	
data	will	be	saved	in	the	"standard"	Meade	Autostar	format	for	minor	planet	elements.

Once	you've	selected	the	source,	and	clicked	OK,	you	will	be	presented	with	a	list	of	minor	planet	
objects	for	which	elements	are	available	(Figure	454).	Note	that	the	following	description	applies	to	
all	the	data	sources	apart	from	ASTORB.DAT	and	MPCORB.DAT.	See	Section	24.2.1	on	page	343	for	a	
description	of	those	data	sources.

Select	one	or	more	minor	planets	to	be	added	to	your	plan	by	checking	the	checkbox	to	the	left	of	
the	entry	in	the	list.	The	All	and	None	buttons	select	all	displayed	minor	planets,	or	clears	all	selec-
tions,	respectively.

The	list	includes	the	ID	of	the	minor	planet	and	some	other	parameters	computed	from	the	minor	
planet	elements	and	based	on	the	current	local	date/time:

• Mag.	The	current	estimated	magnitude	of	the	minor	planet.

• Motion/hr.	The	current	motion	per	hour	of	the	minor	planet	across	the	sky,	in	either	arcminutes
or	arcseconds.

• Bearing.	The	current	bearing	of	the	motion	of	the	minor	planet	with	respect	to	north	(via	east)	
in	degrees.

• RA.	The	current	R.A.	of	the	minor	planet.

• Dec.	The	current	Declination	of	the	minor	planet.

• E.Lat.	The	current	ecliptic	latitude	of	the	minor	planet.

• E.Long.	The	current	ecliptic	longitude	of	the	minor	planet.
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• Const.	The	current	constellation	that	the	minor	planet	is	travelling	through.

Figure	454:	Minor	planet	listing	dialog

The	Location	Map	tab	shows	all	minor	planets	on	an	all-sky	map,	with	any	selected	minor	planets	
circled	in	red.	Double-clicking	a	minor	planet	on	the	chart	will	select	that	line	in	the	list.

Figure	455:	Minor	planet	location	map

When	a	minor	planet	entry	is	selected,	the	orbital	parameters	(elements)	of	the	minor	planet	are	
displayed	in	a	table	under	the	list	of	minor	planets.
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By	default	the	list	of	minor	planet	shows	all	available	minor	planet.	However,	you	can	use	the	Dis-
play	restrictions	table	to	select	only	those	minor	planets	that	obey	the	restrictions.	For	example,	in	
Figure	456,	the	list	has	been	restricted	to	minor	planets	whose	current	magnitude	is	11	or	brighter,	
and	whose	declination	is	-30°	or	greater.	This	reduces	the	list	from	53	total	down	to	14	displayed.

Figure	456:	Minor	planet	list	with	display	restrictions

24.2.1 ASTORB & MPCORB data sources
The	ASTORB.DAT	and	MPCORB.DAT	data	sources	are	huge	collections,	containing	many	hundreds	of	
thousands	of	minor	planet	entries.	For	this	reason	they	are	treated	slightly	differently	for	reasons	of	
efFiciency.

Once	you've	selected	the	source,	and	clicked	OK,	you	will	be	presented	with	a	list	of	minor	planet	
objects	for	which	elements	are	available	(Figure	457).

This	dialog	works	largely	the	same	way	as	the	previously-described	dialog	for	selecting	minor	plan-
ets,	with	the	following	differences:

Partitioning
Since	there	are	so	many	entries	to	manage,	the	complete	set	is	"partitioned"	into	more	manageable	
chunks.	The	Partition	size	setting	speciFies	the	maximum	size	of	each	"chunk".	The	popup	menu	at	
the	top	left	allows	you	to	select	the	partition	of	your	choice.	The	most	recent	entries	will	be	listed	
First	if	the	checkbox	to	the	right	of	the	popup	is	checked	(the	default).

Find
To	help	navigate	around	the	enormous	data	sets,	the	Find...	button	(and	Again	button	for	subse-
quent	searched	for	the	same	text)	allows	you	to	search	for	text	in	the	currently-displayed	partition.	
If	the	Find	globally	checkbox	is	checked,	the	search	will	search	the	entire	data	set.
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Figure	457:	ASTORB/MPCORB	Minor	planet	listing	dialog

24.3 Quick insertion of a comet or minor planet
If	you	have	previously	downloaded	elements	for	a	comet	or	minor	planet	(see	above)1,	then	you	can	
insert	a	comet/minor	planet	from	the	cached	elements	by	using	one	of	the	following	methods:

• Use	the	+	button	under	the	object	list.	In	the	New	Object	dialog,	type	in	the	name	of	the	comet	or	
minor	planet.	Then	use	the	Lookup...	button	to	display	a	list	of	all	cached	objects	of	the	required	
type,	with	the	search	Field	preloaded	with	the	ID.

Figure	458:	Entering	a	minor	planet	from	the	New	Object	dialog

1. With	the	exception	of	ASTORB	and	MPCORB	data	caches.
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• Use	the	Add	Special	popup	under	the	object	list,	and	choose	Comet...	or	Minor	planet...	to	dis-
play	a	list	of	all	cached	objects	of	the	required	type,	with	the	search	Field	preloaded	with	the	ID.

Figure	459:	Cached	minor	planet	object	dialog

24.4 Creating a comet or minor planet object manually
If	you	have	the	elements	for	a	comet	or	minor	planet,	you	can	enter	the	information	manually	using	
one	of	these	techniques:

• Use	the	+	button	under	the	object	list	and	click	the	Empty	button	in	the	New	Object	dialog	to	cre-
ate	an	"empty"	object	in	the	object	list.	Select	that	object,	and	change	its	Type	to	"Comet"	or	"Mi-
nor".	Once	that	is	done,	click	the	Edit	Elements...	button	at	the	lower	left	of	the	plan	window	(it	
will	be	available	for	any	Comet	or	Minor	planet	objects).	Edit	the	elements.

• Use	the	Add	Special	popup	under	the	object	list,	and	choose	Comet...	or	Minor	planet...	and	in	
the	dialog,	check	the	Create	a	new	object	with	default	elements	checkbox	and	click	OK.	Edit	
the	elements.

Figure	460:	Manual	editing	of	minor	planet	elements
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24.5 Updating elements
If	you	have	a	plan	with	comet	or	minor	planet	objects	and	you	wish	to	update	the	elements	for	those
objects,	you	can	do	so	by	using	Object	>	Refresh	Objects	from	Catalogues....	In	the	dialog,	select	the
Comets/Minor	Planets	option	(no	other	controls	need	setting)	and	click	OK.

Any	comet	or	minor	planet	objects	in	the	list	that	were	inserted	from	a	downloaded	data	source	will	
have	their	elements	updated	from	the	cached	download	(assuming	there	is	one	present).

Figure	461:	Refreshing	comet/minor	planet	elements
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25 Double Stars
25.1 Double star orbits
Double	(or	multiple)	star	systems	are	not	static.	The	primary	and	secondary	stars	typically	move	
with	respect	to	each	other.	These	relative	movements	can	be	extremely	small	(i.e.	they	don't	appear	
to	move	over	a	period	of	decades	or	longer),	or	they	might	move	relatively	rapidly	(with	noticeable	
relative	motion	over	a	period	of	months	or	years).	The	double	star	catalogues,	and	in	particular	the	
Washington	Double	Star	(WDS)	catalogue,	typically	only	show	a	single	instance	or	snapshot	of	rela-
tive	position	(separation	and	position	angle)	for	each	object,	which	might	be	quite	out-of-date	(some
even	100+	years	out	of	date).

Many	such	star	systems	have	been	observed	and	the	relative	positions	of	the	stars	noted	over	an	ex-
tended	period,	allowing	the	actual	orbits	of	the	stars	to	be	estimated.	A	feature	in	AstroPlanner	al-
lows	you	to	see	those	orbits	and	estimate	the	current	relative	positions	of	the	stars.

The	US	Naval	Observatory,	which	maintains	the	WDS,	also	maintains	a	database	of	orbital	elements	
for	a	(relatively	small)	subset	of	the	double	stars	in	the	WDS.	There	are	currently	2,400+	orbits	in	
the	database.	The	AstroPlanner	WDS	catalogues	have	been	modiFied	to	include	these	data	where	
applicable.

When	you	open	a	double-star	catalogue	(initially,	at	least,	it	will	only	be	the	WDS	catalogues),	any	
double	star	entry	that	has	associated	orbit	information	will	be	shown	with	the	Separation	and	Posi-
tion	Angle	column	entries	in	orange	(See	Figure	462). In	the	example,	two	objects	have	orbits	(or-
ange	text	in	the	Sep	and	Angle	columns).	To	see	information	about	the	orbits,	select	the	desired	ob-
ject	and	right-click.	Choose	then	Show	Orbit/s…	menu	entry.

Figure	462:	Double	star	orbit	entries	in	a	catalogue

A	window	is	displayed	with	the	known	orbital	info	for	that	star	system	(Figure	463).

The	orbit	is	plotted	on	axes	(scaled	in	arcseconds	from	the	primary	-	the	red	blob).	The	current	posi-
tion	of	the	secondary	is	shown	in	blue,	and	some	future	positions	are	shown	in	green,	with	the	year.	
The	information	above	the	chart	shows	that	this	particular	orbit	has	an	estimated	period	of	1550	
years	(1.55	Kyr),	and	that	based	on	the	orbit,	the	current	separation	and	position	angle	are	5.9	arc-
sec	and	188°	respectively.	The	Orbit	elements	popup	tells	you	that	the	chart	is	for	the	AB	compo-
nents,	and	the	reference	is	given	in	parentheses.	The	Fixed	separation/position	angle	refers	to	the	
Fixed	values	in	the	catalogue	entry	(which	as	mentioned	before	might	be	quite	old,	and	possibly	
inaccurate).

The	Elements	tab	shows	the	actual	numbers,	if	you	are	interested	(Figure	464).	There	might	be	
more	than	one	orbit	for	the	system.	In	this	case	there's	another	AB	orbit	(Figure	465).	Note	that	this	
(2001)	orbit	is	signiFicantly	different	from	the	other	(1996)	orbit,	although	the	current	position	is	
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pretty	much	identical.	Such	is	the	world	of	insufFicient	information.	As	the	years	go	by,	the	estimated
orbital	elements	will	undoubtedly	get	better.

Figure	463:	Double	star	orbit

Figure	464:	Double	star	elements
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Figure	465:	Double	star	orbit

The	same	applies	to	the	object	list	and	the	results	window	(the	columns	are	shown	in	orange,	and	
there's	a	right-click	Show	Orbit/s…	item).	However,	in	the	case	of	the	object	list	there's	also	a	Set	
Object	button.	Clicking	it	will	replace	the	"Fixed"	separation/position	angle	values	for	the	object	
with	the	computed	current	values,	and	the	Period	with	the	computed	period.

26 Import and Export
AstroPlanner	has	various	methods	of	importing	and	exporting	objects	and/or	observations.	These	
methods	can	be	useful	if	you	have	data	from	other	sources	that	need	to	be	used	by	AstroPlanner,	or	
if	you	wish	to	save	data	in	a	form	that	can	be	used	by	other	applications.

26.1 Import
26.1.1 Generic text data files
Import	objects	into	your	plan	document,	or	observations/sessions	into	the	observation	database,	
from	a	plain	text	File.	Use	File	>	Import	>	Generic	Text	File...	to	start	the	import.	Note	that	a	plan	
document	must	be	open	to	be	able	to	select	this	option,	even	if	you	are	importing	observation	data	
only.

You	will	First	be	asked	to	locate	the	text	File	you	want	to	import.

Then	the	import	dialog	appears.	The	First	line	to	be	processed	is	displayed	in	the	Sample	Data	Line	
area.	The	rest	of	the	parameters	deFine	the	format	of	the	incoming	data.
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Figure	466:	Generic	text	import	dialog

The	imported	text	File	should	have	one	line	per	imported	entity	(object,	etc.).	Each	line	should	con-
sist	of	a	Fixed	number	of	Pields,	with	each	Field	containing	the	value	of	some	parameter	of	the	entity	
(e.g.	ID,	RA,	Notes,	etc.).

• Field	DeOinitions.	This	list	contains	an	entry	for	each	imported	Field,	and	the	list	represents	all	
the	Fields	in	a	single	line	of	the	text	data.	Entity	parameters	are	imported	in	the	same	order	as	
the	rows	of	the	list.	You	can	add	and	delete	entries	from	the	list	using	the	+	and	-	buttons,	and	the
list	can	be	reordered	by	dragging	the	rows	around.	The	Clear	All	button	deletes	all	entries,	and	
the	Add	All	button	adds	all	possible	Fields	to	the	list.	You	can	edit	a	new	or	existing	entry	by	se-
lecting	it	and	changing	the	parameters	in	the	Edit	Field	DeOinition	Entry	section.	The	Value	col-
umn	contains	the	entity	parameter	to	be	imported;	the	Format	column	contains	the	selected	for-
mat;	the	Imported	column	shows	the	value	that	is	imported	from	the	sample	data	line	(the	value
shown	in	this	column	should	match	the	correct	value	you	are	trying	to	import.	If	it	doesn't,	then	
the	format	is	probably	incorrect).

• Edit	Field	DeOinition	Entry.	This	changes	the	currently-selected	entry	in	the	Field	DeOinitions	
list.	The	Value	popup	is	the	entity	parameter	you	want	to	export,	and	is	typically	a	parameter	of	
an	object,	session	or	observation.	There's	also	an	<Ignore>	choice	that	can	be	used	to	ignore	an	
empty	Field	if	necessary.	The	Format	popup	is	the	way	the	incoming	Value	is	formatted.	Typically
you'd	use	the	Default	format	in	most	cases,	but	some	parameter	types	specify	various	formats	
(e.g.	R.A.	can	be	formatted	in	hours	or	degrees,	as	a	decimal,	or	in	the	form	hh:mm:ss,	etc.).	If	you
have	chosen	the	Text	Format	to	be	Formatted	then	there	will	also	be	Column	From	and	Col-
umn	To	entries.	You	can	use	the	Modify	Text...	button	to	modify	the	incoming	text	before	it	is	
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imported	(See	Figure	467).	You	can	use	this	feature	to	add,	remove	or	replace	the	imported	text	
in	various	ways.

• Text	Format.	The	Formatted	option	allows	you	to	specify	the	column	range	for	each	Field	(e.g.	ID	
in	columns	1	through	6,	RA	in	columns	7	through	15,	etc.	Tab-separated,	comma-separated	and	
arbitrary-character-string-separated	options	assumes	the	requisite	character	string	between	
Fields	of	each	input	line.

• Ignore	Oirst	n	lines.	Read	past	the	First	n	lines.	Useful	to	ignore	column	headings,	etc.

• Convert	from	epoch.	If	the	object	coordinates	(RA	&	Dec)	of	the	input	data	are	of	an	epoch	oth-
er	than	J2000.0,	then	they	should	be	converted	from	that	epoch	to	J2000.0.

• Catalogue	lookup.	Lookup	the	object	data	in	the	internal	catalogues.	You	can	use	ID	as	the	key	
(if	available	in	the	input	data),	or	RA/Dec.	This	option	is	useful	if	you	have	data	that	only	has	IDs,
or	RA/Dec	coordinates.	If	the	Reject	if	not	found	option	is	checked,	then	if	the	catalogue	lookup	
fails	to	Find	a	matching	object,	the	input	data	will	be	ignored	and	a	new	object	will	not	be	created
using	the	data.

• Validate	only.	Perform	the	import	without	actually	creating	any	object/observation/session	
data.	This	is	a	convenient	way	of	checking	the	data	for	errors	before	committing	to	the	import.

• Import.	SpeciFies	what	is	to	be	exported.	Plan	Objects	only	will	consider	only	objects	in	your	
object	list	and	output	a	line	for	each.	Objects	and	Observations	will	consider	each	object	in	
your	object	list	and	output	a	line	for	each	observation	associated	with	it.	Any	object	parameters	
speciFied	will	be	duplicated	in	each	observation	line.	Sessions	and	Observations	ignores	ob-
jects	and	looks	at	all	observation	Sessions	included	in	the	speciFied	date	range,	and	all	observa-
tions	associated	with	those	sessions.

• Use	localised	formatting.	If	this	option	is	checked,	imported	date,	times	and	numbers	will	be	
assumed	to	be	in	the	local	format	as	speciFied	by	the	operating	system	(e.g.	decimal	comma	in	
Europe,	etc.).	If	it	is	unchecked	then	the	standard	(U.S.?)	formatting	is	used.

• Settings.	Once	you've	set	up	the	dialog,	the	Save...	button	allows	you	to	save	the	settings	to	a	File,
which	can	be	later	retrieved	using	the	Load...	button.	This	is	useful	if	you	are	juggling	multiple	
import	formats.

If	errors	occur,	a	dialog	with	a	list	of	those	errors	is	presented	(Figure	468),	listing	the	line	number,	
the	error	type,	the	Field	in	error	if	applicable,	and	the	original	data.	You	can	edit	the	data	externally	
with	a	text	editor,	or	you	can	click	the	Edit	Text...	button	and	edit	the	text	using	the	built-in	text	edi-
tor	(which	conveniently	shows	the	line	numbers,	and	Flags	the	lines	in	question).	See	Figure	469.
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Figure	467:	Text	ModiFications	dialog

Figure	468:	Import	error	dialog
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Figure	469:	Import	data	text	editor

26.1.2 Comet data
This	is	covered	in	detail	in	Chapter	24	on	page	338.

26.1.3 Minor Planet data
This	is	covered	in	detail	in	Chapter	24	on	page	338.

26.1.4 Supernova data
Use	the	File	>	Import	>	Supernova	Data...	menu	command	to	retrieve	supernova	data.	The	dialog	
lets	you	choose	the	source	of	the	data	to	import.

Figure	470:	Select	supernova	data	source

Both	options	download	the	latest	data	from	the	Internet	(assuming	you	have	a	connection).	If	you	
have	previously	downloaded	from	a	source,	the	Use	cached	checkbox	will	be	enabled.	Checking	this	
will	use	the	cached	copy	rather	than	requiring	a	download.

Once	you've	selected	the	source,	and	clicked	OK,	you	will	be	presented	with	a	list	of	supernovae	
(Figure	471).	Select	one	or	more	supernovae	to	be	added	to	your	plan	by	checking	the	checkbox	to	
the	left	of	the	entry	in	the	list.
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Figure	471:	Import	supernova	data	dialog

The	Location	Map	tab	shows	all	supernovae	on	an	all-sky	map,	with	any	selected	supernovae	cir-
cled	in	red.	Double-clicking	a	supernova	on	the	chart	will	select	that	line	in	the	list.

Figure	472:	Supernova	location	map
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26.1.5 Gamma Ray Burst (GRB) data
Use	the	File	>	Import	>	Gamma	Ray	Burst	Data...	menu	command	to	retrieve	gamma	ray	burst	
data.	The	dialog	lets	you	choose	the	source	of	the	data	to	import	(currently	only	one).

Figure	473:	Select	GRB	data	source

The	latest	data	is	downloaded	from	the	Internet	(assuming	you	have	a	connection).	If	you	have	pre-
viously	downloaded	from	a	source,	the	Use	cached	checkbox	will	be	enabled.	Checking	this	will	use	
the	cached	copy	rather	than	requiring	a	download.

Once	you've	selected	the	source,	and	clicked	OK,	you	will	be	presented	with	a	list	of	gamma	ray	
burst	candidates	(Figure	474).	Select	one	or	more	of	these	to	be	added	to	your	plan	by	checking	the	
checkbox	to	the	left	of	the	entry	in	the	list.

New	items	since	the	last	time	you	used	this	feature	are	marked	in	red	(or	green	if	they	are	currently	
visible	from	your	observing	site).	If	the	item	is	never	visible	from	your	observing	site	(i.e.	always	be-
low	the	theoretical	horizon),	it	is	coloured	grey.

Figure	474:	Import	GRB	data	dialog
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Figure	475:	Selecting	older	items	with	additional	data

The	Location	Map	tab	shows	all	GRB	sources	on	an	all-sky	map,	with	any	selected	entries	circled	in	
red.	Double-clicking	a	GRB	source	on	the	chart	will	select	that	line	in	the	list.

Figure	476:	GRB	location	map
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26.1.6 Exoplanet data
Use	the	File	>	Import	>	Exoplanet	Data...	menu	command	to	retrieve	exoplanet	data.	The	dialog	lets
you	choose	the	source	of	the	data	to	import	(currently	only	one).

Figure	477:	Select	exoplanet	data	source

The	latest	data	is	downloaded	from	the	Internet	(assuming	you	have	a	connection).	If	you	have	pre-
viously	downloaded	from	a	source,	the	Use	cached	checkbox	will	be	enabled.	Checking	this	will	use	
the	cached	copy	rather	than	requiring	a	download.

Once	you've	selected	the	source,	and	clicked	OK,	you	will	be	presented	with	a	list	of	exoplanet	dis-
coveries.	Select	one	or	more	of	these	to	be	added	to	your	plan	by	checking	the	checkbox	to	the	left	of
the	entry	in	the	list.

New	items	since	the	last	time	you	used	this	feature	are	marked	in	red	(or	green	if	they	are	currently	
visible	from	your	observing	site).	If	the	item	is	never	visible	from	your	observing	site	(i.e.	always	be-
low	the	theoretical	horizon),	it	is	coloured	grey.
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Figure	478:	Select	exoplanet	data

26.1.7 Observations/Sessions
Use	File	>	Import	>	Observations/Sessions...	to	import	observations	and	sessions	into	the	observa-
tion	database	from	a	File	previously	exported	from	another	installation	of	AstroPlanner.	This	is	use-
ful	for	moving	recent	observation	information	from,	say,	a	Field	laptop	to	an	ofFice	desktop	computer.
See	Section	26.2.10	on	page	365	for	the	corresponding	exporting	information.

26.1.8 Sky Commander catalogues
Use	File	>	Import	>	Sky	Commander	Catalogue...	to	import	a	Sky	Commander	catalogue	File	(.s37	
extension).	

26.1.9 SkySafari observing lists
Use	File	>	Import	>	SkySafari	observing	list...	to	import	a	SkySafari	observing	list	File	(.skylist	ex-
tension).	If	the	list	contains	observations	made	in	SkySafari,	then	you'll	be	prompted	to	import	those
observations	as	well	(optionally).

26.1.10 EQTour observing lists
Use	File	>	Import	>	EQTour	observing	list...	to	import	an	EQTour	observing	list	File	(.lst	extension).

26.1.11 Cartes du Ciel observing lists
Use	File	>	Import	>	Cartes	du	Ciel	observing	list...	to	import	an	Cartes	du	Ciel	observing	list	File	
(.txt	extension).
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26.2 Export
26.2.1 Generic text files
AstroPlanner	includes	a	very	Flexible	way	to	export	object	and	observation	data	in	the	form	of	plain	
text	Files.	Use	File	>	Export	>	Generic	Text,	Excel,	XML	or	JSON...	to	do	this.

The	exported	text	File	has	one	line	per	exported	entity	(object,	etc.).	Each	line	consists	of	a	Fixed	
number	of	Pields,	with	each	Field	representing	the	value	of	some	parameter	of	the	entity	(e.g.	ID,	RA,	
Notes,	etc.).

Figure	479:	Generic	text	export	dialog

• Sample	Data	Line.	This	area	displays	a	sample	of	what	will	be	exported	to	a	line	of	the	text	File,	
and	will	change	as	you	change	the	settings	within	the	dialog.

• Field	DeOinitions.	This	list	contains	an	entry	for	each	exported	Field,	and	the	list	represents	all	
the	Fields	in	a	single	line	of	text	data.	Entity	parameters	are	exported	in	the	same	order	as	the	
rows	of	the	list.	You	can	add	and	delete	entries	from	the	list	using	the	+	and	-	buttons,	and	the	list
can	be	reordered	by	dragging	the	rows	around.	The	Clear	All	button	deletes	all	entries,	and	the	
Add	All	button	adds	all	possible	Fields	to	the	list.	You	can	edit	a	new	or	existing	entry	by	selecting
it	and	changing	the	parameters	in	the	Edit	Field	DeOinition	Entry	section.

• Edit	Field	DeOinition	Entry.	This	changes	the	currently-selected	entry	in	the	Field	DeOinitions	
list.	The	Value	popup	is	the	entity	parameter	you	want	to	export,	and	is	typically	a	parameter	of	
an	object,	session	or	observation.	There's	also	an	<empty>	choice	that	can	be	used	to	output	an	
empty	Field	if	necessary.	The	Format	popup	is	the	way	you	want	to	format	the	Value.	Typically	
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you'd	use	the	Default	format	in	most	cases,	but	some	parameter	types	specify	various	formats	
(e.g.	R.A.	can	be	formatted	in	hours	or	degrees,	as	a	decimal,	or	in	the	form	hh:mm:ss,	etc.).	If	you
have	chosen	the	Text	Format	to	be	Formatted	then	there	will	also	be	Column	From	and	Col-
umn	To	entries.	You	can	also	specify	text	to	be	preFixed	and/or	sufFixed	to	the	formatted	Field	
data,	as	well	as	various	other	text	substitutions,	etc.	by	using	the	Modify	Text...	button.

• Text	Format.	The	Formatted	option	allows	you	to	specify	the	column	range	for	each	Field	(e.g.	ID	
in	columns	1	through	6,	RA	in	columns	7	through	15,	etc.	Tab-separated,	comma-separated	and	
arbitrary-character-string-separated	options	put	the	requisite	character	string	between	Fields	of	
each	output	line.	The	Comma-separated	option	also	makes	sure	that	Fields	containing	commas	
are	enclosed	in	quotes,	etc.	Excel,	XML	and	JSON	are	covered	in	the	next	sections.

• Objects	to	export.	SpeciFies	which	objects	to	export,	unless	you	are	exporting	Sessions	and	
Observations.

• Header	line.	This	option	will	output	a	single	header	line	before	the	data	with	appropriate	Field	
headings,	in	the	same	Text	Format	as	the	data.

• To	epoch.	The	object	data	is	exported	with	the	same	epoch	as	shown	in	the	object	list	(i.e.	
J2000.0).	This	option	lets	you	convert	the	coordinates	to	another	epoch	(in	particular,	JNow,	
which	represents	the	epoch	of	the	current	date).

• Multiple	resource	combinations.	If	you	are	exporting	observations,	this	option	speciFies	what	
to	do	with	multiple	resource	combinations	(i.e.	you	made	observations	with	more	than	one	tele-
scope/eyepiece/etc.	combination).	You	can	elect	to	Ignore	all	but	Oirst	in	which	case	a	single	ob-
servation	line	is	output,	using	only	the	First	resource	combination.	Alternatively,	Duplicate	
record	for	each	will	output	a	duplicate	record/line	for	each	combination	(i.e.	the	lines	will	be	
identical	except	for	the	resource	combination	Fields	-	telescope,	eyepiece,	etc.).

• File	extension.	The	File	name	extension	to	use	by	default.

• Export.	SpeciFies	what	is	to	be	exported.	Plan	Objects	only	will	consider	only	objects	in	your	
object	list	and	output	a	line	for	each.	Objects,	Observations	and	Sessions	will	consider	each	
object	in	your	object	list	and	output	a	line	for	each	session/observation	associated	with	it.	Any	
object	parameters	speciFied	will	be	duplicated	in	each	observation	line.	Sessions	and	Observa-
tions	ignores	objects	and	looks	at	all	observation	Sessions	included	in	the	speciFied	date	range,	
and	all	observations	associated	with	those	sessions.	The	checkboxes	allow	you	to	specify	"open-
ended"	ranges.

• Use	localised	formatting.	If	this	option	is	checked,	date,	times	and	numbers	will	be	exported	in	
the	local	format	as	speciFied	by	the	operating	system	(e.g.	decimal	comma	in	Europe,	etc.).	If	it	is	
unchecked	then	the	standard	(U.S.?)	formatting	is	used.

• Line	Endings.	Specify	whether	each	line	end	with	a	carriage	return	(Macintosh),	a	line	feed	
(Unix),	or	both	(Windows).	You	can	also	specify	a	character	string	to	replace	any	line	endings	
within	a	Field.	This	is	useful	when	you	export,	say,	Notes	Fields	with	multiple	lines/paragraphs.

• Settings.	Once	you've	set	up	the	dialog,	the	Save...	button	allows	you	to	save	the	settings	to	a	File,
which	can	be	later	retrieved	using	the	Load...	button.	This	is	useful	if	you	are	juggling	multiple	
export	formats.

26.2.2 XML
Largely	the	same	as	described	in	Section	26.2.1	on	page	359,	with	some	minor	additional	features.	
Choose	the	XML	option	under	Text	Format.	Some	of	the	items	are	no	longer	applicable	and	are	dis-
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abled	(e.g.	line	endings,	header	line,	etc.).	Export	is	done	to	an	XML	text	File,	using	default	XML	set-
tings	and	styles.		These	can	be	changed	by	clicking	the	XML/JSON	Settings...	button.

Figure	480:	XML	option	in	the	Generic	text	export	dialog

Figure	481:	XML/JSON	Export	Settings	dialog

The	XML/JSON	Settings	are:

• Include	non-default	format	as	an	XML	element	attribute.	If	a	Field	has	a	format	that	is	not	
"Default",	then	this	option	adds	a	"format"	attribute	for	the	element.	e.g.	If	the	ID	File	has	the	
"Number	only"	format,	then	the	Field	will	be	exported	as	<id	format="Number	only">1234</id>.

• Format	XML/JSON	with	line	endings	and	indentation.	If	this	option	is	unchecked,	the	XML	is	
output	without	whitespace	or	line	endings	(which	are	not	relevant	in	XML).	If	it	is	checked	then	
the	XML	will	have	line	endings	and	whitespace	indentation	to	make	the	File	more	human-
readable.
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• Save	Notes	Oields	as	XML	CDATA	sections.	This	option	will	save	the	Notes	Fields	as	CDATA	(a	
sort-of	encoded	format	that	retains	non-ASCII	characters,	line	endings,	etc.).	However,	not	all	ap-
plications	reading	this	data	will	understand	it.

• Replace	line	endings	in	Notes	Oields	with.	If	you	don't	use	CDATA	for	the	Notes	Fields,	you	can	
convert	any	line	endings	into	a	short	string	(otherwise	they	will	be	ignored	or	converted	into	
whitespace).

• Omit	blank	elements.	If	an	element	is	blank,	leave	it	out.	e.g.	if	an	object	has	no	Size	parameter,	
then	normally	this	will	be	added	as	<size></size>.	Checking	this	option	leaves	out	the	empty	ele-
ment	altogether.

• Transform	XML	by	applying	XSLT	or	XPath	stylesheet.	If	you	have	an	XSLT	or	XPath	
stylesheet,	you	can	apply	it	to	the	exported	XML.	Use	the	Browse...	button	to	select	the	File	to	use.

26.2.3 JSON
Largely	the	same	as	XML	export.	See	Section	26.2.2	on	page	360	for	details.	Choose	the	JSON	option	
under	Text	Format.

26.2.4 Excel
Largely	the	same	as	described	in	Section	26.2.1	on	page	359.	Choose	the	Excel	option	under	Text	
Format.

26.2.5 Argo Navis user catalogues
This	exports	objects	from	the	object	list	to	a	text	File	suitable	for	downloading	to	an	Argo	Navis	tele-
scope	controller.

Figure	482:	Argo	Navis		export	dialog

You	can	specify	a	preFix	to	be	added	to	the	exported	object	text	for	reference/sorting	purposes.	In	
addition	to	adding	a	preFix	to	the	exported	objects,	you	can	also	modify	the	source	plan	document	to
match	those	downloaded	objects.	You	specify	which	Field	is	to	be	modiFied	(ID,	Name,	etc.)	and	how	
it	will	be	modiFied.

26.2.6 Autostar tours
You	can	export	the	objects	in	your	object	list	to	a	text	File	in	the	Meade	Autostar	Tour	format.	This	
File	can	then	be	uploaded	to	your	Autostar	controller	via	the	(sadly)	Windows-only	Meade	ASU	
application.

Use	the File	>	Export	>	Autostar	Tour...	menu	command.
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Figure	483:	Autostar	tour	export	dialog

The	Turn	Auto	Slew	on	and	Turn	Auto	Select	on	parameters	are	described	in	the	Autostar	Tour	
creation	manual,	available	from	the	Meade	Instruments	web	site.

The	Use	Autostar	library	references	and	notes	where	possible	setting	will	use	the	built-in	
Autostar	data	where	possible.	If	you	have	an	object	that	should	be	present	in	the	controller	database
(e.g.	M31,	NGC	6177,	etc.)	then	it	will	be	used	instead	of	the	data	in	your	plan	document.

Expand	Bayer/Flamsteed	abbreviations	where	possible	will	convert	abbreviations	such	as	bet	
UMa	to	Beta	Ursa	Major.

The	Autostar	handbox	displays	two	lines	of	text.	Typically	the	top	line	(16	characters)	remains	static,
while	the	bottom	line	scrolls.	The	Static	Title	line	contains	option	deFines	what	is	shown	in	the	top	
line	of	the	handbox	display.	Note	that	this	will	be	truncated	to	16	characters	if	necessary.	The	
Scrolling	Description	line	contains	option	does	the	same	for	the	bottom	line.	e.g.	If	you	are	ob-
serving	double	stars	you	might	want	magnitude	and	separation,	but	not	size.	You	can	reorder	the	
lists	by	dragging	their	entries	if	necessary.

If	you	choose	a	setting	from	“Pick	one”	Lists	then	the	objects	will	be	grouped	according	to	the	cho-
sen	combination.	The	tour	will	then	let	the	user	select	one	from	each	group.	If	the	Include	“None	
available”	message	is	set	then	the	user	will	get	a	message	if	none	of	the	objects	in	a	group	is	visible.

The	Introductory	text	is	displayed	at	the	start	of	a	tour.	Here	is	a	sample	listing	of	a	(very	short)	
generated	File:
/////////////////////////////////////////////////////////////// 
// Tour created: Monday, March 14, 2011 at 10:19:14 
// by: AstroPlanner 
//
// Generated by AstroPlanner 
// http://www.ilangainc.com/astroplanner/ 
// Copyright (c) 2002-11 iLanga, Inc. 
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/////////////////////////////////////////////////////////////// 
TITLE "Autostar tour" 
AUTO SLEW ON 
AUTO SELECT TEXT "M1" "Crab Nebula" 
AUTO SELECT MESSIER 1 
AUTO SELECT MESSIER 2 
AUTO SELECT MESSIER 3 
AUTO SELECT TEXT "M4" "Cat's Eye" 
AUTO SELECT MESSIER 4 
AUTO SLEW OFF 
#END

26.2.7 NexRemote tours
Use	File	>	Export	>	NexRemote	Tour...	is	used	to	export	object	data	into	a	File	suitable	for	importing	
into	the	NexRemote	application	for	controlling	Celestron	telescopes.	You	get	to	select	which	objects	
get	exported.	Note	that	there	is	a	maximum	of	200	objects	in	the	exported	File.

Figure	484:	NexRemote	tour	export	dialog

26.2.8 EQTour observing list
Use	File	>	Export	>	EQTour	Observing	List...	is	used	to	export	object	data	into	a	File	suitable	for	im-
porting	into	the	EQTour	application	for	controlling	ASCOM	telescopes.	You	get	to	select	which	ob-
jects	get	exported.

Figure	485:	EQTour	export	dialog

26.2.9 SkySafari observing lists
Use	File	>	Export	>	SkySafari	Observing	List...	is	used	to	export	object	data	into	a	File	suitable	for	
importing	into	the	SkySafari	planetarium	application	(Mac	and	iOS).	You	get	to	select	which	objects	
get	exported.	Note	that	SkySafari	may	not	import	all	of	the	exported	objects,	since	it	requires	them	
to	match	up	with	its	own	internal	catalogues.
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Figure	486:	SkySafari	observing	list	export	dialog

26.2.10 Observations/Sessions
Use	File	>	Export	>	Observations/Sessions...	to	export	selected	observations	and	sessions	from	the	
observation	database	to	a	File	in	a	format	for	re-importation	into	another	installation	of	AstroPlann-
er.	This	is	useful	for	moving	recent	observation	information	from,	say,	a	Field	laptop	to	an	ofFice	
desktop	computer.	See	Section	26.1.7	on	page	358	for	the	corresponding	importing	information.

Figure	487:	Export	Observations/Sessions	dialog

You	can	choose	to	export	all	sessions/observations	from	the	database,	sessions/observations	made	
since	the	last	export,	sessions/observations	dated	after	a	given	date,	or	sessions/observations	dated
in	a	range.	The	information	will	be	saved	in	a	File	with	a	.obs	extension.

26.2.11 Sky Commander catalogues
The	Sky	Commander	XP4	allows	catalogues	of	objects	to	be	added	to	Firmware	uploads.	Astro-
Planner	can	create	such	catalogues	ready	for	uploading.

The	File	>	Export	>	Sky	Commander	Catalogue...	command	lets	you	Firstly	select	an	AstroPlanner	
catalogue	to	convert.	
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Figure	488:	Selecting	a	catalogue	to	export

Since	many	of	these	catalogues	are	too	large	for	the	Sky	Commander	to	handle,	a	dialog	is	presented	
that	allows	you	to	control	which	objects	from	the	catalogue	are	to	be	included.

You	select	which	object	types,	which	ID	is	to	be	used,	and	possibly	restrict	the	objects	by	RA,	Dec,	
Magnitude,	Separation	(double	stars),	constellation	and/or	Spectral	type	(stars).

You	can	also	specify	that	the	Name	Field	should	be	used	rather	than	ID	(useful	for	double	stars	in	the
WDS,	for	example).

Figure	489:	Sky	Commander	catalogue	export	dialog
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26.2.12 Plan to Sky Commander Catalogue
The	File	>	Export	>	Plan	to	Sky	Commander	Catalogue...	command	will	export	the	current	plan	
document	objects	as	a	Sky	Commander	catalogue.	You	can	select	all	objects	or	just	highlighted	ob-
jects,	and	whether	to	use	the	Name	Field	rather	than	the	ID	Field.

Figure	490:	Plan	to	Sky	Commander	export	dialog

26.2.13 Cartes du Ciel observing lists
Use	File	>	Export	>	Cartes	du	Ciel	Observing	List...	to	export	the	plan	document	contents	to	a	File	
(.txt	extension)	that	can	be	read	by	Cartes	du	Ciel	V3.10	or	later.

26.2.14 Sequence Generator Pro Target List
Use	File	>	Export	>	Sequence	Generator	Pro	Target	List...	to	export	the	plan	document	contents	to	
a	File	that	can	be	read	by	Sequence	Generator	Pro.

26.3 Scripted solutions
It	is	possible	to	write	a	script	to	import	or	export	objects,	observations,	etc.	This	is	covered	in	more	
detail	in	the	Scripting	manual.	You	can	check	the	inventory	of	user-contributed	scripts	and	see	if	a	
script	exists	that	will	do	the	job,	or	that	might	be	modiFied	to	Fit	the	bill.	See	Section	27.2	on	page	
371	for	more	details.
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27 Scripting
Scripting	is	a	method	of	extending	the	capabilities	of	AstroPlanner	using	a	built-in	scripting	lan-
guage	(an	object-oriented	language	similar	to	Visual	Basic).	In	particular	it	is	possible	to	construct	
scripts	to	extend	the	following	application	features:

• General	scripts	that	run	to	perform	a	single	task	(e.g.	import	data,	construct	an	observing	calen-
dar,	etc.).	These	are	the	most	common	types	of	scripts.

• Scripts	that	compute	a	value	for	a	user-deFined	Field.

• Scripts	that	extend	or	complement	the	printing	mechanism	for	printing	object	or	observation	
lists.

• Scripts	that	implement	telescope	drivers.

Writing	a	script	does	require	a	moderate	understanding	of	computer	programming.	However,	those	
folk	with	such	knowledge	can	also	upload	their	scripts	to	an	on-line	repository	that's	available	to	all	
users.	Downloading	and	using	a	user-contributed	script	is	easy,	and	does	not	require	any	program-
ming	ability	(unless	you	want	to	modify	it	for	your	own	uses,	that	is).

The	actual	scripting	language,	the	software	framework	that	allows	you	to	communicate	with	the	ap-
plication,	and	other	details	(all	the	geeky	stuff)	are	contained	in	a	separate	scripting	manual.	The	
rest	of	this	chapter	discusses	how	to	use	the	scripting	system,	not	how	to	program	it.

27.1 Editing and managing scripts
All	(or	most)	script	operations	occur	in	the	Script	menu.	The	menu	is	in	two	parts.	

The	First	part	is	a	list	of	scripts	that	you	have	speciFied	to	appear	in	the	menu	(identiFiable	by	the	
script	icon	on	the	left	of	each	item).	Selecting	any	of	these	scripts	will	execute	the	script	immediate-
ly.	Initially	there	will	be	no	scripts	in	this	menu.

The	second	part	of	the	menu	are	various	script-related	commands.

Figure	491:	Script	menu

Using	the	Script	>	Edit/Run	Scripts...	command	opens	the	script	editor	window.	This	is	where	man-
agement	and	editing	of	scripts	is	done.	On	the	left	side	of	the	window	is	a	list	of	installed	scripts,	se-
lecting	one	of	these	loads	the	script	into	the	editor	on	the	right	side	of	the	window.
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You	can	then	edit	the	script	if	desired,	save	the	changes	using	the	Save	button	(or	File	>	Save),	and	
execute	the	script	using	the	Execute	button	(or	Script	>	Execute).

Figure	492:	Script	editor	window

The	row	of	buttons	underneath	the	script	list	have	the	following	functionality,	from	left	to	right:

• Add	new	script.	Add	a	new	script	to	the	list.	The	submenu	lists	the	various	types	of	script	that	
can	be	created.	The	most	common	being	the	"General"	script.	A	new	script	File	is	created	given	a	
name	you	specify	(which	must	be	unique).

• Delete	selected	script.	Delete	the	selected	script.	This	cannot	be	undone.

• Duplicate	selected	script.	Make	a	duplicate	copy	of	the	selected	script.

• Open	script	preferences.	Open	the	script	preferences	window	(see	Section	20.11	on	page	316)

• Open	a	framework	reference	window.	Open	a	new	Framework	Reference	window	(see	Section
27.5	on	page	374).
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• Download	user-contributed	scripts.	Open	the	user-contributed	script	download	dialog	in	or-
der	to	download	a	script	and	add	it	to	your	inventory	(see	Section	27.2	on	page	371).

• Upload	a	user-contributed	script.	Open	the	user-contributed	script	upload	dialog	and	prepare	
to	upload	the	selected	script	to	the	on-line	inventory	(see	Section	27.7	on	page	377).

You	can	rename	an	existing	script	by	selecting	it	and	clicking	the	Rename...	button.

You	can	examine	and	use	various	included	sample	scripts	(some	of	which	are	mentioned	in	the	
scripting	manual),	by	clicking	the	Samples...	button.	Selecting	a	sample	script	will	copy	it	into	a	new	
script	in	your	list,	which	you	can	then	try,	edit,	etc.

Figure	493:	Renaming	a	script

Figure	494:	Sample	script	dialog

The	Check	for	Errors	button	(and	Script	>	Check	for	Errors)	compiles	and	checks	your	script	for	
syntax	errors	without	actually	running	it.	The	Execute	button	compiles	the	script	if	necessary	(if	
this	is	the	First	time	you	have	used	it,	or	if	you	have	made	changes),	and	executes	it.

There	is	also	a	Script	>	Check	ALL	Scripts	for	Errors	menu	command.	This	will	run	through	all	
scripts	in	your	list	and	check	each	one	for	errors.	Note	that	if	a	script	is	compiled	and	has	syntax	er-
rors,	it	is	designated	by	a	red	dot	in	the	script	list.

- 370 -



Figure	495:	Script	list	showing	script	with	syntax	error

Use	the	Include	in	Script	menu	checkbox	if	you	want	to	include	the	script	at	the	top	of	the	Script	
menu	for	faster	access.	You	can	also	add	a	keyboard	shortcut	to	that	menu	item	for	even	faster	
access.

The	Show	deprecated	methods	checkbox	detects	any	use	of	older	framework	calls	from	Astro-
Planner	V1.x	that	have	been	deprecated	(i.e.	replaced	by	newer	methods).	It	is	recommended	that	
you	replace	any	deprecated	method	calls	by	their	newer	replacements,	since	the	older	code	will	
probably	disappear	in	future	versions	of	the	application.	After	the	script	has	run,	a	window	contain-
ing	a	list	of	deprecated	method	calls	and	the	new	method	to	use,	is	displayed.

The	PreOix	with	script	Field	allows	you	to	preFix	your	script	with	the	contents	of	another	script	File	
before	executing	(allowing	you	to	include	common	libraries,	etc.).	You	can	specify	several	script	pre-
Fix	Files	by	separating	their	names	with	semicolons	(;).

Figure	496:	Deprecated	methods	window

27.2 Downloading a user-contributed script
You	download	a	user-contributed	script	via	the	Script	>	User-Contributed	Scripts	>	Download...	
menu	command,	or	via	the	download	button	underneath	the	script	list	in	the	script	editor	window	
(see	above).	This	feature	is	only	available	if	you	have	an	active	Internet	connection.

The	current	inventory	of	user-contributed	scripts	is	downloaded	from	the	Internet	and	displayed	in	
a	hierarchical	fashion	in	a	dialog.	
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Figure	497:	User-contributed	scripts	download	dialog

The	dialog	displays	the	available	scripts	in	various	ways:

• Most	Recent	10	Scripts.	The	ten	most-recently	uploaded	scripts	are	displayed	First.	These	are	
usually	the	ones	you	will	be	most	interested	in.

Figure	498:	Most	recent	10	scripts

• My	Scripts.	All	of	the	scripts	created	and	uploaded	by	you	(if	applicable)	are	listed	here.
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Figure	499:	My	scripts

• All	Scripts.	Lists	of	all	scripts,	with	subsections	by	Date,	by	Name,	and	By	Author.

Figure	500:	All	scripts

• Printing	Scripts.	All	printing-related	scripts	(if	applicable).

• User	Field	Scripts.	All	user	Field	scripts	(if	applicable).

• Telescope	Control	Scripts.	All	telescope	control	scripts	(if	applicable).

• By	Category.	All	scripts,	by	category.

• By	Keyword.	All	scripts,	by	keyword.

27.3 Deleting user-contributed scripts
Once	you	have	uploaded	a	user-contributed	script,	only	you	can	delete	that	script	from	the	server.	To
delete	one	or	more	of	your	contributed	scripts,	use	Script	>	User-Contributed	Scripts	>	Delete...	Se-
lect	the	script/s	you	want	to	delete	using	the	checkboxes,	and	click	Delete	to	remove	them	(sorry,	no
undo	possible).

- 373 -



Figure	501:	Deleting	user-contributed	scripts

27.4 Running scripts
Running	General	scripts	is	typically	done	by	opening	the	editor	using	Script	>	Edit/Run	Scripts...,	
selecting	the	required	script	in	the	list	and	clicking	Execute.

If	you	are	running	a	script	regularly	you	can	arrange	for	the	script	to	appear	in	the	Script	menu	(See	
page	371)	where	selecting	it	will	start	its	execution.

Note	that	a	plan	document	must	be	open	in	order	to	run	a	script.

27.5 Using the Framework Reference
There	is	a	built-in	feature	that	displays	graphically	the	contents	of	the	AstroPlanner	scripting	frame-
work.	The	scripting	framework	is	a	collection	of	methods,	functions	and	classes	that	can	be	used	
when	writing	your	scripts.	The	framework	reference	is	designed	to	be	used	as	a	convenient	refer-
ence	while	you	are	constructing	scripts	or	trying	to	understand	existing	script	code.

To	open	a	new	Framework	Reference	window	(you	can	open	as	many	as	you	like):

• Use	the	Script	>	Framework	Reference	menu	command.

• Use	the	"F"	button	under	the	script	list	in	the	script	editor	window.

There	is	a	Key	at	the	top	of	the	hierarchical	listing.	This	deFines	the	meaning	of	the	various	coloured	
icons	(Figure	503).

Selecting	an	entry	displays	the	deFinition	of	the	item	in	the	bottom	pane.

You	can	use	the	Find	Field	and	button	to	search	the	framework	for	a	search	string.	The	results	are	
added	to	the	top	of	the	hierarchy	(Figure	504).	You	can	clear	Find	results	by	right-clicking	and	se-
lecting	Clear	Find	results.
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Deprecated	items1	are	not	shown	by	default.	Right-click	and	use	Show	deprecated	items	if	you	
wish	to	see	those	items.

The	Show	changes	for	version...	popup	adds	a	section	showing	what	was	changed	in	the	frame-
work	in	a	particular	version	of	the	application.

Figure	502:	Framework	reference	window

1. A deprecated item is a class, method call, property, etc. that is no longer necessary, or has been replaced by another item. They
are	still	part	of	the	framework	so	that	older	scripts	can	still	function,	but	will	be	dropped	from	the	framework	at	a	future	time.
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Figure	503:	Framework	reference	key

When	the	script	editor	is	open,	double-clicking	an	entry	will	paste	a	"template"	of	the	method	or	
function	into	the	script	editor.

It	is	possible	to	add	your	own	entries	into	the	Framework	reference.	This	is	detailed	in	the	scripting	
manual.

Figure	504:	Find	results

27.6 Script requirements
Normally	a	script	will	run	as	long	as	a	plan	document	window	is	open.	However,	the	script	might	
have	certain	requirements	(e.g.	at	least	one	plan	object,	certain	catalogues,	installed,	etc.).	You	can	
check	for	these	items	in	your	script	programmatically,	e.g.

if Plan().nObjects<=0 then 
Print "Must have at least one object in your plan!"
return

end if

However,	these	is	tedious.	You	can	set	requirements	using	Script	>	Script	Requirements...	with	your
script	selected	in	the	editor.	This	allows	you	to	specify	requirements	for	the	script	to	be	runnable.	
For	example,	in	Figure	505,	the	script	must	have	at	least	2	plan	objects,	all	plan	objects	must	be	dou-
ble	stars,	the	All-Sky	Compiled	Catalogue	must	be	present,	at	least	1	telescope	resource	must	be	
present,	and	V2.0	of	the	AstroPlanner	application	is	required.
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Figure	505:	Script	requirements	dialog

When	you	run	a	script	with	such	restrictions,	and	the	script	does	not	comply	with	a	requirement,	an	
alert	message	is	displayed	and	the	script	is	not	run.

Figure	506:	Script	non-compliance	message

27.7 Uploading a user-contributed script
Uploading	a	(user-contributed)	script	is	done	from	the	script	editor,	using	the	upload	button	under-
neath	the	script	list.	The	currently-selected	script	will	be	uploaded.

The	upload	dialog	is	"pre-populated"	with	data	from	the	script,	as	much	as	possible1.	

1. Create	a	new	script	in	order	to	see	an	example	of	the	use	of	"special"	comments	to	help	populate	the	dialog.
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Figure	507:	Script	upload	dialog

You	can	announce	the	upload	on	the	Yahoo	group	automatically	using	the	checkbox	at	the	lower	left.	
If	you	have	library	or	preFix	scripts	deFined,	you	can	elect	to	have	them	included	in	the	upload.

If	you	already	have	a	script	uploaded	with	the	same	name,	it	will	be	overwritten	by	the	new	upload.	
If	someone	else	has	uploaded	a	script	with	the	same	name,	you	will	not	be	allowed	to	upload.

27.8 Event scripts
You	can	elect	to	run	a	General	script	each	time	a	particular	event	occurs.	To	do	this,	a	plan	document
window	must	be	at	the	front.

Use	Script	>	Event	Scripts...	to	open	the	event	script	dialog.	The	dialog	shows	a	list	of	possible	
events.	Each	event	can	be	enabled	Locally	(i.e.	for	the	current	plan	document	only)	or	Globally	(for	
all	plan	documents).	The	popup	list	in	the	Enabled	column	lets	you	choose.	The	popup	list	in	the	
Script	column	lets	you	choose	one	of	your	installed	scripts.

In	the	example	shown,	when	the	current	plan	document	is	opened	in	the	future,	the	"Add	Sequence	
Number"	script	will	run	(once).	For	all	plan	documents,	just	before	printing,	the	"NSOG	Ratings"	
script	will	be	run.
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Figure	508:	Event	Script	dialog

27.9 Printing scripts
Printing	scripts	are	special	scripts	that	drive	the	printing	process	for	the	object	list	and	observation	
database.	Creating	these	is	detailed	in	the	scripting	manual	(and	is	not	for	the	faint	of	heart).

When	you	print	from	the	object	list	or	observation	database	window,	the	print	dialog	has	a	Printing
script	popup	menu	that	includes	the	Default	printing	script	(built-in)	and	any	other	printing	scripts	
you	might	have	installed.

27.10 Web Services management
The	Web...	button	on	the	script	editor	window	allows	you	to	access	a	remote	or	local	AstroPlanner	
application	running	web	services	(you	can	even	access	this	instance	of	AstroPlanner,	for	testing	pur-
poses,	if	you	have	Web	Services	running.	See	Web	Preferences).	You	can	send	commands	to	the	re-
mote	AstroPlanner	client	in	order	to	manage	it.

You	specify	the	IP	address	and	port	number	of	the	remote	AstroPlanner	client	running	Web	Ser-
vices,	as	well	as	its	authentication	string	where	needed.	Then	you	can	perform	certain	commands	
from	the	various	tabs	on	the	window	(such	as	sending	a	local	script	to	the	remote	client,	retrieving	a
script	from	the	client,	getting	a	list	of	scripts	available	on	the	remote	client,	etc.).
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Figure	509:	Web	services	access
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28 Troubleshooting
This	chapter	covers	strategies	to	use	when	the	application	crashes,	when	you	don't	know	why	some-
thing	has	happened,	or	you	just	wish	that	AstroPlanner	could	do	something	it	doesn't.

28.1 Getting help
This	was	covered	in	Chapter	6	on	page	38.	You	should	use	the	following	resources,	in	order	of	
preference:

• Search	the	user	manual.

• See	if	the	issue	appears	in	the	FAQ.

• Search	on	the	Yahoo	Group	and	see	if	the	issue	has	been	raised.

• Contact	AstroPlanner	support.

28.2 Reporting bugs
The	best	way	to	report	a	bug	is	to	use	the	built-in	bug	reporter1,	Help	>	Report	a	Bug...

Figure	510:	Bug	Report	dialog

Using	this	method	of	reporting	bugs	has	several	advantages:

1. Note	that	this	feature	requires	an	Internet	connection.
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• You	can	do	it	directly	from	the	application.

• The	bug	report	goes	straight	into	the	bug	database	and	is	therefore	more	likely	to	get	resolved.

• There's	a	convenient	way	to	attach	commonly	needed	Files	without	having	to	go	looking	for	
them.

• The	report	will	automatically	include	the	application	version	in	use,	your	platform	OS	informa-
tion,	screen	size,	etc.

Of	course,	if	the	application	will	not	run,	or	it	crashes	before	or	when	(!)	you	use	the	bug	reporting	
feature,	then	you	should	send	an	e-mail	report	of	the	bug	to	support@astroplanner.net.

There	are	some	important	things	to	know	about	reporting	bugs.	Proper	bug	reporting	is	critical	to	
getting	the	application	bug	free	(or	as	near	to	it	as	is	reasonably	possible).

28.2.1 Why report bugs?
Surely	the	person	who	is	developing	the	application	is	aware	of	all	the	bugs?	After	all,	isn't	he/she	
responsible	for	all	the	code?

In	a	perfect	world	this	would	be	the	case.	However,	it's	not	a	perfect	world.	The	application	is	an	ex-
tremely	complex	beast	with	many	parts	that	interact	with	one	another.	The	bugs	often	occur	in	
those	interactions.	For	the	developer	to	be	aware	of	all	bugs,	he	would	have	to	test	every	possible	in-
teraction	with	every	possible	input	data	value,	on	all	platforms,	with	all	operating	systems,	etc.	This	
is	not	feasible.	Hence,	you	will	Find	bugs	that	have	never	been	seen	before.	It's	important	that	the	de-
veloper	is	made	aware	of	those	problems	so	that	they	can	be	Fixed.

28.2.2 What is a bug?
A	bug	can	be	any	of	the	following	(typically	in	descending	order	of	nastiness):

• A	crashing	bug	that	causes	the	application	to	quit	unexpectedly.

• An	unhandled	exception.	These	are	error	conditions	that	are	not	being	handled	by	the	applica-
tion	code,	but	should	be.

• Bad	results	(e.g.	an	altitude	reported	as	95°,	an	RA	of	-2.5	hours,	12	items	reported	deleted	when
only	11	are	in	the	list,	etc.).	These	do	not	cause	a	crash	or	exception,	but	are	nonetheless	
incorrect.

• Unexpected	side-effects.	(e.g.	when	you	open	a	preferences	window	another	window	is	resized,	
etc.)

• Cosmetic	problems	(e.g.	overlapping	text,	controls	that	are	not	redrawn	properly,	incorrect	tab-
bing	order,	spelling	typos,	Flickering	controls,etc.).	These	do	not	affect	the	operation	of	the	appli-
cation,	but	are	annoying	or	irritating.

• Documentation	problems	(e.g.	diagram	in	manual	does	not	correspond	with	the	actual	applica-
tion,	etc.).

28.2.3 When to report bugs
As	soon	as	any	bug	appears,	it	should	be	reported,	unless	you	have	already	done	so	for	the	exact	
same	bug	and	don't	have	anything	different	to	say	about	it.	That	is	the	case	for	any	of	the	above	bug	
types.	Anything	you	consider	an	anomaly	is	probably	a	bug	and	should	be	reported.	Just	because	you
can	work	around	a	bug	does	not	mean	it	is	not	worth	reporting.
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Even	if	you	do	something	completely	outrageous,	like	pasting	the	entire	works	of	Shakespeare	into	
an	object's	Notes	Field,	or	making	20,000	observations	of	NGC1234,	it	should	not	cause	an	exception	
or	any	other	kind	of	bug,	but	should	fail	with	a	suitable	error	message	or	warning.	If	a	bug	does	oc-
cur	-	report	it.

28.2.4 What to include in a bug report
The	quality	of	your	bug	report	is	critical	to	getting	the	bug	Fixed.	A	good	report	should	include	the	
following	(where	applicable):

• The	version	of	the	application	you	are	testing	(e.g.	2.0b53)1.

• The	platform	and	operating	system	you	are	using	(e.g.	Windows	XP	SP3,	Mac	OS	X	10.5.8)1.

• What	you	were	doing	when	the	bug	occurred.	Please	try	and	use	correct	terminology	to	make	
your	description	more	understandable.	(e.g.	Bad:	"the	eyepiece	picture	isn't	always	there"	vs.	
Good:	"The	chart	on	the	Field	of	View	tab	often	doesn't	redraw	properly	when	you	First	select	
that	tab").

• Whether	you	are	able	to	reproduce	to	bug	when	you	tried	a	second	time.	Reproducible	bugs	are	
much	easier	to	Find	and	Fix.

• Any	error	messages	reported.

• Attach	any	error	log	Files	from	your	desktop.

• Attach	screen	shots	(images)	showing	the	bug	occurring,	if	possible.	This	is	really	important	and	
useful	for	the	developer,	especially	if	English	is	not	your	First	language.	Remember	that	"a	picture	
is	worth	a	thousand	words."	I	have	Fixed	many	bugs	almost	instantly	based	on	a	screenshot,	
where	the	user	has	struggled	to	describe	the	problem	adequately	in	words.

• If	you	wish,	you	can	attach	copies	of	the	plan	document	you	were	working	on	when	the	bug	
occurred.

28.3 Feature requests
If	AstroPlanner	does	not	have	a	particular	feature	that	you	feel	would	beneFit	yourself	and	others,	no
matter	how	trivial	or	major,	please	feel	free	to	request	that	it	be	added.	While	doing	this	is	no	guar-
antee	that	it	will	be	implemented	in	the	future,	many	(if	not	the	majority)	of	new	features	in	succes-
sive	releases	of	AstroPlanner	have	been	requested	by	users.

The	probability	of	a	feature	being	implemented	depends	on	several	factors:

• Applicability.	If	the	feature	is	applicable	to	AstroPlanner	(e.g.	better	Finder	charts)	then	it	is	
more	likely	to	be	implemented	than	a	feature	that	is	not	(e.g.	image	acquisition	and	processing).

• Generality.	A	feature	that	is	likely	to	appeal	to	many	users	(e.g.	a	built-in	star	atlas)	is	more	like-
ly	to	get	attention	than	a	feature	that	is	speciFic	to	a	few	users	(e.g.	a	telescope	mount	driver	for	
the	200"	telescope	at	Mt	Palomar).

• Ease	of	implementation.	A	feature	that	can	be	implemented	and	integrated	fairly	easily	(e.g.	a	
new	scripting	command,	a	new	catalogue)	has	a	better	chance	of	seeing	the	light	of	day	than	one	
that	requires	a	lot	of	developer	effort	(e.g.	built-in	3D	planetarium).

1. You	don't	have	to	include	these	if	you	are	using	the	built-in	bug	reporter	-	it	will	include	that	information	automatically.
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• Developer	expertise.	A	feature	that	the	developer	knows	how	to	implement	without	too	much	
research	is	more	like	to	be	implemented	than	one	that	the	developer	would	need	to	spend	a	lot	
of	time	researching.

• Cost.	A	feature	that	has	additional	monetary	cost	associated	with	it	(e.g.	licencing	fees,	software	
libraries,	etc.)	would	not	be	implemented	unless	there	is	a	general	desire	for	it	(and	possibly	an	
increase	in	product	cost	to	offset).

• Popularity.	If	multiple	users	request	the	same	feature,	it	is	more	likely	to	be	implemented	than	
one	requested	by	a	single	user.

All	that	being	said:	feel	free	to	request	any	feature	you	like.	The	request	will	be	added	to	the	data-
base.	There	are	currently	hundreds	of	requests	-	enough	for	many	future	revisions	of	the	
application.

The	best	way	to	File	a	feature	request	is	to	use	the	built-in	request	mechanism1,	Help	>	File	a	Fea-
ture	Request...

Figure	511:	Feature	request	dialog

28.4 Built-in tools
AstroPlanner	has	a	few	built-in	tools	to	help	with	debugging.	Under	normal	circumstances	you	
won't	need	to	use	these,	but	if	you	have	an	issue	they	might	prove	handy	to	have.

1. Note	that	this	feature	requires	an	Internet	connection.
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28.4.1 Where's my stuff?
AstroPlanner	keeps	its	support	Files,	databases,	etc.	is	places	that	are	"approved"	by	the	operating	
system.	Sometimes	these	Files	and	folders	are	difFicult	to	locate.	The	Help	>	Where's	my	Stuff?	
menu	command	tells	you	where	most	of	the	important	Files	are.

If	you	select	an	item	in	the	list,	clicking	the	Reveal	button	will	open	and	show	the	File/folder	in	the	
Finder	(Mac	OS)	or	Windows	Explorer	(Windows).

Figure	512:	Where's	my	stuff?

The	More	info	checkbox	reveals	additional	information	about	the	items	(see	Figure	513).	The	F	col-
umn	speciFies	if	the	item	is	a	folder	(Y)	or	a	File	(N).	The	E	column	speciFies	whether	or	not	the	item	
exists.	The	P	column	shows	the	permissions	(octal)	for	the	item.	The	R	column	speciFies	if	the	item	
is	readable,	the	W	column	speciFies	if	the	item	is	writeable.	The	Owner	column	shows	the	owner	of	
the	folder/File.

Note	that	several	of	these	additional	columns	only	apply	to	Mac	OS.

If	a	particular	item	is	in	a	problematic	state,	it	will	be	coloured	red.
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Figure	513:	Where's	My	Stuff?	with	addition	info	displayed

28.4.2 Tracking threads
AstroPlanner	V2	is	a	multi-threaded	application.	A	thread	is	a	piece	of	code	that	runs	concurrently	
with	the	main	application	(i.e.	runs	in	the	background).	This	is	done	to	make	the	application	more	
responsive	and	to	allow	tedious	processes	to	run	in	the	background	rather	than	making	you	have	to	
go	and	Find	coffee.

If	you	Find	that	the	application	is	running	sluggishly	for	no	apparent	reason,	it	could	be	that	one	of	
more	background	threads	are	causing	the	issue.

The	Help	>	Track	Threads	menu	command	opens	a	window	that	lets	you	see	what	background	
threads	are	running.

Note	that,	if	you	have	a	plan	document	window	open	there	will	always	be	at	least	one	"TimeUp-
dateThread"	and	one	"Visibility	Thread"	running	(even	though	they	spend	most	of	the	time	asleep).

Figure	514:	Tracking	threads

28.4.3 Forcing plan document closure
Sometimes	a	bad	or	corrupted	plan	document	can	cause	the	application	to	crash	or	freeze	when	
starting	up	(since,	by	default,	the	application	tries	to	re-open	any	plan	documents	that	were	open	
when	the	application	last	quit).	You	can	force	the	application	to	ignore	any	previously-open	plan	
documents	when	you	start	up	by	holding	down	the	Ctrl	key	as	you	start	the	application.
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28.4.4 Archiving & resetting preferences
A	fairly	common	problem	that	causes	assorted	issues	happens	when	a	preference	setting	gets	cor-
rupted.	If	you	suspect	that	this	is	the	case,	or	would	like	to	eliminate	this	suspicion,	then	you	can	re-
set	the	preferences	back	to	"factory	settings".

This	is	done	by	restarting	the	application	while	holding	down	the	Shift	key.	This	causes	the	Prefer-
ences	Management	dialog	to	appear.

Figure	515:	Resetting	preferences	-	the	First	time

You	can	choose	to	backup	the	current	preferences	before	resetting	(a	good	idea,	in	case	the	resetting
doesn't	resolve	the	issue	and	you	want	to	revert	back	to	the	old	preferences),	or	you	can	just	reset	
the	preferences	without	making	a	backup	if	you	want	to	live	dangerously.

If	you	backup	the	preferences	and	subsequently	use	this	feature	again,	then	you'll	be	able	to	choose	
to	restore	the	backed-up	preferences.

Figure	516:	Restoring	preferences

The	Re-import	V1	databases	option	will	trigger	the	process	that	imports	your	observation	data-
base,	etc.	from	a	V1	installation	(see	Section	#.#	on	page	#).	This	might	be	useful	if	you	run	V2	for	a	
while	before	deciding	to	move	your	V1	data	across.

28.4.5 Test telescope communication
If	your	telescope	won't	connect,	and	you're	sure	you	have	the	right	cables,	etc.	Then	this	feature	
might	prove	useful	for	debugging	the	connection.

The	details	are	covered	in	Section	13.12.1	on	page	211.
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29 Glossary
This	chapter	deFines	some	terms	you	might	not	be	familiar	with.

Age,	Moon.	The	age	of	the	moon	in	days	from	the	time	of	new	moon.	i.e.	New	Moon	=	0	days,	First	
Quarter	=	7	days,	Full	Moon	=	14	days,	etc.

Air	Mass.	A	number	that	represents	the	thickness	of	the	atmosphere	in	the	direction	of	the	object	
being	observed.	At	the	zenith	it	has	the	value	1.00	and	becomes	larger	as	the	object	nears	the	
horizon.	This	is	of	use	in	determining	atmospheric	extinction.

Alignment,	Mount.	Computerised	telescope	mounts,	when	initialised,	need	to	be	calibrated	with	
the	sky	so	that	the	mount	can	Figure	out	where	it	is	pointing.	This	process	is	called	alignment,	
and	typically	requires	the	user	to	point	the	telescope	at	one	or	more	known	stars.

Alignment,	Polar.	A	telescope	that	is	polar	mounted	must	be	physically	aligned	so	that	its	main	RA	
axis	points	towards	the	north	or	south	pole.	This	is	done	by	using	a	polar	alignment	scope,	or	
various	other	alignment	techniques	designed	to	minimise	the	error.

Alignment	Stars.	Computerised	telescopes	generally	have	a	Fixed	set	of	bright	stars	that	their	soft-
ware	can	choose	to	align	the	mount.

Alt/Az.	This	usually	refers	to	a	telescope	that	is	mounted	so	that	its	main	axis	points	towards	the	
zenith	point	and	the	other	axis	is	parallel	with	the	horizon.

Altitude.	The	angle	of	an	object	above	the	horizon.	An	object	on	the	horizon	would	be	at	0°	altitude	
and	an	object	at	the	zenith	point	would	be	at	90°	altitude.	Note:	in	AstroPlanner	there	is	also	an
altitude	setting	associated	with	Site	resources	-	in	this	case	altitude	refers	to	the	distance	in	me-
tres	above	sea	level.

Aperture.	The	diameter	of	the	main	mirror	or	main	lens	of	a	telescope.	Typically	measured	in	mm	
or	inches.	The	larger	the	aperture	of	a	telescope,	the	more	light	is	collected	(allowing	dimmer	
objects	to	be	seen)	and	the	greater	the	resolution	(objects	close	together	can	be	differentiated).

Apparent	Magnitude.	The	magnitude	of	an	object	is	speciFied	as	if	it	was	at	the	zenith	(air	mass	=	
1).	The	apparent	magnitude	takes	into	account	atmospheric	extinction	as	the	object	is	ob-
served	close	to	the	horizon	(the	object	appears	to	get	dimmer	as	it	approaches	the	horizon).

Arcminute.	An	angular	measure.	One	arcminute	=	1/60	degree	=	60	arcseconds

Arcsecond.	An	angular	measure.	One	arcsecond	=	1/60	arcminute	=	1/3600	degree.

ASCOM.	(AStronomy	Common	Object	Model)	is	a	group	that	supplies	an	open-source	software	prod-
uct	that	provides	a	generic	method	of	driving	telescope	mounts.	Currently	Windows-only.	http:/
/ascom-standards.org/

Asterism.	A	collection	of	stars	that	forms	a	pattern,	but	the	stars	that	it	is	composed	of	are	other-
wise	unrelated	(e.g.	the	Big	Dipper	in	the	constellation	Ursa	Major,	or	Orion's	Belt	in	the	con-
stellation	Orion).

Asteroid.	See	Minor	Planet.
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Astrometric.	Refers	to	the	exact	measurement	of	star	positions,	and	sometimes	the	measurement	of
double	star	separation	and	position	angle.

Atmospheric	Extinction.	The	dimming	of	light	by	its	passing	through	the	atmosphere.	At	the	zenith
the	extinction	is	minimum,	and	increases	as	you	approach	the	horizon.

Atmospheric	Refraction.	The	atmosphere	acts	as	a	lens,	especially	near	the	horizon,	and	can	bend	
incoming	light.	This	leads	to	the	apparent	altitude	of	objects	near	the	horizon	being	greater	
than	expected,	and	objects	appear	to	rise	above	the	horizon	before	they	physically	do	so.

Azimuth.	The	horizontal	angle	of	an	object	with	respect	to	true	north.	This	is	usually	measured	
through	east.	i.e.	North	=	0°	azimuth,	East	=	90°,	South	=	180°,	West	=	270°.

Barlow	Lens.	A	lens	that	is	used	between	an	eyepiece	and	a	telescope	to	increase	the	effective	focal	
length	of	the	telescope.	e.g.	if	you	use	a	2X	Barlow	with	a	2000mm	focal	length	telescope,	it	ef-
fectively	turns	the	telescope	into	a	4000mm	focal	length	telescope.	

Best	Pair.	An	algorithm	(developed	by	Jim	Burrows)	speciFically	to	choose	the	best	alignment	stars
for	a	Meade	LX200	Classic	telescope	on	an	alt/az	mount.	Although	the	algorithm	was	designed	
around	the	shortcomings	of	the	LX200	Classic	mount,	many	have	found	it	works	well	with	other
alt-az-mounted	telescopes.

Binocular.	In	AstroPlanner	this	refers	to	a	binocular	or	monocular	device,	and	not	a	device	that	al-
lows	two	eyepieces	to	be	used	on	a	telescope.	Binoculars	are	typically	deFined	with	the	magni-
Oication	and	aperture	(in	mm)	of	the	optical	system	(e.g.	10x70	binoculars	have	a	magniFica-
tion	of	10X	and	a	main	objective	lens	70mm	in	diameter).

Bolide.	A	very	large	meteor	that	typically	leaves	a	long	and	bright	trail	that	takes	several	seconds	or
more	to	dissipate.

Bright	Star	Catalogue.	The	Yale	Bright	Star	Catalogue	is	a	catalogue	containing	several	thousand	of
the	brightest	stars	in	the	sky.	It	is	used	as	a	base	catalogue	by	AstroPlanner	for	many	different	
purposes	(e.g.	the	Sky	chart,	etc.).

Cardinal	Points.	The	directions	of	the	N-S-E-W	points.	e.g.	the	North	cardinal	point	is	the	direction	
of	the	north	pole,	etc.

Catalogue.	A	collection	of	related	astronomical	objects,	usually	observed	and	published	by	profes-
sional	astronomers.	Probably	the	most	famous	(and	oldest)	is	the	Messier	catalogue.

Celestial	Equator.	An	imaginary	line	on	the	celestial	sphere	that	is	equidistant	from	the	north	and	
south	celestial	poles.	It	is	the	line	in	equatorial	coordinates	with	Declination	=	0°.

Celestial	Poles.	The	points	at	which	the	earth's	rotational	axis	intersects	the	celestial	sphere.

Cluster,	Open.	A	cluster	of	randomly	distributed	stars	that	are	associated	(i.e.	they	are	at	a	similar	
distance	from	the	sun,	typically	share	similar	properties	and	typically	have	similar	proper	
motions).

Cluster,	Globular.	A	cluster	of	associated	stars	that	are	collected	in	a	spherical	or	globular	shape	by	
gravity.

Comet.	An	icy	body	in	the	solar	system	that	forms	a	tail	as	it	approaches	the	sun.	These	may	pass	by	
the	sun	once	only,	or	may	be	periodic	(e.g.	Halley's	comet).

Constellation.	A	collection	of	bright	stars	that	cover	a	region	of	the	sky	and	purport	to	form	mythi-
cal	and	other	Figures	(e.g.	Orion	the	Hunter,	Ursa	Major	the	Great	Bear,	etc.).	The	boundaries	of	
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the	constellations	are	accurately	deFined	and	any	object	that	falls	within	that	boundary	is	part	
of	the	constellation	(e.g.	the	star	Sirius	is	in	the	constellation	of	Canis	Major).

Dec.	See	Declination.

Declination.	One	of	the	two	coordinates	(together	with	Right	Ascension)	used	to	specify	the	posi-
tion	of	an	astronomical	object.	It	is	the	angular	distance	north	or	south	of	the	celestial	equator	
measured	in	degrees.	The	north	celestial	pole	has	Declination	+90°	and	the	south	celestial	pole	
has	Declination	-90°.	It	is	similar	to	latitude	on	the	Earth.

Deep	Sky	object	(DSO).	Generally	this	is	any	astronomical	object	outside	the	solar	system.	In	Astro-
Planner	this	generally	means	any	non-stellar	object	outside	the	solar	system.	AstroPlanner	
does	not	consider	stars	to	be	DSOs.

DifOiculty	Index.	A	computed	measure	for	double	stars,	dependent	on	their	separation	and	relative	
magnitude,	that	gives	an	indication	of	how	difFicult	it	would	be	to	"split"	the	double	in	a	
telescope.

Digital	Setting	Circles	(DSC).	A	computerised	mount	that	only	reports	the	pointing	coordinates	of	
the	telescope.	i.e.	does	not	have	a	motorised	go-to	feature.	Also	known	as	"push-to"	telescope	
mounts.

Digital	Sky	Survey	(DSS).	A	photographic	survey	of	the	entire	sky	done	at	the	Palomar	Observatory.
Two	such	surveys	were	done,	the	1st	generation	survey	was	done	at	a	much	lower	resolution	
than	the	2nd	generation	survey.	Both	surveys	were	done	through	red	and	blue	Lilters.

Ecliptic.	The	plane	of	the	earth's	orbit	around	the	sun,	projected	onto	the	celestial	sphere.	It	is	tilted	
at	about	23°	with	respect	to	the	celestial	equator.	The	planets	and	the	moon	all	revolve	in	pret-
ty	much	the	same	orbit.

Epoch.	The	earth,	as	it	rotates,	acts	like	a	spinning	top	or	gyroscope,	and	its	axis	slowly	traces	a	path
through	the	heavens.	This	means	that	the	north	and	south	celestial	poles	are	constantly	
moving	with	respect	to	the	celestial	sphere.	This	means	that	the	equatorial	coordinates	of	ob-
jects	are	also	changing	with	time.	Because	of	this,	one	needs	to	know	the	epoch	or	date	and	
time	that	the	coordinates	were	measured.	To	avoid	confusion,	certain	standard	epochs	are	used.
Epoch	B1950.0	concerns	coordinates	(effectively)	measured	on	1/1/1950.	AstroPlanner,	and	
most	other	astronomical	software	assumes	coordinates	are	for	Epoch	J2000.0	(1/1/2000).	As-
troPlanner	has	features	to	convert	coordinates	between	coordinate	epochs.

Equatorial	Coordinates.	The	Right	Ascension	and	Declination	of	an	object.	This	is	a	Fixed	position	
with	respect	to	the	celestial	sphere.

Equatorial	Grid.	A	grid	of	lines	imposed	on	the	celestial	sphere	showing	lines	of	intersection	of	RA	
and	Dec.	The	lines	of	RA	intersect	at	the	celestial	poles	(a	la	geographical	longitude	lines),	and	
the	lines	of	Dec	are	parallel	(a	la	geographical	latitude	lines).

Field	of	View.	What	you	see	when	you	look	through	an	optical	instrument.	It	can	also	refer	to	the	
angular	diameter	of	that	Field	of	view.

Field	of	View,	Apparent.	This	is	a	property	of	an	eyepiece	and	refers	to	the	apparent	angular	size	of
the	view	through	the	eyepiece.	e.g.	Televue	Nagler	eyepieces	have	an	apparent	Field	of	view	of	
82°.

Field	of	View,	Actual.	When	you	attach	an	eyepiece	to	a	telescope	the	actual	Field	of	view	is	the	ap-
parent	Lield	of	view	of	the	eyepiece	divided	by	the	magniFication	of	the	system.
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Filter.	A	transparent	or	partially	transparent	Film	of	a	particular	colour	that	is	placed	in	the	optical	
path	of	a	telescope	in	order	to	emphasise	aspects	of	the	object	being	observed.

Focal	Length.	The	distance	between	the	main	lens	or	mirror	of	a	telescope	or	eyepiece	and	the	
point	at	which	it	focusses	light.

Focal	Ratio.	The	ratio	of	the	aperture	of	a	telescope	and	its	focal	length.	Usually	designated	f/xxx,	
where	xxx	is	the	ratio.	e.g.	a	telescope	of	aperture	200mm	and	focal	length	2000mm	will	have	a	
focal	ratio	of	f/10.

Focal	Reducer.	An	optical	device	that,	when	placed	in	the	optical	path	of	a	telescope,	effectively	
reduces	the	focal	length	of	the	telescope.

Galactic	Equator.	An	imaginary	line	(great	circle)	that	(attempts	to)	bisect	our	own	galaxy	(the	
Milky	Way)

Galaxy.	A	distant	collection	of	(typically)	billions	of	stars	that	form	"island	universes"	like	our	own	
Milky	Way.	They	come	in	various	Flavours:	elliptical,	spiral,	etc.

GMT	Offset.	The	number	of	hours	local	time	is	ahead	(+ve)	or	behind	(-ve)	Greenwich	Mean	
Time.

Greenwich	Mean	Sidereal	Time	(GMST).	The	current	(local)	sidereal	time	at	Greenwich	(longi-
tude	=	0°).	Daylight	saving	time	is	not	considered.

Greenwich	Mean	Time	(GMT).	The	standard	time	at	Greenwich	(longitude	=	0°).	Daylight	saving	
time	is	not	considered.

Heliocentric	Julian	Date	(HJD).	The	Julian	date	is	geocentric	(i.e.	measured	w.r.t	the	earth).	Since	
the	earth	revolves	around	the	sun,	the	distance	to	an	astronomical	object	differs	by	up	to	16	
minutes	(light	travel	time).	For	this	reason,	when	measuring	actual	event	times	the	HJD	is	
measured	w.r.t.	the	sun	and	hence	offers	an	event	time	that	is	independent	of	where	the	earth	is
in	its	orbit.

Horizon.	This	typically	refers	to	any	point	on	the	celestial	sphere	where	the	observer	is	looking	ex-
actly	horizontally	(altitude	=	0°).

Hour	Angle.	The	difference	between	the	RA	of	an	object	and	the	RA	of	the	meridian	(or	any	point	
on	the	meridian).

Illumination,	Moon.	The	percentage	of	the	visible	moon's	surface	that	is	illuminated	by	the	sun.	
Varies	between	0%	(new	moon)	and	100%	(full	moon).

Imager.	A	digital	camera	used	for	astro-imaging.

Julian	Date.	A	number	representing	the	number	of	days	(and	fractions	of	a	day)	since	January	1,	
4713	BCE,	at	Greenwich.	This	is	often	used	as	a	standard	way	to	represent	date/time	universal-
ly	(see,	however,	Heliocentric	Julian	Date)

Light	Dome.	A	dome	of	light	thrown	onto	the	night	sky	by	a	distance	city	or	other	bright	light	
source.

Local	Time.	The	local	clock	time	at	your	site.	It	will	differ	from	GMT	by	the	GMT	offset,	and	might	
be	further	modiFied	by	daylight	saving	time	rules.

Local	Sidereal	Time.	See	Sidereal	Time.
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Log	Object	Contrast.	A	measure	of	the	contrast	of	a	deep-sky	object	against	the	background	sky.

Lord's	Rating.	This	is	a	measure	applicable	only	to	double	star	objects	and	is	based	on	the	work	of	
Christopher	Lord	(see	the	article	"Enjoying	Unequal	Double	Stars"	in	Sky	and	Telescope,	Jan	
2002,	Page	118-121).	The	value	is	based	on	telescope	aperture,	central	obstruction	(if	any)	and
seeing	conditions.	The	ratings	are:	"F"	=	one	or	both	stars	are	too	faint	to	see	through	the	se-
lected	telescope,	"UN"	=	double	is	unresolvable,	"XD"	=	exceedingly	difFicult,	"ED"	=	extremely	
difFicult,	"VD"	=	very	difFicult,	"D"	=	difFicult,	"MD"	=	moderately	difFicult,	"ND"	=	not	difFicult,	
"E"	=	easy.

Magnitude.	A	number	associated	with	an	astronomical	object	that	indicates	its	relative	brightness	
w.r.t.	other	objects.	The	magnitude	used	in	AstroPlanner	is	usually	assumed	to	be	a	visual	mag-
nitude	(as	opposed	to	a	photographic	magnitude,	which	depends	on	Filters,	etc.).

Meridian.	An	imaginary	line	(of	RA)	that	passes	through	the	north	and	south	celestial	poles	and	the
zenith	point.

Messier	Catalogue.	A	catalogue	of	110	"fuzzy	blobs"	that	Messier	catalogued	to	avoid	them	being	
mistaken	for	comets.	They	consist	of	open	and	globular	clusters,	bright	galaxies,	planetary	neb-
ulae,	etc.

Meteor	Show	Radiant.	Meteors	appear	either	sporadically	(randomly)	or	as	a	shower.	Such	show-
ers	appear	to	arrive	from	a	point	in	the	sky,	radiating	outwards.	The	shower	radiants	are	typi-
cally	named	for	the	constellation	from	whence	they	"radiate".	e.g.	Leonids,	Capricornids,	Persei-
ds,	etc.

Milky	Way.	Our	home	galaxy.	Appears	(in	a	dark	sky)	as	a	bright	glow	circling	the	sky.

Minor	Planet,	Asteroid.		A	rocky	object	orbiting	the	sun	that	is	not	otherwise	considered	a	planet	
(e.g.	Vesta)

Naked	Eye	Limiting	Magnitude	(NELM).	The	limiting	magnitude	of	a	star	(i.e.	the	dimmest	visible	
star)	as	seen	by	the	naked	eye.	Depends	on	light	pollution,	visual	accuity,	etc.

Observability.	This	is	a	computed	value	that	runs	from	0	(object	is	below	the	horizon)	to	100	(ab-
solute	best	for	observing	the	object,	no	moon,	near	the	meridian,	dark	sky,	etc.).	This	doesn’t	
mean	that	you	will	be	able	to	observe	the	object	(your	telescope	might	not	be	up	to	the	task	for	
dim	objects,	or	be	able	to	split	double	stars,	etc.).	It	just	means	that	the	higher	the	value,	the	
better	chance	you	have	of	observing	or	imaging	the	object.

Optical	Aid.	AstroPlanner	terminology:	any	optical	device	used	with	a	telescope	that	changes	the	ef-
fective	focal	length	of	the	telescope	(e.g.	a	Barlow	lens,	focal	reducer,	etc.)

Optimum	Detection	MagniOication	(ODM).	A	computed	magniFication	required	to	detect	a	diffuse	
DSO	in	a	telescope.	Depends	on	the	telescope	aperture,	the	surface	brightness	of	the	DSO	in	
question,	and	the	brightness	of	the	background	sky.

OTA.	Optical	Tube	Assembly.	The	part	of	the	telescope	containing	the	optics	(i.e.	not	the	mount	or	
tripod).

Period.	Usually	refers	the	period	over	which	a	variable	star	pulsates.

Phase,	Moon.	The	relative	stage	of	illumination	of	the	moon.	e.g.	full,	new,	crescent,	gibbous,	etc.

Planet.	Major	solar	system	bodies	that	revolve	in	orbit	around	the	sun.	AstroPlanner	still	thinks	that
Pluto	is	a	planet.
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Polar.	With	reference	to	the	celestial	poles.

Position	Angle,	Pos.	Angle.	The	angle	that	the	major	axis	of	a	galaxy	makes	w.r.t.	the	north	celes-
tial	pole.	Also	the	angle	that	the	secondary	star	of	a	double	star	system	makes	with	the	primary
star	(w.r.t.	the	north	celestial	pole).

Proper	Motion.	The	actual	motion	of	a	star	against	the	celestial	sphere.	This	is	typically	very	small	
and	can	be	ignored.	However	some	closer	stars	move	several	arcseconds	per	year.

RA,	R.A.	See	Right	Ascension.

Resolution.	The	amount	of	detail	one	can	see	through	a	telescope.	This	is	usually	proportional	to	
the	aperture	of	the	telescope.

Reticle,	Reticule.	Cross	hairs,	or	scales	etched	onto	glass,	at	the	focus	of	an	eyepiece.	Sometimes	il-
luminated	to	make	them	show	up	against	a	dark	sky.

Rigel	QuickOinder.	A	unit	magniFication	(i.e.	1x	magniFication)	device	like	a	gun	site	that	effectively	
projects	circular	lines	onto	the	sky.

Right	Ascension.	One	of	the	two	coordinates	(together	with	Declination)	used	to	specify	the	posi-
tion	of	an	astronomical	object.	It	is	the	angular	distance	along	the	celestial	equator	measured	
from	the	vernal	equinox.	It	is	usually	measured	in	hours	(where	1	hour	=	15°).	It	is	similar	to	
longitude	on	the	Earth.

Rising	Time.	The	time	at	which	an	object	rises	above	the	horizon.

Seeing.	A	measure	of	the	stability	of	atmosphere	for	observing.	Bad	seeing	implies	the	atmosphere	
is	causing	images	to	be	blurred	and	in	constant	motion.	Good	seeing	implies	steady	and	un-
blurred	images.

Separation.	The	angular	distance	between	the	stars	in	a	double	(or	multiple)	star	system.	Typically	
measured	in	arcseconds.

Setting	Time.	The	time	at	which	an	object	falls	below	the	horizon.

Sidereal.	Refers	to	the	rotation	rate	of	the	earth	(23	hours	56	minutes	per	rotation,	give	or	take.	It	is
the	time	between	transits	of	the	same	star	on	two	successive	nights).

Sidereal	Time.	A	system	of	time	based	on	the	hour	angle	of	the	vernal	equinox	(i.e.	RA=0,	Dec=0).

Site	Horizon.	In	AstroPlanner	this	refers	to	a	user-deFined	horizon	(i.e.	objects	blocking	the	real	
horizon	such	as	trees,	buildings,	etc.).

Size,	Angular.	The	angular	size	of	an	object	in	the	sky.	Usually	measured	in	arcminutes,	it	is	of	the	
form	AxB,	where	A	is	the	longer	dimension,	and	B	the	shorter.

Sloan	Digital	Sky	Survey	(SDSS).	A	colour	photographic	survey	of	the	sky.	It	only	covers	part	of	the	
sky.

Solar	System	object.	Any	object	in	the	solar	system	(i.e.	the	sun,	the	planets	and	their	moons,	minor
planets	and	comets).

Spectral	(Class).	The	class	into	which	the	object	falls,	based	on	its	measured	spectrum.

Surface	Brightness.	The	overall	brightness	of	a	diffuse	object	measured	in	magnitudes	per	square	
arcsecond.	Objects	with	low	surface	brightness	are	more	difFicult	to	see,	especially	if	there	is	
light	pollution.
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Stellar	object.	A	star	(apart	from	the	sun).

Telrad.	A	unit	magniFication	(i.e.	1x	magniFication)	device	like	a	gun	site	that	effectively	projects	cir-
cular	lines	onto	the	sky.

Transit.	When	an	object	reaches	its	highest	altitude	in	the	sky	during	the	passage	of	a	day.

Transit	Altitude.	The	highest	altitude	achieved	by	an	object	as	it	transits.	This	depends	directly	on	
the	object's	declination	and	the	site's	latitude.

Transit	Time.	The	time	at	which	an	object	transits.

Transparency.	A	measure	of	the	clarity	of	the	atmosphere.

Twilight.	The	period	between	sunset	and	total	darkness,	and	again	before	the	sun	rises.	When	the	
sun's	altitude	is	between	0°	and	-6°,	this	is	known	as	Civil	twilight.	When	the	sun's	altitude	is	
between	-6°	and	-12°,	this	is	known	as	Nautical	twilight.	When	the	sun's	altitude	is	between	
-12°	and	-18°,	this	is	known	as	Astronomical	twilight.	When	the	sun's	altitude	is	below	-18°,	it	is
considered	to	be	astronomically	dark.

Universal	Time	(UT).	See	Greenwich	Mean	Time.

Vernal	Equinox.	The	point	where	the	ecliptic	crosses	the	celestial	equator.

Zenith.	The	point	immediately	above	the	observer's	head.	equidistant	from	all	points	on	the	hori-
zon.	It	has,	by	deFinition,	altitude	=	90°.
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30 Revision Notes
30.1 V2.0.1
V2.0.1	includes	many	Fixes	to	problems	in	V2.0.	They	are	not	listed	here.	You	can	use	Help	>	Revi-
sion	Notes	to	see	details	of	bug	Fixes	and	enhancements.	

Note	that	there	might	be	slight	changes	in	the	illustrations	(the	V2.0	manual	was	illustrated	using	
screen	shots	from	Mac	OS	X	10.6,	while	the	V2.0.1	changes	were	illustrated	using	screen	shots	from	
Mac	OS	X	10.7).

The	following	list	enumerates	all	non-trivial	changes	and	improvements	between	V2.0	and	V2.0.1,	
and	where	you	can	Find	them	in	this	manual.
• You can now print catalogue Annotations for observations (assuming the observation has a valid ID).

The Annotations entry is included in the Observation fields list. See page 242.

• The Field of View chart now has a Display Option: Display > Show constellation sub-chart. This
places a small chart of the constellation where the chart is centred at the bottom right of the main chart.
See page 128.

• The Field of View chart now has a Display Option: Display > Show Date/Time if date Lixed. If this
option is on and the date is fixed, then the date/time is shown at the bottom of the main chart as a
warning. See page 128.

• The Field of View chart now has a Display Option: Display > Current telescope position. This allows
the telescope position to be turned off. See page 127.

• The Field of View chart now has a Display Option: Display > Plan object at chart centre only. If this
option is on then any plan objects that are in the field of view, but not at the centre coordinates of the
field of view, will not be displayed. See page 128.

• A Visibility graphic is displayed that shows the altitude and azimuth of an observed object at the
time of an observation. This is present on the Observations tab of the plan document window (see page
117), and also in the Observation database window (see page 185).

• The Lord's Rating settings in the Object List Preferences have been removed, since they were mainly
used for debugging, and interest only to one user (possibly).

• The Object List preferences now has a setting to display alert badges next to objects if they are close to
bright objects (sun, moon, etc.). See page 296.

• You can now import SkySafari observing lists. See page 358.

• Up and Down buttons on Field of View and Sky charts. Up/down buttons to the right of the field of view
chart (see page 140) and sky chart (see page 158) allow you to navigate through the objects in the object
list without needing to swap between tabs.

• The list of catalogues in the Catalogue Manager window now has a S column (signifying that the cata-
logue contains spectral info) and a P column (signifying that the catalogue contains proper motion info).
See page 327.

• The Catalogue Manager window now includes a Plan Creation Wizard tab that summarises which cata-
logues are contributing to the Plan Creation Wizard's database, and allowing others to be installed where
necessary. See page 331.
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• Added a Catalogue preference to transfer other field information (e.g. proper motion) to plan objects.
See page 308.

• Load... and Save... buttons added to the user-defined field editor so that sets of definitions can be trans-
ferred. See page 278.

• Load... and Save... buttons added to the custom highlighting editor so that sets of highlighting scenarios
can be transferred between plan documents. See page 274.

• Changed the Observer resource to use Year of Birth instead of Age (which requires updating annually).
See page 71.

• Image preferences now has a way to recreate the image index/cache file if there is an issue with missing
or mismatched images. See page 315.

• Double-clicking the Constellation indicator in the Objects tab causes the application to switch to
the	Field	of	View	tab	and	draw	the	entire	constellation	in	the	Field	of	View	chart. See page 110.

• Generic text export now includes session info when exporting object and observation data. See page
359.

• You can choose XON/XOFF and/or Data Terminal Ready (DTR) Flow control if your telescope
mount	demands	it. See page 199.

• If your site defines a user horizon, it will be displayed in the telescope mimic window. See page 198.

• You can search for multiple IDs using the "..." range notation. See page 160.

• The Obs column in the object list has been changed: if one or more observations were made from the
current plan document, the number is circled. If any of those observations were made in the past 12
hours, the circle is inverted. See page 95.

• The fix date preset options popup menu now contains Date of Next Full Moon and Date of Next New
Moon. See page 94.

• Plan document window title now contains the number of highlighted objects (in addition to the total
number and number selected).

• In the search results window, you can right-click an object row and use the Find Synonyms command
(or alternately, use the Object	>	Search	>	Find	Synonyms menu command).

• The Where's My Stuff? window now has the ability to show additional info. See page 385.

30.2 V2.1
V2.1	includes	many	Fixes	to	problems	in	V2.0	and	V2.0.1.	They	are	not	listed	here.	You	can	use	Help	>
Revision	Notes	to	see	details	of	bug	Fixes	and	enhancements.	

Note	that	there	might	be	slight	changes	in	the	illustrations	(the	V2.0.1	manual	was	illustrated	using	
screen	shots	from	Mac	OS	X	10.6	and	Mac	OS	X	10.7,	while	the	V2.1	changes	were	illustrated	using	
screen	shots	from	Mac	OS	X	10.8).

The	following	list	enumerates	all	non-trivial	changes	and	improvements	between	V2.0.1	and	V2.1,	
and	where	you	can	Find	them	in	this	manual.

• The	Field	of	View	chart	Display	Options	now	have	entries	to	turn	On/Off	the	display	of	solar	sys-
tem	objects.	See	page	137.	Note:	these	options	also	appear	for	the	Finder	Charts	printing	feature.
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• Observability.	Introduced	the	concept	of	observability	(see	page	392).	This	is	available	as	an	ob-
ject	list	column	(see	page	101),	and	on	the	short-term	visibility	indicator	(see	page	106).	Also	
available	as	an	object	list	column	is	the	Best	Time	(which	is	the	time	of	the	highest	observability	
in	the	next	24	hours)	(see	page	97).

• Added	a	section	to	the	manual	that	describes	each	available	object	list	column	value	(see	page	97).

• Added	an	Example	button	to	the	Image	Preferences	window	to	help	get	an	idea	what	the	effects	of
saving	images	at	different	qualities	would	be	(see	page	314).

• Added	the	ability	to	import	plan	objects	(page	358)	from	and	export	plan	objects	(page	364)	to	a	
File	in	EQTour	format.

• Constellations	are	now	valid	object	types,	with	Type	=	Const,	and	ID	=	the	constellation	abbrevia-
tion.	You	can	add	them	using	the	"+"	button	under	the	object	list	(see	page	75),	or	use	the	Add	
Special	popup	(see	page	82).

• Perform	a	global	search	for	plan	documents	containing	a	given	search	term	(see	page	164).

• If	you	use	the	Plan	Creation	Wizard	to	choose	objects	by	constellation,	you	can	now	limit	the	con-
stellations	to	those	visible	or	partially	visible	at	a	site,	possibly	at	a	given	date/time	(see	Figure	
Figure	112	on	page	86).

• Added	Computer	Time,	Computer	Date,	and	Local	-	Computer	entries	to	the	"LED"	displays	(see
page	91).

• Outgoing	e-mail	settings	now	allows	for	SSL/TLS.	Also	added	a	GMail	button	to	make	the	settings	
easy	(see	page	290).

• Added	a	Parallactic	Angle	column	to	the	object	list	(see	page	101).

• Added	a	Plan	Creation	Wizard	Level	column	to	the	object	list	(see	page	100).

• The	catalogue	manager	now	has	a	right-click	menu	that	allows	you	to	select	all	catalogues	that	are	
uninstalled,	deprecated,	etc.	Additionally	you	can	Find	catalogues	that	contain	speciFic	ID	preFixes	
and	install	them	where	necessary	(see	page	328).

• Deprecated	items	in	the	scripting	framework	window	are	now	hidden	by	default.	They	can	be	
made	visible	again	by	right-clicking	(see	page	375).

• Hovering	the	cursor	over	the	sun/moon	widgets	on	the	plan	document	window	shows	additional	
information	(see	page	93).

• Handle	the	UCAC4	external	catalogue	(see	page	304).

• The	telescope	tracking	can	be	toggled	on/off	via	Telescope	>	Toggle	Tracking,	where	applicable	
(only	some	computerised	mounts	can	do	this)	(see	page	204).

• Quick	observation	logging.	A	fast	method	of	logging	that	an	observation	was	made,	without	mess-
ing	with	notes,	dates,	etc	(see	page	180).

• Native	driver	support	for	Gemini	mount	controller.

• After	slewing,	a	text	caption	under	the	Slew	button	reports	the	ID	of	the	last	object	slewed	to.

• Added	object	list	columns	for	Ecliptic	Latitude	and	Ecliptic	Longitude,	and	Galactic	Latitude	
and	Galactic	Longitude	(see	page	99).
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• Added	columns	for	ecliptic	latitude	and	longitude	to	the	comet	and	minor	planet	selection	dialogs,	
and	allow	restrictions	based	on	those	values	(see	page	339,	for	example).

• Added	an	option	to	Catalogue	Preferences:	Include	objects	with	no	magnitude	in	magnitude-
range	searches.	If	this	is	set,	then	searching	using	a	magnitude	range	will	include	catalogue	ob-
jects	with	no	speciFied	magnitude	(see	page	307).

• Added	an	option	to	Catalogue	Preferences:	Ignore	objects	with	no	coordinates	(RA	=	Dec	=	0).	
If	this	is	set,	then	any	searches	will	ignore	such	objects	(see	page	307).

• The	Wiki	has	been	discontinued	and	removed	from	the	Help	menu.

• When	you	lookup	a	DSO,	you	can	also	search	on	common	names.

• Added	Chart	#	support	for	the	recent	one-volume	Uranometria	atlas.

• Previously,	the	At	Site	option	for	non-Site	resources	in	the	Resources	window	allowed	you	to	spec-
ify	that	a	resource	was	located	at	a	particular	Site.	That	is	now	extended	to	a	resource	being	avail-
able	at	multiple	sites	(see	page	51).

• Off-axis	guider	support.	Custom	reticles	have	been	modiFied	to	allow	for	off-axis	guiders.	i.e.	(a)	
custom	Round	reticles	now	have	an	(optional)	offset,	and	(b)	for	Round	or	Rectangular	reticles	you
can	now	give	the	units	in	degrees,	%	of	the	FoV	diameter,	or	%	of	the	FoV	radius.	This	will	allow	
you	to	deFine	a	custom	reticle,	with	an	offset,	that	remains	in	constant	proportion	to	the	FoV	(see	
page	140).	Also,	the	custom	reticle	editor	now	includes	a	sample	Field	graphic	that	allows	you	to	
get	a	feel	for	what	you	are	designing.

• The	menu	revealed	by	right-clicking	the	object	list	now	has	a	Chart/s	submenu	that	allows	you	to	
select	all	selected	charts/atlases,	or	any	one	of	them	(if	more	than	one	has	been	checked)	(see	
page	297).	Note	also	that	the	Object	List	preferences	window	now	places	the	Chart#	atlas	list	on	a	
separate	tab	(see	page	297).

• Added	Meridian	as	a	Display	Options	line	option	for	the	Sky	chart	(see	page	149).

• Added	the	Rotate	Chart	display	option	to	the	Sky	Chart	(see	page	151).

• Implemented	Telescope	>	Slew	to	Sky	Flat	Position...	to	slew	to	a	suitable	position	to	take	sky	
Flats	for	astrophotography	(see	page	215).

• Added	Deep	Sky	Atlas	chart	number	support.

• Can	now	specify	the	search	radius	used	by	Find	Closest	Object	(see	page	#).

• The	ODM/Eyepiece	info	for	an	object	is	now	available	without	having	to	make	an	observation	First	
(see	page	88).

• The	Nexus	wireless	device	for	connecting	wirelessly	to	telescope	mounts	(http://www.astrode-
vices.com/products/Nexus/Nexus.html)	is	now	supported	in	the	mount	options.	The	mount	op-
tions	have	been	changed	to	allow	for	other	devices	as	well	(see	page	199).

• There	is	now	a	Script	>	User-Contributed	Scripts	>	Upload...	menu	command.	Previously	it	was	
only	available	as	a	button	in	the	script	editor	window.

• Added	Date	of	Opposition	column	to	the	object	list	(see	page	101).

• The	Capabilities...	button	in	the	mount	editor	now	works	for	ASCOM	mounts	(see	page	202).

• Added	Best	Eyepiece	and	Best	MagniOication	object	list	columns	(see	page	97).
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• Added	Splitability	and	Splitability	Aperture	columns	to	the	object	list.	This	uses	an	enhanced	al-
gorithm	developed	by	Dr	Wilfried	Knapp	to	decide	whether	or	not	you	will	be	able	to	split	double	
stars	with	a	speciFic	telescope	(see	page	103).

• Added	the	ability	to	sync	AstroPlanner's	Files	between	two	or	more	computers	using	a	common	
folder	(see	page	319).

• Implemented	the	Dark	Start,	Dark	End,	and	Dark	Duration	object	list	columns	(see	page	98).	
These	columns	make	use	of	the	Dark	Time	object	list	preferences	(see	page	297).

• Added	Object	Properties	vs.	Time	feature	that	allows	you	to	chart	changes	in	value	of	certain	ob-
ject	properties	over	time.	See	page	172.

• Journal.	A	simple	journal/diary	feature	has	been	added.	See	page	252.

• Import	of	Gamma	Ray	Burst	(GRB)	data.	See	page	355.

30.3 V2.2
V2.2	includes	many	Fixes	to	problems	in	V2.0	and	V2.1.	They	are	not	listed	here.	You	can	use	Help	>	
Revision	Notes	to	see	details	of	bug	Fixes	and	enhancements.	

Note	that	there	might	be	slight	changes	in	the	illustrations	(the	V2	manual	was	illustrated	using	
screen	shots	from	Mac	OS	X	10.6	and	Mac	OS	X	10.7,	V2.1	was	illustrated	with	Mac	OS	X	10.8,	while	
the	V2.2	changes	were	illustrated	using	screen	shots	from	Mac	OS	X	10.9).

The	following	list	enumerates	all	non-trivial	changes	and	improvements	between	V2.1	and	V2.2,	and
where	you	can	Find	them	in	this	manual.	They	are	in	no	particular	order.

• SkySafari	observation	import.	You	can	now	(optionally)	import	observations	from	SkySafari	obser-
vation	lists.	See	Section	26.1.9	on	page	358.

• You	can	add	a	Fixed	text	preFix	to	imported	Fields	in	the	Generic	Text	import	feature.	e.g.	you	might	
wish	to	add	the	preFix	"NGC"	to	a	Field	containing	only	the	NGC	catalogue	number.	Generic	text	
import	and	export	now	have	a	Text	ModiFications	feature	on	each	Field	that	allows	preFixes,	
sufFixes,	substitutions,	etc.	See	page	350.

• You	can	now	have	Fixed	text	import	Fields.	e.g.	if	you	are	importing	a	File	of	double	stars,	you	might	
want	to	force	the	Type	Field	to	"Dbl".	Generic	text	import	and	export	now	have	a	Text	ModiFications
feature	on	each	Field	that	allows	preFixes,	sufFixes,	substitutions,	etc.	See	page	350.

• Double	star	orbits.	Computes	double	star	orbits,	given	elements	embedded	in	select	double	star	
catalogues	(currently	the	WDS	catalogues).	See	Section	25.1	on	page	347.

• The	Mag-7	Star	Atlas	(http://www.cloudynights.com/item.php?item_id=1052)	is	supported	as	a	
chart	numbering	target.

• You	can	now	import	non-ASCII	text	(i.e.	with	text	encodings	such	as	UTF8,	UTF-16,	etc.),	and	retain
any	non-ASCII	characters	(e.g.	Greek).

• Enabled	axis	movement	commands	in	ASCOM.

• When	exporting	sessions/observations	to	a	text	File,	etc.,	you	no	longer	need	to	specify	the	start	
and	end	dates.	Those	dates	are	now	optional	so	that	it's	easy	to	export,	say,	all	observations,	all	
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observations	starting	on	a	given	date,	etc.	See	page	360.

• If	you	export	a	Field	containing	line	endings	(e.g.	the	Notes	Field)	to	a	text	File,	extra	lines	are	
created.	A	new	setting	in	the	export	dialog	substitutes	given	text	(default	=	"	/	")	for	any	line	
endings	found	in	a	text	Field.

• User-deFined	Field	formatting.	You	can	now	optionally	deFine	a	user	Field	to	display	in	bold,	italic	
and/or	underlined.	Additionally,	user-deFined	Field	scripts	can	override	the	display	style	
individually.	See	Section	19.3	on	page	277.

• Added	buttons	to	the	Date/Time	controls	that	allow	you	to	step	forwards	or	backwards	through	
time,	with	a	variable	step	size	(from	1	second	to	1	year).	See	page	94.

• You	can	now	use	an	USB	Flash	drive,	instead	of	a	DVD-ROM,	for	loading	catalogues.

• Added	the	facility	to	list/search	catalogues	for	objects	nearby	(within	user	speciFied	angular	
distance)	from	current	telescope	position	or	current	selected	object.	Object	>	Search	>	Find	
Objects	Within	Radius....	See	page	165.

• Added	the	ability	to	add	more	than	one	constellation	object	at	a	time	from	the	Add	Special	popup	
menu.

• You	can	now	right-click	the	list	of	alignment	stars	in	the	Sky	tab	and	select:		Add	alignment	stars	
to	plan...	See	page	155.

• When	a	constellation	object	is	selected	in	the	object	list,	and	the	Field	of	View	tab	is	selected,	the	
FoV	chart	is	made	to	Fit	the	whole	constellation	by	setting	the	FoV	diameter.

• Allow	multiple	Object	Types	in	custom	highlighting.

• Added	"Ignore	All	Rules"	to	the	custom	highlighting	rule	set	popup.	This	gives	a	quick	way	to	
disable	a	rule	set	temporarily.	See	page	273.

• You	can	now	import	and	export	Cartes	du	Ciel	(V3.10	or	after)	observing	lists.	File	>	Import	>	
Cartes	du	Ciel	Observing	List...	and	File	>	Export	>	Cartes	du	Ciel	Observing	List...	See	pages	
358	and	367.

• Field	of	View	Display	Options	now	has	Reticles/FoVs	>	Crosshairs/Grid...	This	allows	you	to	add	
cross	hairs	or	a	grid	to	the	chart.	Double-clicking	lets	you	choose	the	grid	spacing	or	crosshairs.	
See	page	136.

• Each	Telescope	resource	can	optionally	create	and	use	a	custom	alignment	star	set.	This	alignment
star	set	will	be	used	even	if	the	resource	deFines	a	telescope	mount	with	built-in	alignment	stars.	
Any	star	in	the	Bright	Star	catalogue	can	be	used.	You	can	also	upload/download	to	a	user-
contributed	library	of	alignment	star	sets.	See	page	59.

• The	dialog	that	lets	you	select	multiple	new	objects	now	has	the	guide	for	double	star	identiFiers	
and	greek	letters.	See	page	161.
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• Edit	>	Copy	IDs	copies	the	ID	column	of	the	object	list	to	the	clipboard.	You	can	then	paste	it	into	a
text	File	of	your	own	choosing.	See	Section	11.6.21	on	page	176.

• Observation	>	7Timer	Chart	shows	an	observing	conditions	chart	based	on	data	from	
7timer.com.	This	works	internationally	(apparently).	See	page	120.

• Off-axis	Guider	support	in	the	Field	of	View	chart.	Custom	reticles	now	have	three	choices	for	
rotation:	Rotate	with	the	Reticle	Rotation	slider,	rotate	with	the	FoV	Angle	slider,	or	no	rotation.	If	
you	make	your	main	imager	reticle	have	"No	rotation"	and	the	pickoff	mirror	reticle	have	"Reticle	
rotation"	then	the	pickoff	mirror	will	be	adjusted	w.r.t.	the	imager	using	the	Reticle	Rotation	slider.	
The	FoV	Rotation	slider	can	be	used	to	rotate	the	FoV	under	the	main	imager	reticle	for	framing.	
See	page	143.

• When	adding	a	user	image	you	can	now	specify	the	size,	centre	coordinates,	and	orientation	w.r.t.	
North	of	the	image.	See	page	176.	Any	such	user	image	will	be	displayable	in	the	FoV.	Also,	if	you	
select	the	user	image	in	the	Image	Manager	then	you	can	edit	the	attributes	where	necessary.	

• Synonym	checkbox	added	to	the	New	Object	dialog.	If	this	is	checked	and	the	All...	button	used	
then	IDs	will	be	searched	as	well	as	synonyms	based	on	the	object's	coordinates.	See	page	76.

• Added	the	ability	to	create	your	own	Chart#	deFinitions	(for	the	Chart#	column).	You	can	also	
upload	and	download	as	user-contributed	deFinitions.	In	the	Chart#	tab	of	the	Object	List	
preferences	window.	See	page	297.

• Improvements	to	the	Help	>	Revision	Notes	window:	Show	the	list	for	all	releases,	show	bugs-
only,	etc.

• Object	List	preferences	>	Sorting	>	Show	groupings	after	sorting	a	column.	If	this	option	is	set
then	whenever	you	sort	the	object	list,	a	black	line	will	appear	between	groupings	(e.g.	sort	on	
Constellation	-	the	line	appears	between	constellation	changes;	sort	on	R.A.	-	the	line	appears	on	
every	hour	change,	etc.).	See	page	295.

• Added	Load...	and	Save...	buttons	to	the	catalogue	search	dialog.	This	allows	you	to	save	and	
reload	complex	search	parameters.	See	page	82.

• Added	a	"Set	plan	date/time"	checkbox	option	to	the	visibility	section	of	the	catalogue	search	
dialog.	Setting	this	option	will	set	the	plan's	date/time	to	the	beginning	of	the	speciFied	period	
when	the	search	is	done	(regardless	of	the	search	results).	See	page	82.

• Added	a	right-click	menu	to	any	date	Fields,	containing	relevant	entries,	e.g.	sunrise,	moonset,	etc.	
This	is	a	convenient	way	to	set	the	date/time	to	often-used	values.	See	page	48.

• The	tally	of	observations	in	now	displayed	in	the	top	of	the	Observation	Database	window	as	the	
"total	#	of	observations	for	#	of	objects".

• The	Site	Status	window	now	allows	the	local	time	to	be	Fixed	to	allow	for	future	planning,	shows	
the	current	moon	altitude	and	the	time	of	the	next	rise/set,	and	has	a	keyboard	shortcut.	
Additionally,	clicking	the	"Site:"	label	next	to	the	current	site	popup	on	the	plan	document	window	
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will	open	the	Site	Status	window.	See	page	121.

• On	most	(but	not	all)	list	widgets	in	the	application,	including	the	observation	database	window	
lists,	object	list,	etc.	you	can	right-click	and	select	Appearance...	On	the	Appearance	dialog	there's	
now	a	Columns	tab	that	allows	you	set	the	style	separately	for	each	column	in	the	list:	bold,	italic,	
underline,	the	colour	of	the	text,	and	the	colour	of	the	background.	See	page	45.

• A	new	"Components"	Field	has	been	added	for	objects	in	order	to	deal	with	double	star	
components	in	a	more	consistent	fashion,	rather	than	just	being	embedded	in	the	Notes	Field.	New	
versions	of	the	WDS	will	populate	this	Field	automatically.	See	page	98.

• The	magnitude	limits	for	particular	catalogues	being	displayed	in	the	Field	of	View	chart	can	be	
set	via	File	>	Catalogue	Manager	>	Settings	and	Coverage	(change	the	FoV	Min	Mag	and	FoV	
Max	Mag	columns).	See	page	329.	Once	set,	those	limits	can	be	used	via	the	FoV	Display	option:	
Display	>	Obey	catalogue	min/max	magnitudes.	In	the	FoV	catalogue	list,	any	catalogues	with	
limits	will	have	a	suitable	icon	displayed	to	the	left	of	the	catalogue	name.	See	page	128.

• Movement	commands	(NESW)	have	been	implemented	for	the	ServoCAT	and	Ultima	2000	
telescope	mounts.	Using	the	arrow	keys	in	Telescope	>	Telescope	Control	Palette	will	use	a	
combination	of	slew	and	cancel-slew	commands	to	move	the	mount.

• Added	a	"Selected	object/s"	option	separate	from	the	"Objects"	option	in	the	Sky	chart	Display	
Options.

• Added	a	Scale	Factor	setting	in	Preferences	>	Printing.	This	is	typically	left	to	the	default	value	
of	1,	but	can	be	changed	if	your	printer	driver	is	printing	at	an	incorrect	size.	See	Section	20.2.4	on	
page	289.

• Right-clicking	the	user-deFined	Fields	listbox	shows	"Show	Column:	xxxx"	or	"Hide	Column:	
xxxx"	(for	deFined	Fields	xxxx).	Selecting	one	of	these	toggles	the	column's	visibility	in	the	object	
list.	Note	that	it	doesn't	change	the	position	of	the	column	-	to	do	that	you'll	still	need	to	go	to	
Edit	>	List	Columns...	See	Section	19.5	on	page	284.

• Added	a	Reset	option	in	Catalogue	Manager	>	Preferences.	This	will	reset	all	"used"	Plan	
Creation	Wizard	objects	so	that	they	can	be	chosen	again.	See	Section	20.8.8	on	page	308.

• Added	a	Catalogue	Notes	Field	to	objects	and	renamed	the	existing	Notes	Field	to	User	Notes.	This
separates	notes	derived	from	the	source	catalogue	from	user-entered	notes.	Particularly	useful	
when	you	refresh	the	catalogue	notes	-	i.e.	the	user	notes	are	left	untouched.	See	page	98.

• ModiFied	the	Refresh	Objects	from	Catalogues	feature	and	revised	the	code.	You	now	have	more	
control	over	how	objects	are	updated.	See	page	169.

• All	objects	in	the	object	list	now	have	a	corresponding	constellation	map	displayed	to	the	right	of	
the	object	list	(available	in	the	list	of	images	under	the	image	display).	The	constellation	is	
displayed	with	borders,	Figure,	and	naked-eye	stars,	as	well	as	the	position	of	the	object	(and	any	
other	objects	in	the	plan	that	are	located	in	that	constellation).	The	generation	of	this	map	can	be	
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turned	off	in	the	Object	List	preferences.	See	page	104.

• Statistics	tab	has	been	added	to	the	observation	database	window.	(Note	that	Observation	>	
Statistics...	has	been	removed).	This	tab	shows	one	(or	more,	depending	on	the	window	size)	
tables	and	associated	pie	charts	showing	various	statistics	of	the	observations	in	your	database.	
See	Section	12.2.17	on	page	190.

30.4 V2.3
V2.3	includes	many	Fixes	to	problems	V2.2	and	before.	They	are	not	listed	here.	You	can	use	Help	>	
Revision	Notes	to	see	details	of	bug	Fixes	and	enhancements.	

Note	that	there	might	be	slight	changes	in	the	illustrations	(the	V2	manual	was	illustrated	using	
screen	shots	from	Mac	OS	X	10.6	and	Mac	OS	X	10.7,	V2.1	was	illustrated	with	Mac	OS	X	10.8,		V2.2	
changes	were	illustrated	using	screen	shots	from	Mac	OS	X	10.9,	while	V2.3	changes	are	illustrated	
using	macOS	10.14).

The	following	list	enumerates	all	non-trivial	changes	and	improvements	between	V2.2	and	V2.3,	and
where	you	can	Find	them	in	this	manual.	They	are	in	no	particular	order.

• The	macOS	version	is	now	a	64-bit	Cocoa	application	(previously	a	32-bit	Carbon	application)	
which	corrects	many	UI	issues	(and	probably	introduces	new	ones)	and	is	compatible	with	all	ma-
cOS	versions	from	10.10.5	onwards.	The	application	is	also	Retina-aware	when	used	on	a	Retina	
screen.

• The	Windows	version	is	now	a	32-bit/64-bit	application	that	is	HiDPI-aware,	and	runs	on	all	
Windows	systems	from	Windows	7	SP1	onwards.

• Apparent	Magnitude	at	Best	Time.	Object	list	column.	See	page	97.

• Eyepiece	resource	Field	of	view	can	be	selected	as	either	the	Apparent	FoV	(as	before)	or	the	Field	
Stop	Diameter.	See	page	63.

• Reproduce	Observation	in	Field	of	View	Chart.	Added	ability	to	set	the	date,	time,	RA,	Dec,	and	
resources	for	the	FoV	chart	to	reproduce	what	the	Field	of	view	would	have	been	for	the	observa-
tion.	Right-click	on	an	observation	in	the	Observations	tab	of	a	plan	document,	or	on	an	observa-
tion	in	the	observation	database	window.

• Date/time	qualiOiers	in	custom	highlighting	rules.	You	can	now	select	special	qualiFiers	for	any	
date/time	properties.	e.g.	sunset,	end	of	civil	twilight,	etc.	See	Section	18.1.3	on	page	272	for	more	
details.

• Optionally	force	constellation	view	in	the	DSS/User	image	on	the	objects	page.	Object	List	
Preferences	>	Constellation	Chart	Display.	See	page	295.

• Increase	number	of	shown	columns	in	the	object	list.	Previously	this	was	limited	to	62.	Now	it	
is	254.

• Arrows	on	the	Sky	chart	Time	offset	slider.	Helps	with	one	hour	increments.

• Adding	"excess"	IDs	from	catalogue	searches	as	separate	user-deOined	Oield	values.	File	>	
Catalogue	Manager	>	Preferences	>	Add	additional	IDs	to	>	Separate	User	Fields.

• Show	star	Type	when	hovering	the	cursor	on	a	star	in	the	Sky	chart.
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• Show	APASS	catalogue	V	magnitudes	option	to	UCAC4	external	catalogue.	Field	of	View	Pref-
erences	>	External	Catalogues	>	UCAC4

• Optionally	show	the	moon	altitude	in	the	long-term	visibility	indicator.	Right-clicking	reveals
the	option.

• Display	the	object	sequence	in	the	Field	of	View	chart,	c.f.	the	Sky	chart.	Display	Options	>	
Display	>	Plan	object	sequence.	Line	colour	can	be	selected	in	the	FoV	preferences.

• Cmd-Shift-U	keyboard	shortcut	for	Edit	>	Adjust	all	list	columns.

• Allow	import	of	PNG-formatted	image	Oiles	(in	addition	to	JPEG	Files).

• The	Alt/Az	indicator	on	the	Objects	tab	now	has	a	right-click	option	to	rotate	the	cardinal	
directions	by	90	degrees.

• Object	>	Search	>	Find	Objects	Within	Radius...	now	has	an	option	to	search	plan	objects	(as	
well	as	catalogues).

• Reset	Criteria	button	added	to	Catalogue	Manager	>	Preferences.	The	Rebuild…	button	no	
longer	resets	the	criteria.

• Added	“Show	object	in	catalogue”	item	to	right-click	menu	for	the	object	list.

• Changed	telescope	mount	option	to	“Use	WiOi-to-Serial	adapter	or	TCP/IP”,	and	added	a	“Di-
rect	TCP/IP”	option	to	that	just	to	make	things	clear.

• All	date	selector	widgets	in	the	UI	now	have	calendar	selection	on	macOS.

• Added	iOptron	V2	mount	protocol	support.

• User-deOined	boolean	Oields	can	now	use	a	blank	for	the	negative	case.

• Transit	Altitude	column	in	Object	list	now	has	an	option	to	append	N	or	S	to	the	value,	de-
pending	on	whether	the	object	transits	N	or	S	of	the	zenith	from	the	user's	location.

• The	Observation	Database	window	now	has	a	"#	Obs"	column	for	each	observation,	showing
the	total	number	of	observations	of	the	object	in	the	database.

• RA/Dec	grid	option	for	the	Field	of	View	chart	(Display	Options	>	Display	>	RA/Dec	Grid).

• Ability	to	Auto-merge	any	observation	sessions	less	than	n	hours	apart.	Right-click	the	Ses-
sions	list	in	the	Observation	Database	window	and	select	Auto-Merge	Sessions...

• File	>	Export	>	Sequence	Generator	Pro	Target	List.	See	page	367.

• Improved	Excel	export.	Now	exports	properly-formatted	.xlsx	Files.

• Cartes	du	Ciel	V4	external	application	support.

• If	you	try	and	save	changes	to	a	locked	(read-only)	plan	Oile,	the	Save	As...	dialog	is	presented.

• Sun	and	Moon	Info	widgets	now	include	current	azimuth.

• The	Delete...	popup	under	the	object	list	now	has	a	All	Unselected	Objects	option.

• File	>	Import	>	Exoplanet	Data...	allows	import	of	recent	exoplanet	discovery	data.	See	page	
357.

• The	Add	Special	popup	under	the	object	list	now	has	options	to	add	meteor	shower	radiant	info	
to	the	plan.

- 404 -



• Added	new	standard	object	type:	Galaxy	Group.

• Can	now	Fix	the	date/time	to	the	rise/transit/set	time	of	the	currently	selected	object	(using
the	popup	on	the	right	of	the	Fix	date	checkbox.

• Removed	obsolete	support	for	Planetarium,	Astromist,	and	Palm	DSC	(Palm	Pilot	apps).

• Removed	obsolete	support	for	V1	document	conversion.

• Added	text	encoding	support	for	generic	text	import	and	export.

• Removed	obsolete	ScopeDriver	support	(Mac	classic	app).

• Removed	obsolete	EquinoX	support.

• Resources	now	appear	in	the	same	order	in	popup	menus	as	they	do	in	the	Resources	win-
dow	(where	they	can	be	re-ordered	by	dragging).	Previously	they	were	in	alphabetic	order.

• The	application	now	supports	HTTPS	and	HTTP	1.1	online	data	sources.

• Redundant	HTTP	Web	Proxy	settings	removed	from	Web	preferences.

• If	one	or	more	objects	in	the	object	list	have	the	same	ID	then	the	window	title	will	reveal	the	
number	of	unique	IDs	as	well	as	the	total	number.

• Added	Session	>	Site	to	custom	highlighting	rules.

• Added	the	ability	to	custom	highlight	objects	that	were	observed	during	a	particular	session,	
or	at	a	particular	site.

• Edit	>	Find	on	the	object	list	presents	a	checkbox	list	of	columns	to	search	(default:	all	of	
them).

• Can	now	copy	and	paste	rows	from	one	object	list	to	another.

• Field	of	View	chart	magnitude	limit	values	now	have	up/down	arrows	that	increment	the	value	
by	0.1	magnitude.

• A	popup	menu	in	the	image	download	window	lets	you	choose	the	types	of	object	you	want	to	
download	images	for.

• A	right-click	menu	item	on	the	object	list	lets	you	lookup	information	on	an	object's	ID	or	Name
in	Wikipedia.

• Removed	the	"user_"	preOix	when	exporting	XML	data.

• Scripting	now	supports	JSON	import	and	export	of	data.

• Added	Web	Services	feature,	allowing	the	app	to	act	as	a	simple	server,	and	responding	to	certain
incoming	commands.	Includes	scripting	support,	logging.	Setting	up	in	Web	Preferences	is	covered
on	page	291.	Testing	and	managing	a	remote	AstroPlanner	application	running	web	services	is	
covered	in	Section	27.9.10	on	page	379.

• Plan	document	event	scripts	(Script	>	Event	Scripts)	can	now	be	run	every	15,	30	or	60	minutes,
or	once	a	day.

• Colour	user-deOined	Oields.	You	can	now	add	a	user-deFined	Field	with	a	colour	value.

• Scripting	support	for	Python.	You	can	run	Python	scripts,	or	Python	code,	from	an	AstroPlanner	
script.
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• Tabular	data	support	for	observations.	Includes	scripting	support.	See	Section	12.2.9	on	page	
186.

• Removed	support	for	user-Field	and	telescope	scripts	(they	were	very	unreliable).

• Separate	colour	in	Sky	Preferences	for	constellation	boundaries.

• Added	scripting	support	to	access	missing	plan	object	computed	properties:	Observability,	
HJD,	ParallacticAngle,	BestEyepiece,	DarkTimeStart,	DarkTimeEnd,	DarkTimeDuration,	BestMag-
niFication,	DateofOpposition,	SplittableAperture,	Splitability,	BestTime,	BestTimeApparentMagni-
tude,	TransitAltitude.

• Observation	list	(Observations	tab)	now	includes	site	and	equipment.
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